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INTRODUCTION

Computers have brought about major changes in all spheres of life, and especially
so in business and management. Today it is extremely difficult to imagine the world
without computers. Computers help us to communicate using modems, telephone
and Wi-Fi facilities and it seems as if you are sitting side by side and communicating
directly with each other. This modern way of communicating has been made possible
by computers. Through the Internet and e-mail, we now have the ability to
communicate with anybody in any part of the world in a matter of minutes. Internet
links are computer networks across the world so that users can share resources
and also communicate with each other. Some computers have direct access to all
the facilities on the Internet and e-mail facilities of the Internet have been a boon to
society, especially in terms of time saved.

The fact that computers have made a big impact on many aspects of our
lives can hardly be questioned. They have opened up an entire world of knowledge
and information that is readily accessible. The hardware by itself cannot do any
calculation or manipulation of data without being instructed on what to do and
how to do it. Thus, there is a need of software in a computer system. The software
used in a computer system is grouped into applications software, system software
and utility software. The system software is the Operating System (OS) software
that supports a computer’s basic functions, such as scheduling tasks, executing
applications and controlling peripherals. Application software is used by end users
to accomplish specific tasks. Some examples of application software are Microsoft
Word, Microsoft Excel, Microsoft PowerPoint, Microsoft Access, etc. The
Internet is the global network that uses the standard Internet Protocol Suite (TCP/
IP) to serve billions of users worldwide. A search engine is designed to search for
information on the Internet. A Web browser is a type of software that retrieves
and presents information resources on the Internet. Among various uses of the
Internet, e-mailing is of very significant use because it provides method of
exchanging digital messages from an author to one or more recipients. HTML or
HyperText Markup Language is a standardized set of symbols used to create
documents on the World Wide Web (WWW). JavaScript is a scripting language
that is added to standard HTML to create interactive documents.

Today, businesses rely heavily on computer technology to assist them in
almost every aspect of their work. Computers have invaded grocery stores, fast
food restaurants, big businesses and small offices. They process data, store
information, work out complex mathematical problems, track inventory and even
control temperature and lighting in office buildings. In medical sciences, CAT scans
help doctors view internal organs to check if they are healthy and functioning
properly. Farmers rely on computers to plan planting and harvesting of crops.

This book, Basics of Computer and Information Technology, is designed
to be a comprehensive and easily accessible book covering the basic concepts of
basics of computer and the Internet. It will help readers to understand the basic
concepts of computer systems, operating systems, hardware and software, and
also how to use basic application programs for managing information on computers.
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The book is divided into five units that follow the self-instruction mode with each
unit beginning with an Introduction to the unit, followed by an outline of the
Objectives. The detailed content is then presented in a simple but structured manner
interspersed with Check Your Progress Questions to test the student’s
understanding of the topic. A Summary along with a list of Key Terms and a set of
Self-Assessment Questions and Exercises is also provided at the end of each unit
for understanding, revision and recapitulation.
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UNIT 1 AN INTRODUCTION TO
COMPUTERS

Structure

1.0 Introduction
1.1 Objectives
1.2 Basic Organization of Computer System
1.3 Types of Computing Devices
1.4 Primary Memory and Their Types
1.5 Peripheral Devices
1.6 Storage Devices
1.7 Answers to ‘Check Your Progress’
1.8 Summary
1.9 Key Terms

1.10 Self-Assessment Questions and Exercises
1.11 Further Readings

1.0 INTRODUCTION

Computer is an electronic device that receives input, stores or processes the input
into meaningful information as per the user instructions and provides output in
desired format. Consequently, the literal meaning of computer is a device that can
calculate. However, modern computers can do a lot more than only calculation.
The term ‘Computer’ is derived from the Latin word ‘Computare’ means ‘To
Calculate’.

Technically, a computer is a machine that can be instructed to carry out
sequences of arithmetic or logical operations automatically via computer
programming. Modern computers have the ability to follow generalized sets of
operations, called ‘Programs’. These programs enable computers to perform an
extremely wide range of tasks. A computer system is comprised of the computer
hardware, the operating system (main computer software) and other required
specific software to accomplish specified tasks, and various types of peripheral
equipment required and used for performing various computer operations. The
group of two or more computers can be connected and work together in particular
computer network or computer cluster, this type of computer system is termed as
computer networking.

Computer is, therefore, an advanced electronic device that takes raw data
as an input from the user and processes it under the control of a set of instructions
(called program), produces a result (output), and saves it for future use. Computer
systems typically include a CPU (Central Processing Unit), monitor, keyboard,
mouse, printer and other optional components. Components of computer system
include computer hardware which are the input devices, output devices, Central
Processing Unit (CPU) and storage devices, computer software also known as
programs or applications and are classified into system software and application
software. Both hardware and software are necessary for working of a computer.
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An Operating System (OS) is the program that, after being initially loaded
into the computer by means of a boot program, manages all of the other application
programs in a computer. The application programs make use of the operating
system by making requests for services through a defined Application Program
Interface (API).

In this unit, you will study about the basic organization of computer system,
different types of computing devices, computer primary memory and its different
types, peripheral devices and storage devices.

1.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand the basic organization of a computer system

 Discuss about the different types of computing devices

 Explain the computer primary memory and their different types

 Describe the various peripheral devices of computer

 Differentiate between input devices and output devices

 Elaborate on the different types of computer storage devices

1.2 BASIC ORGANIZATION OF COMPUTER
SYSTEM

1. Definition of Computer

A computer is a machine that manipulates data according to a set of instructions.
The ability to store and execute a prerecorded list of instructions called programs
makes computers extremely versatile. Hence, it is a programmable electronic device
and responds to a specific set of instructions and performs high-speed processing
of numbers, as well as of text, graphics, symbols and sound. Modern computers
are electronic and digital. The Central Processing Unit (CPU), wires, transistors,
circuits, memory, peripheral devices, etc., are called hardware, while the
instructions and data are called software.

Technically speaking, a computer is a programmable machine, which
executes a programmed list of instructions and also responds to new instructions
that are given to it.  Basically, computers are of three types, digital, analog and
hybrid. The digital computer stores data in discrete units and performs arithmetical
and logical operations at very high speed. The analog computer has no memory
and is slower than the digital computer but has a continuous rather than a discrete
input. The hybrid computer combines some of the advantages of digital and analog
computers.

As per Oxford Dictionary the definition of a computer is, ‘An automatic
electronic apparatus for making calculations or controlling operations that are
expressible in numerical or logical terms.’
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History of Computer

The first mechanical adding machine was invented by Blaise Pascal in 1642. Later,
in the year 1671, Baron Gottfried Wilhelm von Leibniz of Germany invented the
first calculator. Around this time, Herman Hollerith came up with the concept of
punched cards, which were extensively used as an input medium in mechanical
adding machines.

Charles Babbage, a nineteenth-century professor at Cambridge University,
is considered the father of the modern digital computer. During this period,
mathematical and statistical tables were prepared by a group of clerks. Utmost
care and precautions, however, could not eliminate human errors.

In 1842, Babbage came up with his new idea of the Analytical Engine,
which was intended to be completely automatic. This machine was capable of
performing basic arithmetic functions. But, these machines were difficult to
manufacture because the precision engineering required to manufacture them was
not available at that time.

The following is a brief description of the various generations of computers:
I. Mark I Computer (1937-44): This was the first fully automatic

calculating machine designed by Howard A. Aiken and the design of
which was based on the technique of punching card machinery. In this
technique, both mechanical and electronic components were used.

II. Atanasoff-Berry Computer (1939-42): This computer was
developed by Dr. John Atanasoff to solve certain mathematical
equations. It used 45 vacuum tubes for internal logic and capacitors
for storage.

III. ENIAC (1943-46): The Electronic Numerical Integrator And
Calculator (ENIAC) was the first electronic computer developed for
military requirements and was used for many years to solve ballistic
problems.

IV. EDVAC (1946-52): One of the drawbacks of ENIAC was that its
programs were wired on boards, which made it difficult to change
them. To overcome the drawbacks of ENIAC, the Electronic Discrete
Variable Automatic Computer (EDVAC) was designed. The basic
idea behind this concept was that sequences of instructions could be
stored in the memory of the computer for automatically directing the
flow of operations.

V. EDSAC (1947-49): Professor Maurice Wilkes developed the
Electronic Delay Storage Automatic Calculator (EDSAC), by which
machine, addition and multiplication operations could be accomplished.

VI. UNIVAC I (1951): The Universal Automatic Computer (UNIVAC)
was the first digital computer to be installed in the Census Bureau in
1951 and was used continuously for 10 years. In 1952, International
Business Machines (IBM) introduced the 701 commercial computers.
These computers could be used for scientific and business purposes.
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Application of Computers

Information Technology (or IT as it is popularly called) has dramatically changed
the way of our life. After the discovery of electricity, the computer ranks as one of
the most important breakthroughs of the modern era. Like electricity, IT has
impacted all facets of  life and, in fact, its usage is so ubiquitous that it is hard for
today’s generation to even visualize how our ancestors lived without computers.
From medicine to transportation, from banking to the entertainment industry, there
is hardly any industry or sector that does not deploy IT in a fundamental manner to
achieve one of the three goals:

I. Reducing the cost of operations by increasing operational efficiency and
staff productivity.

II. Improving revenues and bottom lines by helping  management in informed
decision-making and focusing on priority areas.

III. Improving customer satisfaction by providing better, faster and value-added
services.
IT has opened up several allied industries and  employment opportunities

which never  existed before. Whether it is Business Process Outsourcing or BPO,
(remote data processing) or web-enabled services (medical transcription, call
centres, etc.), IT has opened up new avenues for jobs. Thanks to the Internet,
developing nations today can also participate in the global economy and help
bridge the divide between haves and have-nots.

Computers play important role in Railway and Airway Reservations,
Banking, Insurance, Financial Accounting, Education, Telephone Exchange,
Weather Forecasting, etc.

Characteristics of Computer

The increasing popularity of the computer has proved that it is a powerful and
useful tool. Its usefulness is due to its following features:

I. Speed: Computers are very fast. They can process millions of instructions
every second. The speed is related to the amount of data it processes and
the time it takes to complete the processing task.

II. Storage: Computers can store vast amounts of information in the form of
files, which can be recalled at any time. These files help in easy and speedy
retrieval of information. This type of storage is known as electronic storage
system.

III. Accuracy: In addition to being fast, computers are also accurate. The degree
of accuracy for a particular computer depends upon its design. Most errors
in computers are non-technical. Generally, programmers are responsible
for these errors.

IV. Diligence: Computers are diligent as they can perform any complicated
task accurately without making any error. Computers do not suffer from
carelessness, boredom or tiredness. Moreover, their efficiency does not
decrease with age.

V. Versatility: Computers perform various tasks depending upon the
instructions fed into them and their hardware characteristics. They are
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capable of performing any task, provided the task is reduced to a series of
logical steps. A computer can be used to prepare a Word document and in
between called to search for another document that is stored in its memory.
It can perform both tasks simultaneously.

Limitations of Computer

Though the computer can do better than any human being in accuracy, memory
and also speed, but even then there are certain limitations for it because it depends
on a human being for operation and functioning. The following are some of the
limitations of a computer system:

I. It is programmed by a human being for efficient, accurate and fast functioning.

II. It cannot think intelligently like a human being and work independently but
it follows the instructions given in a program or by the user.

III. It can neither take decisions nor can correct wrong instructions.

IV. It is maintained and updated by a programmer or a user.

V. It has no feelings and ethics.

VI. It cannot work without power.

2. Hardware: Computer Architecture

The size, shape, cost and performance of computers have changed over the years,
but the basic logical structure has not. Any computer system essentially consists of
three important parts, namely, input device, Central Processing Unit (CPU) and
output device. The CPU itself consists of  the main memory, the Arithmetic Logic
Unit (ALU) and the Control Unit (CU). Figure 1.1 illustrates the Central Processing
Unit (CPU).

 

 

 

 

 
 

Secondary Storage

Main Memory

Control Unit

Arithmetic Logic Unit

Input Unit

(Data and Instructions) (Information-Results)

Fig. 1.1 Central Processing Unit (CPU)

Central Processing Unit

Execution of programs is the main function of the computer. The programs or the
set of instructions are stored in the computer’s main memory and are executed by
the CPU. The CPU processes the set of instructions along with any calculations
and comparisons to complete the task. Additionally, the CPU controls and activates
various other functions of the computer system. It also activates the peripherals to
perform input and output functions.
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Figure 1.2 Illustrates the block diagram of CPU.

Arithmetic Logic
Unit (ALU) 

Memory Unit 

Control Unit

Fig. 1.2 Block Diagram of CPU

The CPU consists of three major components: the register set (associated
with the main memory) that stores the transitional data while processing the programs
and commands, ALU which performs the necessary micro-operations for
processing the programs and commands, and the control unit that controls the
transmitting of information amongst the registers and directs the ALU on the
instructions to follow.

Control Unit: The control unit not only plays a major role in transmitting data
from a device to the CPU and vice versa but also plays a significant role in the
functioning of the CPU. It actually does not process the data but manages and
coordinates the entire computer system including the input and the output devices.
It retrieves and interprets the commands of the programs stored in the main memory
and sends signals to other units of the system for execution. It does this through
some special purpose registers and a decoder. The special purpose register called
the instruction register holds the current instruction to be executed, and the program
control register holds the next instruction to be executed. The decoder interprets
the meaning of each instruction supported by the CPU. Each instruction is also
accompanied by a microcode, i.e., the basic directions to tell the CPU how to
execute the instruction.

Arithmetic Logic Unit (ALU): The ALU is responsible for arithmetic and logic
operations. This means that when the control unit encounters an instruction that
involves an arithmetic operation (add, subtract, multiply, divide) or a logic operation
(equal to, less than, greater than), it passes control to the ALU, which has the
necessary circuitry to carry out these arithmetic and logic operations.

As an example, a comparison of two numbers (a logical operation) may
require the control unit to load the two numbers in the requisite registers and then
pass on the execution of the ‘compare’ function to the ALU.

Memory: Memory is used for storage and retrieval of instructions and data in a
computer system. The CPU contains several registers for storing data and
instructions. But these can store only a few bytes. If all the instructions and data
being executed by the CPU were to reside in secondary storage (like magnetic
tapes and disks), and loaded into the registers of the CPU as the program execution
proceeded, it would lead to the CPU being idle for most of the time, since the
speed at which the CPU processes data is much higher than the speed at which
data can be transferred from disks to registers.
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Register and Buffer

Normally, the memory cycle time is approximately 1–10 times higher than the
CPU cycle time, hence temporary storage is provided within the CPU in the form
of CPU registers. The CPU registers are termed as fast memory and can be
accessed almost instantaneously.

Further, the number of bits a register can store at a time is called the length
of the register. Most of the CPUs sold today have 32-bit or 64-bit registers. The
size of the register is also called the word size and indicates the amount of data that
a CPU can process at a time. Thus, the bigger the word size, the faster the speed
of the computer to process data.

The number of registers varies in different computers. The following are the typical
registers found in most computers:

I. Memory Address Register (MAR): It specifies the address of memory
location from which data is to be accessed (in case of read operation) or to
which data is to be stored (in case of write operation).

II. Memory Buffer Register (MBR): It receives data from the memory (in
case of read operation) or contains the data to be written in the memory (in
case of write operation).

III. Program Counter (PC): It keeps track of the instruction that is to be
executed next, after the execution of the current instruction.

IV. Accumulator (AC): It interacts with the ALU and stores the input or output
operand. This register, therefore, holds the initial data to be operated upon,
the intermediate results and final results of processing operations.

V. Instruction Register (IR): The instructions are loaded in the IR before
their execution, i.e., the instruction register holds the current instruction that
is being executed.

Motherboard
A motherboard is the main PCB (Printed Circuit Board) sometimes alternatively
known as a logical board or a main board of a Personal Computer or in fact any
complex electronic system. It is basically a flat fibreglass platform which hosts the
CPU (Central Processing Unit), the main electronic components, device controller
chips, main memory slots, slots for attaching the storage devices and other
subsystems. Figure 1.3 illustrates the motherboard.

Fig. 1.3 Motherboard
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System Clock

Nowadays, usually all PC systems has various different system clocks. There is a
particular frequency for each clock to vibrate, which is measured in MHz
(MegaHertz). It is the smallest unit of time where the processing occurs as the
clock’s ‘Tick’ and is at times termed as a cycle. At present, a normal non-assembled
system consists of four to five different clocks working at varied speeds. Generically,
the term ‘System Clock’ is referred to the speed of the memory bus functioning on
the motherboard rather than a processor.

Different clocks in the modern PC are created using a single clock generator
circuit on the motherboard to generate the ‘main’ system clock, and then different
clock multipliers or divider circuits to generate the other signals. The entire system
depends upon the speed of the system clock. Hence, it is important to increase
the clock speed instead of increasing the speed of raw processor.

CMOS

CMOS (Complementary Metal Oxide Semiconductor) is the technology for making
semiconductors (integrated circuits) like processors, chipset chips, DRAM, etc.
A benefit using the CMOS is that it requires very less power in comparison to
various different semiconductor technologies. This benefit is the sole reason for
CMOS being used as to minimize the amount of power required from the battery
resulting in a long lasting life of the battery. The system uses something called a
CMOS checksum as an error-detecting code. Each time you change the BIOS
settings, the checksum is generated by adding together all the bytes in the CMOS
memory and then storing the lowest byte of the sum. If they are different, then the
system knows that the CMOS has been corrupted somehow and will warn you
with an error, typically something like ‘CMOS Checksum Error’.

Bus

Bus is a set of lines which carries information about the data is transferred to and
from in the memory. Data along with memory addresses is carried on the bus
because it controls the location in memory about the processed data. The speed
of the bus is controlled by system clock speed and main driver of bus performance.
If the data part of the bus is wider, the more information is transmitted simultaneously;
it means it gives higher performance. All computers use three types of basic buses
such as control bus, address bus and data bus. Figure 1.4 illustrates the bus
organization in a computer system.

Control Bus

Central Processing
Unit

Address Bus

Memory

Control 
Bus

Input/Output External
Connections

Printer,
Monitor,

Mouse, etc.

Data Bus

Fig. 1.4 Bus Organization
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Check Your Progress

1. What is a computer system?

2. Explain about the characteristics of computer.

3. Define the terms CMOS and Bus in computer.

1.3 TYPES OF COMPUTING DEVICES

Computers are available in different shapes, sizes and weights. Because of different
shapes and sizes they perform different types of jobs from one another. They can
also be classified in different ways. Here the computers are classified on the basis
of function, size and capacity, and speed.

Classification of Computer by Function

A computer can be classified as analog, digital and hybrid computers on the basis
of the functions it performs.

1. Analog Computer: Analog computers are generally used in industrial
process controls and to measure physical quantities, such as pressure,
temperature, etc. An analog computer does not operate on binary digits to
compute. It works on continuous electrical signal inputs and the output is
displayed continuously. Its memory capacity is less and can perform only
certain type of calculations. However, its operating speed is faster than the
digital computer as it works in a totally different mode. Analog computers
perform computations using electrical resistance, voltage, etc. The use of
electrical properties signifies that the calculations can be performed in real
time or even faster at a significant fraction of the speed of light. Typically, an
analog computer can integrate a voltage waveform using a capacitor which
ultimately accumulates the charge. The basic mathematical operations
performed in an electric analog computer are summation, inversion,
exponentiation, logarithm, integration with respect to time, differentiation
with respect to time, multiplication and division. Hence in the analog
computers, an analog signal is produced which is composed of DC and AC
magnitudes, frequencies and phases. The starting operations in an analog
computer are done in parallel. Data is represented as a voltage that is a
compact form of storage.

2. Digital Computer: Digital computers are commonly used for data
processing and problem solving using specific programs. A digital computer
stores data in the form of digits (numbers) and then processes it in the
discrete form from one state to the next. These processing states involve
binary digits which acquire the form of the existence or nonexistence of
magnetic markers in a standard storage devices, on-off switches or relays.
In a digital computer, letters, words, symbols and complete texts are digitally
represented, i.e., using only two digits 0 and 1. It has a large memory to
store huge quantity of data. The functional components of a typical digital
computer system are input-output devices, main memory, control unit and
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arithmetic logic unit. The processing of data in a digital computer is done
with the help of logical circuits, which are also termed as digital circuits. All
the circuits processing data inside a computer function in an extremely
synchronized mode; which is further controlled using a steady oscillator
acting as the computer’s ‘clock’. The clock rate of a typical digital computer
ranges from several million cycles per second to several hundred million
cycles, whereas the clock rate of fastest digital computers are about a billion
cycles per second. Hence, the digital computers operate on very high speed
and are able to perform trillions of logical or arithmetic operations per second
to provide quick solution to problems, which is not possible for a human
being to do manually.

3. Hybrid Computer: Hybrid computers are the combination of digital and
analog computers. A hybrid computer uses the best features of digital and
analog computers. It helps the user to process both continuous and discrete
data. Hybrid computers are generally used for weather forecasting and
industrial process control. The digital component basically functions as a
controller to provide logical operations, whereas the analog component
functions as a solver to provide solutions of differential equations. Remember
that the hybrid computers are different from hybrid systems. The hybrid
system is a digital computer equipped with an analog-to-digital converter
for input and a digital-to-analog converter for output. The term ‘hybrid
computer’ signifies a mixture of different digital technologies to process
specific applications with the help of various specific processor technologies.

Classification of Computer by Size and Capacity

1. Supercomputers: Supercomputers are the most powerful and expensive
computers available today. They are primarily used for processing complex
scientific applications that involve tasks with highly complex calculations
and solving problems with mechanical physics, such as weather forecasting
and climate research systems, nuclear weapon simulation and simulation of
automated aircrafts. Military organizations, major research and development
centres, universities and chemical laboratories are major users of
supercomputers.

Supercomputers use multiprocessing and parallel processing technologies
to solve complex problems promptly. They use multiprocessors, which
enable the user to divide a complex problem into smaller problems. A parallel
program is written in a manner that can break up the original problem into
smaller computational modules. Supercomputers also support
multiprogramming, which allows simultaneous access to the computer by
multiple users. Some of the manufacturers of supercomputers are IBM,
Silicon Graphics, Fujitsu and Intel.

2. Mainframe Computers: Mainframe computers are generally used for
handling the needs of information processing of organizations like banks,
insurance companies, hospitals and railways. This type of system is placed
in a central location with several user terminals connected to it. The user
terminals act as access stations and may be located in the same building.
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Mainframe computers are bigger and more expensive than workstations.
They look like a row of large file cabinets and need a large room with
closely monitored humidity and temperature levels. A mainframe system of
lower configuration is often referred to as a minicomputer system.

3. Server: In computing, a ‘Server’ is a computer program or a device that
provides functionality for other programs or devices, termed as ‘Clients’.
This architecture is termed as the client–server model, and a single overall
computation is distributed across multiple processes or devices. Servers
can provide various functionalities, often called ‘Services’, such as sharing
data or resources among multiple clients, or performing computation for a
client. A single server can serve multiple clients, and a single client can use
multiple servers. A client process may run on the same device or may connect
over a network to a server on a different device. Typical servers are Database
Servers, File Servers, Mail Servers, Print Servers, Web Servers, Game
Servers, and Application Servers.

Fundamentally, the server is a computer that provides data to other
computers. It may serve data to systems on a Local Area Network (LAN)
or a Wide Area Network (WAN) over the Internet. Each type of server
runs software which is specific to the purpose of the server. For example, a
Web Server may run Apache HTTP (HyperText Transfer Protocol) Server
or Microsoft IISs (Internet Information Services), which both provide access
to Websites over the Internet. A Mail Server may run a program like Exim
or iMail, which provides SMTP (Simple Mail Transfer Protocol) services
for sending and receiving e-mail. A File Server might use Samba or the
operating system’s built-in file sharing services to share files over a network.

Client–server systems are today most frequently implemented by (and often
identified with) the request–response model, such as a client sends a request
to the server, which performs some action and sends a response back to
the client, typically with a result or acknowledgement. Designating a computer
as ‘Server-Class Hardware’ implies that it is specialized for running servers
on it. This often implies that it is more powerful and reliable than standard
personal computers, but alternatively, large computing clusters may be
composed of many relatively simple, replaceable server components.

The regular desktop computers can be turned into a server by adding or
installing the appropriate software. For example, a computer connected to
a home network can be designated as a File Server, Print Server, or both.
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Most servers are accessed remotely using remote access software, so input
devices are often not even necessary.

While servers can run on different types of computers, it is significant that the
hardware is sufficient to support the demands of the server. For example, a
Web Server that runs lots of Web scripts in real-time should have a fast
processor and enough RAM to handle the ‘Load’ without slowing down. A
File Server should have one or more fast hard drives or SSDs (Solid State
Drives) that can read and write data quickly. Regardless of the type of server,
a fast network connection is critical, since all data flows through that connection.

4. Workstation: A workstation is a special computer designed for technical
or scientific applications. Intended primarily to be used by one person at a
time, they are commonly connected to a local area network and run multi-
user operating systems.

Workstation is basically a high-performance computer system that is basically
designed for a single user and has advanced graphics capabilities, large
storage capacity, and a powerful microprocessor (central processing unit).
A workstation is more capable than a Personal Computer (PC) but is less
advanced than a midrange computer (which can manage a large network of
peripheral PCs or workstations and handle immense data-processing and
reporting tasks). The term workstation is also sometimes ascribed to dumb
terminals (i.e., without any processing capacity) that are connected to
mainframe computers.

A workstation is a special computer typically designed for technical or
scientific applications. Intended primarily to be used by one person at a
time, they are commonly connected to a Local Area Network or LAN and
run multi-user operating systems. The term workstation has also been used
loosely to refer to everything from a mainframe computer terminal to a PC
connected to a network, but the most common form refers to the group of
hardware offered by several current and defunct companies, such as Sun
Microsystems, Silicon Graphics, Apollo Computer, DEC, HP, NeXT and
IBM which opened the door for the 3D graphics animation revolution of
the late 1990s.

Workstations offered higher performance than mainstream personal
computers, especially with respect to CPU and graphics, memory capacity,
and multitasking capability. Workstations were optimized for the visualization
and manipulation of different types of complex data, such as 3D mechanical
design, engineering simulation (e.g., computational fluid dynamics), animation
and rendering of images, and mathematical plots. Typically, the form factor
is that of a desktop computer, consist of a high resolution display, a keyboard
and a mouse at a minimum, but also offer multiple displays, graphics tablets,
3D mice (devices for manipulating 3D objects and navigating scenes), etc.
Workstations were the first segment of the computer market to present
advanced accessories and collaboration tools.
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Most workstation microprocessors employ Reduced Instruction Set
Computing (RISC) architecture, as opposed to the Complex Instruction Set
Computing (CISC) used in most PCs. Because it reduces the number of
instructions permanently stored in the microprocessor, RISC architecture
streamlines and accelerates data processing. A corollary of that feature is that
applications software run by workstations must include more instructions and
complexity than CISC-architecture applications. Workstation microprocessors
typically offer 32-bit addressing (indicative of data-processing speed),
compared to the exponentially slower 16-bit systems found in most PCs.
Some advanced workstations employ 64-bit processors, which possess four
billion times the data-addressing capacity of 32-bit machines.

5. Minicomputer: The minicomputers are comparatively smaller in size and
have lower processing speed and cost in comparison to mainframe. These
are termed as minicomputers because of their small size. The minicomputers
are basically used for business, education and government departments.
The minicomputers are designed for a single user as well as for complex
systems having multiple terminals. Minicomputers are frequently used as
servers in network environment where hundreds of personal computers are
attached to the network. Single user minicomputers are also used for design
generation tasks. The first minicomputer was introduced in the mid-1960s
by Digital Equipment Corporation (DEC). After this IBM Corporation (AS/
400 computers), Data General Corporation and Prime Computer also
designed the minicomputers.

6 Microcomputer: The microcomputers are also termed as personal
computers or simply PCs and have a microprocessor for processing the
task. These are very small in size and cost is also less as compared to other
types. The first microcomputer by IBM was designed in 1981 and was
termed as IBM-PC. Many other companies then copied the design of IBM-
PC computer hardware. The well known types of personal computers are
the PC and the Apple. These types of computers can work with different
operating systems. Personal computers are available in the models Desktop
PCs and Tower PCs. A desktop personal computer is most popular model
of personal computer. Microcomputers are further categorized as Laptop
computer, Workstation, Network computer and Handheld computer.

7. Personal Computers/Desktop Computers: A Personal Computer (PC)
is a small single-user microprocessor-based computer that sits on your
desktop and is generally used at homes, offices, and schools. As the name
implies, PCs were mainly designed to meet the personal computing needs
of individuals. Personal computers are used for preparing normal text
documents, spreadsheets with predefined calculations and business analysis
charts, database management systems, accounting systems and also for
designing office stationary, banners, bills and handouts.

The configuration varies from one PC to another depending on its usage.
However, it consists of a Central Processing Unit (CPU) or system unit, a
monitor, a keyboard and a mouse. It has a main circuit board or motherboard
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(consisting of the CPU and the memory), hard disk storage, floppy disk
drive, CD-ROM drive and some special add-on cards (like Network
Interface Card) and ports for connecting peripheral devices like printers.
PCs are available in two models—desktop and tower.

8. Notebook/Laptop Computers: Notebook computers are battery-
operated personal computers. Smaller than the size of a briefcase, these
are portable computers and can be used in places like libraries, in meetings
or even while travelling. Popularly known as laptop computers, or simply
laptops, they weigh less than 2.5 kg and can be only 3 inches thick. These
computers have large storage space and other peripherals such as serial
port, PC card, modem or network interface card, CD-ROM drive and
printer. They can also be connected to a network to download data from
other computers or to the Internet.

Foldable flat screen

9. Smartphone: Smartphones are a class of mobile phones that are specifically
used as multi-purpose mobile computing devices. They are distinguished
from feature phones by their stronger hardware capabilities and extensive
mobile operating systems, which facilitate wider software, Internet (including
Web Browsing over Mobile Broadband), and multimedia functionality
(including music, video, cameras, and gaming), alongside core phone
functions, such as voice calls and text messaging. Smartphones typically
contain a number of Metal Oxide Semiconductor (MOS) Integrated Circuit
(IC) chips, include various sensors that can be leveraged by their software
(such as, a magnetometer, proximity sensors, barometer, gyroscope, or
accelerometer), and support wireless communications protocols (such as,
Bluetooth, Wi-Fi, or Satellite Navigation).

Early smartphones were marketed primarily towards the enterprise market,
attempting to bridge the functionality of standalone Personal Digital Assistant
(PDA) devices with support for cellular telephony, but were limited by their
bulky form, short battery life, slow analog cellular networks, and the
immaturity of wireless data services. These issues were eventually resolved
with the exponential scaling and miniaturization of MOS transistors down
to sub-micron levels (based on the Moore’s law), the improved Lithium
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Ion Battery, faster digital mobile data networks (based on the Edholm’s
law), and more mature software platforms that allowed mobile device
ecosystems to develop independently of data providers.

In the 2000s, NTT DoCoMo’s i-mode platform, BlackBerry, Nokia’s
Symbian platform, and Windows Mobile began to gain market traction,
with models often featuring QWERTY keyboards or resistive touchscreen
input, and emphasizing access to push email and wireless internet. Since the
unveiling of the iPhone in 2007, the majority of smartphones have featured
thin, slate-like form factors, with large, capacitive screens with support for
multi-touch gestures rather than physical keyboards, and offer the ability
for users to download or purchase additional applications from a centralized
store, and use cloud storage and synchronization, virtual assistants, as well
as mobile payment services.

Improved hardware and faster wireless communication (due to standards,
such as LTE or Long Term Evolution) have strengthened the growth of the
smartphone industry. In the third quarter of 2012, one billion smartphones
were in use worldwide. Global smartphone sales surpassed the sales figures
for feature phones in early 2013. The following are some of the other key
features of a smartphone:

 Internet Connectivity.

 A Mobile Browser.

 The Ability to Sync more than one E-Mail Account to a Device.

 Embedded Memory.

 A Hardware or Software-Based QWERTY Keyboard.

 Wireless Synchronization with Other Devices, such as Laptop or
Desktop Computers.

10. Tablet PC: Tablet PC is a mobile computer that looks like a notebook or
a small writing slate but uses a stylus pen or your finger tip to write on the
touch screen. It saves whatever you scribble on the screen with the pen, as
shown in picture in the same way as you have written it. The same picture
can than be converted to text with the help of a HR (hand recognition)
software.
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Check Your Progress

4. How are computers classified?

5. Why are supercomputers used?

6. Explain about smartphone giving its features.

1.4 PRIMARY MEMORY AND THEIR TYPES

The primary memory is the main memory of the computer which communicates
directly with the processor. This memory is large in size and fast, but not as fast as
the internal memory of the processor. It comprises a couple of integrated chips
mounted on a printed circuit board plugged directly on the motherboard. Random
Access Memory (RAM) is an example of primary storage memory.

(i) Magnetic Core Memory: It was previously used and was termed as
Random Access Computer Memory. It used small magnetic rings, termed
cores, for storage.

(ii) Internal Processor Memory: This is a small set of high-speed registers
placed inside a processor and used for storing temporary data while
processing.

(iii) Static and Dynamic RAM: There are two types of integrated circuit RAM
chips available in the market, Static RAM (SRAM) and Dynamic RAM
(DRAM). Static RAM stores binary information using clocked sequential
circuits. The information stored in the SRAM remains valid as long as the
power is supplied to the unit, whereas DRAM stores information inside a
chip in the form of electric charges supplied to the capacitor. The dynamic
memory needs to be refreshed by periodically recharging the capacitors as
they tend to get discharged with time. The dynamic RAM offers larger
storage capacity and reduced power consumption. Therefore, large
memories use Dynamic RAM, while static RAM is mainly used for
specialized applications.

(iv) Read Only Memory (ROM): Most of the memory in a general-purpose
computer is made of RAM integrated circuit chips, but a portion of the
memory may be constructed using ROM chips. Originally, RAM was used
to refer to random-access memory, but now we use the term read/write
memory to distinguish it from read-only memory (since ROM is also random
access). RAM is used for storing bulk of the  programs and data that are
subject to change, while ROM is used to store programs that are permanently
resident in the computer and do not change once the production of the
computer is completed.
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The ROM portion of the main memory is used for storing an initial program
called the bootstrap loader. The bootstrap loader is a program whose
function is to start the computer software operation when power is turned
on. Since RAM is volatile, its contents are destroyed when the power is
switched off. The contents of ROM remain unchanged even after the power
is switched off and on again.

Read-only memories can be manufacturer programmed or user
programmed. When the data is burnt into the circuitry of the computer by
the manufacturer, it is called manufacturer-programmed ROM. A personal
computer manufacturer, for example, may store the boot program
permanently in the ROM chip of the computers manufactured by it. Such
chips are supplied by the manufacturer and are not modifiable by users.
This is a rigid process and requires massive production.

(v) PROM: Therefore, a new kind of ROM called PROM (Programmable
Read-Only Memory) was designed. This is also non-volatile in nature and
can be written only once using special electronic equipment.  In both ROM
and PROM, the write operation can be performed only once and the written
information cannot be edited later on. But what about the cases where you
mostly read but also write a few times?

(vi) EPROM and EEPROM: Another type of memory chip called EPROM
(Erasable Programmable Read-Only Memory) was developed to take care
of such situations. EPROMs are typically used by R&D personnel who
experiment by changing micro-programs on the computer system to test
their efficiency. EPROM chips are of two types: EEPROMs (Electrically
EPROM) in which high voltage electric pulses are used to erase stored
information and  UVEPROM (Ultraviolet EPROM) in which stored
information is erased by exposing the chip for some time to ultraviolet light.

(vii) Cache Memory:  This is another category of memory used by modern
computer systems. It temporarily stores and supplies the data and instructions
from the main memory to the internal memory (registers) to speed up the
process.
Cache memories are small, high-speed memories that function between the

CPU and the primary memory. They are faster than the main memory with access
time closer to the speed of the CPU. Although caches are fast, they are also very
costly and are used only in small quantities. Caches of size 64K, 128K, for example,
are mostly available in PC -386 and PC-486, which can have 1 to 8 MB of RAM
or even more. Cache memories are made to provide high-speed memory retrieval
without sacrificing the size of the memory.

Secondary Storage Memory

This stores all the system software and application programs and is basically used
for data backups. It is much larger in size and slower than primary storage memory.
Hard disk drives, floppy disk drives and flash drives are a few examples of
secondary storage memory.
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Check Your Progress

7. What is primary memory?

8. Define Static RAM (SRAM) and Dynamic RAM (DRAM).

9. What are RAM and ROM?

10. Why is Cache memory used?

1.5 PERIPHERAL DEVICES

The computer system is a dumb and a useless machine if it is not capable of
communicating with the outside world. It is very important for a computer system
to have the ability to communicate with the outside world, i.e., receive and send
data and information.

1. Input Devices

A. Basic Input Devices

Input devices are used to transfer user data and instructions to the computer. The
basic input devices can be classified into the following categories:

(i) Keyboard Devices

Keyboard devices allow input into the computer system by pressing a set of keys
mounted on a board, connected to the computer system. Keyboard devices are
typically classified as general-purpose keyboards and special-purpose keyboards.

General-purpose keyboard: The most familiar means of entering information
into a computer is through a typewriter-like keyboard that allows a person to
enter alphanumeric information directly.

QWERTY Keyboard

Function Keys
 

Numeric Keypad

Cursor Movement Keys

Space Bar
 

Enter Key
 

Shift Key

The most popular keyboard used today is the 101 key with a traditional
QWERTY layout, with an alphanumeric keypad, 12 function keys, a variety of
special function keys, numeric keypad, and dedicated cursor control keys. It is so
called because the arrangement of its alphanumeric keys in the upper-left row.

Another popular key arrangement, called Dvorak system, was designed
for easy learning and use. It was designed with the most common consonants in
one part and all the vowels on the other part of the middle row of the keyboard.
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This key arrangement made the users use alternate keystrokes back and forth
between both the hands. This keyboard was never been commonly used.

(ii) Mouse

A mouse is a small input device used to move the cursor on a computer screen to
give instructions to the computer and to run programs and applications. It can be
used to select menu commands, move icons, size windows, start programs, close
windows, etc. Initially, the mouse was a widely used input device for the Apple
computer and was a regular device of the Apple Macintosh. Nowadays, the mouse
is the most important device in the functioning of a Graphical User Interface (GUI)
of almost all computer systems.

B. Special Input Devices

The keyboard facilitates input of data in text form only. While working with display-
based packages, we usually point to a display area and select an option from the
screen (fundamentals of GUI applications). For such cases, the sheer user-
friendliness of input devices that can rapidly point to a particular option displayed
on screen and support its selection resulted in the advent of various point-and-
draw devices.

(i) Touch Screen

A touch screen is probably one of the simplest and most intuitive of all input devices.
It uses optical sensors in or near the computer screen that can detect the touch of
a finger on the screen. Once the user touches a particular screen position, sensors
communicate the position to the computer. This is then interpreted by the computer
to understand the user’s choice for input. The most common usage of touch screens
is in information kiosks where users can receive information at the touch of a
screen. These devices are becoming increasingly popular today.

(ii) Touch Pads

A touch pad is a touch sensitive input device which takes user input to control the
onscreen pointer and perform other functions similar to that of a mouse. Instead of
having an external peripheral device such as a mouse, the touch pad enables the
user to interact with the device through the use of a single or multiple fingers being
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dragged across relative positions on a sensitive pad. They are mostly found in
notebooks and laptops where convenience, portability and space are the prime
design concerns. Touch pads are pressure and touch sensitive. They use finger
drag and tapping combinations to perform multiple control operations.

(iii) Light Pen

The light pen is a small input device used to select and display objects on a screen.
It functions with a light sensor and has a lens on the tip of a pen-shaped device.
The light receptor is activated by pointing the light pen towards the display screen
and it then locates the position of the pen with the help of a scanning beam application
to directly draw on screen.

(iv) Trackball

The trackball is a pointing device that is much like an inverted mouse. It consists of
a ball inset in a small external box or adjacent to, and in the same unit, as the
keyboard of some portable computers.

It is more convenient and requires much less space than the mouse since
here the whole device is not moved (as in the case of a mouse). Trackball comes
in various shapes but supports the same functionality. Typical shapes used are a
ball, a square and a button (typically seen in laptops).

(v) Joystick

The joystick is a vertical stick that moves the graphic cursor in the direction the
stick is moved. It consists of a spherical ball, which moves within a socket and has
a stick mounted on it. The user moves the ball with the help of the stick that can be
moved left or right, forward or backward, to move and position the cursor in the
desired location. Joysticks typically have a button on top that is used to select the
option pointed by the cursor.
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Video games, training simulators and control panels of robots are some
common uses of a joystick.

(vi) Scanning Devices

Scanning devices are input devices used for direct data entry from the source
document into the computer system. With the help of the scanner you can capture
your images and documents and convert it into digital formats for easy storage on
your computer. The scanner comprises of two major components, the first
component lights up the page in order to capture the optical image and the second
component converts that captured image into a digital format for viewing and
storing it on your computer system.

There are two types of scanners, CONTACT and LASER. Both illuminate
the image first to calculate the reflected light and determine the value of the captured
image. Hand-held contact scanners make contact as they are brushed over the
printed matter to be read. Laser-based scanners are more versatile and can read
data passed near the scanning area.

(vii) Optical Mark Recognition (OMR)

The Optical Mark Recognition (OMR) devices can scan marks from a computer-
readable paper. Such devices are used by universities and institutes to mark test
sheets where the candidate selects and marks the correct answer from multiple
choices given on a special sheet of paper. These marksheets are not required to
be evaluated manually as they are fed in the OMR and the data is then transferred
to the computer system for further evaluation.

The actual technique used by an OMR device once again involves focusing
a light on the page being scanned, thereby detecting the reflected light pattern for
the marks. Pencil marks made by the user reflect the light determining which
responses are marked.

(viii) Optical Character Recognition (OCR)

Optical Character Recognition (OCR) is used to translate the mechanical or
electronic images which are handwritten, typed or in printed form into machine-
editable format. Basically, it converts books and paper documents into electronic
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file format for preparing computerized record system. When a paper page is scanned
into a computer then it produces just an image file, i.e., a photo of the page. OCR
software is used to convert it into a text or word processor file for performing text
modification. OCR is widely used in pattern recognition, artificial intelligence and
computer vision. Optical Character Recognition or OCR is done with the help of
optical tools mirrors and lenses. Digital Character Recognition (DCR) is done
with the help of scanners.
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(ix) Magnetic Ink Character Recognition (MICR)

Magnetic Ink Character Recognition (MICR) is like an optical mark recognition
device and is  used only in the banking industry. MICR devices scan cheque
numbers directly from the cheque leaflets and then automatically feed them in the
computer systems for further use, doing the job quickly, accurately and efficiently.

Magnetic Ink Characters

Banks using MICR technology print cheque books on special types of paper.
The necessary details of the bank (like the bank’s identification code, relevant
account number and cheque number) are pre-printed on the cheques using an ink
that contains iron oxide particles that can be magnetized.

(x) Optical Bar-Code Reader (OBR)

Data coded in the form of small vertical lines forms the basis of bar coding.
Alphanumeric data is represented using adjacent vertical lines called bar-codes.
These are of varying widths and the spacing between them are used to uniquely
identify books, merchandise in stores, postal packages, etc.
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A bar-code reader uses laser beam technology. The laser beam is moved
across the pattern of bars in a bar-code. These bars reflect the beam in different
ways. The reflected beam is then sensed by a light-sensitive detector, which then
converts the light patterns into electrical pulses, thereby transmitting them to logic
circuits for further conversion to alphanumeric value. Bar-code devices are available
as hand-held devices.

(xi) Digitizer

Digitizers are used to convert drawings or pictures and maps into a digital format
for storage into the computer. A digitizer consists of a digitizing or graphics tablet,
which is a pressure-sensitive tablet, and a pen with the same X and Y coordinates
as on the screen. Some digitizing tablets also use a crosshair device instead of a
pen. The movement of the pen or crosshair is reproduced simultaneously on the
display screen. When the pen is moved on the tablet, the cursor on the computer
screen moves simultaneously to the corresponding position on the screen (X and
Y coordinates). This allows the user to draw sketches directly or input existing
sketched drawings easily. Digitizers are commonly used by architects and engineers
as a tool for Computer-Aided Designing (CAD).

(xii) Vision-Input Devices

Vision-input devices allow data input in the form of images. It usually consists of a
digital camera, which focuses on the object whose picture is to be taken. The
camera creates the image of the object in digital format, which can then be stored
within the computer. As the speech recognition system digitizes the voice input,
this system similarly compares the digitized images to be interpreted to the pre-
recorded digitized images of the database of your computer system. Once it finds
the right match it sends it for further processing or pre-defined action. Webcams
and video cameras are most commonly used to input visual data.

(xiii) Web Camera

A Web camera is a video capturing device attached to the computer system,
mostly using a USB port used for video conferencing, video security, as a control
input device and also in gaming.

(xiv) Glide Pad

Glide pad uses a touch sensitive pad for controlling cursor on the display screen.
The user slides finger across the pad and the cursor follows the finger movement.
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There are buttons to click or tap on the pad with a finger. The glide pad is a
popular alternate pointing device for laptops and is built into the keyboard. The
user can use either buttons or taps of the pad for right or left clicking. The glide
pad can be installed on notebook computers, POS terminals, specialized
keyboards, touchpad, mouse replacements, etc.

2. Output Devices

An output device is an electromechanical device that accepts data from the
computer and translates it into a form that can be understood by the outside world.
The processed data, stored in the memory of the computer, is sent to an output
unit, which then transforms the internal representation of data into a form that can
be read by the users.

Normally, the output is produced on a display unit like a computer monitor
or can be printed through a printer on paper. At times speech outputs and mechanical
outputs are also used for some specific applications.

A. Monitor or Visual Display Devices Unit

It is almost impossible to even think of using a computer system without a display
device. A display device is the most essential peripheral of a computer system.
Display screen technology may be of the following categories:

(i) Cathode Ray Tube (CRT): The CRT consist of an electron gun with an
electron beam controlled with electromagnetic fields and a phosphate-coated glass
display screen structured into a grid of small dots known as pixels. The image is
created with the electron beam produced by the electron gun, which is thrown on
the phosphor coat displayed by the electromagnetic field.

(ii) Liquid Crystal Display (LCD): LCD was first introduced in the 1970s
in digital clocks and watches, and is now widely being used in computer display
units. The Cathode Ray Tube (CRT) was replaced with the Liquid Crystal Display
(LCD) making it slimmer and more compact. But the image quality and the image
colour capability got comparatively poorer.

The main advantage of LCD is its low energy consumption. It finds its most
common usage in portable devices where size and energy consumption are of
main importance.

B. Video Standards

Video display standards have evolved from early monochrome to today’s high
resolution color. Following are some significant video standards that are used in
computer technology.

VGA: The Video Graphics Array (VGA) is a graphics display system for PCs
developed by IBM. VGA has become one of the de facto standards for PCs. In
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text mode, VGA systems provide a resolution of 720 by 400 pixels. In graphics
mode, the resolution is either 640 by 480 (with 16 colors) or 320 by 200 (with
256 colors). The total palette of colors is 262,144. Consequently, a monitor
designed for one of the older standards will not be able to use VGA. All PCs
made today support VGA, and possibly some other more advanced standard.

SVGA: It is abbreviation for Super VGA and is referred as a set of graphics
standards designed to offer greater resolution than VGA. SVGA supports 800 x
600 resolution, or 480,000 pixels. The SVGA standard supports a palette of 16
million colors, but the number of colors that can be displayed simultaneously is
limited by the amount of video memory installed in a system. One SVGA system
might display only 256 simultaneous colors while another displays the entire palette
of 16 million colors. The SVGA standards are developed by a consortium of
monitor and graphics manufacturers called VESA.

XGA: The XGA refers to eXtended Graphics Array. It is a high-resolution graphics
standard introduced by IBM in 1990. XGA was designed to replace the older
8514/A video standard. It provides the same resolutions (640 by 480 or 1024 by
768 pixels), but supports more simultaneous colors (65 thousand compared to
8514/A’s 256 colors). In addition, XGA allows monitors to be non-interlaced.

C. Printers

Printers are used for creating paper output. There is a huge range of commercially
available printers today (estimated to be 1500 different types). These printers can
be classified into categories based on:

 Printing Technology

 Printing Speed

 Printing Quality

(i) Impact Printers

Impact printers are the oldest print technologies still in active production. Impact
printers use forceful impact to transfer ink to the media, similar to a typewriter.
Some of the largest printer vendors continue to manufacture, market, and support
impact printers, parts, and supplies. Impact printers are most functional in specialized
environments where low-cost printing is essential. The three most common forms
of impact printers are Dot Matrix, Daisy Wheel and Line Printers.

Dot Matrix: Dot matrix printers are the most widely used impact printers in personal
computing. These printers use a print head consisting of a series of small metal
pins that strike on a paper through an inked ribbon, leaving an impression on the
paper through the ink transferred. Characters thus produced are in a matrix format.
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The shape of each character, i.e., the dot pattern, is obtained from information
held electronically.

The speed, versatility and ruggedness, combined with low cost, tend to
make such printers particularly attractive in the personal computer market. Typical
printing speeds in case of dot matrix printers range between 40 - 1000 characters
per second (cps). In spite of all theses features in dot matrix printer technology,
the low print quality gives it a major disadvantage.

Daisy Wheel Printers: These printers have print heads composed of metallic or
plastic wheels cut into petals. Each petal has the form of a letter (in capital and
lower case), number or punctuation mark on it. When the petal is struck against
the printer ribbon, the resulting shape forces ink onto the paper. Daisy wheel
printers are loud and slow. They cannot print graphics, and cannot change fonts
unless the print wheel is physically replaced. With the advent of laser printers,
daisy wheel printers are generally not used in modern computing environments.

Line Printers: Line printers have a mechanism that allows multiple characters to
be simultaneously printed on the same line. Line printers, as the name implies,
print an entire line of text at a time. The mechanism may use a large spinning print
drum or a looped print chain. As the drum or chain are rotated over the paper’s
surface, electromechanical hammers behind the paper push the paper (along with
a ribbon) onto the surface of the drum or chain, marking the paper with the shape
of the character on the drum or chain. Because of the nature of the print mechanism,
line printers are much faster than dot matrix or daisy wheel printers; however, they
are quite loud, have limited multi-font capability and often produce lower print
quality.

(ii) Non-Impact Printers

Non-impact printers are much quieter than impact printers as their printing heads
do not strike the paper. It is a printer that prints without banging a ribbon onto
paper. LED, Laser, Inkjet, Solid Ink, Thermal Wax Transfer and Dye Sublimation
printers are examples of non-impact printers. Most non-impact printers produce
dot matrix patterns.

Inkjet: Inkjet printers are based on the use of a series of nozzles for propelling
droplets of printing ink directly on almost any size of paper. They, therefore, fall
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under the category of non-impact printers. The print head of an inkjet printer
consists of a number of tiny nozzles that can be selectively heated up in a few
microseconds by an IC register. When this happens, the ink near it vapourizes and
is ejected through the nozzle to make a dot on the paper placed in front of the print
head. The character is printed by selectively heating the appropriate set of nozzles
as the print head moves horizontally.

Laser: Laser printers work on the same printing technology as photocopiers,
using static electricity and heat to print with a high quality powder substance known
as toner.

Laser printers are capable of converting computer output into print, page
by page. Since characters are formed by very tiny ink particles, they can produce
very high quality images (text and graphics). They generally offer a wide variety of
character fonts, and are silent and fast in use. Laser printers are faster in printing
speed than other printers discussed above. Laser printers can print from 10 pages
to 100 pages per minute, depending upon the make/model. Laser is high quality,
high speed, high volume and non-impact technology that works on almost any
kind of paper.

Thermal Printer: A thermal printer or direct thermal printer produces a printed
image by selectively heating coated thermochromic paper or thermal paper, when
the paper passes over the thermal print head. The coating turns black in the areas
where it is heated to produce an image. Two-colour direct thermal printers can
print both black and an additional colour (usually red), by using heat at two different
temperatures.

Page Printer: Page printer prints a page at a time from four to more than 800
ppm. Laser, LED, Solid Ink and Electron Beam Imaging Printers are examples
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of this category. All of these printers use toner or ink onto a drum which is
transferred to the entire page in one cycle for black and white and multiple
cycles for colour. Laser printers and LED printers employ the electro-
photographic method used in copy machines. Both technologies are available
from small desktop units to high-speed digital printing presses, ranging in speed
from four to more than 700 ppm, and colour units from 3 to 75 ppm.

Check Your Progress

11. What are input devices?

12. Explain why the keyboard device is used?

13. What are scanning devices?

14. Explain the significance of the output devices.

15. What are printers? Differentiate between the impact printers and non-impact
printers.

1.6 STORAGE DEVICES

A disk drive is a peripheral device used to store and collect information. It can be
removable or fixed, high capacity or low capacity, fast or slow speed, and magnetic
or optical.

Structurally, a drive is the object inside which a disk is either permanently or
temporarily stored. While a disk contains the media on which the data is stored, a
drive contains the machinery and circuitry required for implementing read/write
operations on the disk into two major groups – magnetic and optical.

Magnetic Drives

These are magnetized storage media on which digital or analog information is
recorded as electromagnetic signals over tracks and sectors predesigned on the
media. They are a non-volatile source for storing data because they can store
information for a long time and do not require electricity or any other element to
retain the information stored in them.

Hard Disk Drive (HDD)

This is a crucial hardware component of a personal computer, without which
modern-day computers cannot function. Although the RAM is a place of primary
storage, it is ephemeral (i.e., its life is dependent on the power source – RAM is
active only as long as the computer is turned on). A hard disk drive, though
technically a secondary form of storage, is the primary form of permanent storage
(since the data stored on the hard disk is not dependent on the computer being
switched ON or OFF). The features of HDDs that have made them an irreplaceable
component in our computers are their high capacity for storing data and the high
speeds at which they can access it at relatively lower cost. They come in various
interfaces and specifications such as IDE, EIDE, SCSI, SATA and SATA II.
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Internal and External HDD: An external hard disk is just a Hard Disk Drive
(HDD) or Solid-State Drive (SSD) that needs to be connected to the computer
rather than being inside the computer. External hard disks are sometimes referred
to as portable hard drives or mobile hard drives. Almost every computer comes
with an internal Hard Disk Drive (HDD) which is used to storage Operating
System (OS), programs and other types of files. When Hard Disk Drive (HDD) is
getting full, external Hard Disk Drive (HDD) may be useful because users can
use it to back up data from hard disk drive. As a storage device which can be
attached to computer, external hard drive has the significant features, such as high
storage capacity (120GB, 160GB, 500GB, 1TB, 1.5TB, 2TB and 3TB and more),
small size, high speed, convenient and easy to use, provides data security, etc.
Some popular brands of external hard drives are Seagate, Western Digital, Maxtor,
Samsung, Toshiba, Patriot, Hitachi, BUSlink, iThink, Transcend, Kingston, etc.

Floppy Disks

These are portable media consisting of a magnetically coated disk kept inside a
protective covering. They are low capacity and cheap to manufacture, but highly
prone to dust and scratching. Due to these limitations, they are no longer considered
a standard component of a personal computer system. Their size varies from 360K
to 2.88MB.

ZIP Drives

These are similar to disk drives but with thicker magnetic disks and a larger number
of heads in the drive to read/write. The Zip drive was introduced mainly to overcome
the limitations of the floppy drive and replace it with a higher capacity and faster
medium. The disk size ranges from 100MB to 750MB.

Magnetic Tape

Magnetic tape drives represented the sequential access method of storage and
retrieval. Sequential access, as opposed to the now prevalent random access,
means that data can be stored and retrieved only in a sequential manner – as
defined by the order in which the data was stored on the tape drive. For instance,
in case of cassette tape drives (used in tape recorders and players), which are an
example of sequential access based storage, if you want to play song number 4,
you can do so only after you have either played or fast forwarded song numbers 1
to 3 (there is no way to directly go to song number 4 without going through songs
1 to 3). Tape drives were widely used in the 1980s and 1990s as backup devices,
but due to their slow speed and sequential read/write access, they have now become
virtually obsolete.

Optical Drives

An optical drive is a type of storage medium that stores the content in digital form
which is written and read by a low intensity laser. The laser reads data from the
reflective surface of an optical disc by measuring surface changes in height and
depth. All types of optical media are divided into tracks and sectors that contain a
series of tiny indentations in which data is stored.
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(i) CD-ROM: This is an optical medium of data storage. The current maximum
capacity of a CD-ROM is 900MB with a maximum read/write access speed
of 52X, (which means 10,350 RPM - rotations per minute) and transfer
rate of 7.62 MBPS (mega-bytes per second). The data is written with the
help of a red infrared laser beam from an optical lens and the same laser of
lower intensity is used to read data from the CD-ROM.

(ii) HD-DVD: A high density, mostly single sided, double layered optical disc
which can hold up to 15GB on a single layer and 30GB on a dual layer
disc. The read/write speed on an HD-DVD varies between 36 MBPS and
72 MBPS. These were primarily designed for the storage of high-definition
videos and large volumes of data. The basic look and feel of an HD-DVD
drive and disk is the same as that of a CD-ROM and DVD except that it
uses a laser of different wavelength and the microscopic structure of storage
on a disk is different.

(iii) Blu-Ray: Another high-density optical storage media format is gaining popularity
these days. It is mainly used for high-definition video and storing data. The
storage capacity of a dual layer Blu-ray Disc is 50 GB, almost equal to storing
data in six double-dual layer DVD or more than 10 single-layer DVD.

Pen Drive: The Data Traveller

USB Flash Pen drives or Data Traveler are considered perfect for use at home,
office, small business, etc.  A USB pen drives is normally removable and has
lesser storage capacity than any other external storage device since it is much
smaller than even a floppy disk and is more durable than other external storage
device. It usually connects to the USB1.1 or USB2.0 ports. The Pen drives are
normally used to transport personal files such as documents, pictures, video’s,
music files, presentation, etc. System and network administrators use pen drives
for configuring software used for system maintenance, troubleshooting and for
data recovery. It can be used as bootable pen drives also known as Live drives
for booting PC’s and can be used at the time of system crash or virus cleaning.

Check Your Progress

16. Define disk drive.

17. What is the significance of Hard Disk Drive (HDD)?
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1.7 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. A computer is a machine that manipulates data according to a set of
instructions. The ability to store and execute a prerecorded list of instructions
called programs makes computers extremely versatile. Hence, it is a
programmable electronic device and responds to a specific set of instructions
and performs high-speed processing of numbers, as well as of text, graphics,
symbols and sound. Modern computers are electronic and digital. The
Central Processing Unit (CPU), wires, transistors, circuits, memory,
peripheral devices, etc., are called hardware, while the instructions and
data are called software.

2. The computer is a powerful and useful tool. Its usefulness is due to its
following significant characteristics:

Speed: Computers are very fast. They can process millions of instructions
every second. The speed is related to the amount of data it processes and
the time it takes to complete the processing task.

Storage:  Computers can store vast amounts of information in the form of
files, which can be recalled at any time. These files help in easy and speedy
retrieval of information. This type of storage is known as electronic storage
system.

Accuracy: In addition to being fast, computers are also accurate. The degree
of accuracy for a particular computer depends upon its design. Most errors
in computers are non-technical. Generally, programmers are responsible
for these errors.

Diligence: Computers are diligent as they can perform any complicated task
accurately without making any error. Computers do not suffer from
carelessness, boredom or tiredness. Moreover, their efficiency does not
decrease with age.

Versatility: Computers perform various tasks depending upon the instructions
fed into them and their hardware characteristics. They are capable of
performing any task, provided the task is reduced to a series of logical
steps. A computer can be used to prepare a Word document and in between
called to search for another document that is stored in its memory. It can
perform both tasks simultaneously.

3. CMOS (Complementary Metal Oxide Semiconductor) is the technology
for making semiconductors (integrated circuits) like processors, chipset
chips, DRAM, etc. A benefit using the CMOS is that it requires very less
power in comparison to various different semiconductor technologies.

Bus is a set of lines which carries information about the data is transferred
to and from in the memory. Data along with memory addresses is carried
on the bus because it controls the location in memory about the processed
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data. The speed of the bus is controlled by system clock speed and main
driver of bus performance. If the data part of the bus is wider, the more
information is transmitted simultaneously; it means it gives higher
performance. All computers use three types of basic buses, such as control
bus, address bus and data bus.

4. Computers are available in different shapes, sizes and weights. Because of
different shapes and sizes they perform different types of jobs from one
another. They can also be classified in different ways, such as the computers
are classified on the basis of function, size and capacity, and speed.

5. Supercomputers are the most powerful and expensive computers available
today. They are primarily used for processing complex scientific applications
that involve tasks with highly complex calculations and solving problems
with mechanical physics, such as weather forecasting and climate research
systems, nuclear weapon simulation and simulation of automated aircrafts.
Military organizations, major research and development centres, universities
and chemical laboratories are major users of supercomputers.

6. Smartphones are a class of mobile phones that are specifically used as
multi-purpose mobile computing devices. They are distinguished from feature
phones by their stronger hardware capabilities and extensive mobile
operating systems, which facilitate wider software, Internet (including Web
Browsing over Mobile Broadband), and multimedia functionality (including
music, video, cameras, and gaming), alongside core phone functions, such
as voice calls and text messaging. Smartphones typically contain a number
of Metal Oxide Semiconductor (MOS) Integrated Circuit (IC) chips, include
various sensors that can be leveraged by their software (such as, a
magnetometer, proximity sensors, barometer, gyroscope, or accelerometer),
and support wireless communications protocols (such as, Bluetooth, Wi-
Fi, or Satellite Navigation).

The Smartphones were eventually developed with the exponential scaling
and miniaturization of MOS transistors down to sub-micron levels (based
on the Moore’s law), the improved Lithium Ion Battery, faster digital mobile
data networks (based on the Edholm’s law), and more mature software
platforms that allowed mobile device ecosystems to develop independently
of data providers.

Improved hardware and faster wireless communication (due to standards,
such as LTE or Long Term Evolution) have strengthened the growth of the
Smartphone industry. In the third quarter of 2012, one billion smartphones
were in use worldwide. Global smartphone sales surpassed the sales figures
for feature phones in early 2013. The following are some of the other key
features of a Smartphone:

 Internet Connectivity.

 A Mobile Browser.
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 The Ability to Sync more than one E-Mail Account to a Device.

 Embedded Memory.

 A Hardware or Software-Based QWERTY Keyboard.

 Wireless Synchronization with Other Devices, such as Laptop or
Desktop Computers.

7. The primary memory is the main memory of the computer which
communicates directly with the processor. This memory is large in size and
fast, but not as fast as the internal memory of the processor. It comprises a
couple of integrated chips mounted on a printed circuit board plugged directly
on the motherboard. Random Access Memory (RAM) is an example of
primary storage memory.

8. There are two types of integrated circuit RAM chips available in the market,
Static RAM (SRAM) and Dynamic RAM (DRAM). Static RAM stores
binary information using clocked sequential circuits. The information stored
in the SRAM remains valid as long as the power is supplied to the unit,
whereas DRAM stores information inside a chip in the form of electric
charges supplied to the capacitor.

9. Most of the memory in a general-purpose computer is made of RAM
integrated circuit chips, but a portion of the memory may be constructed
using Read Only Memory (ROM) chips. Originally, RAM was used to
refer to random-access memory, but now we use the term read/write memory
to distinguish it from read-only memory (since ROM is also random access).
RAM is used for storing bulk of the  programs and data that are subject to
change, while ROM is used to store programs that are permanently resident
in the computer and do not change once the production of the computer is
completed.

10. Cache memory is the category of memory used by modern computer
systems. It temporarily stores and supplies the data and instructions from
the main memory to the internal memory (registers) to speed up the process.
Cache memories are small, high-speed memories that function between the
CPU and the primary memory. They are faster than the main memory with
access time closer to the speed of the CPU. Although caches are fast, they
are also very costly and are used only in small quantities. Cache memories
are made to provide high-speed memory retrieval without sacrificing the
size of the memory.

11. Input devices are used to transfer user data and instructions to the computer.
The input devices can be categorized as basic input devices and special
input devices. Basic input devices include Keyboard, Mouse, etc., while
the special input devices include Touch Screen, Touch Pads, Light Pen,
Joystick, Scanning Devices, Optical Mark Recognition (OMR),  Optical
Character Recognition (OCR), Magnetic Ink Character Recognition



An Introduction to
Computers

NOTES

Self - Learning
36 Material

(MICR), Optical Bar-Code Reader (OBR), Digitizer, Vision-Input Devices,
Web Camera, etc.

12. Keyboard devices allow input into the computer system by pressing a set
of keys mounted on a board, connected to the computer system. The most
popular keyboard used today is the 101 key with a traditional QWERTY
layout, with an alphanumeric keypad, 12 function keys, a variety of special
function keys, numeric keypad, and dedicated cursor control keys. It is so
called because the arrangement of its alphanumeric keys in the upper-left
row.

13. Scanning devices are input devices used for direct data entry from the source
document into the computer system. With the help of the scanner you can
capture your images and documents and convert it into digital formats for
easy storage on your computer.

14. An output device is an electromechanical device that accepts data from the
computer and translates it into a form that can be understood by the outside
world. The processed data, stored in the memory of the computer, is sent
to an output unit, which then transforms the internal representation of data
into a form that can be read by the users. Normally, the output is produced
on a display unit like a computer monitor or can be printed through a printer
on paper.

15. Printers are used for creating paper output. There is a huge range of
commercially available printers today (estimated to be 1500 different types).
These printers can be classified into categories based on the Printing
Technology, Printing Speed and Printing Quality.

 Impact printers are the oldest print technologies still in active production.
Impact printers use forceful impact to transfer ink to the media, similar
to a typewriter. Some of the largest printer vendors continue to
manufacture, market, and support impact printers, parts, and supplies.
Impact printers are most functional in specialized environments where
low-cost printing is essential. The three most common forms of impact
printers are Dot Matrix, Daisy Wheel and Line Printers.

 Non-impact printers are much quieter than impact printers as their printing
heads do not strike the paper. It is a printer that prints without banging
a ribbon onto paper. LED, Laser, Inkjet, Solid Ink, Thermal Wax Transfer
and dye sublimation printers are examples of non-impact printers. Most
non-impact printers produce dot matrix patterns.

16. A disk drive is a peripheral device used to store and collect information. It
can be removable or fixed, high capacity or low capacity, fast or slow
speed, and magnetic or optical.

Structurally, a drive is the object inside which a disk is either permanently
or temporarily stored. While a disk contains the media on which the data is
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stored, a drive contains the machinery and circuitry required for implementing
read/write operations on the disk into two major groups – magnetic and
optical.

17.  Hard Disk Drive (HDD) is a crucial hardware component of a personal
computer, without which modern-day computers cannot function. Although
the RAM is a place of primary storage, it is ephemeral (i.e., its life is dependent
on the power source – RAM is active only as long as the computer is
turned on). A hard disk drive, though technically a secondary form of storage,
is the primary form of permanent storage (since the data stored on the hard
disk is not dependent on the computer being switched on or off). The features
of HDDs that have made them an irreplaceable component in our computers
are their high capacity for storing data and the high speeds at which they
can access it at relatively lower cost. They come in various interfaces and
specifications such as IDE, EIDE, SCSI, SATA and SATA II.

1.8 SUMMARY

 A computer is a machine that manipulates data according to a set of
instructions.

 The ability to store and execute a prerecorded list of instructions called
programs makes computers extremely versatile. Hence, it is a programmable
electronic device and responds to a specific set of instructions and performs
high-speed processing of numbers, as well as of text, graphics, symbols
and sound.

 Modern computers are electronic and digital. The Central Processing Unit
(CPU), wires, transistors, circuits, memory, peripheral devices, etc., are
called hardware, while the instructions and data are called software.

 Basically, computers are of three types, digital, analog and hybrid.

 The digital computer stores data in discrete units and performs arithmetical
and logical operations at very high speed.

 The analog computer has no memory and is slower than the digital computer
but has a continuous rather than a discrete input.

 The hybrid computer combines some of the advantages of digital and analog
computers.

 As per Oxford Dictionary the definition of a computer is, ‘An automatic
electronic apparatus for making calculations or controlling operations that
are expressible in numerical or logical terms.’

 Charles Babbage, a nineteenth-century professor at Cambridge University,
is considered the father of the modern digital computer.

 Computers are very fast. They can process millions of instructions every
second. The speed is related to the amount of data it processes and the
time it takes to complete the processing task.
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 Computers can store vast amounts of information in the form of files, which
can be recalled at any time. These files help in easy and speedy retrieval of
information. This type of storage is known as electronic storage system.

 In addition to being fast, computers are also accurate. The degree of
accuracy for a particular computer depends upon its design. Most errors in
computers are non-technical. Generally, programmers are responsible for
these errors.

 Computers are diligent as they can perform any complicated task accurately
without making any error. Computers do not suffer from carelessness,
boredom or tiredness. Moreover, their efficiency does not decrease with
age.

 Computers perform various tasks depending upon the instructions fed into
them and their hardware characteristics. They are capable of performing
any task, provided the task is reduced to a series of logical steps.

 The size, shape, cost and performance of computers have changed over
the years, but the basic logical structure has not. Any computer system
essentially consists of three important parts, namely, input device, Central
Processing Unit (CPU) and output device. The CPU itself consists of the
main memory, the Arithmetic Logic Unit (ALU) and the Control Unit (CU).

 The CPU consists of three major components, namely the register set
(associated with the main memory) that stores the transitional data while
processing the programs and commands, ALU which performs the
necessary micro-operations for processing the programs and commands,
and the control unit that controls the transmitting of information amongst the
registers and directs the ALU on the instructions to follow.

 Memory is used for storage and retrieval of instructions and data in a
computer system.

 Normally, the memory cycle time is approximately 1–10 times higher than
the CPU cycle time, hence temporary storage is provided within the CPU
in the form of CPU registers.

 The CPU registers are termed as fast memory and can be accessed almost
instantaneously.

 CMOS (Complementary Metal Oxide Semiconductor) is the technology
for making semiconductors (integrated circuits) like processors, chipset
chips, DRAM, etc. A benefit using the CMOS is that it requires very less
power in comparison to various different semiconductor technologies.

 Bus is a set of lines which carries information about the data is transferred
to and from in the memory. Data along with memory addresses is carried
on the bus because it controls the location in memory about the processed
data.

 The speed of the bus is controlled by system clock speed and main driver
of bus performance. If the data part of the bus is wider, the more information
is transmitted simultaneously; it means it gives higher performance. All
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computers use three types of basic buses, such as control bus, address bus
and data bus.

 Computers are available in different shapes, sizes and weights. Because of
different shapes and sizes they perform different types of jobs from one
another. They can also be classified in different ways. Here the computers
are classified on the basis of function, size and capacity, and speed.

 Supercomputers are the most powerful and expensive computers available
today. They are primarily used for processing complex scientific applications
that involve tasks with highly complex calculations and solving problems
with mechanical physics, such as weather forecasting and climate research
systems, nuclear weapon simulation and simulation of automated aircrafts.
Military organizations, major research and development centres, universities
and chemical laboratories are major users of supercomputers.

 In computing, a ‘Server’ is a computer program or a device that provides
functionality for other programs or devices, termed as ‘Clients’. This
architecture is termed as the client–server model, and a single overall
computation is distributed across multiple processes or devices. Servers
can provide various functionalities, often called ‘Services’, such as sharing
data or resources among multiple clients, or performing computation for a
client. Typical servers are Database Servers, File Servers, Mail Servers,
Print Servers, Web Servers, Game Servers, and Application Servers.

 A workstation is a special computer designed for technical or scientific
applications. Intended primarily to be used by one person at a time, they
are commonly connected to a local area network and run multi-user operating
systems.

 A Personal Computer (PC) is a small single-user microprocessor-based
computer that sits on your desktop and is generally used at homes, offices,
and schools. As the name implies, PCs were mainly designed to meet the
personal computing needs of individuals.

 Notebook/Laptop computers are battery-operated personal computers.
Smaller than the size of a briefcase, these are portable computers and can
be used in places like libraries, in meetings or even while travelling.

 Smartphones are a class of mobile phones that are specifically used as
multi-purpose mobile computing devices. They are distinguished from feature
phones by their stronger hardware capabilities and extensive mobile operating
systems, which facilitate wider software, Internet (including Web Browsing
over Mobile Broadband), and multimedia functionality (including music,
video, cameras, and gaming), alongside core phone functions, such as voice
calls and text messaging.

 Tablet PC is a mobile computer that looks like a notebook or a small writing
slate but uses a stylus pen or your finger tip to write on the touch screen. It
saves whatever you scribble on the screen with the pen.

 This is the main memory of the computer which communicates directly with
the processor. This memory is large in size and fast, but not as fast as the
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internal memory of the processor. It comprises a couple of integrated chips
mounted on a printed circuit board plugged directly on the motherboard.
Random Access Memory (RAM) is an example of primary storage memory.

 There are two types of integrated circuit RAM chips available in the market,
Static RAM (SRAM) and Dynamic RAM (DRAM). Static RAM stores
binary information using clocked sequential circuits. The information stored
in the SRAM remains valid as long as the power is supplied to the unit,
whereas DRAM stores information inside a chip in the form of electric
charges supplied to the capacitor.

 Most of the memory in a general-purpose computer is made of RAM
integrated circuit chips, but a portion of the memory may be constructed
using Read Only Memory (ROM) chips. Originally, RAM was used to
refer to random-access memory, but now we use the term read/write memory
to distinguish it from read-only memory (since ROM is also random access).

 RAM is used for storing bulk of the  programs and data that are subject to
change, while ROM is used to store programs that are permanently resident
in the computer and do not change once the production of the computer is
completed.

 Cache memory is the category of memory used by modern computer
systems. It temporarily stores and supplies the data and instructions from
the main memory to the internal memory (registers) to speed up the process.

 Cache memories are small, high-speed memories that function between the
CPU and the primary memory. They are faster than the main memory with
access time closer to the speed of the CPU. Cache memories are made to
provide high-speed memory retrieval without sacrificing the size of the
memory.

 Input devices are used to transfer user data and instructions to the computer.
The input devices can be categorized as basic input devices and special
input devices.

 Basic input devices include Keyboard, Mouse, etc., while the special input
devices include Touch Screen, Touch Pads, Light Pen, Joystick, Scanning
Devices, Optical Mark Recognition (OMR),  Optical Character Recognition
(OCR), Magnetic Ink Character Recognition (MICR), Optical Bar-Code
Reader (OBR), Digitizer, Vision-Input Devices, Web Camera, etc.

 Keyboard devices allow input into the computer system by pressing a set
of keys mounted on a board, connected to the computer system. Keyboard
devices are typically classified as general-purpose keyboards and special-
purpose keyboards.

 The most popular keyboard used today is the 101 key with a traditional
QWERTY layout, with an alphanumeric keypad, 12 function keys, a variety
of special function keys, numeric keypad, and dedicated cursor control
keys. It is so called because the arrangement of its alphanumeric keys in the
upper-left row.
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 A mouse is a small input device used to move the cursor on a computer
screen to give instructions to the computer and to run programs and
applications. It can be used to select menu commands, move icons, size
windows, start programs, close windows, etc.

 A touch screen is probably one of the simplest and most intuitive of all input
devices. It uses optical sensors in or near the computer screen that can
detect the touch of a finger on the screen. Once the user touches a particular
screen position, sensors communicate the position to the computer.

 The trackball is a pointing device that is much like an inverted mouse. It
consists of a ball inset in a small external box or adjacent to, and in the same
unit, as the keyboard of some portable computers.

 The joystick is a vertical stick that moves the graphic cursor in the direction
the stick is moved. It consists of a spherical ball, which moves within a
socket and has a stick mounted on it. The user moves the ball with the help
of the stick that can be moved left or right, forward or backward, to move
and position the cursor in the desired location.

 Scanning devices are input devices used for direct data entry from the source
document into the computer system. With the help of the scanner you can
capture your images and documents and convert it into digital formats for
easy storage on your computer.

 The Optical Mark Recognition (OMR) devices can scan marks from a
computer-readable paper. The actual technique used by an OMR device
involves focusing a light on the page being scanned, thereby detecting the
reflected light pattern for the marks.

 Optical Character Recognition (OCR) is used to translate the mechanical
or electronic images which are handwritten, typed or in printed form into
machine-editable format. Basically, it converts books and paper documents
into electronic file format for preparing computerized record system.

 OCR software is used to convert it into a text or word processor file for
performing text modification. OCR is widely used in pattern recognition,
artificial intelligence and computer vision. Optical Character Recognition or
OCR is done with the help of optical tools mirrors and lenses.

 Digitizers are used to convert drawings or pictures and maps into a digital
format for storage into the computer. A digitizer consists of a digitizing or
graphics tablet, which is a pressure-sensitive tablet, and a pen with the
same X and Y coordinates as on the screen. Some digitizing tablets also use
a crosshair device instead of a pen. The movement of the pen or crosshair
is reproduced simultaneously on the display screen. When the pen is moved
on the tablet, the cursor on the computer screen moves simultaneously to
the corresponding position on the screen (X and Y coordinates). This allows
the user to draw sketches directly or input existing sketched drawings easily.

 An output device is an electromechanical device that accepts data from the
computer and translates it into a form that can be understood by the outside
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world. The processed data, stored in the memory of the computer, is sent
to an output unit, which then transforms the internal representation of data
into a form that can be read by the users.

 Normally, the output is produced on a display unit like a computer monitor
or can be printed through a printer on paper.

 A display device is the most essential peripheral of a computer system.

 Cathode Ray Tube (CRT) consist of an electron gun with an electron beam
controlled with electromagnetic fields and a phosphate-coated glass display
screen structured into a grid of small dots known as pixels. The image is
created with the electron beam produced by the electron gun, which is
thrown on the phosphor coat displayed by the electromagnetic field.

 Liquid Crystal Display (LCD) was first introduced in the 1970s in digital
clocks and watches, and is now widely being used in computer display
units.

 The Cathode Ray Tube (CRT) was replaced with the Liquid Crystal Display
(LCD) making it slimmer and more compact. But the image quality and the
image colour capability got comparatively poorer.

 The main advantage of LCD is its low energy consumption. It finds its most
common usage in portable devices where size and energy consumption are
of main importance.

 Printers are used for creating paper output. There is a huge range of
commercially available printers today (estimated to be 1500 different types).
These printers can be classified into categories based on the Printing
Technology, Printing Speed and Printing Quality.

 Impact printers are the oldest print technologies still in active production.
Impact printers use forceful impact to transfer ink to the media, similar to a
typewriter. Some of the largest printer vendors continue to manufacture,
market, and support impact printers, parts, and supplies.

 Impact printers are most functional in specialized environments where low-
cost printing is essential. The three most common forms of impact printers
are Dot Matrix, Daisy Wheel and Line Printers.

 Non-impact printers are much quieter than impact printers as their printing
heads do not strike the paper. It is a printer that prints without banging a
ribbon onto paper. LED, Laser, Inkjet, Solid Ink, Thermal Wax Transfer
and dye sublimation printers are examples of non-impact printers. Most
non-impact printers produce dot matrix patterns.

 A disk drive is a peripheral device used to store and collect information. It
can be removable or fixed, high capacity or low capacity, fast or slow
speed, and magnetic or optical.

 Structurally, a drive is the object inside which a disk is either permanently
or temporarily stored. While a disk contains the media on which the data is
stored, a drive contains the machinery and circuitry required for implementing
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read/write operations on the disk into two major groups – magnetic and
optical.

 Hard Disk Drive (HDD) is a crucial hardware component of a personal
computer, without which modern-day computers cannot function. Although
the RAM is a place of primary storage, it is ephemeral (i.e., its life is dependent
on the power source – RAM is active only as long as the computer is
turned on).

 A hard disk drive, though technically a secondary form of storage, is the
primary form of permanent storage (since the data stored on the hard disk
is not dependent on the computer being switched on or off).

 The features of HDDs that have made them an irreplaceable component in
our computers are their high capacity for storing data and the high speeds
at which they can access it at relatively lower cost. They come in various
interfaces and specifications such as IDE, EIDE, SCSI, SATA and SATA
II.

 An optical drive is a type of storage medium that stores the content in digital
form which is written and read by a low intensity laser. The laser reads data
from the reflective surface of an optical disc by measuring surface changes
in height and depth.

 All types of optical media are divided into tracks and sectors that contain a
series of tiny indentations in which data is stored. The CD-ROM, HD-
DVD, Blu-Ray, etc., are examples of optical drive.

1.9 KEY TERMS

 Computer: A computer is a machine that manipulates data according to a
set of instructions, it is a programmable electronic device and responds to a
specific set of instructions and performs high-speed processing of numbers,
as well as of text, graphics, symbols and sound. Modern computers are
electronic and digital.

 Memory: The computer memory is used for storage and retrieval of
instructions and data in a computer system.

 CMOS (Complementary Metal Oxide Semiconductor): CMOS is the
technology for making semiconductors (integrated circuits) like processors,
chipset chips, DRAM, etc., the benefit using the CMOS is that it requires
very less power in comparison to various different semiconductor
technologies.

 Bus: Bus is a set of lines which carries information about the data is transferred
to and from in the memory, data along with memory addresses is carried on
the bus because it controls the location in memory about the processed
data, all computers use three types of basic buses, such as control bus,
address bus and data bus.
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 Supercomputers: These are the most powerful and expensive computers
available today, and are primarily used for processing complex scientific
applications that involve tasks with highly complex calculations and solving
problems with mechanical physics, such as weather forecasting and climate
research systems, nuclear weapon simulation and simulation of automated
aircrafts, etc.

 Workstation: A workstation is a special computer designed for technical
or scientific applications. Intended primarily to be used by one person at a
time, they are commonly connected to a local area network and run multi-
user operating systems.

 Cache memory: This is the category of memory used by modern computer
systems, it temporarily stores and supplies the data and instructions from
the main memory to the internal memory (registers) to speed up the process.

 Optical Mark Recognition (OMR): The OCR devices can scan marks
from a computer-readable paper. The actual technique used by an OMR
device involves focusing a light on the page being scanned, thereby detecting
the reflected light pattern for the marks.

 Optical Character Recognition (OCR): The OCR is used to translate
the mechanical or electronic images which are handwritten, typed or in
printed form into machine-editable format. Basically, it converts books and
paper documents into electronic file format for preparing computerized
record system.

 OCR software: It is used to convert it into a text or word processor file
for performing text modification with the help of optical tools mirrors and
lenses, OCR is widely used in pattern recognition, artificial intelligence and
computer vision.

 Digitizers: These are used to convert drawings or pictures and maps into
a digital format for storage into the computer, a digitizer consists of a digitizing
or graphics tablet, which is a pressure-sensitive tablet, and a pen with the
same X and Y coordinates as on the screen.

 Cathode Ray Tube (CRT): The CRT consist of an electron gun with an
electron beam controlled with electromagnetic fields and a phosphate-coated
glass display screen structured into a grid of small dots known as pixels, the
image is created with the electron beam produced by the electron gun,
which is thrown on the phosphor coat displayed by the electromagnetic
field.

 Liquid Crystal Display (LCD): LCD was first introduced in the 1970s in
digital clocks and watches, and is now widely being used in computer display
units, the main advantage of LCD is its low energy consumption, it is most
commonly used in portable devices where size and energy consumption
are of main importance.

 Impact printers: These are the oldest print technologies still in active
production, the impact printers use forceful impact to transfer ink to the
media, similar to a typewriter, the three most common forms of impact
printers are dot matrix, daisy wheel and line printers.
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1.10 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is a computer?

2. What is the basic organization of computer system?

3. Explain the components of the computer system.

4. Name the various types of types of computing devices.

5. Explain about the significance of the primary memory.

6. What are peripheral devices?

7. What do you mean by MICR?

8. What are storage devices?

Long-Answer Questions

1. Discuss about the basic organization of computer system giving examples.

2. Briefly discuss about the types of computing devices with the help of
appropriate examples.

3. Explain in detail how the computer systems are classified.

4. What do you mean by personal computers? How would you differentiate a
personal computer from a workstation?

5. Discuss about the primary memory and their types used in a computer.

6. Explain the significance of peripheral devices in a computer system.

7. What are input devices? Explain the salient features of a general-purpose
keyboard.

8. What are output devices? Explain the salient features of scanners, MICR,
OCR, OMR, Bar-Code Reader, Voice Recognition Device, Light Pen and
Touch Screen.

9. Explain the different types of printing devices giving features of each type.

 10. Discuss the different types of storage devices highlighting their advantages
and disadvantages.
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UNIT 2 OPERATING SYSTEM (OS)
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2.9 Self-Assessment Questions and Exercises

2.10 Further Readings

2.0 INTRODUCTION

An Operating System (OS) is an interface between the computer user and computer
hardware. An operating system is specific software which performs all the basic
tasks like file management, memory management, process management, handling
input and output, and controlling peripheral devices, such as disk drives and printers.
An operating system is a program that acts as an interface between the user and
the computer hardware and controls the execution of all kinds of programs.

Fundamentally, an Operating System (OS) is system software that manages
computer hardware, software resources, and provides common services for
computer programs. A single-tasking operating system can only run one program
at a time, while a multi-tasking operating system allows more than one program to
be running in concurrency. This is achieved by time sharing, where the available
processor time is divided between multiple processes.

A Disk Operating System (DOS) is a computer operating system that can
use a disk storage device, such as a floppy disk, hard disk drive, or optical disc. A
disk operating system must provide a file system for organizing, reading, and writing
files on the storage disk. This definition does not apply to current generations of
operating systems, such as versions of Microsoft Windows operating systems.
DOS were available for mainframes, microprocessors and home computers and
were usually loaded from the disks themselves as part of the boot process.

Windows is a series of operating systems developed by Microsoft. Each
version of Windows includes a Graphical User Interface (GUI), with a desktop
that allows users to view files and folders in Windows. For the past two decades,
Windows has been the most widely used Operating System (OS) for Personal
Computers (PCs). Microsoft introduced Windows on November 20, 1985, as a
graphical operating system shell for MS-DOS in response to the growing interest
in Graphical User Interfaces (GUIs).



Operating System (OS)

NOTES

Self - Learning
48 Material

Windows 7 was primarily intended to be an incremental upgrade to Microsoft
Windows. Windows 8 is a personal computer operating system that was produced
by Microsoft as part of the Windows NT family of operating systems. Windows 8
introduced major changes to the operating system’s platform and user interface to
improve its user experience on tablets, where Windows was now competing with
mobile operating systems, including Android and iOS.

In this unit, you will study about the basic features of Operating System or
OS, the DOS commands, the various functions and commands to work in
Windows, and the features of Windows 7 and Windows 8.

2.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the basic features of Operating System or OS

 Understand and work with the DOS commands

 Know the various functions and commands to work in Windows

 Analyse the features of Windows 7 and Windows 8

2.2 OS BASICS

An Operating System (OS) is the primary control program for managing all other
programs in a computer. The other programs, commonly referred to as ‘application
programs’, use the services provided by the OS through a well-defined Application
Program Interface (API). Every computer necessarily requires some type of
operating system that tells the computer how to operate and utilize other programs
installed in the computer. The role of an OS in a computer is similar to the role of
a principal in a college who is responsible for the overall management of the college.

Any computer system can be broadly classified in terms of four component
dimensions:

1. Hardware
2. Operating system
3. Application programs (like MS Word, Games, Calculator)
4. Users (people who work on the computer)

Figure 2.1 illustrates an abstract view showing these components of the
computer system.

 
  . . . . . . . . . . 

 

Calculator Games MS Word 
Application Programs 

Hardware

OPERATING SYSTEM

User-2 User-NUser-1

Fig. 2.1 Components of a Computer System
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Components of an Operating System

An operating system has three main components:

1. Control Programs: These control and maintain the operations of a
computer. There is an Initial Program Loader (IPL) which is in the form of
firmware and is stored in the Read Only Memory (ROM) section of the
Memory Unit. When the computer is switched on, the electronic chip is
automatically activated and the IPL reads the Boot Sector Routine (BSR),
which resides in the primary memory of the computer.

2. System Service Programs: These support the control programs. Each of
these is divided into three portions: Linkage Editor, Librarian and Input/
Output control system.

A Linkage Editor is an editor program that creates one module from
several by resolving cross-references among the modules.

3. Utility Programs: These programs run on the operating system in order to
carry out various user related commands to manage the software linking the
user and the operating system. In MS-DOS, for example, the utility programs
are Fdisk, FORMAT, ATTRIB, BACKUP, FIND, and others.

Booting Process: In computing, a bootstrapping process called booting (booting
up)  starts the OS when the computer system is switched on. The first set of
operations performed by the computer when switched on is called boot sequence.
The main operating system for the computer is loaded by the bootloader.

One can boot an operating system in two conditions: (i) where there is a
single OS installed and (ii) where there are multiple OSs installed on the computer.

Common Terminology

Multitasking: A type of OS that permits multiple programs to be run simultaneously
by the same computer. A user of the computer can simultaneously play games
while a Word document is being printed (The user is simultaneously working with
two different applications–Word and Games). Operating systems supporting
multitasking include UNIX and the Windows range.

Multithreading: A form of multitasking that permits multiple parts of a software
program to be run simultaneously; for example, a user can perform a spell check
on a Word document and simultaneously print another Word document. (User is
working with two different components (Spell Check) and printing of the same
application (Word). Operating systems supporting multitasking include UNIX and
Windows.

Multiprocessing: This involves the use of multiple processors (more than one
CPU) to simultaneously execute multiple programs. The inclusion of multiple CPUs
in a single computer system improves the performance to a large extent.
Multiprocessing involves simultaneous processing by a computer system having
multiple CPUs, whereas multitasking involves simultaneous processing by a
computer system with single CPU. Operating systems supporting multiprocessing
include UNIX and Windows NT.



Operating System (OS)

NOTES

Self - Learning
50 Material

Single User: This type of OS does not permit multiple users to use the computer
and run programs at the same time. This assumes that at any given time only one
user uses the system and runs only one program, i.e., it does not allow two users
to concurrently work on the same program. MS-DOS is an example.

Multiuser: This type of OS permits multiple users to use the computer and run
programs at the same time, e.g., UNIX, Linux, Windows NT.

Functions of Operating Systems

Resource Management: Computer resources include main memory (RAM),
storage devices (floppy disk and hard disk drives), and input and output devices
(keyboard, mouse, monitor, printer). The OS is responsible for:

1. Allocating and deallocating memory space as needed by various application
programs.

2. Functioning as a secondary storage management. All application programs,
compilers and loaders are stored in the secondary storage (hard disk).

3. Dealing with input and output to and from other connected hardware
devices, such as printers, hard disks, modems and scanners.

File Management: The OS is responsible for the creation and deletion of
files/directories and the mapping of these files/directories on to the secondary
storage.

Security Management: The OS is responsible for protecting the resources
and information of a computer system from destruction and misuse.

Operating System Services: The OS is responsible for providing a set of
services to programs and users of those programs. The main services include:

 Program Execution: It loads the program requested by the user into
the memory.

 Error Detection: It generates messages to each application or user
about the status of the operations that have been performed. It
constantly detects and corrects errors generated by the system.

 Resource Utilization: It ensures efficient utilization of the computer’s
resources.

Check Your Progress

1. Explain about the Operating System (OS).

2. What is booting process?

3. Define multitasking.

2.3 DOS BASICS

Microsoft Disk Operating System (MS-DOS) is a single user, single tasking
operating system. DOS has a command-line, text-based/non-graphical user-
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interface commonly referred to as Character-Based User Interface (CUI). When
the computer is switched on, a small program checks all internal devices, electronic
memory and peripherals. Once this process is completed, MS-DOS is loaded.

DOS Prompt: The DOS prompt known as the command prompt looks like C:\>
or D:\> where ‘C’,‘D’ represent the hard drives of the computer system. All
commands are typed at the DOS prompt. Enter key is pressed to view the output
of the typed command. If the command is correctly typed desired output would
be displayed. Otherwise an error message (bad command or filename/Invalid
parameter) is displayed on the screen.

Limitations of MS-DOS

1. It has a text based user interface where the commands have to be typed for
each operation that the user wants to perform. The user is expected to
remember the commands as well as their syntax.

2. It is a single-user, single-task operating system and the working is limited to
one megabyte of memory. 640 kilobytes of the memory is used for the
application program.

3. It does not allow using long file names. The user is restricted to eight-character
file names with three-character extensions.

Below is the list of commonly used DOS commands. All DOS commands are
case-insensitive (i.e., there is no difference whether you type COPY, copy or
coPY). The same is true for the attributes, parameters and filenames. To view the
complete description of each command type HELP followed by the command
name, e.g., HELP COPY. Alternatively help can also be displayed using
<command>/? (COPY/?).

Simple DOS Commands

Command Syntax Explanation Example Notes 

COMMAND COMMAND Starts a new Window for the DOS command 
interpreter. 

C:\>Command Starts a new Window for the DOS 
command interpreter. 

EXIT EXIT Quits   the   COMMAND.COM   program 
(command interpreter). 

C:\>EXIT Quits the command interpreter. 

CLS CLS Clears the screen display completely leaving 
only the DOS prompt. 

C:\>CLS Clears the screen and displays C: 
Prompt at the top of the screen. 

DATE DATE Displays the system’s current date and prompts 
to enter the new date. 

C:\>DATE Current date is Fri 05-09-2003 
Enter new date <mm-dd-yy>: 

TIME TIME Displays the current time and prompts the user 
to enter the new time. 

C:\>TIME Current time is 12:55:25.34p Enter 
new time. 

VER VER Displays the windows version. C:\>VER Displays the Windows version 
installed on your computer. 

HELP HELP 

<Command 

Name> or 

Command 

Provides complete, information about queried 
MS-DOS commands. 

C:\>DATE/? Complete information about the 
DATE command is displayed. 

DOSKEY DOSKEY Edits lines of command, recalls commands of 
MS-DOS, and creates macros. 

C:\>DOSKEY Once the Doskey is installed then 
Up and Down arrow keys can be 
used in the subsequent commands to 
recall the previous commands. 
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Command Syntax Explanation Example Notes 

PROMPT PROMPT 
[Text] 

Changes the MS-DOS command prompt to the 
specified text. If the command is typed without 
any parameters then the default prompt setting is 
restored. 

D:\>PROMPT Changes the prompt to the default 
setting. 

PRINT PRINT 
<Filename> 

Prints a text file while other MS-DOS 
commands are being used. 

C\DATA>PRINT 
TEMP.TXT 

Prints ‘TEMP.TXT’ stored in the 
‘DATA’ folder of the C: drive. 

LABEL LABEL Makes, changes, or deletes the label of volume 
of a disk. 

C:\>LABEL Displays the current volume label 
and volume serial number. Also 
prompts to enter a new label. 

MEM MEM Displays the amount of and free and used 
memory in your system. 

C:\>MEM Displays the total amount of 
memory, amount of used and free 
memory in the system. 

MORE MORE 
<Filename> 

Displays output on the screen at a time for the 
text files. Useful in cases where the content of 
text file does not fit in a single screen. 

C:\DATA> 

MORE 

TEMP.TXT 

Breaks the contents of ‘TEMP.TXT’ 
in multiple screens. Subsequent 
screens can be viewed by pressing 
the ‘enter’ key. 

ECHO ECHO Displays messages, or turns on or off the 
echoing command. 

C:\>ECHO Displays the current echo setting. 
(‘OFF’ or ‘ON’) 

EDIT EDIT Starts MS-DOS editor, which produces and 
changes ASCII files. 

C:\>EDIT Opens the MS-DOS editor. 

SET SET Displays,   sets,   or   removes   MS-DOS 
environment variables. 

C:\>SET Displays the settings for the current 
environment variables. 

 CHKDISK CHKDISK 
<Drive-Name> 

Checks a disk and gives the information like 
how many bytes have been used and how many 
are free and if any bad sectors are there on the 
disk. 

C:\>CHKDSK 
A: 

Checks A: drive and gives 
information about the disk. 

SCANDISK SCANDISK 
<Drive-Name> 

Finds errors from a drive and fixes any 
problem it encounters. 

OSCANDISK 
A: 

Scans the A: drive and repairs the 
disk if any problem is there, like 
damaged area or virus, etc. 

DISKCOPY DISKCOPY Copies the content of one floppy disk to 
another. 

ODISKCOPY 

A: 

Copies the entire content of one 
floppy to another. 

FORMAT FORMAT 
<Drive-Name> 

Formats the specified drive. C:\>Format A: Floppy inserted in the A: drive will 
be formatted. Any information in the 
floppy A: will be erased. 

Simple File Operations

Command Syntax Explanation Example Notes 

MOVE MOVE <Source> 
<Destination> 

Moves the file from one source to the 
specified destination. File will exist only 
at the specified destination. 

C\DATA>MOVE 
TEST.TXT 
\LETTER 

Moves the file‘TEXT. TXT’ from 
‘DATA’ folder in the C: drive to the 
‘LATTER’ folder in the C: drive. 

COPY COPY <Source> 
<Destination> 

Creates a copy of the specified file and 
places it in the specified location, file will 
exist at the specified location as well as 
the source location. 

C:\DATA> 
MOVE 
HELLO.TXT 
\LETTER 

Creates a copy of HELLO.TXT in 
the LETTER folder of the C: drive. 

Command Syntax Explanation Example Notes 

REN REN <Path> 
<01dfile> <Newfile> 

Renames the old file name by the 
specified new file name. 

C:\DATA>REN 

HELLO.TXT 

Hi.TXT 

Renames ‘HELLO.TXT’ as ‘Hi.TXT’ 

DFt /FRASF DEL 
<Path><Filename> 

Deletes the specified file present in the 
Specified path/location from the hard disk. 

C:\DATA>DEL 
Hi.TXT 

Deletes the file ‘Hi.TXT’ located in 
the ‘DATA’ folder of the C: drive. 

TYPE TYPE <Filename> Displays the contents of a text file. C:\DATA>TYPE 
TMP.TXT 

Displays the contents of TMP.TXT. 

 ATTRIB [+A|-A] 
[+R|-R][+H|-H] [+S | -
S] <filename> + Sets 
an attribute 

   

ATTRIB + Clears an attribute 
A-Archive attribute R-
Read only attribute H-
Hiddenfile attribute 
S-System file 
attribute 

Displays or changes file attributes. C:\>ATTPJB+H 
+R FIRST.TXT 

Sets the attributes of ‘FIRST.TXT’ as 
Read only and hidden. 

FC FC <Filel> <File2> Compares two files or sets of files, and 
displays the dissimilarities between them. 
Generally used to compare files with same   
names   located   in   different directories. 

C:\>DATA\ 
ONE.TXT 

INFCA 
ONE.TXT 

Compares the file ‘ONE.TXT’ 
located  in DATA folder with 
‘ONE.TXT’ located in INFO folder 
and displays the differences between 
them. 

XCOPY XCOPY <Source> 
<destination> 

Copies files and subdirectories to the 
specified location. 

C:\>XCOPY 

C:\DATA 

C:\INFO 

Copies the entire contents of the 
‘DATA’folder to ‘INFO’folder. Ifthe 
‘DATA’ folder contains ‘ami’ 
subdirectories then they will also be 
copied to the 'INFO' folder. 

BACKUP BACKUP <Source> 
<Destination> 

Copies the files onto diskettes or to other 
source. 

C:\>BACKUP 
C:\DATA\TEMP. 
TXT C:\DMFO 

Copies ‘TEMP.TXT’ file in the 
‘DATA’ folder into the ‘INFO’ folder. 

RESTORE RESTORE<Source> 
<Destination> 

Reinstates files that were backed up by 
using the BACK UP command. 

C:\>RESTORE 
C:\DATA\TEMP. 
TXT C:\INFO 

Restores ‘TEMP.TXT’ file in the 
‘DATA’ folder into the ‘INFO’ folder. 
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Wild Cards

Wild card characters can be used in specifying filenames in DOS. There are two
types of wild cards (?,*):

? It is used to represent any single character in the file name.

SYNTAX: C:\  DIR BA?.TXT

Displays all the text files in the C: drive starting with ‘BA’ and ending with any
single character.

Examples: BAT.TXT, BAG.TXT, BAR.TXT, BAD.TXT, etc.

* It is used to represent one or more characters in a file name.

SYNTAX: C:\ DIR CON*.TXT

Displays all the text files in the C: drive starting with ‘CON’.

Examples: CONCEPT.TXT, CONCATENATE.TXT, CONTEMPT.TXT,
CONSOLE.TXT, etc.

Directory Related Commands
Command Syntax Explanation Example Notes 

DIR DHKDrive/ 
Directory - Name 
Name> 

Displays all the sub-directories and files of 
the specified drive/directory. It also shows 
the size of the files and the date and time 
they were last modified. 

C:\>DIRD: Displays all the contents (files and 
directories) of the D: drive. 

DIR/P DHKDrive/ Directory 
-Name>/P 

Displays the contents of directory one 
screen at a time and pauses until any other 
key is pressed to continue the display. 

C:\>DIR 
DATA/P 

Displays the contents of the ‘DATA’ 
directory by pausing the screen. 

DIR/W DIR <Drive/ 
Directory>/W 

Displays the contents of the directory 
width-wise. It omits file size, date and time 
of creation of file so that more files can be 
displayed at one time on the screen. 

C:\>DIR 
DATA/W 

Displays the contents of the ‘DATA’ 
directory width-wise. 

DIR/W/P DIR <Drive/ 
Directory>/W/P 

The Wide and Pause display option can be 
combined. 

C:\>DIR 
DATA/W/P 

Displays the contents of the ‘DATA’ 
directory width-wise and by pausing 
the screen. 

CD CD<Directory-
Name> CD\ -Directly 
takes to the root 
directory. 

Displays the name of the current directory if 
no parameter is specified with the 
command. Changes the current directory 
to the specified directory. 

C:\>CDDATA\ 
SUBDATA 

Changes the current directory to 
‘DATA\SUBDATA’. 

MD 
MD <Drive/ 
Directory-Name> 

Creates a new directory in the specified 
location. 

C:\>MD 
‘HELLO’ 

Creates a directory named ‘HELLO’ 
in the C: Drive. 

RD RD <Directory-
Name> 

Removes the specified directory. C:>RD HELLO To remove a directory first you 
should come to one level above the 
current directory and then remove 
command should be given. This 
command will delete the ‘HELLO’ 
directory from the C:drive. 

DELTREE DELTREE 
<Directory-Name> 

Deletes a directory and all the sub-
directories and files in it. 

C:\>DELTREE 
TEMP 

Prompts the user for confirmation. If 
user selects ‘Y’ (Yes) then the 
directory ‘TEMP’ and all its sub-
directories will be deleted. 

 

Concept of File

A file is created with the help of another application program. A user, for instance,
may create a text document in Notepad. So the application program in this case in
Notepad and the file is a Notepad file.

It is a portion of a software program that is used to store data, information,
settings, and/or commands used with that program. Examples of files are Word
document files, Excel files, PowerPoint presentation files, database files, and so
on.
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Apart from the normal application program files, such as MS Word, MS
Excel, MS PPT, a computer system includes other file types also. These are:

 Batch File: A batch file allows the users of MS Windows and MS-
DOS to generate a list of commands for running in sequence after the
execution of the batch file. A batch file can be used for running the
commands that are frequently run, deleting files, moving files, etc. No
special programming skills are required for a simple batch file and can
be prepared by users who have a basic knowledge of MS-DOS
commands.

An instance of a batch file is a file that is somewhat similar to an icon
on the Mac OS or a shortcut in Windows. Similar to a shortcut, batch
files can be used for running one or more commands and/or programs
through the command line.  Another popular instance of a batch file is a
simple boot file called autoexec.bat, which is loaded every time the OS
is loaded. It works on computers with early Windows. This batch file
had all the required commands and programs used for running MS-
DOS and Windows every time the computer started.

 Executable File:  It is a file that performs different functions or operations
on a computer. Since an executable file is compiled, unlike a data file, it
is generally not readable. On an IBM-compatible computer, the common
executable files are .COM, .BAT, .BIN and .EXE. Other types of
executable files can also be there depending on the operating system
and its setup.

 System File:  A file that is being used by an operating system and cannot
be deleted or changed without the stopping of the operating system is
known as a system file. Since these files are in use by the operating
system, generally they cannot be deleted.

              A system file is also an attribute that can be added to any file in
Microsoft operating systems  that allows the OS to know the file is an
important system file. Files that are marked as system files will also be
hidden files.

Naming Files

A filename is a special type of string which is used for identifying a file stored on
the file system of a computer.

A filename is divided in two parts: basename (the primary filename) and the
extension (which indicates the type of file related to a certain format of file).

A filename includes one or more of the following components:

 protocol (or scheme) — Method of accessing (e.g.,  ftp, http, file, etc.)

 host (or network ID) — Host name, IP address, domain name, or the
network name of LAN (e.g., wikipedia.org, 207.142.131.206,
\\MYCOMPUTER, SYS:, etc.)

 device (or node) — Port, socket, drive, root mountpoint, disc, volume
(e.g., C:, /, SYSLIB, etc.)



Operating System (OS)

NOTES

Self - Learning
Material 55

 directory (or path) — Directory tree (e.g., /usr/bin, \TEMP,
[USR.LIB.SRC], etc.)

 file – Base name of the file

 type (format or extension) — Indicates the nature / type of the content
of the file (e.g., .txt, .exe, .dir, etc.)

 version — Revision number of the file

An extension name of a computer file is usually a three-character addition
after the file’s name. This extension assists IBM-compatible computers, such as
those running Microsoft Windows, in identifying the program to relate the file with
and correctly open the file.

Given below are the characters that cannot be used in filenames or directory
names in most operating systems.

\, /, :, *, ?, “, <, > and |

Creating Directories

A hierarchical file system in the operating system, such as UNIX, Linux, DOS,
OS/2, etc., contain directories. To refer to a directory, a user usually indicates it
by name. Some of the important directories are: root directory, home directory
and current directory.

Therefore, in Windows, there is no concept of a directory unless we create
a folder and then create sub-folders and sub-sub folders within it.

The following is an example of a directory path in MS-DOS.

C:\Windows\System32>

In the above example, C: denotes the drive, and System32 – which is in the
directory of the Windows – is the present directory one would see.

The following is an example of a directory in a Linux/UNIX variant.

/usr/bin

In the above example, you are located in the bin directory which is a
subdirectory of the usr directory.

For changing a directory in Linux, MS-DOS, UNIX and other command
line operating systems, the ‘cd’ command is used.

Given below are the special characters that cannot be used file or directory
names in most operating systems:

\, /, :, *, ?, “, <, > and |

Managing Files and Directories

You will see two main types of icons in Windows Explorer. One is that of file and
the other is that of a folder.

This is a folder symbol. It represents a normal folder that we use in

everyday life. A folder contains sub-folders and files. It can also contain
some programs or their shortcuts.Files are generally represented by
other icons. Some of them are as follows:
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 This is an icon of a PowerPoint presentation and represents the

PowerPoint file. Note that this is also a shortcut to that file.

 This is a Word file. One can click on this icon and access the

file.

Explorer

Windows Explorer helps you to work with files and folders. In the left frame of
Windows Explorer, click on the folder you want to open. Double click the left
mouse. The folder contents including files and sub-folders open in the right frame.
Alternatively, right mouse click on the folder in the left frame. The tasks menu
opens. Click on Open option. Another window opens in the Taskbar at the bottom
of the screen with the name of the Folder you wanted to open. To Close the
folder, click on the ‘X’ button in the top-right corner of the folder window.

Check Your Progress

4. What is Microsoft Disk Operating System (MS-DOS)?

5. Define about the DOS prompt.

6. What are Wild card characters? Give the syntax with example.

2.4 WINDOWS - BASIC INTRODUCTION

The Desktop

The first thing that you see when you start Windows is the desktop. The desktop
hosts icons for programs and shortcuts to programs and files.
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Icons

Icons are graphical representations of the programs and files stored on the desktop.

Selecting an Icon

In order to give a command, you have to select the particular icon. Selecting an
icon can be done by moving the mouse pointer over it and pressing the left mouse
button once. Each time you select a particular icon, the color of the icon changes,
indicating that the icon is selected.

Moving an Icon

You can move icons around to rearrange your files on the disk or for your own
convenience.

Icons can be moved on screen by simply holding the left mouse button
down when you click on the icon, dragging the mouse to the desired position on
the screen, and then releasing the mouse button.

Arranging Desktop and Task Bar Items

Menus are very useful parts of the Windows system. They consist of various
commands and subcommands for default and other applications and programs
stored on your computer.

Start Menu

Windows also has a new Start menu for enabling faster access to commonly
used programs and common system areas, such as My Computer, Control Panel
and Search.
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The Start menu and the Start button are user-interface elements in Microsoft
Windows, and serve as the central launching point for all applications. By default,
the Start button is always visible in the lower left-hand corner of the screen. It
exhibits the Windows logo and the word ‘Start’.

For choosing a program from the Start menu click on the Start menu option
on the Taskbar. Once the Start Menu is expanded you can drag the mouse to the
right and switch over to the submenus.

Start Button and its Items

You can move icons around to rearrange your files on the disk or for your own
convenience.

Icons can be moved on screen by simply holding the left mouse button
down when you click on the icon, dragging the mouse to the desired position on
the screen, and then releasing the mouse button.

Typically, you would be simultaneously running more than one application
or task. Each application will run in a separate window.  Every open window
(folder or an application window) has a separate button that appears on the Taskbar.
You can make any one of these windows ‘active’ at a time. To do so you will need
to click on the respective button on the Taskbar.

When the contents of the window do not fit in one screen, you will see
boxes with arrows at the top and bottom. These boxes are called scroll bars. You
can click on the arrows in the scroll bars to browse the hidden part of the screen.
The blue rectangular indicators on the scroll bar tell you the position of the screen.

Scroll bars can be vertical as well as horizontal. The horizontal scroll bar is
the one that moves the window on the horizontal axis, while the vertical scroll bar
moves the window on the vertical axis. Figure below illustrates the Program
Application Window.

Using and Manipulating My Documents Folder

Now since we have put in substantial amount of work creating this document, it
might be a good idea to save it for posterity! In fact, for all your subsequent
documents you must go on saving your work from time to time, let us say every 15
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minutes or so, or after completing every section. Doing this ensures that if there is
problem like power off or your machine has gone into hung state, etc., you only
lose minimal work.

 









 Choose  Save  command  from  File menu or click the Save command
icon in the Standard toolbar.

 Type the file name by which you wish to save your file.

 Specify where you want to save your document. By default MS Word
saves your documents in the default My Documents folder.

 Click on the Save button.

Note: In the Save As dialog box specify the name of your document. Although this name can
be anything, but it would make a lot of sense to give a meaningful name to your documents,
so that just by reading the name you can have the idea of its contents.

Control Panel and Its Items

Adding or Removing programs (Adding All Programs and changing Windows
Components).

 Click on the Start menu and go to Control Panel.

 Select the Add or Remove Programs option by double-clicking on it.
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A The following screen will be displayed.

You will see icons in the left panel of the screen that say Change or Remove
Programs, Add New Programs, and Add/Remove Windows Components.

Change or Remove Programs

This option allows you to change or remove existing installed programs. To remove
a program

 Select the program by clicking on it.

 Click once the Remove button shown against the program

Add New Programs

To install and/or uninstall additional software programs click on the Add New
Programs buttons.

A The following window would be displayed. By clicking once on the CD or
Floppy button you can install a new program from either a CD or a floppy.
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B You can choose Windows Update to add new Windows features or system
updates over the Internet.

Adding or Removing Windows Components

For installing and/or uninstalling specific components or subcomponents of
Windows, click on the Add/Remove Windows Components button.

 Click once the Add/Remove Windows Components button.

 Select the required component by clicking once on the check box.

 Click on the Details button. It provides you details of the selected
component. You can add or remove individual subcomponents contained
in the selected component group.

 Click on the Next button to install the component.

Date and Time

There is a small component inside your computer called Real Time Clock (RTC).
This RTC and CMOS setup are powered by a battery cell to ensure that the basic
settings of your computer are not lost when you switch off your system. RTC
stores the current date and time in your computer and passes on this information
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to put a date and time stamp on all file operations. The date and time option gives
you the liberty of adjusting the system’s date and time to correct settings. It is
important that your computer works on the correct clock and calendar timings, so
that it uses current date and time information to create and update your files. As
you may recall from the earlier section, when you display a directory, the computer
shows you not only the names and size of all files, but also the date and time of
last updation of each file. This information is very useful in keeping track of which
files you created, and when. Also, when you insert the current date and time in any
of MS Office packages, the information is picked up from here.

Windows allows you to set the date, time, and time zone for your computer
using the Date and Time option of the Control Panel.

Changing the Date and Time

 Click once on the Date and Time icon.

 Click on the month drop-down list to change the month.

 Click on this button to change the year.

 Click on any of the dates to change the date.

 Click on this draw to change the time.

 Click on Apply button to apply the changes you have made.

 Click on OK button to continue.

Setting the Time Zone

The option of setting a time zone is especially useful for laptop users who zip
across many countries (and time zones) frequently. It helps them maintain the
computer date and time as per the local settings. For example, for India the time
zone is GMT+ 05:30 Mumbai, Kolkata, Chennai, New Delhi. To change a time
zone:
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 Select the Date and Time option from the Control Panel.

 Click once on the Time Zone folio.

 Choose the time zone you want to change to by scrolling up or down in the
list displayed below.

 Click on Apply button for applying the changes you have made.

 Click on OK button to continue.

Display

The Display option allows you to change the appearance of your desktop, such
as the desktop background, screen saver, menu appearance, etc. and apply special
effects and settings. To do so:

A Click on the Display icon of the Control Panel.

The screen that is displayed allows you to make the necessary display
changes.
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Screen Saver

A screen saver is a moving image or pattern that appears on your monitor when
you have left your computer idle for a specified time. It serves four main functions:

(a) Most screen savers are interesting and provide fun and entertainment.

(b) When the same static image stays on a screen for a long period of time it
can burn the delicate phosphors on the inside surface of the picture of your
monitor. This can leave a permanent ghost of the image on the screen, thereby
damaging your monitor.

(c) Many newer computers have inbuilt power saving options built into them
(e.g., EPA energy star, VESA, etc.) which powers down the monitor as
soon as the screen saver comes into effect, thereby saving on your electricity
bills.

(d) The screen saver also has an optional security feature. Through this option
you can define a password. Once the screen saver is activated it requires
the user typing in the correct password before you can resume working.
This makes sure that nobody peeps and messes with your computer files
while you are away from your desk.
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 Click on the Screen Saver tab.
 The drop-down list lets you choose the screen saver that you want to

apply.
 Click on the Settings button to change other settings.
 You can preview the selected screen saver before applying it. To do

so click on the Preview button once.
 You can increase or decrease the time (in minutes) for activating the

screen saver.
 Click on Apply button for applying the changes made.
 Click on OK button to continue.

Wallpaper or Background

Desktop wallpapers do exactly what your room wallpaper does—decorate your
surrounding and add more colour and fun to your life. Use this option to modify
and apply different pictures and images as your desktop wallpaper. You can also
use repetitive designs called Patterns to get a woven fabric or block printed look
on your desktop.

 Click once on the Desktop option from the Display Properties pop-up
screen.

 Click once on  the background/wallpaper you desire from the list.
Background lists the available wallpapers you can use to decorate your
desktop. When you click on a wallpaper in this list, a preview of how the
wallpaper will look will appear on the dialog box screen. Alternatively, you
can click on the Browse tab to select a file from the desired location.

 You can define the position of the wallpaper here, i.e., whether you want
the wallpaper in the centre of the screen, tiled across your screen, or you
want it stretched to fit the screen.

 Click on the Apply button to apply the settings that you have changed.

 Click on the OK button to continue.
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A You can further customize your desktop. These include options like choosing
the icons displayed on your desktop and icons used for representing a
program. Click on the Customize Desktop button to see available options.

Customizing Your Desktop

 Select the icons you want to display on the Desktop.

 Click here in case you want to change the picture of the selected desktop
icons.

A Click here to restore the default settings.
B Click here to clean the Desktop.

 Click on OK once to apply the changes.

Fonts

Fonts are like having different handwritings available on your computer. They are
typefaces that you can use to pep up your work and also for changing the
appearance of characters on the screen and as well as the printed paper. Fonts
help you to express your message more clearly and emphatically. Windows comes
bundled with a large number of fonts, which are automatically installed (depending
upon your monitor and printer type) during the Windows setup installation. You
can install additional fonts from other software, as and when required.

To work with fonts:

A Choose Fonts option from the Control Panel.

B A list of all the available fonts would be displayed. To look at a sample of a
font, double-click the icon for the font.
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Mouse

As explained earlier, a mouse is a small hand-held device through which you can
quickly and easily navigate different parts of the screen. You can customize various
aspects of the mouse to make it work the way you prefer. You can control the
mouse pointer speed, shape, button configuration, double-click speed, etc. You
can even swap the left and right buttons. If you frequently lose track of where your
mouse pointer is, you can choose to have a mouse trail effect, which will make the
mouse pointer more visible. To change any of the above-mentioned mouse settings:

A Choose Mouse option from the Control Panel.

Button Configuration

To customize button configuration follow the steps given below:

 Click on the Buttons tab.

 Click on the check box under the Button configuration option to convert
your left mouse button into right button and vice versa.
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 Drag this button to increase or decrease the clicking speed of the mouse.

 Click on the Apply button to apply the changes that you have made.

 Click on the OK button to continue.

Pointer Configuration

To customize pointer configuration:

 Click on Pointers tab.

 Click on the pull-down list to choose the scheme that you want to apply.

A You can choose a scheme from another location by clicking on the Browse
button.

 Click on Apply button to apply the chosen scheme.

 Click on the OK button to continue.

Motion Configuration

You can also customize the motion configuration of the mouse. To do so:

 Click on the Pointer Options tab.

 Click on this button to increase or decrease the pointer speed.

 You can also click on the Hide pointer while typing option to hide the
pointer while you are typing.



Operating System (OS)

NOTES

Self - Learning
Material 69

 Click on the Apply button to apply the changes you have made.

 Click on the OK button to continue.

Mouse Pointers

At this stage it is important to understand the various mouse pointers that would
be shown to you at different times. In short, the mouse pointer gives you a clue
about the work that Windows is either doing or expecting you to do. Let us see
these pointers one by one:

Vertical resize: Whenever you move the cursor on the top or bottom
boundary of a window/object, your mouse pointer would  turn into this
shape.

Horizontal resize: Whenever you move the cursor on the left or right
boundary of a window/object, your mouse pointer would  turn into this
shape.

Diagonal resize 1: Whenever you move the cursor on the upper-left or
lower -right diagonal corner of a window/object, your mouse pointer would
turn into this shape.

Diagonal resize 2: Whenever you move the cursor on the upper-right  or
lower-left diagonal corner of a window/object, your mouse pointer would
turn into this shape.

Move: Whenever you select an object for moving, your mouse pointer
would turn into this shape.

Normal select: Whenever you normally point the mouse pointer at any
object or icon, scroll bar or menu, it would turn into this shape.

Help select: Whenever you press the Help icon to get help on a specific
topic, the mouse pointer would turn into this shape. Once you get this
mouse pointer simply click on the icon for which you want help and
Windows will display the help text.

Working: Whenever you have executed a command which takes a couple
of moments, Windows would display this mouse pointer. This means that
Windows is processing your request in the background.

Busy: Whenever Windows is trying to load some information into the
computer memory or is busy trying to open or save a file, this mouse
pointer would be displayed. At this stage you would not to be able to
execute any other command.

Text select: Whenever you  work on some text matter or some typed
input is required from the user (usually in a word processor like Notepad
or MS Word), this mouse pointer would be displayed.

In case you are using a laptop instead of a desktop computer, depending
upon the make of the laptop, it may have a trackpoint (IBM), touchpad (HP-
Compaq) or trackball instead of a mouse. These pointing devices, though they
look very different from a conventional mouse, work on exactly the principles of
point, click and click-drag. Once you learn to use a mouse mastering these pointing
devices is quite easy.
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Printers and Faxes

Use this option to install new printers. You would need the Windows XP CD or
the Printer Installation CD to run this option. Windows XP installation CD includes
many printer drivers from various well-known printer manufacturers. However, if
your printer or its exact model is not listed in the driver’s list provided by Windows
XP, you need not worry — simply insert the CD or floppy (which must have come
along with the printer) and complete the printer installation procedure.

 Choose the Printers and Faxes option from the Control Panel to see the
printers installed.

A You will get a list of the printers installed on your machine.

Scanners and Cameras

 Choose the Scanners and Cameras option from the Control Panel to
see the imaging devices installed.

B You will get a list of the scanners and cameras installed on your machine.
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Sound and Audio Devices

Multimedia, as the name suggests, is a combination of many mediums—sounds,
static pictures, movie clips, animation, text, etc. The main components of Windows
Multimedia are: Sound Recorder, CD player, Media Player and Active Movie
Player. Although most new computers today have inbuilt multimedia facilities,
multimedia is not a standard or necessary feature of all computers. You must have
multimedia hardware like the CD Rom drive, sound card, speakers and microphone
pre-installed before you can use multimedia features.

Sounds

You can use this option for assigning different sounds to various system events,
such as error messages, warning dialog boxes, starting and exiting windows, etc.
Needless to say, this option will work only if you have a sound card and speakers
installed. To do so:

 Choose the Sounds and Audio Devices option from the Control Panel.

 Choose the Sounds icon from the Sound and Audio Devices Properties
pop-up menu.

 Click on the Sound scheme drop-down list to choose a scheme. This list
displays schemes that you can use to simultaneously change the sounds
assigned to many system events.

 Click on the OK button to apply the changes that you have made.
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System Properties

The Control Panel’s System applet is loaded with features for power users. It
displays information about your computer’s internal devices, RAM size, CPU
details, etc. It also lets you add, remove, enable and disable specific devices of
your computer.

A Choose System option from the Control Panel.

B A dialog box will appear through which you can gather the system information
and change the environment settings. You can also update Windows directly
from the Internet.

Taskbar and Start Menu Settings

You can customize your Taskbar and Start Menu, such as the types of items to be
displayed and how they should appear.

 Click on the Taskbar and Start Menu icon from the Control Panel.

A You can change your Taskbar settings here.

B You can also change your Start Menu settings here.
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User Accounts

Change User Account settings and passwords for people who share a computer.

 Click on the User Accounts icon from the Control Panel.

A You can change your settings from this screen.

Network

In a computer network you can link several computers so that they can exchange
information between themselves. Another advantage of a computer network is
that expensive resources like plotters, scanners and printers can be shared between
many computers, thereby eliminating the need for duplicating these resources for
each computer.

The Network Connections Window contains utilities like Network Setup,
Mail, Schedule and Remote Access.

 Choose the Network Connections command from the Control
Panel.
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 Double-click on the Local Area Connection icon.

A You will get this Local Area Connection Status pop-up window.

 Choose Properties from the window.

 You can modify any network setting you want and then click on OK
once to apply the settings.

Recycle Bin–Use, Cleanup and Setting Up Properties

The Recycle Bin

 Click on the Recycle Bin icon on the Desktop.

A You can select from the options available. These include deleting the files
from the Recycle Bin permanently, or restoring it to the position where they
had been deleted from.
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Create, Save, Find, Open, Close, Copy, Move, Rename, Delete Files
and Folders

A Click on the Windows Explorer command from All Programs option of
the Start menu. Some versions of Windows call it Programs instead of All
Programs.

Moving Files

 Click on the file which you wish to move.

 Click on the Move this file icon from the Standard buttons toolbar. The
Move Items dialog box will be displayed.

 Click on the location/folder you wish to place the file. In our example, we
have taken Ink as the folder we want to move the file to.

 Click on the Move button to move the file.
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Copying Files by Click and Drag Method

 Click on the file that you want to copy to another folder.

 Keeping the left mouse button pressed on the highlighted file, drag it to the
folder which you want to copy. Make sure that the folder you want to drag
the file to is visible. Once you have dragged the selected file to the desired
folder, you can release the mouse button.

You will now see the file displayed in the required folder. Note that when
you drag a file to a folder on the same disk, it will be moved, but if you drag it to
a folder on another disk, it will be copied.

Copying Multiple Files

 Click on a file that you want to copy.

 Press the Ctrl key and while keeping it pressed, click on another file. Repeat
the same process for as many files as you wish to select. Now, follow the
steps that you take to copy a file to another folder. This option of copying
files is easier in the sense that you do not have to copy the required files one
by one to another folder.
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Copying a Continuous Range of Files

A You can also select a continuous range of files by using the Shift key. Click
on the first file, while simultaneously pressing and holding the Shift key, and
clicking on the last file of the range will highlight the required range of files.
Now you can Cut or Copy them to any other folder using  the same steps
for copying files.

Renaming a File

 Highlight the file you want to rename.

 Click on the Rename this file option from the left panel or press the right
mouse button once and select the Rename option from the pop up-menu.

 You can type in the new name for the file here.

A The file name has been changed.

Deleting Files

 Highlight the file you want to delete.

 Click on the Delete this file option from the left panel or press the Delete
key from your keyboard.

 Click on the Yes button once.
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A You will see that the desired file has been deleted.

Searching a File or Folder

 Place your mouse pointer on the Start button. Press the right mouse button
once and select the Search option.

A You can search for the files or folders as desired based on the criteria you
select.

2.5 WORKING WITH WINDOWS 7 AND 8

Microsoft Office 2007 is the latest version of MS Office that runs on Windows
XP SP2 and above. It is packed with many features. It has components, such as
Excel (Spreadsheet), Word (Word processor), OneNote and PowerPoint (for
making presentations). Microsoft gives these four programs in Home and Student
Edition. In the initial stage of its development as beta cycle, it was known as Office
12. It was released on Nov 30, 2006 for volume license customers and was made
available to retail customer in the year 2007 on January 30. This was released vis-
à-vis Windows Vista (Operating System).

New Features at a Glance: There are number of features that Office
2007 contains. It is much improved in comparison to its earlier versions. New
GUI (Graphical User Interface) has been introduced that is known as Fluent User
Interface. This has replaced menus and toolbars and has tabbed tool bars and is
known as Ribbon. These menus and tool bars that were continuing in earlier versions
of Office were dropped. Office 2007 runs on Windows XP SP 2 or above,
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Windows Server 2003 SP 1 or above, Windows Vista/7. It is the last version
Office suite on Windows XP Professional 64-bit Edition. This has also incorporated
Office SharePoint Server 2007 which is thought as a major revision for the server
platform using Office applications. This provides support for ‘Excel Services’ having
C/S (Client/Server) architecture that supports Excel workbooks, shared in real
time mode between many computers.

User Interface: New UI (User Interface) in Office 2007 is now known
officially as Fluent User Interface. This interface got implemented in Excel, Word,
Access and PowerPoint that form the core Office applications. In the item inspector
these are used for creating or editing individual items in MS Outlook.

Office Button: The Office button in 2007 is situated at the top-left corner
of the window and it has replaced File menu. This provides access to functions
common found common in all Office applications such as opening a file, printing
file, saving as well as sharing a file. This is also used for closing applications. A
color schemes can also be chosen by users for the interface.

Ribbon: Ribbon is a panel that houses a fixed arrangement of few icons
and command buttons. This creates organizations for commands that form a set of
tabs that group every relevant command. This can not be customized. Every
application contains a different set of tabs that tells about its functions.

Contextual Tabs: There are certain tabs that show appearance only after
making selection of certain objects. These tabs are known as Contextual Tabs.
Such tabs focus on functions specific to the selected objects only. If you select a
picture then Pictures tab is shown and this gives all options to work with pictures.

Mini Toolbar: This is a new inclusion in Office 2007. It appears automatically
as a context menu when you select a text. This design provides easy access to
formatting commands that are used repeatedly without making use of right button
of the mouse as is done in older versions.

Super Tool Tips: Super tool tips are also known as screen tips. This is
capable of housing formatted text as well as images. These show detailed
descriptions about most buttons and their functions.

Quick Access Toolbar: This tool bar is inside the title bar and is a repository
of functions that are most commonly used. This toolbar can be customized. Any
command can be included to this toolbar and this also includes commands that are
not available in Ribbon and macro.

Zoom Slider: A zoom slider is situated in the bottom-right corner. It magnifies
documents, rapidly and dynamically.

SmartArt: SmartArt has been located under Insert tab inside of the ribbon
in Word, PowerPoint, Outlook and Excel. SmartArt forms a new group of formatted
and editable diagrams. This contains 115 preset layout templates for SmartArt
graphics of categories such as list, cycle, hierarchy and process.

File Formats: This new version of MS Office supports various file formats
having features of XML, PDF etc. A new file format is introduced in Office 2007
as default file format. This format is known as Office Open XML. Files in this
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format are saved by use of X as an extra letter added to the extension such as
.docx for .doc file, .xlsx in .xls, etc. This new file format (Office Open XML) uses
ZIP file container and is based on XML. Microsoft also supported export to PDF
(Portable Document Format) in this new product Office 2007. Users of Office
2007 can export documents in MS Office as XPS documents using a free plug-in
as a separate download. Microsoft Office 2007 also provides support for
OpenDocument to open the previous versions (Office 2000 and earlier) using
converter add-in for Word, Excel and PowerPoint as well as a command-line
utility. MS Office 2007 has integrated a tool as Document Inspector for removal
of metadata. This tool is capable of stripping documents in PowerPoint, Excel and
Word of information containing author name and comments along with some other
‘metadata’.

User Assistance: In earlier versions of MS Office there is a tool Office
Assistants. This has been removed and online help system has been included as
new feature. You may use Super Tool tips extensively that provides a text of nearly
one paragraph telling about what the specific function can do. Help is also provided
that displays content and directly integrates viewing and searching for articles with
Office Online.

Microsoft Office Outlook: MS outlook has also appeared with new
features. Outlook is now capable of indexing e-mails, tasks, calendar entries, etc.,
for fast searches making use of Windows Search APIs. User can create Search
folders using some specific search criteria, for subject, type along with other
attributes of information for which search is made. Outlook 2007 provides support
for text-messaging and SMSs, used in conjunction with Unified Messaging of
Exchange Server 2007. Outlook 2007 has also included a reader to be used for
RSS feeds that used Windows Common Feeds Store. RSS subscription URLs
may also be shared using e-mails. In Outlook there is one To Do Bar that presents
a concise view integrating calendar, task items and appointments. MS Office
Outlook is also capable of including Business Contact Manager.

Microsoft Office Publisher: New features in Office 2007 provide support
for using templates for filling information automatically for company logo, name,
etc. Contents that are used frequently are stored in a folder Content Store for
accessing these quickly. Automatic conversion of a document is possible from one
publication type to another. Saving as PDF and taking quality print of PDF document
is possible. An application known as Catalog Merge creates content by automatic
retrieval of data that includes images, texts and others from some external source.
Design Checker is used to find design inconsistencies.

Microsoft Office InfoPath: This is another useful feature that enables
users to use forms designed in an application named InfoPath from a browser. For
this, server should run InfoPath Forms Services in Office Forms Server or
SharePoint 2007. You can send a form to people by e-mail and such forms may
be filled out using Outlook 2007. You can convert forms automatically in MS
Word as well as Excel into InfoPath forms. Print Layout view can be used to
design forms selecting a view mirroring printed layout. Enable use of MS SQL
Server, MS Access, or other databases serving the purpose of data repository at
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the back-end. Provide many views for the same forms, to expose different features
to different class of users.

Microsoft Office Visio: This feature gives many advantages for users,
such as using PivotDiagrams for visualizing data, showing data groups along with
relationships having hierarchical nature, carrying out visual modification in
PivotDiagrams, showing summary in aggregate for data using PivotDiagrams, linking
shapes with data sources that are external and formatting of shapes are done as
per data and periodic updates of data on such shapes. These shapes may also be
formatted manually by making use of features of Data Graphics.

SharePoint Designer: This is a new inclusion in the Office suite. It has
replaced FrontPage with SharePoint. Users who do not make use of SharePoint
may make use of Microsoft Expression Web. This feature provides support for
constructs that show functionality of SharePoint and also provides support for
Windows Workflow Foundation and ASP.NET 2.0. Enables display of XML by
making use of XSLT.

Server Components: The server components provided in Office 2007
are SharePoint Server 2007, Forms Server 2007, Groove Server 2007, Project
Server 2007, Project Portfolio Server 2007 and PerformancePoint Server 2007.
Each type has unique specifications.

Windows 8

The transition from Windows 7 to Windows 8 introduced a number of new features
across various aspects of the operating system. These include a greater focus on
optimizing the operating system for touchscreen-based devices (such as, tablets)
and cloud computing.

Language and Standards Support: Windows 8 introduces the new Windows
Runtime (WinRT) platform, which can be used to create a new type of application
officially known as Windows Store apps and commonly called Metro-Style apps.
Such apps run within a secure sandbox and share data with other apps through
common APIs. WinRT, being a COM-based API, allows for the use of various
programming languages to code apps, including C++, C++/CX, C#, Visual Basic
.NET, or HTML5 and JavaScript. Metro-Style apps are packaged and distributed
via APPX, a new file format for package management. Unlike desktop applications,
Metro-Style apps can be sideloaded, subject to licensing conditions. Windows
8.1 Update allows for sideloading apps on all Windows 8.1 Pro devices joined to
an Active Directory domain.

In Windows 8 up to two apps may snap to the side of a widescreen display
to allow multi-tasking, forming a sidebar that separates the apps. In Windows 8.1,
apps can continually be resized to the desired width. Snapped apps may occupy
half of the screen. Large screens allow up to four apps to be snapped. Upon
launching an app, Windows allows the user to pick which snapped view the app
should open into.

The term ‘Metro-Style Apps’ referred to ‘Metro’, a design language
prominently used by Windows 8 and other recent Microsoft products. Reports
surfaced that Microsoft employees were told to stop using the term due to potential
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trademark issues with an unspecified partner. A Microsoft spokesperson however,
denied these reports and stated that ‘Metro-Style’ was merely a codename for
the new application platform.

Windows 8 introduces APIs to support Near Field Communication (NFC)
on Windows 8 devices, allowing functionality like launching URLs/applications
and sharing of information between devices via NFC.

Windows Store: It is a digital distribution platform built into Windows 8, which in
a manner similar to Apple’s App Store and Google Play, allows for the distribution
and purchase of apps designed for Windows 8. Developers will still be able to
advertise desktop software through Windows Store as well. To ensure that they
are secure and of a high quality, Windows Store will be the only means of distributing
WinRT-based apps for consumer-oriented versions of Windows 8. In Windows
8.1, Windows Store features a redesigned interface with improved app discovery
and recommendations and offers automatic updates for apps.

Bundled Apps: A number of apps are included in the standard installation of
Windows 8, including Mail (an e-mail client), People (a contact manager),
Messaging (an IM client), Calendar (a calendaring app), Photos (an image viewer),
Music (an audio player), Video (a video player), Camera (a webcam or digital
camera client), SkyDrive, Reader (an e-book reader), and six other apps that
expose Bing services (Search, News, Finance, Weather, Travel and Sports).
Windows 8.1 adds Calculator, Alarm Clock, Sound Recorder, Reading List, Food
& Drink, Health & Fitness, Help + Tips, Scan, and a file manager integrated in the
SkyDrive app.

Windows 8 also includes a Metro-Style system component called PC
Settings which exposes a small portion of Control Panel settings. Windows 8.1
improves this component to include more options that were previously exclusive
to Control Panel. Windows 8.1 Update adds additional options to PC Settings.

Start Screen of Windows 8

The new Start screen in Windows 8 replaces the Start menu seen in previous
versions of Windows.
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Windows 8 introduces a new form of start menu called Start screen, which
resembles the home screen of Windows Phone, and is shown in place of the
desktop on Start Up. The Start screen serves as the primary method of launching
applications and consists of a grid of app tiles which can be arranged into columnar
groups; groups can be arranged with or without group names. App tiles can either
be small (taking up 1 square) or large (taking up 2 squares) in size and can also
display dynamic content provided by their corresponding apps, such as notifications
and slide shows. Users can arrange individual app tiles or entire groups. An
additional section of the Start screen called ‘All Apps’ can be accessed via a right
click from the mouse or an upward swipe and will display all installed apps
categorized by their names. A semantic zoom feature is available for both the Start
screen and ‘All Apps’ view which enables users to target a specific area or group
on the screen. The Start screen can uninstall apps directly.

Check Your Progress

7. Why an icon is selected?

8. What are Menus in Windows?

9. Explain the significance of scroll bars.

10.  Explain the features of Microsoft Office 2007 and Windows 8.

2.6 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. An Operating System (OS) is the primary control program for managing all
other programs in a computer. The other programs, commonly referred to
as ‘Application Programs’, use the services provided by the OS through a
well-defined Application Program Interface (API). Every computer
necessarily requires some type of operating system that tells the computer
how to operate and utilize other programs installed in the computer. The
role of an OS in a computer is similar to the role of a principal in a college
who is responsible for the overall management of the college.

Any computer system can be broadly classified in terms of four component
dimensions, namely Hardware, Operating System, Application Programs
(MS Word, Games, Calculator), and Users (people who work on the
computer).

2. In computing, a bootstrapping process called booting (booting up) starts
the OS when the computer system is switched on. The first set of operations
performed by the computer when switched on is called boot sequence.

The main operating system for the computer is loaded by the bootloader.
One can boot an operating system in two conditions: (i) Where there is a
single OS installed and (ii) Where there are multiple OSs installed on the
computer.

3. Multitasking is a type of OS that permits multiple programs to be run
simultaneously by the same computer. A user of the computer can
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simultaneously play games while a Word document is being printed (The
user is simultaneously working with two different applications–Word and
Games). Operating systems supporting multitasking include UNIX and the
Windows range.

4. Microsoft Disk Operating System (MS-DOS) is a single user, single tasking
operating system. DOS has a command-line, text-based/non-graphical user
interface commonly referred to as Character Based User Interface (CUI).
When the computer is switched on, a small program checks all internal
devices, electronic memory and peripherals. Once this process is completed,
MS-DOS is loaded.

5. The DOS prompt known as the command prompt looks like C:\> or D:\>
where ‘C’,‘D’ represent the hard drives of the computer system. All
commands are typed at the DOS prompt. Enter key is pressed to view the
output of the typed command.

6. Wild card characters can be used in specifying filenames in DOS. There are
two types of wild cards (?, *).

? : This is used to represent any single character in the file name.

SYNTAX: C:\  DIR BA?.TXT

Displays all the text files in the C: drive starting with ‘BA’ and ending
with any single character.

Examples: BAT.TXT, BAG.TXT, BAR.TXT, BAD.TXT, etc.

* : This is used to represent one or more characters in a file name.

SYNTAX: C:\ DIR CON*.TXT

Displays all the text files in the C: drive starting with ‘CON’.

Examples: CONCEPT.TXT, CONCATENATE.TXT,
CONTEMPT.TXT, CONSOLE.TXT, etc.

7. In order to give a command, you have to select the particular icon. Selecting
an icon can be done by moving the mouse pointer over it and pressing the
left mouse button once. Each time you select a particular icon, the color of
the icon changes, indicating that the icon is selected.

8. Menus are very useful parts of the Windows system. They consist of various
commands and subcommands for default and other applications and
programs stored on your computer.

The Start menu and the Start button are user-interface elements in Microsoft
Windows, and serve as the central launching point for all applications. By
default, the Start button is always visible in the lower left-hand corner of the
screen. It exhibits the Windows logo and the word ‘Start’.

For choosing a program from the Start menu click on the Start menu option
on the Taskbar. Once the Start Menu is expanded you can drag the mouse
to the right and switch over to the submenus.

9. When the contents of the window do not fit in one screen, you will see
boxes with arrows at the top and bottom. These boxes are called scroll
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bars. You can click on the arrows in the scroll bars to browse the hidden
part of the screen. The blue rectangular indicators on the scroll bar tell you
the position of the screen.

Scroll bars can be vertical as well as horizontal. The horizontal scroll bar is
the one that moves the window on the horizontal axis, while the vertical
scroll bar moves the window on the vertical axis.

10. Microsoft Office 2007 is the latest version of MS Office that runs on
Windows XP SP2 and above. It is packed with many features. It has
components, such as Excel (Spreadsheet), Word (Word processor),
OneNote and PowerPoint (for making presentations). It was released on
Nov 30, 2006 for volume license customers and was made available to
retail customer in the year 2007 on January 30. This was released vis-à-vis
Windows Vista (Operating System).

There are number of features that Office 2007 contains. It is much improved
in comparison to its earlier versions. New GUI (Graphical User Interface)
has been introduced that is known as Fluent User Interface. This has replaced
menus and toolbars and has tabbed tool bars and is known as Ribbon.

Windows 8 introduced a number of new features across various aspects of
the operating system. These include a greater focus on optimizing the
operating system for touchscreen-based devices (such as, tablets) and cloud
computing.

Windows 8 introduces the new Windows Runtime (WinRT) platform, which
can be used to create a new type of application officially known as Windows
Store apps and commonly called Metro-Style apps. Such apps run within
a secure sandbox and share data with other apps through common APIs.
WinRT, being a COM-based API, allows for the use of various programming
languages to code apps, including C++, C++/CX, C#, Visual Basic .NET,
or HTML5 and JavaScript.

In Windows 8 up to two apps may snap to the side of a widescreen display
to allow multi-tasking, forming a sidebar that separates the apps.

2.7 SUMMARY

 An Operating System (OS) is the primary control program for managing all
other programs in a computer.

 The other programs, commonly referred to as ‘Application Programs’, use
the services provided by the OS through a well-defined Application Program
Interface (API).

 Every computer necessarily requires some type of operating system that
tells the computer how to operate and utilize other programs installed in the
computer.

 Any computer system can be broadly classified in terms of four component
dimensions, namely Hardware, Operating System, Application Programs
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(MS Word, Games, Calculator), and Users (people who work on the
computer).

 The control programs are used to control and maintain the operations of a
computer. There is an Initial Program Loader (IPL) which is in the form of
firmware and is stored in the Read Only Memory (ROM) section of the
Memory Unit.

 When the computer is switched on, the electronic chip is automatically
activated and the IPL reads the Boot Sector Routine (BSR), which resides
in the primary memory of the computer.

 System service programs support the control programs. Each of these is
divided into three portions: Linkage Editor, Librarian and Input / Output
control system.

 A Linkage Editor is an editor program that creates one module from several
by resolving cross-references among the modules.

 In computing, a bootstrapping process called booting (booting up) starts
the OS when the computer system is switched on. The first set of operations
performed by the computer when switched on is called boot sequence.

 The main operating system for the computer is loaded by the bootloader.
One can boot an operating system in two conditions: (i) Where there is a
single OS installed and (ii) Where there are multiple OSs installed on the
computer.

 Multitasking is a type of OS that permits multiple programs to be run
simultaneously by the same computer. A user of the computer can
simultaneously play games while a Word document is being printed (The
user is simultaneously working with two different applications–Word and
Games).

 Operating systems supporting multitasking include UNIX and the Windows
range.

 Single user type of OS does not permit multiple users to use the computer
and run programs at the same time. This assumes that at any given time only
one user uses the system and runs only one program, i.e., it does not allow
two users to concurrently work on the same program. MS-DOS is an
example.

 Multiuser type of OS permits multiple users to use the computer and run
programs at the same time, e.g., UNIX, Linux, Windows NT.

 The OS is responsible for the creation and deletion of files/directories and
the mapping of these files/directories on to the secondary storage.

 The OS is responsible for protecting the resources and information of a
computer system from destruction and misuse.

 Microsoft Disk Operating System (MS-DOS) is a single user, single tasking
operating system.
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 DOS has a command-line, text-based/non-graphical user interface commonly
referred to as Character Based User Interface (CUI). When the computer
is switched on, a small program checks all internal devices, electronic memory
and peripherals. Once this process is completed, MS-DOS is loaded.

 The DOS prompt known as the command prompt looks like C:\> or D:\>
where ‘C’,‘D’ represent the hard drives of the computer system. All
commands are typed at the DOS prompt. Enter key is pressed to view the
output of the typed command.

 All DOS commands are case-insensitive (i.e., there is no difference whether
you type COPY, copy or coPY). The same is true for the attributes,
parameters and filenames.

 Wild card characters can be used in specifying filenames in DOS. There
are two types of wild cards (?,*). The ‘?’ is used to represent any single
character in the file name and the ‘*’ is used to represent one or more
characters in a file name.

 The batch file allows the users of MS Windows and MS-DOS to generate
a list of commands for running in sequence after the execution of the batch
file. A batch file can be used for running the commands that are frequently
run, deleting files, moving files, etc.

 A filename is a special type of string which is used for identifying a file
stored on the file system of a computer.

 A filename is divided in two parts: basename (the primary filename) and the
extension (which indicates the type of file related to a certain format of file).

 An extension name of a computer file is usually a three-character addition
after the file’s name. This extension assists IBM-compatible computers,
such as those running Microsoft Windows, in identifying the program to
relate the file with and correctly open the file.

 Given below are the characters that cannot be used in filenames or directory
names in most operating systems.

\, /, :, *, ?, “, <, > and |

 Selecting an icon can be done by moving the mouse pointer over it and
pressing the left mouse button once. Each time you select a particular icon,
the color of the icon changes, indicating that the icon is selected.

 Icons can be moved on screen by simply holding the left mouse button
down when you click on the icon, dragging the mouse to the desired position
on the screen, and then releasing the mouse button.

 Menus are very useful parts of the Windows system. They consist of various
commands and subcommands for default and other applications and
programs stored on your computer.

 The Start menu and the Start button are user-interface elements in Microsoft
Windows, and serve as the central launching point for all applications. By
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default, the Start button is always visible in the lower left-hand corner of the
screen. It exhibits the Windows logo and the word ‘Start’.

 For choosing a program from the Start menu click on the Start menu option
on the Taskbar. Once the Start Menu is expanded you can drag the mouse
to the right and switch over to the submenus.

 When the contents of the window do not fit in one screen, you will see
boxes with arrows at the top and bottom. These boxes are called scroll
bars. You can click on the arrows in the scroll bars to browse the hidden
part of the screen. The blue rectangular indicators on the scroll bar tell you
the position of the screen.

 Scroll bars can be vertical as well as horizontal. The horizontal scroll bar is
the one that moves the window on the horizontal axis, while the vertical
scroll bar moves the window on the vertical axis.

 There is a small component inside your computer called Real Time Clock
(RTC). This RTC and CMOS setup are powered by a battery cell to ensure
that the basic settings of your computer are not lost when you switch off
your system.

 RTC stores the current date and time in your computer and passes on this
information to put a date and time stamp on all file operations.

 Windows allows you to set the date, time, and time zone for your computer
using the Date and Time option of the Control Panel.

 The option of setting a time zone is especially useful for laptop users who
zip across many countries (and time zones) frequently. It helps them maintain
the computer date and time as per the local settings. For example, for India
the time zone is GMT+ 05:30 Mumbai, Kolkata, Chennai, New Delhi.

 A screen saver is a moving image or pattern that appears on your monitor
when you have left your computer idle for a specified time.

 Fonts are like having different handwritings available on your computer.
They are typefaces that you can use to pep up your work and also for
changing the appearance of characters on the screen and as well as the
printed paper.

 Fonts help you to express your message more clearly and emphatically.
Windows comes bundled with a large number of fonts, which are
automatically installed (depending upon your monitor and printer type) during
the Windows setup installation.

 The Control Panel’s System applet is loaded with features for power users.
It displays information about your computer’s internal devices, RAM size,
CPU details, etc. It also lets you add, remove, enable and disable specific
devices of your computer.

 In a computer network you can link several computers so that they can
exchange information between themselves. Another advantage of a computer
network is that expensive resources like plotters, scanners and printers can
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be shared between many computers, thereby eliminating the need for
duplicating these resources for each computer.

 The Network Connections Window contains utilities like Network Setup,
Mail, Schedule and Remote Access.

 Microsoft Office 2007 is the latest version of MS Office that runs on
Windows XP SP2 and above. It is packed with many features. It has
components, such as Excel (Spreadsheet), Word (Word processor),
OneNote and PowerPoint (for making presentations).

 It was released on Nov 30, 2006 for volume license customers and was
made available to retail customer in the year 2007 on January 30. This was
released vis-à-vis Windows Vista (Operating System).

 There are number of features that Office 2007 contains. It is much improved
in comparison to its earlier versions. New GUI (Graphical User Interface)
has been introduced that is known as Fluent User Interface. This has replaced
menus and toolbars and has tabbed tool bars and is known as Ribbon.

 Windows 8 introduced a number of new features across various aspects of
the operating system. These include a greater focus on optimizing the
operating system for touchscreen-based devices (such as, tablets) and cloud
computing.

 Windows 8 introduces the new Windows Runtime (WinRT) platform, which
can be used to create a new type of application officially known as Windows
Store apps and commonly called Metro-Style apps. Such apps run within
a secure sandbox and share data with other apps through common APIs.
WinRT, being a COM-based API, allows for the use of various programming
languages to code apps, including C++, C++/CX, C#, Visual Basic .NET,
or HTML5 and JavaScript.

 In Windows 8 up to two apps may snap to the side of a widescreen display
to allow multi-tasking, forming a sidebar that separates the apps.

2.8 KEY TERMS

 Operating System (OS): An Operating System (OS) is the primary control
program for managing all other programs in a computer, the other programs,
commonly referred to as ‘Application Programs’, use the services provided
by the OS through a well-defined Application Program Interface (API).

 Linkage Editor: A Linkage Editor is an editor program that creates one
module from several by resolving cross-references among the modules.

 Booting process: In computing, a bootstrapping process called booting
(booting up) starts the OS when the computer system is switched on, the
first set of operations performed by the computer when switched on is
called boot sequence.
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 Multitasking: It is a type of OS that permits multiple programs to be run
simultaneously by the same computer, operating systems supporting
multitasking include UNIX and the Windows range.

 Microsoft Disk Operating System (MS-DOS): MS-DOS is a single
user, single tasking operating system, DOS has a command-line, text-based/
non-graphical user interface commonly referred to as Character Based User
Interface (CUI).

 DOS prompt: The DOS prompt known as the command prompt looks
like C:\> or D:\> where ‘C’,‘D’ represent the hard drives of the computer
system, all commands are typed at the DOS prompt and then Enter key is
pressed to view the output of the typed command.

 Wild card characters: These can be used in specifying filenames in DOS.
There are two types of wild cards (?,*). The ‘?’ is used to represent any
single character in the file name and the ‘*’ is used to represent one or more
characters in a file name.

 Menus: The Menus are very useful parts of the Windows system. They
consist of various commands and subcommands for default and other
applications and programs stored on your computer.

2.9 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is the significance of an Operating System (OS)?

2. What is MS-DOS? Why it is not used nowadays?

3. List the Naming Rules in MS-DOS.

4. Define the booting process.

5. Name some Internal and External DOS Commands.

6. Why are Wild card characters used in MS-DOS?

7. Explain the basic features of Windows.

8. Analyse the features of Windows 7 and Windows 8.

Long-Answer Questions

1. What are the main functions of operating systems? Discuss.

2. Explain the various components of an operating system.

3. What do you mean by the booting process? Briefly explain the single OS
boot process.

4. What is MS-DOS? What do you mean by Wild card characters? What do
you mean by batch file? Explain with the help of examples.

5. How would you name a file in MS-DOS? Explain with the help of examples.
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6. Briefly explain about the DOS System Files and Internal and External DOS
Commands giving the SYNTAX and examples.

7. Explain how you would create a directory in DOS and a folder in Windows.

8. Explain the various reasons that why one should prefer Windows over other
operating systems.

9. Discuss the features of Windows desktop items.

10. Explain the various items of control panel.

11. Discuss the features of Windows 7 and Windows 8.
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UNIT 3 MICROSOFT WORD 2007

Structure

3.0 Introduction
3.1 Objectives
3.2 Introduction to Microsoft Word 2007 and Office 2010

3.2.1 Microsoft Office 2010
3.2.2 Word Pocessing Software and their Utilities

3.3 Getting Started
3.3.1 Opening Word Application
3.3.2 Explanation of Different Parts of Word Window and Views in Word
3.3.3 Creating a Document
3.3.4 Saving a Document
3.3.5 Opening an Existing Document
3.3.6 Closing a Document
3.3.7 Quitting from Word
3.3.8 Text Editing

3.4 Document Printing
3.4.1 Setup Page to Margin, Paper Size, Orientation for Printing
3.4.2 Print Preview

3.5 Document Formatting
3.5.1 Font Formatting
3.5.2 Border and Shading
3.5.3 Inserting Symbols
3.5.4 Change Case
3.5.5 Text Alignment
3.5.6 Insertion of Current Date and Time in a Word Document
3.5.7 Writing Header/Footer Content
3.5.8 Bullets and Numbering

3.6 Advanced Document Formatting
3.6.1 Indention
3.6.2 Using Tab
3.6.3 Dividing Page of a Document into Multiple Columns
3.6.4 Inserting Contents from another File into the Current Document

3.7 Creating and Using Table
3.7.1 Inserting a Table into the Document
3.7.2 Selection within Table
3.7.3 Insert/Delete Row(s)/Column(s) into Table
3.7.4 Applying Borders and Shading in the Table
3.7.5 Formatting Data within Table Cells
3.7.6 Table Autoformatting
3.7.7 Tabular Data Sorting
3.7.8 Merge/Split Cells
3.7.9 Writing Formula or Calculation within Table
3.7.9 Covert Text to Table and Vice Versa

3.8 Mail Merge
3.8.1 Creating a Master Document
3.8.2 Creating Data Source
3.8.3 Inserting Field Names into Master Document
3.8.4 Merge the Information onto One File
3.8.5 Print the Merged Letters
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3.9 Using Tools
3.9.1 AutoCorrect
3.9.2 Spell Checking
3.9.3 Protecting File

3.10 Inserting Graphics in Word Document
3.10.1 Inserting Clip Art, WordArt, AutoShapes and Text Box
3.10.2 Formatting Graphic Objects Using Drawing Toolbar

3.11 Answers to ‘Check Your Progress’
3.12 Summary
3.13 Key Terms
3.14 Self-Assessment Questions and Exercises
3.15 Further Readings

3.0 INTRODUCTION

Microsoft Office 2010 (Codenamed Office 14) is a version of the Microsoft Office
productivity suite for Microsoft Windows. Office 2010 is the successor to Office
2007 and the predecessor to Office 2013. Principally, Office 2010 introduces
user interface enhancements including a Backstage view that consolidates document
management tasks into a single location. The ribbon introduced in Office 2007 for
MS Access, MS Excel, MS Outlook, MS PowerPoint, and MS Word is the
primary user interface for all apps and is fully customizable in Office 2010. One
feature that has not changed in Office 2010 is the use of XML-based file formats,
such as .docx, .pptx, .xlsx, and .aspx. This means that files you save in Office
2010 can be opened in Office 2007 without requiring the use of a file converter or
compatibility pack.

Microsoft Word 2007 is a full-featured word processing program, which
can be used for any work involving creating and managing text—write letters and
reports, prepare bills, invoices, office stationery (letter-heads, envelopes, forms,
etc.), design brochures, pamphlets, newsletters, magazines, etc. The 2007 version
of the program has introduced the ‘Ribbon User Interface’ which is a work-oriented
Graphical User Interface or GUI. The Ribbon is positioned at the top of the screen
of the Word Window and includes eight tabs, such as Home, Insert, Page Layout,
References, Mailings, Review, View and Add-Ins. You will learn to create a
document, save a document, send a document by e-mail or fax, format a document
as per your requirement and print it. You will also learn how work can be done
faster by changing the view of your document. You will learn the features of various
views. MS Word 2007 permits you to edit features, correct the mistakes and
make alterations, additions or deletions. In MS Word 2007, the AutoCorrect,
thesaurus and spell checking options help you to check spellings and grammar in
a document. The AutoCorrect feature corrects typos and misspellings as they
occur when you are working on your document and saves time. Thus it helps you
eliminate errors that you might otherwise miss. You will learn to cut, copy, paste
and create hyperlink in MS Word 2007. Microsoft Word 2007 also provides
feature to insert/create table in a document for displaying data in a tabular format
and to sort data in ascending or descending order. The mail merge feature is the
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prime application of word processing technology because this tool allows you to
send personalized messages to a large group of people at once without them
knowing who else you have sent it to. You will learn the concept of inserting graphics
in MS Word 2007 document, such as Picture, Clip Art, WordArt, Shapes,
SmartArt, Chart, Symbols and Text boxes. Finally, you will learn how to create
and save Macros, add footnotes, bibliography and citations.

In this unit, you will study about the basic features of Microsoft Office 2010
and detailed concepts of Microsoft Word 2007 (MS Word 2007) which is a
product of Microsoft Office 2007 or the 2007 Microsoft Office System.

3.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the characteristic features of Microsoft Office 2010

 Describe the significant features of Microsoft Word 2007

 Differentiate between Microsoft Word 2007 and its earlier versions

 Understand the significance of the Microsoft Office button and Ribbon

 Use the Quick Access toolbar and customize it

 Create and save a document, and open and rename an existing document

 Work with multiple documents and describe various types of document
views

 Customize the word environment and edit a document using various Word
features

 Format text, apply styles, and add bulleted, numbered and nested lists

 Add tables, symbols, special characters and equations

 Proofread the document using Spelling & Grammar, thesaurus and
AutoCorrect

 Use mail merge feature to send messages to a large group of people

 Insert and resize illustrations, pictures, Clip Art and SmartArt graphics

3.2 INTRODUCTION TO MICROSOFT WORD
2007 AND OFFICE 2010

Microsoft Office, or simply Office, is a family of client software, server software,
and services developed by Microsoft. It was first announced by Bill Gates on
August 1, 1988, at COMDEX in Las Vegas. The first version of Office contained
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years,
Office applications have grown substantially closer with shared features, such as a
common spell checker, OLE data integration and Visual Basic for Applications
scripting language. Microsoft Office is produced in several versions targeted towards
different end-users and computing environments.
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3.2.1 Microsoft Office 2010

Microsoft Office 2010 (Codenamed Office 14) is a version of the Microsoft Office
productivity suite for Microsoft Windows. On April 15, 2010 the Microsoft Office
2010 was released to manufacturing, and on June 15, 2010 it was made available
for retail and online purchase. It is the successor to Office 2007 and the predecessor
to Office 2013. Office 2010 introduces user interface enhancements including a
‘Backstage View’ that consolidates document management tasks into a single
location. The ‘Ribbon’ feature introduced in Office 2007 for MS Access, MS
Excel, MS Outlook, MS PowerPoint, and MS Word is the primary user interface
for all apps and is fully customizable in Office 2010. Furthermore, the additional
new features that are included in Office 2010 are extended file format support;
co-authoring features that enable multiple users to share and simultaneously edit
documents; OneDrive and SharePoint integration; and security improvements,
such as Protected View, a read-only, isolated sandbox environment to protect
users from potentially malicious content. Microsoft also announced Office Online,
formerly Office Web Apps, a collection of free web-based versions of MS Excel,
MS OneNote, MS PowerPoint, and MS Word.

Office 2010 is the first version of Office in two variants for IA-32 and x64,
but the x64 version is not compatible with Windows XP or Windows Server
2003. It is also the first version which required product activation for volume
license editions. Office 2010 supports Windows XP SP3, Windows Server 2003
SP2, Windows Vista SP1 or a later version. It is the last version of Office
compatible with Windows XP, Windows Server 2003, Windows Vista and
Windows Server 2008 as its successor.

Basically, in Office 2010, Microsoft made several improvements to the Office
suite that includes MS Word, MS Excel, MS PowerPoint, MS Access, and MS
Outlook. One feature that has not changed in Office 2010 is the use of XML-
based file formats, such as .docx, .pptx, .xlsx, and .aspx. This means that files you
save in Office 2010 can be opened in Office 2007 without requiring the use of a
file converter or compatibility pack. Following are the new features in Office 2010.

Changes in User Interface

In Office 2007, the Ribbon replaced the menus and toolbars in MS Word, MS
Excel, MS PowerPoint, and MS Access. In Office 2010, all Office applications
use the Ribbon as the default view, including MS Outlook, MS OneNote, Publisher,
InfoPath, and SharePoint Workspace (the new name for Microsoft Office Groove
2007). The ‘Ribbon’ feature groups’ items together based on their context and
how they are used. For example, all editing commands are grouped together on
the Home Ribbon tab. You can customize the Ribbon to include new tabs and
command groups based on your personal preferences. The image below shows
the Ribbon as it appears in MS Outlook.
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Contextual Tabs still appear on the Ribbon when objects are selected. For
example, clicking on a picture within a MS Word document will display a Format
tab with tools for editing graphics.

The File tab has replaced the Office Button in the upper left corner of
most Office 2010 applications. The File tab provides access to commonly used
functions, such as saving, printing, and opening recent files.

Clicking the File tab opens Microsoft Office Backstage View, which
represents a new way of organizing the options for saving, opening, printing, and
sharing files. Following image shows the additional print options in MS Word,
which can now be accessed directly from the File tab (instead of from a separate
Print window). Microsoft Office Backstage View allows you to share, print, and
publish documents with fewer clicks.
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Changes in Office Applications

MS Word 2010

Inserting a screen shot directly into the document in MS Word 2010. Click the
Insert tab and select Screenshot, then choose an available window or use the
Screen Clipping option to select a portion of the window.

The Find feature has been improved. The results of the search are listed in
a panel to the left of the document. By clicking one of these results you can jump
directly to that location within the document. Matching terms are also highlighted
in the text of your document itself. Click the Home tab and select Find to use this
feature.

The Paste preview option allows you to see how text will look before you
paste it into your document.

MS Word 2010 provides more advanced translation options. You can
translate a document, a selection of text, or a single word. Click the Review tab
and select Translate to use this feature. Additional assistance is available for
English as a second language with English text-to-speech playback.
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MS Outlook 2010

In the MS Outlook 2010, the Ribbon organizes the Menu options and features.

MS Outlook 2010 features new tools for editing graphics and pictures. You
can use these tools to insert and format screenshots into your email messages. You
can also insert shapes and apply effects to them, such as Shadow and 3-D
Rotation. Click the Insert tab to insert Shapes, SmartArt, or Screenshot. Then
select the image you want to insert and use the Format tab to apply Shape Effects.

 



Microsoft Word 2007

NOTES

Self - Learning
100 Material

The Conversation view helps you to organize email messages. You can
view all the replies associated with your messages by clicking the View tab and
selecting Show as Conversations.

 

You can also manage conversations with the new options on the Outlook
Ribbon. For example, you can use the Ignore feature to send an entire
conversation to the Deleted Items folder.

 

You can use the new Quick Steps feature (found on the Home tab) to
quickly perform common tasks on specific email messages. For example, you can
move a message to a different folder and mark it as read, or you can reply to and
delete an email.
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The new Schedule View in the Calendar section provides a horizontal
display of multiple calendars. New calendar management tools enable you to save
frequently used groups of calendars so that they can be quickly redisplayed
whenever required.

MS Excel 2010

MS Excel 2010 provides a feature called Sparklines which allows you to insert
simple graphics into a spreadsheet cell that help give context to the data. Unlike
charts, Sparklines are meant to be embedded into what they are describing. You
can create Sparklines from the Insert tab.

MS PowerPoint 2010

In MS PowerPoint 2010, the Picture Effects, such as color saturation, brightness,
and contrast can be added from the Format tab. An advanced cropping tool,
along with artistic filters, such as Blur, Paintbrush, and Watercolor, can be applied
to the images as per the user requirement.

Video files can be directly embedded and edited in MS PowerPoint 2010.
You can add effects, such as Video Fades, Reflections, Bevels, 3-D Rotation, etc.
Additionally, now you can work on multiple presentations and multiple monitors.
Separate windows are opened to view and edit presentations independently, side-
by-side, or even on separate monitors.
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3.2.2 Word Pocessing Software and their Utilities

Microsoft Word 2007 is a product of Microsoft Office 2007 or 2007 Microsoft
Office System.  It introduced the ‘Ribbon User Interface’ instead of the old menu
and toolbar which is a work oriented Graphical User Interface (GUI). You can
create newsletters, articles, annual reports or update a blog using various formats
and themes of Microsoft Word 2007. Themes help to change the presentation of
a document.

A word processor is formally a document preparation system. It is a
computer application used for the production including composition, editing,
formatting and printing of any type of printable material. A word processor can
also be referred as a stand-alone computer unit analogous to a typewriter, but it
includes technological advancements such as a screen for displaying the text and
illustrations, advanced formatting and printing options, and the capability to save
documents onto memory cards or diskettes. Word processing characteristically
refers to text manipulation functions such as automatic formation of batch mailings
using a form letter template and an address database (also termed as mail merging),
indices of keywords and their page numbers, tables of contents with section titles
and their page numbers, tables of figures with caption titles and their page numbers,
cross-referencing with section or page numbers and footnote numbering. Other
word processing functions included in the software are spell checking which in
fact checks against specified wordlists, grammar checking option ensures for what
seem to be simple grammar errors and a thesaurus function option finds words
with similar or opposite meanings.

The early word processors used tag-based markup for document formatting
but the modern word processors uses graphical user interface which provides the
WYSIWYG features that is What You See Is What You Get. Microsoft Word is
considered as the most widely used word processing software. With the growth
of personal computers specially the IBM PC and PC compatibles, the software
based word processors running on general purpose commodity hardware gradually
replaced the dedicated word processors and hence the term is referred as software
rather than hardware. Thus, a word processor enables you to create a document,
store it electronically on a disk, display it on a screen, modify it by entering commands
and characters from the keyboard, and print it on a printer.

Lotus Word Pro

Lotus Word Pro is Word processor software produced by IBM’s Lotus Software
group for use on Microsoft Windows compatible computers and on IBM OS/2
Warp. Word Pro can be obtained as part of the Lotus SmartSuite office suite. The
screen displays the layout of Lotus Word Pro Word processor.
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Notepad

Notepad is a basic text processor which is used to create simple documents. The
most common use for Notepad is to view or edit text files, but many users find that
Notepad is a simple tool for creating Web pages. Because Notepad supports
only very basic formatting, so it is especially useful when creating HTML documents
for a Web page because special characters or other formatting may not appear in
your published Web page or may even cause errors. The given screen shot displays
the layout of Notepad Word processor.

WordFile4ME

WordFile4ME is a shareware Object Linked Embedded (OLE) capable word
processor with nine different stages or faces to suit curriculum requirements the
stage menu selector allows features. To be enabled progressively. Opening a
document reconfigures the application to the stage or level at which it has been
saved hence solving the configuration problem. The given screen shot displays the
layout of WordFile4ME Word processor.

Check Your Progress

1. What is a Word Processor?

2. What is Lotus Word Pro?
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3.3 GETTING STARTED

The Start button in the lower-left corner of your screen gives you access to all the
programs on your PC and also to Word. To start Microsoft Word, Click on the
Start button and select All Programs. To open this window, you will need to
perform the following steps:

 Click on the Start button and select Microsoft Office from All Programs.

 Select Microsoft Office Word 2007.

The user interface of Microsoft Word 2007 is shown in the screen below.

Menus

When you explore Word 2007, you will notice  the new look of the menu bar.
Three new features help you to work with Word 2007, namely the Microsoft
Office Button, the Quick Access Toolbar and the Ribbon which contain various
functions.

The Microsoft Office Button

The Microsoft Office button is located in the upper left corner of the Word 2007
Window. A menu appears when you click on this button. This menu helps in creating
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a new document or file, opening an existing document or file, saving a document
or file, printing a document or file, sending the document or file via fax or e-mail,
etc.

The Quick Access Toolbar

The Quick Access toolbar is right next to the Microsoft Office button. This toolbar
helps you to access the frequently used commands. The default commands which
appear on this toolbar are Save, Undo and Redo. These commands help you to
Save a document or file, Undo an action and Redo an action.

You can customize this toolbar as per your requirements by clicking on the
expansion button as shown here.

More items can be added to the quick access toolbar by right clicking on
the item which you want to add in the Office Button or the Ribbon and then
clicking on Add to Quick Access Toolbar as shown.

The Ribbon

The Ribbon is positioned at the top of the screen of the Word window. It includes
eight tabs, namely Home, Insert, Page Layout, References, Mailings, Review,
View and Add-Ins as shown in screen below. Each tab contains various new and
advanced features of Word.
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Each tab specifically contains certain tools as follows:
 Home: Clipboard, Fonts, Paragraph, Styles and Editing
 Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text and

Symbols
 Page Layout: Themes, Page Setup, Page Background, Paragraph and

Arrange
 References: Table of Contents, Footnotes, Citations & Bibliography,

Captions, Index and Table of Authorities
 Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results

and Finish
 Review: Proofing, Comments, Tracking, Changes, Compare and Protect
 View: Document Views, Show/Hide, Zoom, Window and Macros
 Add-Ins: PDF Transfer or any new add-in program

The Title Bar

The Title bar is next to the Quick Access toolbar. It displays the title of the current
document which is in use. The first new document in Word is named as ‘Document1’
as shown below. When you open more new documents, Word automatically names
them as Document2, Document3, Document4, etc., sequentially. The document
can be saved by giving it a proper file name as per the user’s choice.

Working with Documents

You can perform the following actions vis-à-vis documents:

3.3.1 Opening Word Application

To open a Word 2007 application, you need to select the File Open menu as
shown in the given screen and then select the file which you want to open.
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After selecting the file the content of document file is opened on the screen.

3.3.2 Explanation of Different Parts of Word Window
and Views in Word

Following are the various ways in which a document can be viewed in Word: 

 Print Layout:  This is a view of the document as it would appear when
printed.  It includes all tables, text, graphics and images, as presented in the
document.

 Full Screen Reading:  This refers to a full-length view of a document.  It
is of utility when you want to view two pages at a time.

 Web Layout:  This is a view of the document as it would appear in a Web
browser.

 Outline:  This is an outline of the document in the form of bullets.

 Draft:  This view does not display pictures or layouts. It displays only the
text.

To view a document in various forms, click on any of the document view

shortcuts at the bottom of the screen  or alternatively,,

 Click on the View Tab in the Ribbon.
 Click on the appropriate document view.

A brief outline of the different types of views are as follows:
 Draft View: Draft view is the most frequently used view. The Draft view is

used for the purpose of  editing a document quickly.
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 Web Layout: The Web Layout view enables you to see your document as it
would appear in a browser such as Internet Explorer.

 Print Layout: The Print Layout view shows how the document will look
when it is printed.

 Reading Layout: The Reading Layout view formats your screen so that
you can can read the document more comfortably. You can choose more
such reading options  that appear on the right side of the user interface.

 Outline View: The Outline view displays the document in an outline format.
You can display headings without the text. If you move a heading, the
accompanying text also moves with it.
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3.3.3 Creating a Document

Word provides various ways through which a user can create a new document,
open an existing document and save a document in Word. To create a new
document, Click on the Microsoft Office Button  and then Click on New or
Press CTRL+N on the keyboard.

You will see that when you click on the Microsoft Office Button and then
Click on New, Word provides number of choices about the types of documents
you can create. Select and click on Blank from the list if you want to create a
blank document. 

You can create a document using the option Installed Templates. Select
any one of the templates as per your requirement. You can also browse other
options through the list of choices that appear on the left.
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3.3.4 Saving a Document

To save a document, the following steps need to be performed:

 Click on the Microsoft Office Button  and Click on the Save option.

 The alternate option is to press CTRL+S.

 Click on the File icon in the Quick Access Toolbar.

Saving a Document using Save As

To save a document using the Save As option, Click on the Microsoft Office
Button  and Click on Save As. The Save As option helps you to save a document
as a Word Document, Word Template, Word 97-2003 Document (earlier
versions), Other Format, etc.

Renaming a Document

To rename an existing document, you need to perform the following steps:

 Click on the Office Button  and locate the document you want to

rename.

 Click on the Save As option and then right click on the document name
with the mouse and select Rename from the shortcut menu.
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 Type the new name for the document and press the ENTER key.

Working on Multiple Documents

Multiple documents can be simultaneously opened when you need to type or edit
multiple documents at once.  All the documents as opened will be listed in the
View Tab of the Ribbon when you will click on Switch Windows.  The current
document has a checkmark beside the file name.  You can select a different
document as opened by simply clicking on the tab.

3.3.5 Opening an Existing Document

To open an existing document, the following steps need to be performed:

 Click on the Microsoft Office Button  and then Click on Open.

 The alternate option is to press CTRL+O on the keyboard.
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 For recently used document you can click on the Microsoft Office Button
and then click on the name of the document in the Recent Documents
window.

3.3.6 Closing a Document

To close a document, the following steps need to be performed:

 Click on the Office Button.

 Click on Close.

3.3.7 Quitting from Word

When you work with Word processing, you can either quit or minimize Word
2007. If do not expect to return to it anytime soon, you may just want to quit the
program. If you want to stop work on one document to work on another, you can
close the document and then open another. You can use the Minimize button to
hide Word while you are off doing other things. Following steps are required to
quit from Word 2007:

 Choose Exit Word from the Office Button menu.

 Save any files when Word prompts you to do so.
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 Click Yes to save your file. You may be asked to give the file a name, if you
have not yet done so.

 Click Cancel to ‘quit’ the Exit Word command and return to Word.

If you select quit, Word closes its Window and you return to Windows or
some other program (if open) or to desktop. .

3.3.8 Text Editing

The process of editing a document involves the following steps:

Typing and Inserting Text

To enter text, just type the text in the Word window. The text will appear at the
location of the blinking cursor. You can move the cursor using the arrow keys on
the keyboard or by positioning the mouse and clicking the left button. The keyboard
shortcuts used for this purpose are as follows:

Move Action Keystroke

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END

To change the current attributes of the text as typed, it needs to be highlighted
first. Select the text by dragging the mouse over the text to be modified while
holding down the left mouse button. An alternate way is to hold down the SHIFT
key on the keyboard and use the arrow buttons to highlight the text. Following are
the shortcuts that are used to select a specific portion of the text:

Selection Technique

Whole word Double-click within the word

Whole paragraph Triple-click within the paragraph

Several words or lines Drag the mouse over the words or hold down the SHIFT
key while using the arrow keys

Entire document Choose Editing  Select  Select All from the Ribbon
or simply press CTRL+A

Moving and Copying Text

Moving and copying data are common commands used in many computer programs.
These commands allow us to take information from one document
or location and place them in another without retyping everything. When you move
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data, you are actually taking it from the location in which it is currently placed and
relocating it to another area in the document as shown in the given screen.

When you copy data, the original data remains intact and in addition a copy
of that data is placed in another area in the document as shown in the given screen.

In Word 2007, the commands to move or copy are located on the Home
Tab within the Clipboard Group. Followig are the keyboard shortcuts that are
helpful when moving the text of a document.

Move Action Keystroke

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END

Using Drag and Drop Technique

Text can be inserted in a document at any point using any of the following methods:

Type Text:  Put your cursor where you want to add/insert the text and
begin typing.

Copy and Paste Text:  Highlight the text you wish to copy and right click
to view options. Now click on Copy option. Put your cursor where you want the
text to be inserted in the document and right click to view options. Select Paste to
paste the copied text.

Cut and Paste Text:  Highlight the text you wish to cut and right click to
view options. Now click on Cut option. Put your cursor where you want the text
to be inserted in the document and right click to view the options. Select Paste to
paste the cut text.

Drag Text:  Highlight the text you wish to move. Click on it and drag it to
the place where you want the text to be inserted in the document.
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Using Cut, Copy and Paste Options from Edit Menu

To work with Cut, Copy and Paste operations from Edit menu in Word 2007, you
need to first select the text which you want to copy and paste as shown in the
given screen.

Select either Copy or Paste options or place the mouse pointer where you
want to Paste the selected text. The copied and cut text will be stored in Clipboard
application as shown in the following screen.

Finding and Replacing Text

The find and replace option can be accessed by selecting and pressing key
combinations CTRL+F or CTRL+H. After choosing the Find or Replace option,
you will get the shown screen.
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The special drop down list drops a variety of options as follows:

The match case provides you to find and replace the word as uppercase or
lowercase. For example, if you check on Match case box and type the word in
capital as ‘TOP’, a dialog box appears with a message ‘The search item was
not found’.

If you remove the check box, the found word is replaced by defined word
as follows:

You can also search the items by using wild card (‘*’) as follows:
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Inserting/Deleting Text

In Microsoft Word 2007, you create documents by typing them, for example if
you want to create a report, you open Microsoft Word 2007 and then start typing.
You do not have to do anything when your text reaches the end of a line. Microsoft
Word 2007 automatically moves your text to a new line.  If you want to start a
new paragraph press ENTER key. Microsoft Word creates a blank line to indicate
the start of a new paragraph. To capitalize, hold down the Shift key while typing
the letter that you want to capitalize.  If you make a mistake, you can delete what
you typed. You can use the Backspace key to delete. Each time you press the
Backspace key, Microsoft Word 2007 deletes the character that precedes the
insertion point. The insertion point is the point at which your mouse pointer is
located. You can also delete text by using the Delete [Del] key. First, you select
the text you want to delete and then you press the Delete key. Let us take an
example. Type the given sentence:

I am learning to use Microsoft Word 2007.

Delete the word Microsoft and 2007 from the given sentence. Place the cursor
using either the arrow keys or the mouse at the end of the word Microsoft. Press
the Backspace key until the word ‘Microsoft’ is deleted. Similarly delete ‘2007’
from the sentence. The sentence will be somewhat as follows:

I am learning to use Word.

Insert a word ‘Processor’ at the end of sentence. Place the cursor after the word
‘Word’. Start typing the word Processor and press enter to save the changes.
Similarly insert a word ‘how’ in between learning and to in the given sentence. The
sentence will be somewhat as follows:

I am learning how to use a Word Processor.

Selection with Word Document

To select a block of text, point the mouse cursor at the beginning of the text block
and hold down the left mouse button. Drag the cursor over the text you want to
select and then release the mouse (stop the dragging) to mark the end of the
block.

To change the attributes of text it must be highlighted first. Select the text by
dragging the mouse over the desired text while keeping the left mouse button
pressed or hold down the SHIFT key on the keyboard while using the arrow
buttons to highlight the text. Following shortcuts are used for selecting a portion of
the text.

Selection Action

Whole word Double click within the word.

Whole paragraph Triple click within the paragraph.

Several words or lines Drag the mouse over the words or hold down SHIFT
while using the arrow keys.

Entire document choose Editing  Select  Select All from the
Ribbon or press CTRL+A.
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Deselect the text by clicking anywhere outside of the selection on the page
or press an arrow key on the keyboard.

Check Your Progress

3. Where is Microsoft Office button located in Word 2007 window?

4. What does Print Layout view?

5. Which key combination is used to select the entire document in Word
2007?

3.4 DOCUMENT PRINTING

Microsoft Word is considered as standardized software for creating text documents.
In Word 2007, you can quickly print a document and can avoid the Print dialog
box which saves your time. To use the Preview and Print functions in Microsoft
Word 2007, follow the given steps.

 Open the document to preview, if you are not currently working on it.

 Click the Microsoft Office button in the top left hand corner of your screen.
You will find numerous features here that used to be on the ‘File’ menu in
Microsoft Word 2007.

 Highlight ‘Print’ and then select ‘Print Preview’. You will see the document
on the screen.

Using the Print Function

In Microsoft Office button, three options, such as Print, Quick Print and Print
Preview appear on the screen to perform the printing of the document.

Following steps are required to use a Print function in Microsoft Word
2007.

 Click the Microsoft Office button’ and click on Print.

 Select ‘Quick Print’ if your document does not need any change.
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 Choose ‘Print’ if you want more printing options. The ‘Print Dialog Box’
appears.

 Accept the default printer or choose a new one to the right of ‘Name’.

 Click on the ‘Properties’ or ‘Options’ buttons to choose different options
affecting your document’s appearance.

 Select ‘OK’ after you make your choices and the document will be printed.

3.4.1 Setup Page to Margin, Paper Size, Orientation
for Printing

To print the document you need to check the options on the Ribbon. It tell you that
now you are in the ‘Preview’ mode. You can change margin size, page orientation,
print options and can select many other print functions in the ‘Preview’ mode as
shown in the given screen.

Select Properties button if you want to view the margin, paper size and
orientation to print the selected Word document.

3.4.2 Print Preview

Print Preview option is used to see how the document will look like when it is
printed on paper. You can get into Print Preview mode by clicking the Print Preview
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icon on the Quick Access Toolbar or clicking on the Office Start Menu  Print
 Print Preview.

You can also select the Print Preview option in Word 2007 from Office
button as shown in the given screen.

After clicking on Print Preview option form Print menu, you can see the
previewed pages and can modify the required changes.

3.5 DOCUMENT FORMATTING

Document formatting represents all the types of formatting part which are applied
to a selected document for making suitable presentation of the Word Document.
The page margins can be modified through the following steps:

 Click on the Page Layout Tab on the Ribbon.

 On the Page Setup Group, Click on Margins.
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 Click on Default Margin.

 Or you can also click on Custom Margins and complete the dialog box.

Following steps are required to change the Orientation, Size of the Page or
Columns:

 Click the Page Layout Tab on the Ribbon.
 On the Page Setup Group, Click on the Orientation, Size or Columns drop

down menus.
 Click on the appropriate choice.

To Apply a Page Border and Color

To apply a page border or color following steps are required:

 Click on the Page Layout Tab on the Ribbon.

 On the Page Background Group, click on the Page Colors or Page
Borders drop down menus.

To Insert a Page Break

To insert a page break, following steps are required:

 Click on the Page Layout Tab on the Ribbon.

 On the Page Setup Group, click on the Breaks Drop Down Menu.
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 Click on Page Break.

 Select the option as per requirement.

To Insert a Cover Page

To insert a cover page, following steps are required:

 Click on the Insert Tab on the Ribbon.

 Click on the Cover Page option on the Page Group.

 Choose a style for the cover page.

To Insert a Blank Page

To insert a blank page, following steps are required:

 Click on the Insert Tab on the Ribbon.

 Click on the Blank Page option on the Page Group.
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3.5.1 Font Formatting

To change the font typeface, click on the arrow next to the font name and select a
font.

You can preview how the new font will look by highlighting the text and then
hovering over the new font typeface.

To change the font size, click on the arrow next to the font size and select
the proper size or click on the increase or decrease font size buttons.

Font Styles and Effects

Font styles are predefined formatting options which are used to emphasize specific
text. They include bold, italics and underline. Following are the steps that need to
be followed in order to add these effects:

 Select the text and click on Font Styles as included in the Font Group of
the Ribbon.

 The alternate way is to select the text and right click on it to display the Font
Tools.
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3.5.2 Border and Shading

You can add borders, shade paragraphs and even entire pages. To create a border
around a single paragraph or paragraphs, you need to do the following:

 Select the area of text where you want to add the border or to add shade.

 Click on the borders Button in the Paragraph Group on the Home Tab.

 Select the Border and Shading option.

 Select the options as per your choice and requirement.

3.5.3 Inserting Symbols

Word 2007 permits you to insert special characters, symbols, pictures, illustrations,
etc. Special characters are punctuation, spacing or typographical characters that
are  generally not available on the standard keyboard. Following are the steps for
inserting symbols and special characters:

 Move your cursor in the document where you want to insert the symbol.

 Click on the Insert Tab in the Ribbon.

 Click on the Symbol button in the Symbols Group.

 Select the symbol as required.
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If you want more symbols then click on More Symbols to display the
following dialog box for a list of various symbols in various fonts.

3.5.4 Change Case

In Microsoft Word 2007, you can change the capitalization of words, sentences
or paragraphs by doing the following:

 Select the text for which you want to change the case.

 On the Home tab, in the Font group, click on Change Case  (as
shown in the screen) and then click on the capitalization option that you
want.

 To capitalize the first letter of a sentence and leave all other letters as
lowercase, click on Sentence case.

 To exclude capital letters from your text, click on lowercase.

 To capitalize all of the letters, click on UPPERCASE.

 To capitalize the first letter of each word and leave the other letters lowercase,
click on Capitalize Each Word.

 To shift between two case views, for example, to shift between Capitalize
Each Word and the opposite, cAPITALIZE eACH wORD), click on
tOGGLE cASE.



Microsoft Word 2007

NOTES

Self - Learning
126 Material

3.5.5 Text Alignment

Paragraph alignment helps in organizing the text according to the way you want it
to appear. To change the alignment, follow the given steps:

 Click on the Home Tab.

 Select the appropriate button for alignment in the Paragraph Group.
o Align Left:  The text is aligned with the left margin.
o Center:  The text is centered within the margins.
o Align Right:  The text is aligned with the right margin.
o Justify:  It aligns the text to both the left and right margins.

3.5.6 Insertion of Current Date and Time in a Word
Document

In Microsoft Word 2007, use the following shortcut keys to enter the current
system date and time as shown in the given screen, for example [Alt+Shift+D]
key combination is used to insert the current date and [Alt+Shift+T] key combination
is used to insert the current time.

3.5.7 Writing Header/Footer Content

To apply a page border or color, follow the given steps:

 Click on the Page Layout Tab in the Ribbon.

 In the Page Background Group, click on Page Color or Page Borders to
generate the drop down menus.
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Inserting Common Header and Footer Information

To insert Header and Footer information, such as page numbers, date or title, first
decide  whether you want the information to be in the Header, i.e., at the top of the
page or in the Footer, i.e., at the bottom of the page and then follow the given
steps:

 Click on the Insert Tab in the Ribbon.

 Click on Header or Footer.

 Select a style.

 The Header/Footer Design Tab will be displayed in the Ribbon.

 Select or type the information that you want to have in the Header or Footer,
such as date, time, page numbers, etc.

3.5.8 Bullets and Numbering

Bulleted lists are represented using bullet points, numbered lists are represented
using numbers and outline lists combine together the numbers and letters depending
on the association of the list.

Following are the required steps for adding a list to existing text:
 Select the text for which you wish to make a bulleted or numbered list.
 From the Paragraph Group on the Home Tab, click on the Bulleted or

Numbered Lists button as per requirement.

To create a new list:
 Move your cursor in the document  where you want the list to appear.
 Click on the Bulleted or Numbered Lists button.
 Start typing.
 Bullets or Numbers will automatically appear when you will press the ENTER

key and go to a new line.
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Nested Lists

A nested list is the list which has several levels of indented text. To create a nested
list, do the following steps:

 Create your list following the directions as given above.

 Click on the Increase or Decrease Indent button.

Formatting Lists

The bullet image and the numbering format can be modified using the Bullets or
Numbering dialog box. Following are the steps for formatting a bulleted or a
numbered list:

 Select the entire list to change all the bullets or numbers or just place the
cursor on one line within the list to change a single bullet.

 Right click to view options.

 Click on the arrow next to the bulleted or numbered list and choose the
bullet or numbering style as required.

Check Your Progress

6. Why Print Preview option is used?

7. What are font styles?

3.6 ADVANCED DOCUMENT FORMATTING

Styles include collection of formatting that you can apply to text. To utilize Quick
Styles follow the given steps:

 Select the text you wish to format. 
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 Click on the dialog box next to the Styles Group on the Home Tab. 

 Click on the style you wish to apply.

The use of Styles in Word 2007 will allow you to quickly format a document with
a consistent and professional look.  Styles can be saved for use in other documents.

Apply Existing Styles

There are many styles that are already in Word ready for you to use. To view the
available styles click on the Styles dialog box on the Styles Group in the Home
Tab.  To apply a style follow the given steps:

 Select the text.

 Click on the Styles Dialog Box.

 Click on the Style as per your requirement.

Creating New Styles

You can create styles for formatting that you use regularly.  There are two ways to
do this which are known as New Styles or New Quick Styles.

Style Inspector

Following steps are required to determine the style of a particular section of a
document:

 Insert cursor anywhere in the text which you want to use for applying the
style.

 Click on the Styles Drop Down Menu.
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 Click on the Style Inspector button.

Creating Hyperlinks

A hyperlink or link is a reference to data that the reader can directly follow or that
is followed automatically. A hyperlink points to a whole document or to a specific
element within a document. Hypertext is text with hyperlinks. A user following
hyperlinks is said to navigate or browse the hypertext. A hyperlink has an anchor,
which is the location within a document from which the hyperlink can be followed.
The document containing a hyperlink is known as its source document.

Creating links or hyperlinks in a Word 2007 document allows you to put in
a Uniform Resource Locator (URL) which helps the readers to directly click on
to visit a Web page. To insert a link follow the given steps:

 Click on the Hyperlink Button on the Links Group of the Insert Tab. 

 Type in the text in the ‘Text to Display’ box and the Web address in the
‘Address’ box.

Once you click on Hyperlink tool, following screen will appear.
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3.6.1 Indention

Indention helps you to set the text within a paragraph at different margins. The
various options for indenting text are as follows:

 First Line: Controls the left boundary for the first line of a paragraph.

 Hanging:  Controls the left boundary for every line in a paragraph except
the first one.

 Left:  Controls the left boundary for every line in a paragraph.

 Right:  Controls the right boundary for every line in a paragraph.

Following are the steps that need to be performed for indenting paragraphs:
 Click on the Indent buttons to control the indent. 
 Click on the Indent button repeatedly to increase the size of the indent.
 Click on the dialog box of the Paragraph Group.
 Click on the Indents and Spacing Tab.
 Select the indent as required.

3.6.2 Using Tab

Tab stops are frequently used to create easy-to-format documents. You can use
the ruler to set manual tab stops at the left side, middle and right side of your
document. If the horizontal ruler that runs along the top of the document is not
visible then to view it click on the View Ruler button at the top of the vertical
scroll bar. You can quickly set tabs by clicking on the tab selector at the left end of
the ruler until it displays the type of tab that you require and then clicking the ruler
at the location you require. If you want your tab stops at specific positions that
you can not get by clicking the ruler or if you want to insert a specific character
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before the tab, then you can use the Tabs dialog box. Following are the various
Tab tools used for Tab setting and their functions.

Tools Used For Tab Setting Function

A Left Tab stop sets the start position of text that

will then run to the right as you type.

A Center Tab stop sets the position of the middle

of the text. The text centers on this position as you
type.

A Right Tab stop sets the right end of the text. As

you type, the text moves to the left.

A Decimal Tab stop aligns numbers around a

decimal point. Independent of the number of digits,
the decimal point will be in the same position. You
can align numbers around a decimal character only
and you cannot use the decimal tab to align numbers
around a different character, such as a hyphen or
an ampersand symbol.

A Bar Tab stop does not position text. It only inserts

a vertical bar at the tab position.

3.6.3 Dividing Page of a Document into Multiple Columns

Microsoft Word 2007 can be used for writing term papers, articles or even business
reports. It can also be used to create newsletters, flyers or stationery. When you
become acquainted with the various functions of Microsoft Word, you will find
that you can have a lot of fun using it to create many different things. In order to
create something like a newsletter or a shopping list, you may find it the best
option as it divides your document into several columns. This is not hard to do and
it looks rather impressive and professional. Following steps are required to divide
page of a document into multiple columns:

 Open the document in Microsoft Word 2007.
 Select the text you want to divide into columns before proceeding. If you

have not typed any text, follow these steps and the columns will appear as
you type.

 Click on the ‘Page Layout’ menu. In the Page Setup section, you will see
a button labeled ‘Columns’.

 Click on the ‘Columns’ button. You will see several choices for columns
click on the one you want. If you want to customize the columns, click on
‘More Columns’ at the bottom.

 Select the option for how many columns you want and how wide to make
each one. The preview box will show you how it will look like.

 Click on ‘OK’. Your document will be formatted in columns as shown in
the given screen.
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Select the given option from More Columns… You will get the screen
where you can select the multi columns for documents as shown in the given
screen.

3.6.4 Inserting Contents from another File into the Current
Document

You can insert contents from another file, such as linking to a location in a document
or Web page that you created in Word 2007. You must mark the hyperlink location
or destination and then add the link to it. A hyperlink is a graphic or a piece of text
that links to another Web page. To mark the hyperlink location, following steps
are required:

 Insert a bookmark in the destination file or Web page.
 Open the file that you want to link from and select the text or object you

want to display as the hyperlink.
 Right click and then click on Hyperlink on the shortcut menu.
 Under Link to, click on Existing File or Web Page.
 In the Look in box, click on the down arrow. Then navigate to and select

the file that you want to link to.
 Click on Bookmark, select the bookmark that you want and then click on

OK.
To customize the ScreenTip that appears when you rest the pointer over

the hyperlink, click on ScreenTip and then type the text that you want to insert. If
you do not specify a tip, Word 2007 uses the path to the file including the bookmark
name as the tip.
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Check Your Progress

8. How is indention helpful in Word 2007?

9. Define the term hyperlink.

3.7 CREATING AND USING TABLE

Tables organize data into rows and columns. They are used for the purpose of
displaying data in a tabular format.

To Create a Table
To create a table, follow the given steps:

 Move the cursor on the page where you want the new table.

 Click on the Insert Tab of the Ribbon.

 Click on the Tables Button in the Tables Group.

Following are the four ways in which tables can be created:
o Highlight the number of rows and columns.
o Click on Insert Table and enter the number of rows and columns.
o Click on Draw Table, create your table by clicking and entering the

rows and columns.
o Click on Quick Tables and select a table.
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To enter data in a table, place the cursor in the cell where you want to enter
the data or information. Start typing to enter the data.

3.7.1 Inserting a Table into the Document

To insert a table into the document, you need to select the number for rows and
columns. After selecting the required rows and columns from Insert Table tab, you
can get a table format in which you can work.

 Place the cursor on the page where you want the new table.
 Click on the Insert Tab of the Ribbon.

Click on the Tables Button on the Tables Group. 

You can create a table using one of four following ways:
 Highlight the number of row and columns.
 Click on Insert Table and enter the number of rows and columns.
 Click on the Draw Table, create your table by clicking and entering the

rows and columns.
 Click on Quick Tables and choose a table.

3.7.2 Selection within Table

Selection within tables is prime operation of Word 2007 because it helps you to
select and perform the desired options, such as finding total marks of a specific
student or merge the headings, etc.
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You can also set the various options for selected table as shown in the
following screen.

3.7.3 Insert/Delete Row(s)/Column(s) into Table

To insert rows and columns, you need to select shortcut keys which provide options,
such as Insert Columns to the Left, Insert Columns to the Right, Insert Rows
Above and Insert Rows Below as shown in the following screen.

After selecting the option, for example Insert Columns to the Right, you will
get an extra column to the existing eight most column.

3.7.4 Applying Borders and Shading in the Table

Borders and shading facilitate you to highlight information in a table. Thus it enhances
the appearance of the text in a table. Word automatically applies a ½ point border
and a white background, i.e., no shading to all tables and table cells. Though, to
emphasize definite portions of your table, you can add, remove or modify table
borders or you can add shading to certain cells, rows or columns in your table. In
Word 2007, the Ribbon provides quick access to the table borders and shading
features. You can add borders to a table or individual table cell as shown below.

Competitor 
Ranking 

Current Share Share in 3 Years 

Largest 
Competitor 40% 25% 

Second Largest 
Competitor 30% 18% 

Third Largest 
Competitor 20% 15% 
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3.7.5 Formatting Data within Table Cells

The Ribbon provides options for changing both the vertical and horizontal alignment
with cells.

 Select the cells you want to format.
 Click on the Layout tab under Table Tools on the Ribbon.
 Click on on the required button from the Alignment group.

The cell margins allow you to change the gap between the cell contents and
the border of the cell.

 Select the cells you want to format or the entire table.
 Click on the Layout tab on the Ribbon.
 Click on the Cell Margins button in the Alignment group.
 The Table Options dialog box appears. Adjust the required margin settings.

Adjust the measurement in the Allow spacing between cells box to change
the spacing between the cells as opposed to within the cell between the content
and its borders. Click on OK. Your settings become the default settings for all
future tables.

3.7.6 Table Autoformatting

By selecting certain formatting options, the Microsoft Office 2007 system programs
can automatically format certain kinds of text as you type, such as replacing a
typed hyphen ( - ) with a dash ( – ). Use the AutoFormat As You Type options to
control the automatic formatting that you want. The specific AutoFormat As You
Type options that are available depend on the program that you are using. There
are two ways to use the capabilities of the AutoFormat feature:

 You can use features in Microsoft Office Word and Microsoft Office Outlook.
The AutoFormat As You Type tab includes the most useful capabilities of
the AutoFormat feature.

 In Word, you can add the AutoFormat command to the Quick Access
Toolbar.



Microsoft Word 2007

NOTES

Self - Learning
138 Material

3.7.7 Tabular Data Sorting

To sort the data in a table that is based on the contents of a column that includes
more than one word, you must first use characters to separate the data including
data in the header row. For example, if the cells in a column contain both last and
first names, you can use commas to separate the names.

 Select the column that you want to sort.
 Under Table Tools, on the Layout tab, in the Data group, click on Sort.
 Under My List Has, click on Header row or No Header row.
 Click on Options.
 Under Separate Fields at, click on the type of character that separates the

words or fields that you want to sort and then click on OK.
 Under Sort By, in the Using list, select which word or field you want to sort

by.
 In the first Then By list, enter the column that contains the data that you

want to sort by and then in the Using List, select which word or field you
want to sort by.

 If you want to sort by an additional column, repeat this step in the second
Then By List.

 Click on OK.

3.7.8 Merge/Split Cells

Merging columns and rows are used to prepare the common headings as shown in
the following screen.

Select the columns and also select Merge Cells option. You will get the
following resulted screen.

Name

Java C++

Natasha 56 86

Neha 78 76

Lisa 90 89

3.7.9 Writing Formula or Calculation within Table

Following steps are required to write formula or calculation within table:

 Open the Microsoft Word 2007 document. Locate the Word document on
the hard drive and double click on the file icon.
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 Create the table in Microsoft Word 2007. Click on the ‘Insert’ tab from the
main menu. Then select ‘Table’ and choose the appropriate size of the
table.

 Enter the column titles, row titles and figures for the table. Label each column
and row appropriately and enter the numbers for the table calculations. Be
sure to leave a blank table cell to place the calculations in.

 Select the row and column numbering system. In order to compute the
numbers in the table one must understand that the columns are referred to
as letters and rows are numbers. Therefore, the first cell in the table is A1
and the cell to the right is B1. The cell below A1 is A2. These are the
references which the column and row calculations are based upon.

 Place the cursor in the column cell where the computation will occur. Next,
select ‘Layout’ from the main menu tabs. In addition, from the layout menu
choose the ‘Formula’ button.

 Type in the particular calculation in the designated formula box. For example
if a user has numbers in the A2 and A3 box and wants them added together,
simply type ‘=A2+A3’. The default formula is the Sum function formula.

 Know the basic formula symbols. For addition it is ‘+’, for subtraction ‘-’,
for multiplication ‘*’ and for division ‘/’.

In Microsoft Word 2007, formulae can be executed to get the result of the
functions. The functions can be considered as formulas in Microsoft Word. For
this, a suitable table is generated that displays the formula’s result. Microsoft Word
provides =SUM(ABOVE), =SUM(LEFT),  formulae, etc. The table cell can be
referenced to get the result of formula. The various functions, such as ABS (returns
absolute value), AND (performs AND operation), AVERAGE (returns average
value), COUNT (counts the total number of values in specified columns),
DEFINED, FALSE (performs Boolean operation to return False value), IF (checks
the conditional statement), INT (returns integer value), MAX (finds maximum
value of the given column), MIN (finds minimum value of the given column), MOD
(works as modulus operator), NOT(performs NOT operation), OR (performs
OR operation), PRODUCT (finds the product of given values or specified column),
ROUND, SIGN, SUM (finds the sum or total of specified rows), TRUE (performs
Boolean operation to return True value) can be executed in Microsoft Word based
on predefined table. For example, you can get the total amount in INR from the
given table. For this, keep the cursor where total sum is to be calculated using
formula:
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Click on TableFormula menu. The following screen will be appeared in
which you can type the formula as, =SUM(ABOVE) and select the format in
Number format drop down list, for example 0.00.

After clicking on OK button, it returns the total amount up to two decimal
places because the format selected was for two decimal places.

If you select at the right end of a row, Microsoft Word facilitates
=SUM(LEFT) formula too.

3.7.9 Covert Text to Table and Vice Versa

Insert separator characters to convert the text to table or vice versa. These
separator characters are selected to indicate that you can separate the text when
you convert a table to text or when you want new rows or columns to begin when
you convert text to a table, such as commas or tabs to indicate where you want to
divide the text into columns. Use paragraph marks to indicate when you want to
begin a new row. For example, in a list with two words on a line, insert a comma
or a tab after the first word to create a two column table.

 Select the text that you want to convert.

 On the Insert tab, in the Tables group, click on Table and then click on
Convert Text to Table.

 In the Convert Text to Table dialog box, under Separate text at, click
on the option for the separator character that is in your text.

 In the Number of columns box, check the number of columns.

If you do not see the number of columns that you expect, you may be
missing a separator character in one or more lines of text.
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Convert a Table to Text

Following steps are required to convert a table to text.

 Select the rows or table that you want to convert to paragraphs.

 Under Table Tools, on the Layout tab, in the Data group, click on Convert
to Text.

 Under Separate text at, click on the option for that you want to use in
place of the column boundaries.

Rows are separated with paragraph marks.

Check Your Progress

10. What do tables organize?

11. Why is Separator Character selected?

3.8 MAIL MERGE

Mail Merge is one of the effective features of Microsoft Word. It helps you to
draft and send letters to many recipients in very little time. You can use mail merge
when you want to create a set of documents, such as a form letter that is sent to
many customers. Each letter has the same kind of information yet the content is
unique. For example, in letters to your customers, each letter can be personalized
to address each customer by name. The unique information in each letter comes
from entries in a data source.  The mail merge process entails the following overall
steps:

 Set up the Main Document: The main document contains the text and
graphics that are the same for each version of the merged document, for
example the return address or salutation in a form letter.

 Connect the Document to A Data Source: A data source is a file that
contains the information to be merged into a document, for example the
names and addresses of the recipients of a letter.

 Refine the List of Recipients or Items: Microsoft Office Word 2007
generates a copy of the main document foreach item or record in your data
file. If your data file is a mailing list, these items are probably recipients of
your mailing. If you want to generate copies for only certain items in your
data file, you can choose which items (records) to include.

Add placeholders, called mail merge fields, to the document. When you
perform the mail merge, the mail merge fields are filled with information from your
data file. Preview and complete the merge. You can preview each copy of the
document before you print the whole set. You use commands on the Mailings tab
to perform a Mail Merge. If you plan to use custom contact fields with the Contacts
list in Microsoft Office Outlook, you must begin the mail merge process in Outlook.
You can also perform a Mail Merge by using the Mail Merge task pane which
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leads you step by step through the process. To use the task pane, in the Start Mail
Merge group on the Mailings tab, click Start Mail Merge, and then click Step by
Step Mail Merge Wizard.

3.8.1 Creating a Master Document

Following steps are required to create the main document:

 Start Microsoft Word 207. A blank document opens by default. Leave it
open. If you close it, the commands in the next step are not available. On
the Mailings tab, in the Start Mail Merge group, click on Start Mail Merge.

Click on Letters. You can also use Mail Merge to create the following:
 You can create a catalog or directory which has the same kind of information,

such as name and description is shown for each item but the name and
description in each item is unique. Click on Directory to create this type of
document.

 You can create a set of envelopes. The return address is the same on all the
envelopes, but the destination address is unique on each one.

 You can create a set of mailing labels. Each label shows a person’s name
and address but the name and address on each label is unique.

 You can create a set of e-mail messages. The basic content is the same in
all the messages but each message goes to the individual recipient and each
message contains information that is specific to that recipient, such as the
recipient’s name or some other piece of information.

3.8.2 Creating Data Source

To merge information into your main document, you must connect the document
to a data source or a data file. If you do not already have a data file, you can
create one during the Mail Merge process.   If you use an existing list, make sure
that it contains the information that you want to use, including all the columns and
the rows. You can make some changes during the merge but you cannot open
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your data source separately during the merge. The merge process is easier if your
data source is ready before you connect to it. Choose a data file. On the Mailings
tab, in the Start Mail Merge group click on Select Recipients.

Do one of the following tasks:
 If you want to use your Contacts list in Outlook, click on Select from Outlook

Express Contacts.
 If you have a Microsoft Office Excel worksheet, a Microsoft Office Access

database or another type of data file, click on Use Existing List and then
locate the file in the Select Data Source dialog box.

For Excel, you can select data from any worksheet or named range within
a workbook. For Access, you can select data from any table or query. The query
includes a means of finding all the records stored in a data source that fit a set of
criteria that you name. Queries can contain operators, quotation marks, wildcard
characters and parentheses to help focus your search, i.e., defined in the database.
For another type of data file, select the file in the Select Data Source dialog box.
If the file is not listed, select the appropriate file type or select All Files in the Files
of type box. In a Mail Merge, you can use the following types of data files:

 Files from single tier supports file based database programs for which you
have installed an OLE DB. In fact, OLE DB is a component database
architecture that implements efficient network and the Internet access to
many types of data sources, including relational data, mail files, flat files and
spreadsheets provider or Open Database Connectivity (ODBC).

 A standard method for sharing data between databases and programs.
ODBC drivers use the standard Structured Query Language (SQL) to gain
access to external data.

An HTML file has a single table. The first row of the table must contain
column names and the other rows must contain data.  Any similar address lists that
have been created with a Messaging Application Programming Interface (MAPI)
allows different messaging and workgroup applications including e-mail, voice
mail and fax to work through a single client, such as compatible messaging system
via as Microsoft Outlook or Microsoft Word document. You can merge tables
into a single table as per your requirement. The first row of the table must contain
headings and the other rows must contain the records that you want to merge. You
can also use a header source. A document that contains the header row or header
record to be used with the data source specified for a Mail Merge main document
as a data source. Data fields represent a category of information that corresponds
to one column of information in a data source. The name of each data field is listed
in the first row (header row) of the data source, such as ‘PostalCode’ and
‘LastName’ are examples of data field names which are separated or delimited by
tab characters or commas and data records. A complete set of related information
that corresponds to one row of information in the data source represents data
records. All information about one client in a client mailing list is an example of a
data record which is separated by paragraph marks. Create a new data file in
Word 2007. If you do not have a data file then click on Type New List and then
use the form that opens to create your list. The list is saved as a database (.mdb)
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file that you can reuse, for example a Microsoft Excel list or a Microsoft Access
database. If you are ready to continue, go to the next step. In Microsoft Office
Outlook, on the Go menu click on Contacts. Right click on the Contacts folder
that contains the information that you want to use for a Mail Merge and then click
on Properties.

An Outlook user profile is a group of e-mail accounts and address books.
Usually, you need only one profile but if you share your computer with other people
or use different address books for different purposes, you can set up more than
one profile. When you are prompted for a profile, choose the profile that includes
the Contacts folder that you want to use in the Mail Merge.

To view a profile, do the following:
 Click on Show Profiles.
 To be prompted to select a profile each time you start Outlook, click on

Prompt for a profile to be used and then click on OK.

If your data file is an Excel worksheet that includes percentages, currency
values or postal codes you can preserve the numeric formatting of the data by
using Dynamic Data Exchange (DDE) which will connect the Excel worksheet
from Word 2007. For example, you can make sure a five digit postal code of
07865 from your data file is not displayed as the number 7865 (without the leading
zero). Before you connect to the worksheet, do the following in Word 2007:

 Click on the Microsoft Office Button  and then click on Word Options.

 Click on Advanced.
 Scroll to the General section and select the Confirm file format conversion

on open check box.
 Click on OK.
 With the Mail Merge main document open, in the Start Mail Merge group of

the Mailings tab, click on Select Recipients and then click on Use Existing
List.

 Locate the Excel worksheet in the Select Data Source dialog box and double
click on it.

 In the Confirm Data Source dialog box, click on Microsoft Excel Worksheets
via DDE (*.xls) and then click on OK.

In the New Address List dialog box, type the information for the first address
or record that you want to include in your label merge. If you want to add or
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remove columns, click on Customize Columns and then make the changes that
you want. After you type all the information for your first record, click on New
Entry and then type the information for the next record. Continue until you have
typed information for all the records that you want to include. When you connect
to a certain data file, you might not want to merge information from all the records
in that data file into your main document. If you plan to use your entire list, you can
skip ahead to the next step. To arrange the list of recipients or use a subset of the
items in your data file, do the following:

 On the Mailings tab, in the Start Mail Merge group, click on Edit
Recipient List.

In the Mail Merge Recipients dialog box you need to select the names of
recipients to whom you want to send the mail.

 To filter records, do the following:
 Under Refine recipient list, click on Filter.
 On the Filter Records tab of the Filter and Sort dialog box, choose the

criteria you want to use for the filter. For example, to generate copies of
your main document only for addresses that list Australia as the country/
region, you would click Country or Region in the Field list, Equal to in the
Comparison list, and Australia in the Compare to list.

The placeholders, such as address and greeting are called Mail Merge fields.
Fields in Word correspond to the column headings in the data file that you select.

Columns in a data file represent categories of information. Fields that you
add to the main document are placeholders for these categories. Rows in a data
file represent records of information. Word 2007 generates a copy of the main
document for each record when you perform a Mail Merge. By putting a field in
your main document, you indicate that you want a certain category of information,
such as name or address to appear in that location.
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When you insert a Mail Merge field into the main document, the field name
is always surrounded by chevrons (« »). These chevrons do not show up in the
merged documents. They just help you distinguish the fields in the main document
from the regular text. When you merge, information from the first row in the data
file replaces the fields in your main document to create the first merged document.
Information from the second row in the data file replaces the fields to create the
second merged document, and so on.

By placing a «PersonalNote» field in the main document, you can include
those notes at the bottom of certain messages. Suppose that your mailing list is for
subscribers to your newsletter and your data file includes a column, called
ExpireDate, used for storing the date that each subscription expires. If you place
an «ExpireDate» field in the label main document before you run the merge,
subscribers will each see their own expiration date on their mailing label. You can
combine fields and separate them by punctuation marks. For example, to create
an address, you can set up the fields in your main document in the following way:

«First Name» «Last Name»

«Street Address»

«City», «State» «Postal code»

For things that you use frequently, for example address blocks and greeting
lines, Word 2007 provides composite fields that group a number of fields together.
For example, the Address Block field is a combination of several fields, including
first name, last name, street address, city and postal code as shown in the screen.

3.8.3 Inserting Field Names into Master Document

You may wish to delete or add fields types to your Mail Merge document. You
can do that easily. Just click on the Customize Columns button. The Customize
Columns dialog box opens. Then, click Add, Delete or Rename to alter the field
types. You can also use the Move Up and Move Down buttons to rearrange the
order of the fields. When you do, click on OK. Once you have added all your
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recipients, click on OK on the New Address List dialog box. Name the data
source and click on Save. To insert a field into your document, click on Insert
Merge Field in the Mailings option. Select the field you would like on to insert.
The field name appears where you have the cursor located in your document. You
can edit and format the text surrounding the field. Formats applied to the field will
carry over to your finished document. You can continue to add insert fields to your
document with the help of tool.

You may wish to delete or add fields types to your mail merge document.
You can do that easily. Just click the Customize Columns button. The Customize
Columns dialog box opens. Then, click on Add, Delete or Rename to alter the
field types. You can also use the Move Up and Move Down buttons to rearrange
the order of the fields. When you are done, click on OK. Once you have added
all your recipients, click on OK on the New Address List dialog box. Name the
data source and click on Save.

Using Address Books

You can use the Insert Address button to select an address from your contacts
list. To add an address to your contacts list, you must add it to the address book
in your e-mail program. On the Tools menu, point to Letters and Mailings and
then click on Envelopes and Labels.

 Click on the Envelopes or Labels tab.

 Click on Insert Address .

 In the Show Names from the box, click on the desired address book or
contact list.

 In the Type Name or Select from list box, enter a name or click a name
in the list.
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Creating a Mail Merge Document

Click on Start Mail Merge on the Mailings options and select the type of document
you would like to create. For example, you can select letters, envelopes or labels.
Select Step-by-Step Mail Merge Wizard for more help creating your document.

Click on Select Recipients on the Mailings options to add recipients to the
mailing. You can opt to create a new database of recipients. You can also opt to
use an existing list or Outlook contacts.

In the New Address List Box, begin entering your contacts. You can use
the Tab key to move between fields. Each set of fields is referred to as an entry.
To add additional recipients, click on the New Entry button. To delete an entry,
select it and click on Delete Entry. Click on Yes to confirm the deletion.

3.8.4 Merge the Information onto One File

Once you established the data source and inserted the merge fields in the main
document, you are ready to perform the merge. You can merge to a new file which
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contains a customized version of the main document for each record in the data
source or you can merge directly to a printer or e-mail message.

Sending the Merged Document to the Printer

The last step is to execute the merge operation. A form letter merge results in a
separate letter for each record included from the data source. You can send the
merge either directly to the printer or to a new document. If the appropriate software
is installed, you also can send the merge to a fax or e-mail application. Select a
destination from the dialog box accessed via the Merge button as shown in the
screen.

3.8.5 Print the Merged Letters

One popular use of the Mail Merge feature is to create form letters. Mail Merge
allows you to set up one letter, which serves as your main document. Using data
from a table or external database, you can print this letter with different information
for each record in the database or table. These instructions assume that you have
an understanding of the Word Mail Merge process. Following steps are required
to print the merged letters:

Open a Blank Word Document

 From the Mailings tab, in the Start Mail Merge group, click on Start

Mail Merge .

The Start Mail Merge sub-menu appears.
 From the Start Mail Merge sub-menu, select Letters.
 In the Start Mail Merge group, click on Select Recipients and select

Use Existing List...
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The Select Data Source dialog box appears.
 From the Look in pull down list, locate and select the file you will use for

your list
 Click on Open.
 Following steps are required to select the recipients, you want to include in

your Mail Merge.

o In the Start Mail Merge group, click on Edit Recipient List.
o Select the recipients.
o A recipient is selected if the checkbox beside their entry is selected.
o Click on OK.

To edit the recipient information, following steps are required:
 If you have not already done so, in your document, type the text of your

letters.
 To insert merge fields,

o Position the insertion point at the proper place in your document.
o In the Write and Insert Fields group, click on Insert Merge Field

and select the desired field.
 When finished, click on Preview Results.

A preview of your first recipient’s letter appears. To preview your document
with other recipients’ information, in the Preview Results section, click on the
arrows. To print the letters,

 Click Finish & Merge and select Print Documents...

The Merge to Printer dialog box appears.
 To print letters for all of your records, select All.
 To print a letter for only the record displayed, select Current record.
 To print letters for only certain records, type a range in the text boxes.
 Click on OK.
 The Print dialog box appears.
 You can make any necessary adjustment and Click on OK.
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3.9 USING TOOLS

This step merges the variable information with the form letter. You can output the
merge result by using either of the following options:

 Print: Select this option to send the merged document directly to the printer.
You will not be able to view the document on your screen. When you click
on Print, the Merge to Printer dialog box appears. In the Merge to
Printer dialog box, you can choose which records to merge. When you
click on OK, the Print dialog box appears. Click Print to print the merge
document.

 Edit individual letters: Select this option to display the merged document
on your screen. When you click on Edit individual letters, the Merge to
New Document dialog box appears. In the Merge to New Document
dialog box, you can choose which records to merge. When you click on
OK, the documents are merged to a new Word document. To print the file,
on the File menu, click on Print.

In Word 2007, click on the Microsoft Office Button and then click on
Print.

3.9.1 AutoCorrect

AutoCorrect option is used to correct the common typing or spelling errors. You
can set up the AutoCorrect tool in Word 2007 to keep some text as it is. The
following steps have to be followed to customize AutoCorrect:

 Click on the Microsoft Office button.
 Click on the Word Options Button.
 Click on the Proofing tab.
 Click on the AutoCorrect Options button.
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 In the AutoCorrect Tab, specify the words which you want to replace
whenever you type.

3.9.2 Spell Checking

To check the spelling and grammar of a document, follow the given steps:

 Move the cursor to the beginning of the document or to the beginning of the
section that you want to check.

 Click on the Review Tab in the Ribbon.

 Click on the Spelling & Grammar option in the Proofing Group. 

 Any error as encountered will be displayed in a dialog box which would
permit you to select a more proper spelling or phrasing as shown below.

If you wish to check the spelling of an individual word, you can right click
on any word that has been underlined by Word and select a proper substitution.

Thesaurus

Thesaurus allows you to view synonyms.  To use the thesaurus follow the given
steps:

 Click on the Review Tab of the Ribbon.

 Click on the Thesaurus Button on the Proofing Group. 

 The thesaurus tool appears on the right side of the screen and you can view
the  word options.
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3.9.3 Protecting File

Following steps are required to protect a file:

 Click on the Microsoft Office Button and then click Save As option.

 Click on Tools and then click on General Options.

 You can type a password in Password to open or Password to modify.

 Click on OK.

 When prompted, retype your passwords to confirm them and click on OK.

 Click on Save.

3.10 INSERTING GRAPHICS IN WORD
DOCUMENT

In Word 2007, you can modify objects and include graphics in many ways to add
sparkle to even the most mundane document. You can add drop caps, group two
or more objects into one object and change the layering of overlapping objects.
You can also position graphics anywhere on a page, change text wraps around an
object and modify how objects are aligned relative to each other and to the page.
You can enhance graphic objects with gradient color fills, textures, shadows and
3-D effects and by adding a watermark and page border.
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Word 2007 allows you to insert illustrations and pictures into a document. 
To insert illustration do the following:

 Place your cursor in the document where you want to insert the illustration/
picture.

 Click on the Insert Tab on the Ribbon.
 Click on the Clip Art button.
 The dialog box will open on the screen and you can search for Clip Art.
 Choose the illustration you wish to include.

To insert a picture, following steps are required:
 Place your cursor in the document where you want to insert the illustration/

picture.
 Click on the Insert Tab on the Ribbon.
 Click on the Picture button.
 Browse to the picture you wish to include.
 Click on the Picture.
 Click on Insert.

Watermark is a translucent image that appears behind the primary text in a
document.  To insert a watermark do the following:

 Click on the Page Layout Tab in the Ribbon.
 Click on the Watermark button in the Page Background Group.
 Click on the Watermark you want for the document or click on Custom

Watermark and create your own watermark.
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 To remove a watermark, follow the steps above but click on Remove
Watermark.

3.10.1 Inserting Clip Art, WordArt, AutoShapes and
Text Box

Word 2007 permits you to insert illustrations and pictures into the document, at
the desired location. Following are the steps for the insertion of illustrations into
a document:

 Move your cursor in the document where you want the illustration/picture
to appear.

 Click on the Insert Tab on the Ribbon.

 Click on the Clip Art Button.

 The dialog box will open on the screen and you can search for Clip Art.

 Select the illustration that you want to use in the document.

Smart Art is a collection of graphics that you can utilize to organize information in
your document. It includes timelines, processes or work flow. The following steps
need to be performed in order to insert SmartArt ino the document.

 Move your cursor in the document where you want the illustration/picture
to appear.

 Click on the Insert Tab in the Ribbon.
 Click on the SmartArt button.
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 Click on the SmartArt that you wish to include in your document.
 Click on the arrow on the left side of the graphic to insert text or type the

text in the graphic.

3.10.2 Formatting Graphic Objects Using Drawing
Toolbar

Following steps are required to format graphic objects using Drawing Toolbar:

 Click on the Insert menu in the top right portion of the screen.

 Select Picture from the drop down menu.

 Choose the AutoShapes option.

Once you have completed these steps, the Drawing Toolbar will stay located
under your drop down menus.

Once you insert an object into the screen, you can format objects by resizing
as shown in the screen below.
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Check Your Progress

12. What does data fields represent?

13. Why is AutoCorrect option used?

14. What is SmartArt?

3.11 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. A word processor, known as document preparation system, is a computer
application used for the production including composition, editing, formatting
and printing of any sort of printable material.

2. Lotus Word Pro is Word processor software produced by IBM’s Lotus
Software group for use on Microsoft Windows compatible computers and
on IBM OS/2 Warp.

3. The Microsoft Office button is located in the upper left corner of the Word
2007 Window.

4. The Print Layout view shows how the document will look when it is printed.

5. CTRL+A key combination is used to select the entire document in Word
2007.

6. Print Preview is used to see how the document will look like when it is
printed on paper. 

7. Font styles are predefined formatting options which are used to emphasize
specific text.

8. Indention helps you to set the text within a paragraph at different margins.

9. A hyperlink or link is a reference to data that the reader can directly follow
or that is followed automatically. A hyperlink points to a whole document or
to a specific element within a document. A hyperlink has an anchor, which is
the location within a document from which the hyperlink can be followed.

10. Tables organize data into rows and columns.

11. The separator characters are selected to convert the text to table or vice
versa. These separator characters indicate that you can separate the text
when you convert a table to text or when you want new rows or columns to
begin when you convert text to a table, such as commas or tabs to indicate
where you want to divide the text into columns.

12. Data fields represent a category of information that corresponds to one
column of information in a data source.

13. AutoCorrect option is used to correct the common typing or spelling errors.

14. Smart Art is a collection of graphics that you can utilize to organize information
in your document.



Microsoft Word 2007

NOTES

Self - Learning
158 Material

3.12 SUMMARY

 Microsoft Office, or simply Office, is a family of client software, server
software, and services developed by Microsoft. It was first announced by
Bill Gates on August 1, 1988, at COMDEX in Las Vegas.

 Microsoft Office is produced in several versions targeted towards different
end-users and computing environments.

 Microsoft Office 2010 (Codenamed Office 14) is a version of the Microsoft
Office productivity suite for Microsoft Windows. It is the successor to Office
2007 and the predecessor to Office 2013.

 Office 2010 introduces user interface enhancements including a ‘Backstage
View’ that consolidates document management tasks into a single location.

 The ‘Ribbon’ feature introduced in Office 2007 for MS Access, MS Excel,
MS Outlook, MS PowerPoint, and MS Word is the primary user interface
for all apps and is fully customizable in Office 2010.

 One feature that has not changed in Office 2010 is the use of XML-based
file formats, such as .docx, .pptx, .xlsx, and .aspx. This means that files you
save in Office 2010 can be opened in Office 2007 without requiring the use
of a file converter or compatibility pack.

 Microsoft Word 2007 is the latest version of Windows of the Microsoft
Office System.

 Notepad a simple tool for creating Web pages.

 The Start button in the lower left corner of your screen gives you access to
all the programs on your PC and also to MS Word.

 In Microsoft Word 2007, a blank document opens by default.

 The Microsoft Office button is located in the upper left corner of the Word
2007 Window.

 Web Layout view enables you to see your document as it would appear in
a browser, such as Internet Explorer.

 The Reading Layout view formats your screen so that you can read the
document more comfortably.

 Align Right option is used to align the text with the right margin.

 The bullet image and the numbering format can be modified using the Bullets
or Numbering dialog box.

 Creating links in a word document allows you to put in a URL that readers
can click on to visit a Web page. 

 Selection within tables is prime operation of Word table because it provides
you to select and perform the desired options, such as finding total marks of
a specific student or merge the headings, etc.

 Microsoft Office Word generates a copy of the main document for item or
record in your data file.
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 Queries can contain operators, quotation marks, wildcard characters and
parentheses to help focus your search, i.e., defined in the database.

 Columns in a data file represent categories of information.

3.13 KEY TERMS

 Text editors: They store control information as printable characters.

 Title bar: This toolbar is used to display the title of the current document
which is in use.

 Draft view: This view is used for the purpose of editing a document quickly.

 HOME: This button is used to bring the cursor at the beginning of the line.

 Insertion point: It is the point at which your mouse pointer is located.

 Document formatting: This format represents all the types of formatting
which can be applied to a selected document for making suitable presentation.

 Paragraph alignment: This option helps in organizing the text according
to the way you want it to appear. 

 Justify:  It aligns the text to both the left and right margins.

 Data source: It is a file that contains the information to be merged into a
document, for example the names and addresses of the recipients of a letter.

 Outlook user profile: It is a group of e-mail accounts and address books.

 Placeholders: These are called Mail Merge fields.

3.14 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Explain the features of Microsoft Office 2010 and Microsoft Office 2007.
2. What does Microsoft Office button menu provide?
3.  Which button you will selected to check the margin, paper size and

orientation to print the Word document?
4.  How a nested list is created?
5.  How is new style created?
6.  Why is Word table used?
7.  What is OLE DB?
8.  When ‘Print’ option is selected in Mail Merge operation?
9.  What is AutoCorrect tool in Word 2007?

10. What is Watermark?
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Long-Answer Questions

1. Discuss the characteristic features of Microsoft Office 2010 in detail. Also
explain the difference between Microsoft Office 2010 and Microsoft Office
2007.

2. What is the significance of Word 2007? How is it better than Word 2003?

3.  Describe Word processing software and their utilities.
4.  Explain briefly the concept of ‘Getting Started’ and also name the various

ways in which a document can be viewed in Word 2007.
5.  Discuss the steps required to use a Print function in Microsoft Word 2007.
6. Write all the steps required to insert symbols in Word 2007 document.
7.  Describe the styles with reference to advanced document formatting.
8.  Explain the process of creating and designing table in Word 2007.
9.  How Mail Merge operations are helpful in Word 2007? Explain giving

examples.
10.  Describe the steps which are required to check the spelling and grammar

of a document in Word 2007.
11.  Write the required steps used in inserting picture, WordArt, AutoShape

and Text box.
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UNIT 4 MICROSOFT POWERPOINT 2007
AND MICROSOFT EXCEL 2007
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4.0 INTRODUCTION

Microsoft PowerPoint, generally also termed as just PowerPoint, is a proprietary
commercial presentation program developed by Microsoft. In this unit, you will
learn how the PowerPoint slides can be encapsulated with charts, diagrams, pictures
and animations in order to create effective presentations. PowerPoint presentations
consist of a number of individual pages or slides. The slide analogy is a reference
to the slide projector. Slides may contain text, graphics, sound, movies and other
objects which may be arranged freely. PowerPoint, however, facilitates the use of
a consistent style in a presentation using a template or Slide Master. The presentation
can be printed on paper, displayed live on a computer or navigated through at the
command of the presenter. For larger audiences the computer display is often
projected using a video projector. The presentations in PowerPoint 2007 can be
saved both with a .ppt or the .pptx extension. You will learn how the software
allows you to create a variety of slide master layouts, chart slide layouts, subtitle
slide layouts, table Slide Layouts, picture slide layouts, etc. The ‘Slide Master’
administers a group of ‘slide layouts’. Each layout will have default settings in
accordance with the slide master. It enables you to work with the Quick Access
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toolbar, SmartArt diagrams, Outline and Fill text, WordArt, Clip Art, Other text
effects (shadows, reflection, 3D rotation, etc.), Shapes (ready-made shapes, such
as circles and rectangles, arrows, lines, flowchart symbols, callouts, etc.), Shape
effects (shadows, reflections, 3D depth and rotation control, etc.), Auto Themes,
Custom colors, Recolor picture, Charts, Real-time previews, Font effects, Tables,
Zoom slider, etc. You can save your file in the current version or in the older
version using the Save As command.

MS Excel is an electronic spreadsheet that runs on a personal computer. A
workbook is the Microsoft Excel file in which you enter and store related data. A
worksheet, also known as a spreadsheet, is a collection of cells on a single sheet
where you can actually keep and manipulate the data. You can use it to organize
the data into rows and columns. You can also use it to perform mathematical
calculations quickly. You will also learn to create a spreadsheet using various
formatting and editing features given in the ribbon. The ribbon is the panel at the
top portion of the spreadsheet. You will also learn the concept of selection in a
worksheet in which various operations, such as cell selection, row and column
selection, entire worksheet selection and data range selection are performed to
complete the task. Working with formula is the prime feature of Microsoft Excel
2007. You can calculate various mathematical formulas, such as SUM(), PI(),
POWER(), FACT(), date functions, such as NOW(), DATE(), TODAY(), DAY(),
YEAR(), logical functions, such as IF(), AND(), OR(), NOT(), and text functions,
such as LOWER(), PROPER(), LEN(), LEFT(), MID(), TRIM(). You can create
graphs in the worksheet, and insert clip art, SmartArt, shapes and pictures to
enhance your worksheet. You can freeze and unfreeze rows and columns, and can
also hide or unhide any worksheet. You can perform calculations using the functions
given in Excel and can sort and filter data and generate subtotal as per requirement.
The concept of creating chart is another prime feature of Excel 2007. Once you
prepare chart you can take the print outs. Finally, you will learn the advanced
features in Excel 2007. These features include Office themes, more styles, rich
conditional formatting and easy formula writing, AutoFilter, worksheet and
workbook protection.

In this unit you will study about MS PowerPoint 2007 and MS Excel 2007.

4.1 OBJECTIVES

After going through this unit, you will be able to:
 Describe the significant features and utilities of PowerPoint 2007
 Define commands located in Ribbon
 Use the Quick Access toolbar, themes, copy, cut and paste options
 Work with various commands to create specific presentations
 View slides using various view options and navigate through slides
 Format the slide and apply design template
 Change slide background color
 Animate PowerPoint presentations
 Describe the utility of master slide
 Define and run slide shows
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 Save and print the presentations
 Use Microsoft Excel 2007
 Explain selection in a worksheet
 Work with formulae
 Edit worksheet
 Explain how to manage database and Create charts
 Create and execute  macro
 Print worksheets
 Discuss the advance features of Excel 2007

4.2 MICROSOFT POWERPOINT 2007

Microsoft Powerpoint is a proprietary commercial presentation program developed
by Microsoft.

PowerPoint Presentations in Office 2007 are a way of attracting audience
towards your views and arguments. It is one of the most helping factors behind
success of every meeting. There are various uses of PowerPoint presentations.
The prime utility of PowerPoint presentations in modern days are learning, corporate
training sessions, business and marketing meeting, and sales gatherings. Microsoft
PowerPoint 2007 thus allows for creation of professional, effective and creative
business presentations that can be used for corporate or sales presentations and
trainings. Each page in the presentation, termed as a slide in PowerPoint can be
customized according to business requirements. PowerPoint contains several easy-
to-use features, such as design templates, the capability to insert graphics and
charts, and various printing options that allow the user to create a business
presentation. Companies can develop their specific design theme containing their
logo and design template to give a uniform look to all their presentations.

Learning Solutions

PowerPoint presentation combines audio and visual both aspects, making it easier
to understand for audience. Even the normal teaching or training becomes
interactive by using presentations in lectures. In these days school, colleges and
institutions are providing tailor made presentations for students on different topics
as per the syllabus of study. It makes learning easier and interactive for students.

Corporate Training Session

Companies often utilize PowerPoint to create a visual simplified platform to conduct
the training session for their employees. PowerPoint 2007 is considered as an
essential element of every corporate training session. Hence PowerPoint is
frequently used to develop training materials such as orientations, computer system
lessons, customer service trainings and specific concept trainings. Top executives
and managers (marketing and sales) utilize this powerful tool to train their junior’s
or associates to bestow them better, interactive and more proficient training. The
PowerPoint slides highlight key points on each slide by accommodating titles,
bulleted text, photos and graphics making the presentation easy to read and
understandable.
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Marketing Strategy

Powerful tools and options available in Microsoft PowerPoint makes it easier for
people in marketing, advertising and sales to make presentations for motivation of
their subordinates. Inclusion of different types of charts, images, Clip Arts and
other graphical structures makes PowerPoint 2007 presentation eye catchy.
Animation and sound effects add extra emphasis on these presentations making
them more interactive.

4.2.1 Getting Started

PowerPoint helps in using  charts, diagrams, pictures and animations for the purpose
of creating effective presentation slides. The main feature that separates PowerPoint
2007 from PowerPoint 2003 is that in PowerPoint 2007 file is saved with a .ppt
and .pptx extension. When the PowerPoint slides are saved as .pptx, Windows
2003 is unable to open the file.

Microsoft Office Button

The Microsoft Office button performs all the functions of the ‘File’ menu of the
older versions of PowerPoint. It helps you to create a new presentation, open an
existing presentation, save a presentation, save a presentation with a new name
using the ‘Save As’ option, print a presentation, send a presentation and close a
presentation.

Ribbon

Ribbon refers to the strip of buttons that resides on top of the main Window. The
standard ribbons include the Home tab, the Insert tab, the Design tab, the
Animation tab, the Slide Show tab, the Review tab and the View tab. The
ribbon buttons have been discussed in the subsequent paragraphs.

Design

The Design option is available on the Ribbon. This option facilitates the choice of
colors, background styles, fonts, page setup, slide orientation, etc.
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Opening PowerPoint Application

For opening a file, choose Open from the File menu as shown in the screen.
Choose the file in the FileOpen Window that you want to open or type the
name of the file in the ‘File Name:’ bar. Click on the Open button. The requested
file will be displayed on the screen.

Creating Presentation by Inserting New Blank Slides

To create a new presentation from a Template, the following steps must be
performed:

 Click on the Microsoft Office Button.
 Click on New.
 Click on Installed Templates or Browse through Microsoft Office

Online Templates.
 Click on the template you want.

To Create a New Presentation from an Existing Presentation

To create a new presentation from an existing presentation, the following steps
need to be performed:

 Click on the Microsoft Office Button.
 Click on New.
 Click on New from Existing.
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 Browse and click on the presentation that you require.

To Create a New Presentation from a Word Outline

To create a new presentation from a Word outline, the following steps need to be
performed:

 Click on the slide where you would like the outline to begin.

 Click on New Slide on the Home tab.

 Click on Slides from Outline.

 Browse and click on the Word Document that contains the outline.

Adding Objects to Slides

The WordArt option provides visual effects for the text as selected. For getting
the desired effect, the first step is to select the text. Select Insert  WordArt.

You can use any of the styles of WordArt by choosing any one option from
the list to get the desired effect.

Text

Following are the steps that must be performed to enter text in a slide:

 Select the slide where the text needs to be added.

 Click on the Text Box to add text.
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Following are the steps that must be performed to add a text box:
 Select the slide in which you want to insert the text box.
 Click on the Insert tab, then click on Text Box.
 You will get the changed cursor shape through which you can add text.
 Click on the slide and drag the cursor to enlarge the text box.
 Type the text in the text box.

Graphics

You can add a picture to your PowerPoint slide by selecting InsertPicture
option.

Once you get a picture on your slide, you can move the picture around the
slide by dragging it with your mouse. You can also resize the photo by dragging the
corner handles and rotate using the little circles located at each corner.

Adding Clip Art

The Clip Art picture option helps in adding Clip Art to the slide. To add a Clip Art
select InsertClip Art tool.
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Table

Tables can be inserted along with text to show the statistical data on the slide. You
can insert a table by clicking on InsertTable option.

Entering Data

The data is entered in a table in a tabular format. For example, if marks obtained
by students in a specific course module have to be displayed on the slide, you can
create them in the form of table as shown in the screen.

Format Table

The table that has to be appeared on the slide can be formatted by using the
Design menu. You can also format the border and shading of the table as per
your requirement.



Microsoft Powerpoint 2007
and Microsoft Excel 2007

NOTES

Self - Learning
Material 169

Tables can be embedded from other applications too, such as Microsoft
Excel 2007 and Microsoft Word 2007. For this, you have to first open Microsoft
Excel 2007 and prepare a table. Then click on PowerPoint 2007 to add the
required chart/table.

Chart

Microsoft Excel 2007 charts and tables can also be embedded to Microsoft
PowerPoint 2007. For this, you need to select InsertChart option.

After copying and pasting the chart on slide, you can get the desired chart
from Microsoft Excel 2007.
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Organizational Chart

Information can be communicated visually by using the SmartArt option. It provides
graphics, ranging from graphical list and process diagrams to more complex
graphics. For example, to create Venn diagrams and organization charts, the options
available are Process, Cycle, Hierarchy, Relationship, Matrix, Pyramids,
etc. The SmartArt picture is added by clicking on InsertSmartArt option.

If you select the Pyramid option, it generates various options as shown in
the given screen.

Adding Photo Album

To create a photo album, first click on ‘Insert’ menu and next click on ‘Photo
Album’ and then select ‘New Photo Album’. A pop up Window then opens,
select the photos that you want to insert in the album. After adding the photos, you
can rotate them or even change their brightness/contrast. You can even add your
own photos to  Photo Album and can create a presentation from it.

Saving Presentation

You can save a presentation using the Save or the Save As command. To save a
document with Save command follow these steps:
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 Click on the Microsoft Office Button.

 Click on Save.

Running Slide Presentation

Running slide presentation includes videos, audio clips, images and other multimedia
elements which are a great way to improve the visual appeal of your presentation.
There have been many studies that have shown in the form of presentations and
can have a significant positive impact on audience attentiveness and information
retention. Multimedia can take your presentation to a whole new and attractive
level, helping you to more effectively reach your goal whether it is to educate and
inform, close a sale or prompt your audience to take specific action.  Following
are some of the best ways to run slide presentation:

 Make Sure it is Relevant: It is important that the multimedia elements
you want to use must be exciting and relevant. Be sure that the photos,
videos or sounds that are included are directly related in some way to the
content that you are presenting.

 Keep it Professional: There are a variety of resources available that offer
high quality multimedia elements for making your presentation professional. 

 Variety is Key: Video clips will get dull when used over and over again in
the slides. It is best to incorporate several different multimedia elements into
your presentation using each just once or twice to keep things fresh and
interesting throughout.

 Think Beyond Live Presentations: Multimedia adds tremendous punch
to speaker led sessions.  However, it also extends the value to those
presentations that are not live where it is much harder to engage the audience
and keep their attention for an extended period of time.
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Check Your Progress

1. Name the prime utility of PowerPoint presentation.

2. Write the main feature of PowerPoint which separates PowerPoint 2007
from PowerPoint 2003.

3. What does running slide presentation include?

4.2.2 Slide Formatting

Start PowerPoint and open a blank slide.

To format the Master Title, highlight the text that says ‘Click to edit Master title
style’.

Once you have highlighted all the text, click Format from the menu bar at
the top of PowerPoint. From the Format menu, select Font where you can right
click the highlighted text and select Font from the context menu that appears.

You should now see the Font dialog box appear. Select Arial for the font
and 44 for the size. Click on the color drop down list and select the blue color:

When your Font dialog box looks like the one above, click on OK. Your
Master title should now look like as shown in screen.

Format the AutoLayout Area

With the Master title set up, you can format the AutoLayout area (the one with
the bullets in it). If you only need one slide with bullets in your presentation, then
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delete these and just add some text instead. To format the slide, click indside the
AutoLayout area and select the text.

With the text highlighted, locate the bullet tool on the PowerPoint toolbar at
the top. When you deactivate the bullets, your AutoLayout area should look
without bullets.

Press the delete key on your keyboard to delete this text and type a word
or two as default text in its place as shown.

Format the text like you did for the Master title. Choose Arial for the font
and keep the size 16. Keep it black for the color.

Format the Footer

You can also enter defaults in the Footer area. Click on the word Footer, as
shown in the screen.

Then type the text you want to appear on every slide or just leave it, if you
want this area blank. Leave the Date Area and Number Area as they are. Screen
given here displays the Footer.

If Arial for the font is chosen as size 12 and the color is white then it appears
on screen as shown.
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Formatting Text in a Slide — Font, Alignment, Line Spacing

To change the font in PowerPoint 2007, you need to select the slide on which you
have to format the text. Select the text for which font is to be changed and select
the font type as shown in the given screen.

You can align the selected text as shown in the following screen.

The line spacing is set with the tool as shown in the following screen.

You can adjust the line spacing in Paragraph tab where options are given
as Single, 1.5 lines, Double, Exactly and Multiple as shown in the following
screen:
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Changing Slide Background Color

The background is the area that covers the whole slide in PowerPoint 2007. It is
referred to as background because it stays in the back and it is positioned at the
last in the slide. If you assign or change a presentation’s design, a nicely formatted
background is applied to the slides. You can change and design a slide’s background
anytime or change the presentation’s design manually if none of the designs suits
your particular needs. To design a particular slides, background, open the Slides
tab of the Normal view. Microsoft PowerPoint 2007 ships formatted lists of preset
colors. You can use one of these or design your own from scratch.

 If necessary, in the lower left corner, click on the Normal View button and
click on the Slides tab.

 On the main menu, click on FormatBackground...

 From the Background dialog box, click on the combo box and click on
Fill Effects...

 In the Colors section, click on the One Color radio button.

 Click the Color 1 combo box and select More Colors...

 From the Colors dialog box, in the Standard property page, click on a
dark blue color.

 Click on OK.

 Under the Color 1 combo box, drag the thumb of the scroll bar to the right
but without touching the arrow.



Microsoft Powerpoint 2007
and Microsoft Excel 2007

NOTES

Self - Learning
176 Material

 In the Shading styles, click on Horizontal. In the Variants section, click on
the button in the 2nd column 2nd row.

 Click on OK and in the Background dialog box, click on Apply To All.

Applying Design Template

The PowerPoint 2007 template is a pattern or blueprint of a slide or group of
slides. Templates can contain layouts, theme colors, theme fonts, theme effects,
background and content.

On the Formatting toolbar, click on Design . You can change the color
or animation scheme. If you already have the Slide Design pane open with color
scheme you will see that it is a set of eight balanced colors that you can apply to
slides, notes pages or audience handouts. A color scheme consists of a background
color, a color for lines and text, and six other colors selected to make slides easy
to read. Animation scheme adds preset visual effects to text on slides. Ranging
from subtle to exciting, each scheme usually includes an effect for the slide title and
an effect that is applied to bullets or paragraphs. When the slide is displayed, click
on Design Templates at the top. Do one of the following:

 Apply a design template, a file that contains the styles in a presentation
including the type and size of bullets and fonts, placeholder sizes and
positions, background design and fill color schemes a slide master and
optional title master, to all slides and the slide master. Slide master is the
main slide that stores information about the theme and layouts of a
presentation, including the background, color, fonts, effects, placeholder
sizes and positions. Click on the template you want.

 To apply a template to a single slide, select the thumbnail on the Slides tab
in the task pane. Task pane is a Window within an Office program that
provides commonly used commands. Its location and small size allows you
to use these commands while still working on your files. Select the template
and click on the arrow and then click on Apply to Selected Slides.

 To apply a template to multiple selected slides, select the thumbnails on the
Slides tab and in the task pane, click on the template.

 To apply a new template to a group of slides that currently use a different
template, select one of the slides on the Slides tab; in the task pane, point to
the template and click on the arrow and then click on Apply to Master.

Design templates that you have applied to the slides appear in the Slide Design
task pane under Used in this presentation. All available design templates appear
under Available for use.

 To view the design templates in larger sizes, point to a template, click on
the arrow and then click on Show Large Previews.

 To look for a template that does not appear in the task pane, click on
Browse at the bottom of the task pane.

 To apply a blank design template, under Available for use, click on the
first design in the task pane, titled Default.
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4.2.3 Different Views in PowerPoint

The views in Microsoft Office PowerPoint 2007 enables you to view the slides in
Normal view, Slide Sorter view, Notes Page view, Slide Show view (includes
Presenter view), Handout Master view, Notes Master view and Slide Master
view. The view options helps you to edit and finalize the presentation and includes
Show/Hide Grid Lines, Rulers, Zooms in and Zoom out facility, Fit to Window,
Color, Grayscale, Pure Black and White, Windows (Arrange All, Cascade, Move
Split), Switch Windows and Macros. The macros can be defined for complex
tasks and can be activated as per requirements. The macros are stored and called
in the slides with the specific names given to them. The PowerPoint views are
available either on the View tab in the Presentations Views group where all views
are available or on an easy accessible bar at the bottom of the PowerPoint Window
where the main views (Normal, Slide Sorter and Slide Show) are available.

The Format tab includes drawing tools and picture tools. The picture tool is
a context sensitive tab that appears on the ribbon and allows one to work with
available images, photos and Clip Art pictures. It sets the brightness of images,
crops the picture, etc.

Normal View

Normal View in Microsoft PowerPoint is the main working Window in the
presentation. The slide is shown in full size on the screen. This view is more
commonly known as Slide View.

Notes Page View

Notes Pages show a smaller version of the slide with an area below for printed
notes. Each slide is created on its own notes page. The user can print these pages
and use as a reference while making the presentation. The notes are not visible on
the screen during the presentation. The Notes pane is located just below the Slide
pane. You can type notes that you want to apply to the current slide. To view and
work with your notes in full page format, on the View tab click on Notes Page.
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Master Views

The master views include, Slide, Handout and Notes view. They are the main
slides that store information about the presentation, including background, color,
fonts, effects, placeholder sizes and positions. The key advantage to working in a
master view is that on the slide master, notes master or handout master, you can
make universal style changes to every slide, notes page or handout associated
with your presentation.

Slide Sorter View

Slide Sorter view in PowerPoint 2007 is a Window that displays thumbnail versions
of all your slides, arranged in horizontal rows. A thumbnail is the term used to
describe a miniature version of a slide or picture. This view is useful to make
global changes to several slides at a time. Rearranging or deleting slides is easy to
do in Slide Sorter view. In order to apply the same transition to all of the PowerPoint
slides at one time, users switch their presentation to Slide Sorter view. These
miniature versions of the slides are called thumbnails. Effects, such as transitions
and sounds can be added to several slides at the same time in Slide Sorter view.

Slide Show

Slide show view is used to deliver the presentation. It steps through each slide
sequentially. To move to the next slide in the sequence, press enter or click on the
screen. After the last slide has been displayed, a blank screen appears displaying
the message ‘end of slide show, click to exit’. Slide Show view can be accessed
from the View tab of the ribbon or by pressing the F5 key on the keyboard. To
exit Slide Show view at any time, press the Esc key on the keyboard.

Check Your Progress

4. What is background area in PowerPoint 2007?

5. What is the Slide Master?

6. Define Normal View in PowerPoint 2007.
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4.2.4 Animating PowerPoint Presentation

The animation option contains preview, custom animation and various transition
settings that can be applied to the specified slides. The Slide Show transition can
be set  at mouse clicks or ‘Automatically-After-Seconds’ options. You can preview
the slide show to view the proper effect and the mode of presentations. Various
objects, such as images, text and embedded objects can be added on the slides.
The various transitions available for slide shows are wipes, fades and dissolve,
random, strips and bars, push and cover, etc.

Slide Transition

Transition effects add movement to changes between the slides. The slides appear
as thumbnail diagrams on the Ribbon’s Animations tab. The Normal view is
generated  when the mouse is rolled over a thumbnail. PowerPoint 2007 applies
the transition effect to the slide when we  click on the thumbnail. Clicking on the
slide in Normal or Slide Sorter view highlights the thumbnail to which the slide
transition effect is to be applied. To apply the transition effect to multiple slides,
hold down the CTRL key as you click on several slides and choose an animation.
To insert a transition between every slide in a presentation, click on Apply to All
button in the Animations tab. The transition effect is added after clicking on the
Animations tab. You can even set the transition speed and transition sound as per
requirement.

After setting the slide transition, click on the Slide show option. The slide
speed option can be set as fast, medium or slow.

Automation of Slide Presentation

PowerPoint 2007 presents an effect of slide presentation. You can include wipes,
zooms, pans, spins, reveals or hundreds of visually special effects while the time of
preparing presentation. Automation of slide presentation leads the concept of self
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running presentations. It is a great way to communicate information even without
the help of someone available to run a Slide Show presentation. For example, you
can set up a presentation to run unattended in a trade show or convention or send
a Compact Disk (CD) with a self running slide show to a client. You can make
most controls unavailable so that users cannot make changes to the presentation.
A self running presentation restarts when it has finished and also when it has been
idle on a manually advanced slide for longer than five minutes. When a self running
presentation is designed, the corresponding environment is kept in the mind, such
as elements you add to your presentation, how much control you give users and
what steps you need to take to prevent misuse. Options that can be considered
when designing a self running presentation include:

 Automatic or Manual Timings: You can set up a presentation to run by
itself with automatic timings or you can set it so that users can move through
it at their own pace by using the mouse to click action buttons for navigation.
If you set up a slide show to be browsed at a kiosk, mouse clicks are
ignored unless they are on objects with hyperlinks or action buttons.

 Hyperlinks and Action Buttons: You can use hyperlinks to move through
the presentation or to jump to other slides and programs. Action buttons
are predefined navigation buttons which can give your presentation the look
and familiarity of a Web page with buttons for Home, Help, Back, Next,
and so on.

 Voice Narration:  The recorded narration can be added that plays with
your presentation.

 Capture User Input: You can use the ActiveX controls that come with
PowerPoint to create a response slide in your presentation. For example,
you can add a text box in which people can enter their names and addresses
to receive further information.

You can set timings for your slides manually or you can set them automatically
while you rehearse. You can set the exact amount of time each slide is viewed, for
example you can have the title slide appear for 10 seconds, the second slide for
two minutes, the third for 45 seconds, and so on. You may find it easiest to work
with the Slides tab selected in Normal view so you can see miniatures of each
slide in your presentation. To set the same timing for all slides in your slide show
click on Apply to All Slides. To set timings automatically while you rehearse, you
can use the buttons in the Rehearsal dialog box to pause between slides, restart a
slide and advance to the next slide. As you rehearse the presentation, PowerPoint
tracks how long each slide appears and sets the timing accordingly. If you display
the same slide more than once, for example in a custom show the last timing is the
one PowerPoint records.

Object/Text Animation

You can animate the slide transitions. You can also set up text boxes, objects,
images, etc. Custom animation buttons control the effect on mouse clicks.



Microsoft Powerpoint 2007
and Microsoft Excel 2007

NOTES

Self - Learning
Material 181

PowerPoint 2007 includes triangles, spirals, bounces, etc. This option also
helps in  customizing the animation, for example move, size and close.

Animation Preview

Click on the Slide Show menu and then click on the Custom Animation
 button. To preview animations in the slides click on the Play button in

the  custom animation task pane. The Slide Show can also be viewed with the help
of the  Slide Show tool.

For the shown effect, you have to select Add EffectExitDiamond.

The Animation Preview option is a very useful feature in Slide Show.

Slide Show Options

The Slide Show option can be accessed by clicking on the  tool. You can set
the slide show according to the requirement, that is either for All option or the
From: and To: drop down list. From the displayed Set Up Show dialog box
under the Show type section, choose any one of the following show type options:

 Presented by a Speaker: To run a full screen slide show.

 Browsed by an Individual: To run a slide show in a window and allow
access to some PowerPoint commands.
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 Browsed at a Kiosk: To create a self running, unattended slide show for
kiosk.

Under the Show options section, check or clear the following check boxes:
 Loop continuously until ‘Esc’: Check to replay the slide show again

until you stop it.
 Show Without Narration: Select if you do not want the narration to

play.
 Show Without Animation: Select if you do not  want the animation to

play.

Under the Show slides section, select any one of the following options:
 All: All the slides will be shown during the Slide Show.
 From: Enter the first and last slide numbers of the range that you want to

show.

Under the Advanced slides section, select the Manually or Using timings,
if present option, which will help you to advance the slides manually or
automatically.

 Slide Show Resolution: The drop down list allows you to select the
display resolution that you want.

 Click on the OK button.

Adding Sound Effects in Slides

For adding a video or a movie clip to a slide, you can use the clip organizer option.
Click on the movie button  to add the clip as follows:

The given screen shows the animated picture set on the slide.

The movie clip is usually in the animated .gif format or the .avi format. The
movie file is displayed automatically if you click on the Automatically button.

Note: The movie file can be inserted on the local disk or across the Internet.

Adding Audio

The two common files .wav filename extension and Musical Instrument Digital
Interface (MIDI) files with the .mid, .midi, or .rmi filename extension are always
added as an audio file.  Inserting the audio option provides the Automatically or
When Clicked buttons which render the desired effect to the slide show.
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After adding sound to a slide, the Sound icon appears on the slide as shown
in the screen.

4.2.5 Utility of Master Slide

The Slide Master is one of several master slides that are used in PowerPoint to
make global changes to all your slides at one time. The Slide Master allows you to:

 Change font colors and styles for every slide.

 Add a Clip Art or picture to every slide.

 Add a footer or date to every slide.

Following steps are required to access the Slide Master:
 Click on the View tab of the ribbon.
 Click on the Slide Master button as shown in the screen.

Inserting Date/Time/Slide Number into Master Slide

On the slide, position the insertion point in the placeholder. The placeholders are
boxes with dotted or hatch marked borders that are part of most slide layouts.
These boxes hold title and body text or objects, such as charts, tables and pictures
or text box. A text box is a movable and resizable container for text or graphics.
Use text boxes to position several blocks of text on a page or to give text a
different orientation from other text in the document that you want to add the date
and time or slide number to. On the Insert menu, click on either Slide Number
or Date and Time.
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Inserting Common Objects for All Slides

You can insert the standard objects, text caption, rollover caption, rollover image
and highlight box to a Master Slide. All other standard objects are disabled. You
can also insert the text animation, widget, image, animation and Flash Video (FLV)/
F4V files. You cannot add audio to a Master Slide. To add objects to a Master
Slide, following steps are required:

 Select the Master Slide in the Master Slide strip.

 Add objects in the same way as you do in the slides in your project.

Using Master Slide to Apply Common Title/Text Format for All Slides

A PowerPoint Slide Master is an element of the design template that stores
information about the template including font styles, placeholder sizes and positions,
background design and color scheme information. They also allow you to insert
common elements on every slide, such as a common footer, slide number, copyright
line, logo or even pictures. If you want all of the slides in your presentation to use
similar fonts, formatting, colors and graphics then this is the best way to do this.
You can create a New Master instead of editing the existing one if you want to
apply it only to selected slides or if you only plan to use it temporarily. You can
also create a new Slide Master and then apply it to the main Slide Master once
you are sure about its look.

4.2.6 Some Advanced Features of PowerPoint Presentation

Following are the advanced features of PowerPoint 2007:
 It provides to achieve consistency with Master Slides.
 It supports background. You can set backgrounds individually on every

slide.
 Office 2007 provides about 25 preset textures to use.
 You can use a bitmap as a background as well as gradient fills.
 PowerPoint 2007 dialog box allows you to select the gradient fills

interactively.
 It supports animations which are special effects, such as visual and audio

that highlight important elements in a slide. Some animation effects that
PowerPoint supports are objects flying in from the edge (choose your edge),
text appearing letter-by-letter and sound files playing. These animations
can be timed to happen sequentially or all at once. They can happen
automatically or in response to mouse clicks.

 PowerPoint 2007 allows specific actions to be taken when the mouse is
moved over or clicked on a shape.Actions include jumping to a specific
slide in the Slide Show, running another Slide Show, running a separate
program, playing a sound, as well as a few others.

 In this world of high tech movies and video games, use of multimedia in
business presentations is must. Multimedia has the power to enhance a
presentation, making it more interesting to watch and easier for the viewer
to retain what was presented. While you are developing automated
presentations, be sure that your program can handle scaling to the wide
variety of hardware available for presentations.
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Hide/Unhide in Slide Show

A good way to hide and unhide slides is in Slide Sorter view because an indicator
appears below each slide to show whether it is hidden. This way, you can easily
determine which slide is part of the main presentation. In the slide thumbnail pane
in Normal view, hidden slides appear ghosted out. Follow these steps to hide a
slide:

 Switch to Slide Sorter view.

 Select the slide or slides that you want to hide. Remember, to select more
than one sl ide, hold down the CTRL key as you click the ones that you
want to be hidden.

 Click the Hide Slide button on the Slide Show toolbar. A gray box appears
around the slide number and a diagonal line crosses through it, indicating
that it is hidden.

To unhide a slide, select the slide and click on the Hide Slide button again.
The slide’s number returns to normal. You can also right click a slide and choose
Hide Slide or Unhide Slide to toggle the hidden attribute on and off.

Customizing Slide Show

There are two kinds of custom shows known as basic and hyperlinked. A basic
custom show is a separate presentation or a presentation that includes some of the
slides of the original. A hyperlinked custom show is a quick way to navigate to one
or more separate presentations.

Basic Custom Shows

Use a basic custom show to give separate presentations to different groups in
your organization. For example, if your presentation contains a total of five slides,
you can create a custom show named ‘Site 1’ that includes just Slides 1, 3 and 5.
You can create a second custom show named ‘Site 2’ that includes Slides 1, 2, 4
and 5. When you create a custom show from a presentation and you can run the
entire presentation in its original sequential order.

Hyperlinked Custom Shows

Use a hyperlinked custom show to organize content in a presentation. For example,
if you create a primary custom show about your company’s new overall organization,
you can then create a custom show for each department within the organization
and link to these shows from the primary presentation.
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In the shown screen, 1 represents slide with hyperlinks, 2 represents the
custom show for Department A and 3 represents the custom show for Department
B. On the Slide Show tab, in the Start Slide Show group, click on the arrow next
to Custom Slide Show and then click on Custom Shows.

 In the Custom Shows dialog box, click on New.
 Under Slides in presentation, click on the slides that you want to include in

the custom show and then click on Add.

To select multiple sequential slides, click on the first slide and then hold
down SHIFT while you click the last slide that you want to select. To select multiple
non-sequential slides, hold down CTRL while you click each slide that you want
to select. To change the order in which slides appear, under Slides in custom
show, click on a slide and then click one of the arrows to move the slide up or
down in the list. Type a name in the Slide show name box and then click on OK.
To create additional custom shows with any slides in your presentation, repeat the
above steps. To preview a custom show, click on the name of the show in the
Custom Shows dialog box and then click on Show.

Apply Rehearse Timings for Slide Show

The Rehearse Timing  option provides you the option to make the presentation
within a certain time frame. It is also used to present  the slides with audio.

The Rehearsal tool presents the following options for setting the toolbar:
Once the Rehearsal toolbar appears, the Slide Time box begins to time

the presentation.
The Rehearsal toolbar’s five labels can be described as follows:
Next (advance to next slide)
Pause
Slide Time
Repeat
Total time for presentation

After completing the rehearse timing of the slides a dialog box appears as
follows. Click on Yes to confirm.
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Saving Presentation as PowerPoint Show

By default a presentation is saved with a .ppt file extension name. To save the first
time of the presentation, you need to perform the following tasks:

 Choose FileSave As from File menu.

The shown dialog box will appear. Type the name of the presentation in ‘File
name:’ bar. You can select the folder name in ‘Save In’ drop down list where you
want to save the file.

Click the Save button. In case you wish to save the file into another directory,
specify the correct path and directory. Once you save the file by a name, you need
to click on Save as option. The modification and further changes can be saved
either by pressing CTRL+S keys together or by choosing FileSave menu. If
you choose Save as option again, the shown dialog box will appear on the screen.

Check Your Progress

7. What does animation option contain?

8. What are placeholders?

9. What is the characteristic of hyperlinked custom show in Slide Show option?

10. Write one of the features of Rehearse Timing option in PowerPoint 2007.

4.3 MICROSOFT EXCEL 2007

Microsoft Excel is a spreadsheet application developed by Microsoft for Microsoft
Windows and Mac OS X. Its features include calculation, graphing tools, pivot
tables and a macro programming language called Visual Basic for Applications
(VBA). It is the most extensively used spreadsheet application and is a part of
Microsoft Office. Microsoft Excel 2007 utilizes a proprietary binary file format
called Binary Interchange File Format (BIFF) as its primary format. Excel 2007
also uses Office Open eXtensible Markup Language (XML) as its basic file format.

You can create a spreadsheet using various formatting and editing features
given in the ribbon panel. Thus, you can perform calculations using the functions
given in Excel and can sort and filter data as per your requirements. You can
create graphs in the worksheet, insert illustrations, clip art, SmartArt, shapes and
pictures to enhance your worksheet. You can freeze and unfreeze rows and columns
and can also hide and unhide any worksheet.

4.3.1 Worksheet, Workbook and Workspace

A workbook is the Microsoft Excel file in which you enter and store related data.
A worksheet also known as a spreadsheet is a collection of cells on a single sheet
where you actually keep and manipulate the data. Microsoft Excel consists of
worksheets. Each worksheet contains columns and rows. The columns are lettered
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A to Z and then continuing with AA, AB, AC and so on and the rows are numbered
1 to 1,048,576. The number of columns and rows you can have in a worksheet is
limited by your computer memory and your system resources.

The combination of a column coordinate and a row coordinate make up a
cell address. For example, the cell located in the upper left corner of the worksheet
is cell A1, meaning column A, row 1. Cell E10 is located under column E on row
10. You enter your data into the cells on the worksheet. Each workbook can
contain many worksheets. To work with workspace you need to perform following
steps:

 Click the Office button. Click Open.

 Click the Files of type |:| list arrow. Click Workspace.

 Select the workspace file. Click Open.

4.3.2 Getting Started

As soon as you start Excel 2007, you will see that its features are similar to the
previous versions. You will also see that there are many additional features which
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help you to work with special effects. Three new features that are included in
Excel 2007 are the Microsoft Office Button, the Quick Access Toolbar and the
Ribbon.

Microsoft Office Button

The Microsoft Office Button performs various functions that were found in the
File menu of older versions of Excel. This button permits you to create a new
workbook, open an existing workbook, save a workbook using Save and Save
As, and print, send or close a workbook.

Ribbon

The ribbon is the panel at the top portion of the spreadsheet. It includes seven
tabs namely, Home, Insert, Page Layout, Formulas, Data, Review and View.
Add-Ins is another option which is automatically displayed on the ribbon when
you add any new application to the program. Each tab is a collection of features
designed to perform specific functions that you require while creating or editing
Excel spreadsheets.

The frequently used features are displayed on the ribbon. To view additional
features of each group, click on the arrow at the bottom right corner of each
group.

 Home:  Clipboard, Font, Alignment, Number, Styles, Cells, Editing
 Insert: Tables, Illustrations, Charts, Links, Text
 Page Layout: Themes, Page Setup, Scale to Fit, Sheet Options, Arrange
 Formulas: Function Library, Defined Names, Formula Auditing, Calculation
 Data:  Get External Data, Connections, Sort & Filter, Data Tools, Outline
 Review:  Proofing, Comments, Changes
 View: Workbook Views, Show/Hide, Zoom, Window, Macros

Quick Access Toolbar

The quick access toolbar can be customized as per the user need and contains
commands that you use most frequently. You can place the quick access toolbar
above or below the ribbon. To change the location of the quick access toolbar,
click on the arrow at the end of the toolbar and click Show Below the Ribbon.
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You can also add more items to the Quick Access toolbar. To do this, right
click on any item in the Office Button or the ribbon and then click on Add to Quick
Access Toolbar. A shortcut will be added there.

Mini Toolbar

Mini Toolbar is a new feature in Office 2007. This is a floating toolbar and is
displayed when you select text or right click any text. It displays the common
formatting tools, such as Bold, Italics, Fonts, Font Size and Font Color.

Excel Options

Excel 2007 provides a wide range of customizable options that help you to create
an Excel workbook of required specifications. To access these customizable
options, follow the given steps:

 Click on the Office Button.

 Click on Excel Options.

Popular

The Popular feature helps you to personalize your work environment using the
Mini Toolbar, Color scheme, default options when creating new workbooks and
create lists for use in sort and fill sequences. It also helps you to access the Live
Preview feature to preview how a feature affects the document as you hover over
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different choices. The choices provide new font size, table style or cell style which
can be applied on workbook as per requirement.

Formulas

The Formulas feature permits you to modify the calculation options, working with
formulas, error checking and error checking rules. Working with formulas provide
four check boxes for R1C1 reference style, Formula AutoComplete, Use table
names in formulas and Use GetPivotData functions for PivotTable references.

Proofing

The Proofing feature permits you to personalize the options for correcting words
and formats of your text. You can customize auto correction settings so that it will
ignore certain words or errors in a document via the Custom Dictionaries. You will
get AutoCorrect options in Proofing feature.

Save

The Save feature permits you to personalize your workbook when saved. You
can also specify how often you want auto save to run and where to save the
workbooks.

Advanced

The Advanced feature permits you to specify the options for editing, copying,
pasting, printing as well as displaying formulas, calculations and other general
settings.
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Customize

Customize permits you to add specific features to the Quick Access Toolbar. It
adds the tools which you frequently use.

Opening Excel Application

To create a new Workbook, follow the given steps:
 Click on the Microsoft Office Toolbar.
 Click on New.
 Select Blank Document.

To create a new document using a template, explore the templates and select one
as per your need.

Entering Information in a Worksheet

To enter information in a worksheet, you need to open an empty workbook and
enter the data as shown in the screen.
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Moving Around Worksheet and Workbook

By using the arrow keys, you can move around your worksheet. You can use the
down arrow key to move downward one cell at a time. You can use the up arrow
key to move upward one cell at a time. You can use the Tab key to move across
the page to the right, one cell at a time. You can hold down the SHIFT key and
then press the Tab key to move to the left, one cell at a time. You can use the right
and left arrow keys to move right or left one cell at a time. The Page Up and Page
Down keys move up and down one page at a time. If you hold down the CTRL
key and then press the Home key, you move to the beginning of the worksheet.

It is easy to move or copy a whole worksheet. The term worksheet refers
to the primary document that you use in Excel 2007 to store and work with data.
It is also called a spreadsheet. A worksheet consists of cells that are organized
into columns and rows. It is possible that calculations or charts that are based on
worksheet data might become inaccurate if you move the worksheet. Similarly, if
a moved or copied worksheet is inserted between sheets that are referred to by a
3-D reference (a range that spans two or more worksheets in a workbook), data
on that worksheet might be unexpectedly included in the calculation. Select the
worksheets that you want to move or copy as shown in the screen.

To select two or more adjacent sheets, click the tab for the first sheet. Then
hold down SHIFT while you click the tab for the last sheet that you want to select.
To select two or more nonadjacent sheets, click the tab for the first sheet. Then
hold down CTRL while you click the tabs of the other sheets that you want to
select.

To insert a new worksheet, do one of the following:

 To quickly insert a new worksheet at the end of the existing worksheets,
click the Insert Worksheet tab at the bottom of the screen.

 To insert a new worksheet in front of an existing worksheet, select that
worksheet and then, on the Home tab, in the Cells group, click Insert
and then click Insert Sheet.
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You can also right click the tab of an existing worksheet and then click Insert.
On the General tab, click Worksheet, and then click OK.

Insert multiple worksheets at the same time

Hold down SHIFT and then select the same number of existing sheet tabs of the
worksheets that you want to insert in the open workbook. For example, if you
want to add three new worksheets, select three sheet tabs of existing worksheets.
On the Home tab, in the Cells group, click Insert and then click Insert Sheet.

You can also right click the selected sheet tabs, and then click Insert. On the
General tab, click Worksheet and then click OK.

To move to the next or previous sheet tab, you can press CTRL+PAGE UP
or CTRL+PAGE DOWN. On the Home tab, in the Cells group, click Format
and then under Organize Sheets, click Move or Copy Sheet.

You can also right click a selected sheet tab and then click Move or Copy.
In the Move or Copy dialog box, in the Before sheet list, do one of the following:

 Click the sheet before which you want to insert the moved or copied sheets.

 Click move to end to insert the moved or copied sheets after the last
sheet in the workbook and before the Insert Worksheet tab.

 

To copy the sheets instead of moving them in the Move or Copy dialog box,
select the Create a copy check box. When you create a copy of the worksheet,
the worksheet is duplicated in the workbook; the sheet name indicates that it is a
copy, for example the first copy that you make of Sheet1 is named Sheet1 (2).

To rename the active sheet, do one of the following:
 On the Format menu, point to Sheet and then click Rename.
 On the Sheet tab bar, right click the tab you want to rename and then

click Rename.

Type the new name over the current name.
To delete a worksheet

 Open the workbook.
 Click on the Delete button on the Cells group of the Home tab.
 Click on Delete Sheet.
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Saving a Workbook

To save a workbook, you have two options, Save and Save As. To save a
document, follow the given steps:

 Click on the Microsoft Office Button.

 Click on Save.

You can also use the Save As feature to save the workbook with a different
name or to save it as earlier versions of Excel. The older versions of Excel cannot
be opened in an Excel 2007 worksheet unless you save it as an Excel 97-2003
Format. To use the Save As feature, follow the given steps:

 Click on the Microsoft Office button.
 Click on Save As.
 Give a name for the workbook.
 In the Save as Type box, select Excel 97-2003 workbook.

Closing a Workbook File

To close a workbook file, you need to press CTRL+F4 key combination. You
can close all open workbooks wihout closing Excel 2007. For this, you need to
open file menu and select Close All option.

Opening an Existing Workbook File

To open an existing workbook, follow the given steps:
 Click on the Microsoft Office button.
 Click on Open.
 Browse to the workbook.
 Click on the title of the workbook.
 Click on Open.



Microsoft Powerpoint 2007
and Microsoft Excel 2007

NOTES

Self - Learning
196 Material

 

Quitting From Excel

To quit from Excel 2007, you need to click on Microsoft Office Button and
then select Exit Excel button.
You will quit from Excel.

Check Your Progress

11. What is spreadsheet?

12. What does Advanced feature permit in Excel 2007?

4.3.3 Selection in a Worksheet

To select contiguous columns in the worksheet do the following task:

 Click to select the first column heading in the desired range and then drag
the pointer to the last column in the desired range. Release the mouse button
to select the columns.

 You can also click to select the first column heading in the desired range.
Scroll the worksheet using the scroll bars at the bottom of the worksheet as
needed to display the last column in the desired range.

 Hold down the SHIFT key and click on this last column heading.

To select the entire worksheet, you need to select the first column heading
and then drag the pointer across all remaining column headings in the worksheet.

 Click to select the first column heading, scroll the worksheet until the last
column is visible.

 Press the SHIFT key and click on the last column heading.

Cell Selection

To select a cell or data to be copied or cut, follow the given steps:

 Click on the cell.

 Click and drag the cursor to select many cells in a range.
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Selecting Data Range

Before you can enter your worksheet data in Microsoft Office Excel 2007, you
must know how to select cells in a worksheet. The cell cursor is a black border
that surrounds the active cell sometimes called the current cell in a worksheet. For
selecting data range in Excel 2007, following steps are required and these steps
are required to select multiple cells in a worksheet:

 To select a single entire column, click a column heading, i.e., the letter or
letters that indicate the column. To select multiple columns, drag across
multiple column headings.

 To select a single entire row, click the row number. To select multiple rows,
drag across multiple row numbers.

 To select sequential cells, click the first cell, hold down the Shift key, and
click the last cell you want. Optionally, click and drag the mouse over a
group of cells to select a sequential area.

 To select non-sequential cells, click the first cell, hold down the CTRL key
and click each additional cell or row or column you want to select.

Row(s)/Column(s) Selection

To select a row or column click on the row or column header.
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Entire Worksheet Selection

To select the entire worksheet, click the small box located to the left of column A
and above row 1. You can select all cells in a worksheet by pressing Ctrl+A key
combination as shown in the screen below.

Check Your Progress

13. What do you understand by 'Cell Cursor'?

14. Which key combination is used to select all cells in a worksheet?

4.3.4 Working with Formulae

Formulas, also called functions, are a powerful feature of Excel 2007. Formulas
available in Excel 2007 are grouped into the following categories:

 Financial: Formulas for calculating depreciation, interest, return on an
investment, loan, payment and mortgage.

 Logical: The logical operators of And, True, False, If, Not and Or.
 Text: Formulas for combining text from various cells with the concatenate

formula, converting text to upper case, lower case, or proper case and
trimming extra spaces from text.

 Date and Time: Formulas for calculating the number of days between
two dates, the current date and day of the week for a given date.

 Lookup and Reference: Formulas for doing a horizontal or vertical lookup,
a hyperlink or getting data from a Pivot Table.

 Math and Trig: Formulas for calculating trigonometric functions, logs,
random numbers, Roman numerals, rounding and truncating.

 Statistical: Formulas for calculating averages, frequency, percentile, quartile
and standard deviation.

 Engineering: Formulas for Bessel functions and conversions between
numbering systems, such as octal to binary.

 Cube: Formulas for working with three dimensional sets.
 Information: Includes formulas which return a true or a false response in

determining if a cell is blank or if the content of the cell is a number or text.
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Cell Address

A cell address in a spreadsheet, such as Excel 2007 identifies the location of the
cell in the spreadsheet. The cell address is a combination of column letter and row
number of a cell, such as C4 or D8. When identifying a cell by its address, the
column letter is always listed first followed by the row number. In Excel 2007, a
cell reference identifies the location of a cell or group of cells in the spreadsheet.
Cell address sometimes referred to as a cell reference consists of the column letter
and row number that intersect at the cell’s location. When listing a cell reference,
the column letter is always listed first. Cell references are used in formulas, functions,
charts and other Excel 2007 commands.

Operators – Arithmetic, Logical, Relational, String, Reference
Operators

To perform basic mathematical operations, such as addition, subtraction or
multiplication use the arithmetic operators summarized here.

Arithmetic Operator Example

+ (plus sign) Addition (3+3)
– (minus sign) Subtraction (3–1)Negation (–1)
* (asterisk) Multiplication (3*3)
/ (forward slash) Division (3/3)
% (percent sign) Percent (20%)
^ (caret) Exponentiation (3^2)

You can compare two values with the following operators. When two values
are compared by using these operators, the result is a logical value either TRUE or
FALSE.

Relational Operator Example

= (equal sign) Equal to (A1=B1)

> (greater than sign) Greater than (A1>B1)

< (less than sign) Less than (A1<B1)

>= (greater than or equal to sign) Greater than or equal to (A1>=B1)

<= (less than or equal to sign) Less than or equal to (A1<=B1)

<> (not equal to sign) Not equal to (A1<>B1)

Use the string operator ampersand (&) to join or concatenate, one or more
text strings to produce a single piece of text in the string operator as summarized
here.

String Operator Example

& (ampersand) It concatenates two values to produce one
continuous text value, such as ‘Information’ &
‘Technology’ produces the result as Information
Technology.
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Reference operators combine ranges of cells for calculations with the
following operators:

Reference Operator Example

: (colon) Range operator which produces one reference to all the
cells between two references including the two references
(B5:B15).

, (comma) Union operator which combines multiple references into
one reference (SUM(B5:B15,D5:D15)).

(space) Intersection operator which produces on reference to cells
common to the two references (B7:D7 C6:C8).

In Microsoft Excel 2007, operators are executed in a order as shown here.

Precedence Name Operator

1 Parenthesis ( )
2 Percent %
3 Exponentiation ^
4 Multiplication *
4 Division /
5 Addition +
5 Subtraction –
6 Concatenation (putting strings together, for example

Information & Technology) &
7 Equal to =
7 Greater than >

7 Less than <

Writing Simple Formulas

Formulas can refer to other cells on the same worksheet, cells on other sheets in
the same workbook or cells on sheets in other workbooks. In addition, if you
change the data in your spreadsheet, Excel 2007 will automatically recalculate the
answer without reentering the formula. Writing simple formula format will start
with an equals sign (=) followed by one or more operands, separated by one or
more operators. Operands can be values, text, cell references, ranges, defined
names or function names. Operators are symbols used to represent the various
arithmetic and comparison operations you can perform on the operands.

 Place the cursor in the cell where the formula will appear, e.g., E5.
 Enter an = sign. All Excel 2007 formulas start with the equal sign.
 Enter the expression that will produce the result you want. This can consist

of operands, values, variables and symbols which represent mathematical
procedures, such as + or – to add and subtract, for example A5+C5.

 When the formula is complete press ENTER key. The result of the formula
will be calculated and displayed in the cell E5.
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 You can see the formula in the Formula bar at the top of the screen by
placing the cell pointer on the cell E5.
If there is an error in a formula, an error message is displayed which will

begin with a # sign.

Copying Formula

Select the cell that contains the formula that you want to copy. On the Home tab,
in the Clipboard group, click Copy. Do one of the following steps:

 To paste the formula and any formatting, on the Home tab, in the Clipboard
group, click Paste.

 To paste the formula only, on the Home tab, in the Clipboard group, click
Paste, click Paste Special and then click Formulas.

 To paste only the formula results, on the Home tab, in the Clipboard group,
click Paste, click Paste Special and then click Values.

Verify that the cell references in the formula produce the result that you want. If
necessary, switch the type of reference by doing the following:

 Select the cell that contains the formula.
 In the formula bar you can use to enter or edit values or formulas in cells or

charts. Displays the constant value or formula stored in the active cell
, select the reference that you want to change.

 Press F4 to switch between the combinations.

Here, you can find how a reference type updates if a formula that contains the
reference is copied two cells down and two cells to the right.

For A Formula Being Copied If The Reference Is It Changes To

$A$1 (absolute column and absolute row) $A$1

A$1 (relative column and absolute row) C$1
$A1 (absolute column and relative row) $A3
A1 (relative column and relative row) C3

You can also copy formulas into adjacent cells by using the fill handle. When
you point to the fill handle, the pointer changes to a black cross. . After
verifying that the cell references in the formula produce the result that you want,
select the cell that contains the copied formula and then drag the fill handle over
the range that you want to fill.

Cell Referencing

Calling the cells by just their column and row labels, such as ‘A1’ is called relative
referencing. When a formula contains relative referencing you copy it from one
cell to another, Excel will not create an exact copy of the formula. It will only
change the cell addresses relative to the row and column to which it is moved. For
example, for a simple addition the formula in cell D1 =(A1+B1) will be copied to
cell D2 as =(A2+B2). It will reflect the new row. This is called absolute
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referencing and is accomplished by placing dollar signs ‘$’ within the cell addresses
in the formula. Now, the formula in cell D1 will look like =($A$1+$B$1). Mixed
referencing can also be used when only the row and column is to be fixed. For
example, in the formula =(A$1+$B2) the row of cell A1 is fixed and the column of
cell B2 is fixed.

Relative Referencing, Absolute Referencing and Mixed Referencing

A reference is a connection to something, that is to say when you type in the
formula =SUM (A1;B1) you refer to the sum of the content of A1 and the content
of B1. The types of references are discussed below:

Relative Reference: Reference to rows and columns changes when we
copy the formula in another cell. The formula adapts to its environment because
references relate to the distance between the formula and the cells that form the
formula. This is the option Excel offers by default. Let us see here.

1

2

3

A

15

= A1 + 2

B

20

30

If we copy cell A2 in B3, because you can move one column to the right
and one row down, the formula will change to: =B2+2. What varies is the reference
to the cell A1 because have you have copied the formula in a cell that is in the
column to the right, the name of the column will change from A to B and because
we have gone one row down, 1 will become 2, and the result will be =B2+2. This
maintains the formula that adds two to the content of the cell above.

Absolute Reference: References to rows and columns do not change
when you copy the formula to another cell, the formula’s reference to cells are
fixed. Let us see here.

1

2

3

A

15

= $A$1 + 2

B

20

30

If you copy now the cell A2 in B3 even though you have copied it one
column to the right and one row down, the formula will not change. The sign $
before the column and the row indicates that. So, B3 will show =$A$1+2.

An important difference in Excel spreadsheets is between absolute cell
references and relative cell references. Open the Excel 2007 sheet as follows:
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In cell B2, you need the following formula:

= A1 + A2
 Click inside cell B2 to highlight it.
 Click on cell B2 with your right mouse button, and select Copy from the

menu that appears.
 Now click into cell B3.
 Again, right click the cell to get the menu. But this time click Paste option.

Your spreadsheet should now look as shown.

With cell B3 still highlighted, look at the formula bar at the top of Excel.
You should see this formula:

= A2 + A3

Click into B2 and the formula appears as follows:

= A1 + A2

The problem is due to cell referencing. When you clicked Copy from the
menu, Excel 2007 does not only copy the formula, it took a look at where the cells
were in the formula, relative to the B2 cell and copied this as well. From B2, the
first cell reference (A1) is up one row and left 1 column (the arrow in screen):

The second cell reference (A2) is one column to the left of cell B2:

When you clicked into cell B3 and selected Paste from the menu, Excel
was not only pasting the formula, it was pasting this ‘Up 1, Left 1’. Take a look at
the two images below. Start working at cell B3. Have a look at where the two
arrows are pointing now. The first cell reference appears here:
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The second cell reference appears here:

So, the first arrow is pointing to cell A2 and the second arrow is pointing to
cell A3. This is what has been copied. Excel then took the following formula:

= A2 + A3

But, it will appear as follows:

= A1 + A2

If you want the correct answer in cell B3, you have to stop Excel 2007 from
using this relative cell referencing that it is currently doing.

Absolute cell referencing involves nothing more than placing a dollar symbol
( $ ) before each letter and number. Click inside of cell B2 on your spreadsheet
and change the formula as follows:

= $A$1 + $A$2

Now copy and paste it over to cell B3 again. You will get the correct answer
this time.

Excel 2007 will use absolute formula in its own calculation so it is worth
getting used to them and to recap:

 If you need to copy and paste formulas use absolute cell references.
 Absolute referencing means typing a dollar symbol before the numbers

and letters of each cell reference. You can mix absolute and relative cell
references also.

Mixed Reference: This is a combination of both references. You may
have relative references for the rows and absolute for the columns or vice versa.
Let us see an example here.

1

2

3

A

15

= $A1 + 2

B

20

30

If you copy the cell A2 in B3, the sign $ before the column will mean
that the formula will not change although you move to the right. But not having the
sign before the row when you copy the formula one row down will change it to 2
instead of 1 and the result will be =$A2+2. Let us see an example here.
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1

2

3

A

15

= $1 + 2A

B

20

30

Using Functions in Formulas

A function computes the values provided and shows you the desired results, e.g.,
a simple function SUM automatically adds up all the values provided either in a
range or as individual values. Some functions can even check values and take
actions based on what they find. For example, by using IF function, you can
check whether the current value in a particular cell is greater or less than 100 and
based upon the answer it gets, you can ask the function to multiply or divide this
value by a different amount. Some functions can convert numbers or text to another
measure or format, for example, the function LOWER converts the text entry in
another cell into lower case.

Typically, a function consists of two parts—function name and arguments.
Arguments (or values) may in some cases be mandatory and in some cases optional.
Even within a function, one of the arguments may be mandatory and another optional.

A function is a built-in formula in Excel. The following is a list of common
functions in Excel 2007:

 Sum:  Adds all cells in the argument.
 Average:  Calculates the average of the cells in the argument.
 Min:  Finds the minimum value.
 Max:  Finds the maximum value.
 Count:  Finds the number of cells that contain a numerical value within a

range of the argument.

To calculate a function:
 Click the cell where you want to apply the function.
 Click the Insert Function button.
 Choose the function.
 Click OK.

 Complete the Number 1 box with the first cell in the range that you want to
calculate.

 Complete the Number 2 box with the last cell in the range that you want to
calculate.
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Mathematical Functions

Excel’s 2007 math functions can be used to perform common mathematical
operations, such as addition (SUM function), multiplication (product function)
and rounding numbers (ROUND function). Other mathematical functions are
discussed below:

SQRT()

In Excel, the SQRT function returns the square root of a number. The syntax for
the SQRT function is as follows:

SQRT( number )

In the above statement, number is a positive number that you wish to return the
square root for. If a negative number is entered in the number parameter, the
SQRT function will return the #NUM! error.

ROUND()

The ROUND function in Excel 2007 can be used when rounding integers and
decimal numbers to make them easier to work within your spreadsheets. The
syntax for the ROUND function is as follows:

=ROUND( Number, Num_digits )

SUM()

The SUM function in Excel 2007 provides a quick way to add numbers together
in Excel 2007. The syntax for the SUM function is as follows:

=SUM ( Number1, Number2, ... Number255 )

Up to 255 numbers can be entered into the function.

FACT()

In Excel 2007, the FACT function returns the factorial of a number. The syntax
for the FACT function is as follows:

FACT(Number)

In the above statement, Number is a numeric value.

INT()

The INT function is used to round a number downwards towards the next lowest
number. INT is similar to the ROUNDDOWN function except that it always rounds
a number down to the nearest whole number completely removing the decimal
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portion. The ROUNDDOWN function will round a number down to a desired
number of decimal places. The syntax for the INT function is as follows:

= INT ( Number)

In the above statement, Number is the value to be rounded.

MOD()

The MOD function can be used to divide numbers in Excel 2007. Unlike regular
division, however, the MOD function only gives you the remainder as an answer.
The syntax for the MOD function is as follows:

= MOD (Number, Divisor)

PI()

In Excel, the PI function returns the mathematical constant which is equal to
3.14159265358979. The syntax for the PI function is as follows:

PI( )

POWER()

Although you can use the caret (^) operator to build a formula that raises a number
to any power, the POWER function accomplishes the same thing. For example, to
build a formula that raises 5.9 to the third power, i.e., cubes the number, you can
use the exponentiation operator as follows:

=5.9^3

You can have Excel perform the same calculation with the POWER function
by entering this formula:

=POWER(5.9,3)

In either case, Excel 2007 returns the same result as 205.379.

PRODUCT()

The PRODUCT function provides a quick way to multiple numbers in Excel 2007.
The advantage of using this function becomes apparent if you have several numbers
to multiply together. It is easier than building a long formula. The syntax for the
PRODUCT function is as follows:

=PRODUCT( Number1, Number2, ... Number255 )

In the above statement, up to 255 numbers can be entered into the function.

Date Functions

As an example of how to use date functions in Excel 2007, simple spreadsheets
are constructed for an order form. You will enter the date an order was taken, the
date the order was sent and how long it took to be processed. So, to make a
start, create the spreadsheet as shown below:
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Click inside cell A2, and you enter a date. To enter a date, Click on the
Formulas menu at the top of Excel. Then locate the Function Library panel.
From the Function Library panel, click on Date and Time:

There are a number of date functions available in Excel 2007. Depending
on your needs, you can use a date function in Excel to return the current date, the
current time or the day of the week. Like all functions in Excel 2007, entering date
functions is very straightforward; just type in the function in the cell where you
want the date or time to appear. Some date functions are discussed below:

NOW()

The NOW function, one of Excel’s date and time functions, is used to add the
current time and date to a spreadsheet. The syntax for the NOW function is as
follows:

= NOW( )

The NOW function takes no arguments.

DATE()

The DATE function has several uses for adding dates to a spreadsheet. It can be
used to combine date elements from different locations.  It can be used to convert
dates to the computer’s serial date. It can be used to ensure that imported dates
are formatted correctly in a spreadsheet, such as a date or a number instead of
text. The syntax for the DATE function is as follows:

= DATE( Year, Month, Day)

TODAY()

The TODAY function is used to add today’s date to a spreadsheet. The syntax for
the TODAY function is as follows:

=TODAY( )

The TODAY function takes no arguments.
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DAY()

The DAY() function returns the day of the month.

MONTH()

The function MONTH() takes one argument as MONTH(start_date) where
start_date is the date for which you are trying to find the month. For example,

=MONTH(DATE(2011,3,12)

Above statement will return the value 3.

YEAR()

In Excel 2007, the YEAR function returns a four digit year (a number from 1900
to 9999) given a date value. The syntax for the YEAR function is as follows:

YEAR( date_value )

In the above statement, date_value is a valid date.

Logical Functions - IF(), AND(), OR(), NOT()

Excel 2007 uses seven logical functions, such as AND, FALSE, IF, IFERROR,
NOT, OR and TRUE which appear on the Logical command button’s drop down
menu on the Formulas tab of the Ribbon. All the logical functions return either the
logical TRUE or logical FALSE when their functions are evaluated. Here are the
names of the logical functions along with their argument syntax:

 AND(logical1,logical2,...) tests whether the logical arguments are TRUE
or FALSE. If they are all TRUE, the AND function returns TRUE to the
cell. If any are FALSE, the AND function returns FALSE.

 IF(logical_test,value_if_true,value_if_false) tests whether the logical_test
expression is TRUE or FALSE. If TRUE, the IF function returns the
value_if_true argument. If FALSE, the IF function returns the value_if_false
argument.

 IFERROR(value,value_if_error) tests whether the value expression is an
error. IFERROR returns value_if_error if the expression is an error or value
of the expression if it is not an error.

 NOT(logical) tests whether the logical argument is TRUE or FALSE. If
TRUE, the NOT function returns FALSE. If FALSE, the NOT function
returns TRUE.

 OR(logical1,logical2,...) tests whether the logical arguments are TRUE or
FALSE. If any are TRUE, the OR function returns TRUE. If all are FALSE,
the OR function returns FALSE.

 FALSE() takes no argument and simply enters logical FALSE in its cell.

 TRUE() takes no argument and simply enters logical TRUE in its cell.
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IF() Function

The IF() function is used to test whether a certain condition is True or False.
Following steps help to get the result of IF() function:

 Enter 36 into cell D1.

 Select D2 cell and type the statement as ‘=if(26,100,200)’.
 

 

 After pressing ENTER key, value 100 will appear on D2 because 26 is less
than 36 therefore ‘value_if_true’ condition will be executed.

Changing the IF() function’s results: Click on cell F5 which is the location of
the result. Click on the Formulas tab. Choose Logical from the Ribbon to
open the drop-down list as shown in screen. Click on IF in the list to bring
up the function’s dialog box.

 

 

 On the Logical_test line in the dialog box, type 26. On the Value_if_true
line of the dialog box, type 100. On the Value_if_false line of the dialog
box, type 200.

 

 

 If you click on cell F5, the complete function ‘= IF(D1<26,100,200)’
appears in the formula bar above the worksheet.
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Let us take another example to explain the concept of IF() function.

Type a word ‘Text’ in A1 cell. Keep cursor on cell D5. Type the formula
=IF(A1= ‘Text’, ‘String’, ‘Integer’ in cell D5. Press ENTER key. Word ‘String’
will appear in cell D5.

 

 If you change the word ‘Word’ instead of ‘Text’ then the value of cell D5
will be ‘Integer’ as shown in screen.

 

Nested IF() Function

A nested IF() function works when a second IF() function is placed inside the first
in order to test additional conditions. It is possible to nest multiple IF() functions
within one Excel formula. You can nest up to seven IF() functions to create a
complex IF() statement. The syntax for the nested IF() function is as follows:
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IF(condition1, value_if_true1, IF(condition2, value_if_true2,
value_if_false2))

Above statement displays how to nest two IF() functions in which ‘condition1’ or
‘condition2’ is the value that you want to test, ‘value_if_true’ is the value that is
returned if condition evaluates to True and ‘value_if_false’ returns if condition
evaluates to False. Consider an example where using the nested IF() function the
following grades will be displayed:

 A, if the student scores 80 or above

 B, if the student scores 60 to 79

 C, if  the student scores 45 to 59

 D, if the student scores 30 to 44

 FAIL, if the student scores below 30

Use the nested IF() function to compute and display the result as follows:

=IF(B2>=80, “A”, IF(B2>=60, “B”, IF(B2>=45, “C”, IF(B2 >=30, “D”,
“Fail”) ) ) )

In the above statement, if the answer to the first question is False then
control will go to next IF statement. If it is True then it will display Grade ‘A’ as
shown in result of ‘Student Examination Grade’ spreadsheet.

 

The approach of nesting IF() function increases the flexibility of the function
by a number of possible results. For example, the deductions from an employee’s
income will follow the approach ‘the higher the income, the higher the deduction
rate’.

Text Functions

Some text functions are discussed below:

LOWER()

In Excel 2007, the LOWER function converts all letters in the specified string to
lowercase.

If there are characters in the string that are not letters, they are unaffected
by this function. The syntax for the LOWER function is as follows:

LOWER( TEXT )

In the above statement, TEXT is the string to convert to lowercase.
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UPPER()

In Excel 2007, the Upper function allows you to convert text to all uppercase. The
syntax for the UPPER function is as follows:

UPPER( text )

In the above statement, text is the string that you wish to convert to
uppercase.

PROPER()

In Excel 2007, the PROPER function sets the first character in each word to
uppercase and the rest to lowercase. The syntax for the PROPER function is as
follows:

PROPER( text )

In the above statement, text is the string argument whose first character in
each word will be converted to uppercase and all remaining characters converted
to lowercase.

LEN()

In Excel 2007, the LEN function returns the length of the specified string. The
syntax for the LEN function is as follows:

LEN( text )

In the above statement, text is the string to return the length for.

LEFT()

In Excel 2007, the LEFT function allows you to extract a substring from a string,
starting from the left most character. The syntax for the LEFT function is as follows:

LEFT( text, number_of_characters )

In the above statement, text is the string that you wish to extract from and
the number_of_characters indicates the number of characters that you wish to
extract starting from the left most character.

RIGHT()

In Excel, the RIGHT function extracts a substring from a string starting from the
right most character. The syntax for the RIGHT function is as follows:

RIGHT( text, number_of_characters )

In the above statement, text is the string that you wish to extract from and
number_of_characters indicates the number of characters that you wish to extract
starting from the right most character.

MID()

In Excel 2007, the MID function extracts a substring from a string (starting at any
position). The syntax for the MID function is as follows:

MID( text, start_position, number_of_characters )
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In the above statement, text is the string that you wish to extract from and
start_position indicates the position in the string that you will begin extracting from.
The first position in the string is 1 and number_of_characters indicates the number
of characters that you wish to extract.

REPT()

In Excel 2007, the REPT function returns a repeated text value a specified number
of times. The syntax for the REPT function is as follows:

REPT( text, number )

In the above statement, text is the text value to repeat and number is the
number of times to repeat the text value.

TRIM()

In Excel 2007, the TRIM function returns a text value with the leading and trailing
spaces removed. The syntax for the TRIM function is as follows:

TRIM( text )

In the above statement, text is the text value to remove the leading and
trailing spaces from.

Financial Functions (PMT(), PV(), FV(), RATE(), IPMT(), NPER())

Here is the list of financial functions.

Function Description

FV This function returns the future value of an investment.
IPMT This function returns the interest payment for an investment for a

given period.
NPER This function returns the number of periods for an investment.
PMT This function returns the periodic payment for an annuity.
PV This function returns the present value of an investment.
RATE This function returns the interest rate per period of an annuity.

Check Your Progress

15. Define cell address.

16. What does Excel function compute?

17. What does FACT function return?

18. What does LEN function return?

4.3.5 Editing Worksheet

You can perform Cut, Copy and Paste operations while editing the worksheet.
Various operations, such as copy/move data using menu/keyboard shortcut/drag
and drop technique, changing column width/row height, cells formatting, for example
font, alignment, number format, inserting and deleting cells(s)/row(s) column(s),
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insert /copy/move/rename/delete worksheet are performed while the time of editing
the worksheet. They are discussed below:

Copy/Move Data using Menu/Keyboard Shortcut/Drag and Drop
Technique

To copy and paste data, follow the given steps:

 Select the cell(s) that you want to copy.
 On the Clipboard group of the Home tab, click on Copy.
 Select the cell(s) where you want to copy the data.
 On the Clipboard group of the Home tab, click Paste.

Cut and Paste

To cut and paste data, follow the given steps:

 Select the cell(s) that you want to copy.
 On the Clipboard group of the Home tab, click on Cut.
 Select the cell(s) where you want to copy the data.
 On the Clipboard group of the Home tab, click on Paste.

Undo and Redo

To undo or redo the most recent actions:

 Click on Undo or Redo on the Quick Access Toolbar.

Changing Column Width/Row Height

In Excel 2007, you can change column widths or row heights in your worksheets
to improve the readability and appearance of data. For example, if your worksheet
contains many numbers, you can widen the columns to make the worksheet less
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cluttered. You should always widen columns that contain cells with truncated text
entries or numbers that Excel 2007 shows as ######.

Cells Formatting, Font, Alignment, Number Format

Convert Text to Columns: Sometimes, you may have to split data of one cell
and place them in two or more cells. You can do this by utilizing the Convert Text
to Columns Wizard.

 Highlight the column in which you wish to split the data.
 Click on the Text to Columns button on the Data tab.

 Click on Delimited if you have a comma or tab separating the data, or
click fixed widths to set the data separation at a specific size.

Modify Fonts: Modifying fonts in Excel helps you to emphasize titles and
headings. To modify a font:

 Select the cell or cells where you want to apply the font.
 On the Font group on the Home tab, select the font type, size, bold,

italics, underline or color.

Format Cells Dialog Box: In Excel 2007, you can apply specific formatting
to any cell. To apply formatting to a cell or group of cells:

 Select the cell or cells to change the formatting.
 Click on the Dialog Box arrow on the Alignment group of the Home

tab.
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There are various tabs on this dialog box that permit you to modify the
properties of the cell or cells. 

 Number:  Allows the display of different number types and decimal places.
 Alignment:  Allows the horizontal and vertical alignment of text, wrap

text, shrink text, merge cells and the direction of the text.
 Font:  Allows control of font, font style, size, color and additional features.
 Border:  Allows control of border styles and colors.
 Fill:  Allows  control of cell fill colors and styles.

Adding Borders and Colors to Cells

Borders and colors can be added to cells manually or using the styles. To add
borders manually:

 Click on the Borders drop-down menu on the Font group of the Home
tab.

 Select the suitable border.

To apply colors manually:
 Click on the Fill drop-down menu on the Font group of the Home tab.
 Select the proper color.
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For applying borders and colors using styles:
 Click on Cell Styles on the Home tab.
 Select a style or click on New Cell Style.

Change Column Width and Row Height: To change the width of a column
or the height of a row:

 Click on the Format button on the Cells group of the Home tab.
 Manually adjust the height and width by clicking on Row Height or Column

Width.
 To use AutoFit, click on AutoFit Row Height or AutoFit Column Width.

Hide or Unhide Rows or Columns: To hide or unhide rows or columns:
 Select the row or column you want to hide or unhide.
 Click on the Format button on the Cells group of the Home tab.
 Click on Hide & Unhide.
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Inserting and Deleting Cells(s)/Row(s), Column(s)

Inserting Cells, Rows and Columns

To insert cells, rows and columns in Excel 2007:

 Place the cursor in the row below where you want the new row or in the
column to the left of where you want to have the new column.

 Click on the Insert button on the Cells group of the Home tab.

 Click on the proper option Cell, Row or Column.

Delete Cells, Rows and Columns

To delete cells, rows and columns:

 Place the cursor in the cell, row or column that you want to delete.

 Click on the Delete button on the Cells group of the Home tab.

 Click on the appropriate option  Cell, Row or Column.

4.3.6 Managing MS Excel Database

If you are new to Microsoft Excel, you will find all the basics you need right here
on how to use Excel’s data management tools, such as how to create a list, how to
sort it and how to filter the data to find the specific information you want while
managing database. An Excel 2007 pivot table makes it easy to extract information
from a large table of data without the use of formulas or functions. Various
operations, such as creating Excel database, sorting database using single/multiple
fields, filtering records using autofilter and advanced filter, adding/deleting/searching
records with the data form validating data entry and generating subtotals are
performed in Excel’s data management tools. They are discussed below:
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Creating Excel Database

At times, we need to keep track of information and a good place to do this is in an
Excel database file. Whether it is a personal list of phone numbers, a contact list
for members of an organization or team or a collection of coins, cards or books,
an Excel database file makes it easy to enter, store and find specific information.
Excel 2007 has built-in tools to help you keep track of data and to find specific
information when you want it. Also, with its hundreds of columns and thousands of
rows, an Excel spreadsheet can hold an enormous amount of data.

Sorting Database Using Single/Multiple Fields

Sorting data is an integral part of data analysis. You might want to put a list of
names in alphabetical order, compile a list of product inventory levels from highest
to lowest or order rows by colors or icons. Sorting data helps you quickly visualize
and understand your data better, and organize and find the data that you want.
For this you can use the sort tool . After selecting the tool the Sort dialog
box appears where you set let’s say ‘Largest to Smallest’.

The sorted result comes as shown:

Filtering Records Using Autofilter and Advanced Filter

The data filter option in Microsoft Excel 2007 enables you to filter the data of the
selected cells. The tool  helps you to filter the data.

In Excel 2007, if you use an Excel table, it has built-in filtering features. If your
data is not in an Excel Table, following steps are required to add an Excel 2007
AutoFilter.
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 Select a cell in the database.

 On the Excel Ribbon, click the Data tab and then click Filter.

A drop down arrow appears at the right side of each column heading.

Filter One Column

With the Excel Table or Excel 2007 AutoFilter, you can start filtering the individual
columns. You can filter on just one column, such as Customer or two or more
columns. For example, to filter for a specific customer, follow these steps:

 Click the drop down arrow at the right of the Customer heading

 In the list of Customers, click Select All, to remove all the check marks

 Click the check box for the customer that you want to filter for, such as
MegaStore.

 Click OK, to see the filtered list.

In the filtered worksheet, you will see some changes:
 Only the rows for the selected customer are visible and the other customer

rows have been hidden.
 The row numbers for the filtered rows are shown in blue font.
 The drop down arrow in the Customer column has changed to a filter

symbol with a small arrow.



Microsoft Powerpoint 2007
and Microsoft Excel 2007

NOTES

Self - Learning
222 Material

For performing this operation, you need to select the data as follows:

The shortcut key combination CTRL+Shift+L can also be used to filter the
data. After clicking the tool, you get the drop down list as shown where you are
able to filter the data.

Adding/Deleting/Searching Records with the Data Form

In the data form, click New. Type the data for the new row. To move to the next
field in the row, press TAB. To move to the previous field, press SHIFT+TAB.
After you have finished typing data, press ENTER to add the row to the bottom of
the range or table. In the data form, find the row that you want to delete. To search
record, do one or more of the following:

 To move through rows one at a time, use the scroll bar arrows in the data
form.

 To move through 10 rows at a time, click the scroll bar in the area between
the arrows.

 To move to the next row in the range or table, click Find Next.

 To move to the previous row in the range or table, click Find Prev.

Validating Data Entry

Using AutoFilter to filter data is a quick and easy way to find and work with a
subset of data in a range of cells or table. You can either re-apply a filter to get up
to date results or even clear a filter to redisplay all of the data. It is possible to Auto
Filter the data by choosing using the Data tab. If you click the tool , you can get
many options in which data is to be filtered.
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Valid Criteria

The valid criteria can be set with the filter as shown when you select the  tool:

This option filters the data according to set criteria.

The filtered data comes as shown by clicking Filter button  . This button
shows that a filter is applied.

Invalid Criteria

This option does not filter the data if an invalid criterion is being specified.

Since And operator is used to filter the data, no data is available for the
specified criteria.
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Redundant Criteria

Data redundancy is the property of some disk arrays to recover the data stored in
the array in the case of disk failure.

Generating Subtotals

In Excel 2007, you can calculate subtotals or totals for portions of your worksheet
data. For example, in a worksheet with sales data for three different product
categories you can first sort the products by category and then select all the cells
that contain data and open the Subtotal dialog box from Data menu and select
Subtotals command.

In the Subtotal dialog box, you can choose the column on which to base
your subtotals, such as every change of value in the Week column, the summary
calculation that you want to perform and the column or columns with values to be
summarized. For example, as shown in screen above you could calculate subtotals
for the number of units sold in each category. After you define your subtotals, they
appear in your worksheet as shown in the screen here.

As the screen above shows, when you add subtotals to a worksheet, Excel
2007 also defines groups based on the rows used to calculate the subtotals. The
groupings form an outline of your worksheet based on the criteria that you used to
create the subtotals in which you can also insert currency notation.
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Following are three types of controls in the outline section:

 Hide Detail Buttons: When the rows in a group are visible, a hide detail
button appears next to the group.

 Show Detail Buttons: When you hide a group of rows, the button next
to the group changes to a show detail button . Clicking a show detail
button restores the rows in that group to the worksheet.

 Level Buttons: Each of the numbered level buttons  represents a
level of organization in a worksheet and clicking a level button hides all
levels of detail below the button you clicked.

Excel’s 2007 built-in data entry form is a quick and easy way to enter data
into an Excel database. Using the form allows you to:

 Start a new database table or to add new records to an existing one.

 Scroll through data records one at a time.

 Search for records containing specific information.

 Edit or delete individual records if necessary.

Following screen shows how to use the form to enter data in Excel 2007.
 

 

Freeze Panes

A particular portion of a worksheet can be selected to stay static while you are
working on other parts of the sheet. This is done using the Freeze Rows and
Columns Function. To Freeze a row or column:

 Click on the Freeze Panes button on the View tab.

 Either select the section to be frozen or click on the defaults of top row or
left column.

 To unfreeze, click on the Freeze Panes button.

 Click on Unfreeze.
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Check Your Progress

19. How does modifying fonts in Excel help?

20.  Write the significance of sorting data.

21. What is data redundancy?

4.3.7 Working with Charts

Charts help you to present the information of the worksheet in a graphic format.
Excel 2007 provides various types of charts which includes Column, Line, Pie,
Bar, Area, Scatter, etc. To view the charts click on the Insert Tab on the Ribbon.

Creating a Chart: To create a chart:
 Select the cells that contain the data you would like to use in the chart
 Click on the Insert tab on the Ribbon
 Click on the type of Chart you want to create

Moving a Chart: You can modify and move a created chart. To move the
chart:

 Click on the Chart and Drag it to the location on the same worksheet or
 Click on the Move Chart button on the Design tab
 Select the desired location in the same or another worksheet

To change the data included in the chart:
 Click on the Chart
 Click on the Select Data button on the Design tab
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To reverse the data displayed in the rows and columns:
 Click on the Chart
 Click on the Switch Row/Column button on the Design tab

To modify the labels and titles:
 Click on the Chart
 On the Layout tab, click on the Chart Title or the Data Labels button
 Modify the Title and click on Enter

Chart Tools: The Chart Tools appear on the ribbon when you click on the
chart.  The tools are located on three different tabs: Design, Layout and
Format. Within the Design tab you can control the chart type, layout, styles and
location.

The Layout tab controls inserting pictures, shapes and text boxes, labels,
axes, background and analysis.

Within the Format tab you can modify shape styles, word styles and size of
the chart.
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Copy a Chart to Word

 Select the Chart

 Click on Copy on the Home tab

 Go to the Word document where you want the chart to be located

 Click on Paste on the Home tab

Changing Chart Types

Any change you can make to a chart that is embedded in a worksheet, you can
also make to a chart sheet. For example, you can change the chart type from a
column chart to a bar chart and for this following steps are required:

 Start Microsoft Excel 2007 and open a workbook from your documents
that contains a chart or you can create a chart from data in an existing
workbook.

 Right click on top of the chart that you want to change to a different type of
chart and click ‘Change Chart Type’. The ‘Change Chart Type’ dialog box
will open in the middle of the screen.

 Click the type of chart you would like to change to on the left side of the
‘Change Chart Type’ dialog box.

 Select the specific chart you would like to change your existing chart to by
clicking it in the right portion of the ‘Change Chart Type dialog box. The
chart you have chosen will be highlighted in orange.
Click the ‘OK’ button to close the ‘Change Chart Type’ dialog box and

change the selected chart to the new chart type you have indicated.

Check Your Progress

22. Write the function of Layout tab.

23. Give the default name of first chart sheet which is sequentially started in
Excel 2007.
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4.3.8 Printing Worksheets

You can choose the spreadsheet that you want to print. For this, do the following
steps:

 Click Print on the File menu.

 Under Print what, select Entire workbook radio button.

You will get the Print tab where you can set the ‘Print Range’, ‘Print What’,
Number of copies: options as shown in the screen.

Previewing Worksheet

To preview worksheet, first select Office button and then Print option. Then select
Print Preview option. You will get a preview of printing page as shown in the
screen below.

Page Setup Margin, Paper Size and Orientation Setting

Set Print Titles

The print titles function permits you to repeat the column and row headings at the
beginning of each new page to make reading a multiple page sheet easy when
printed.  To print titles:
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 Click on the Page Layout tab on the ribbon.

 Click on the Print Titles button.

 In the Print Titles section, click on the box to select the rows/columns to
be repeated.

 Select the row or column.

 Click on the Select Row/Column Button.

 Click on OK.

Set Page Margins

To set the page margins:

 Click on the Margins button on the Page Layout tab.

 Select any one of the given options.

 Click on Custom Margins.

 Complete the boxes to set margins.

 Click on Ok.

Changing Page Orientation

To change the page orientation from portrait to landscape:

 Click on the Orientation button on the Page Layout tab.

 Select Portrait or Landscape.

Printing an Area of a Worksheet

If you want to print a specific selection on the worksheet frequently, you can
define a print area. The print area refers to one or more ranges of cells that you
designate to print when you do not want to print the entire worksheet. If a worksheet
includes a print area only the print area is printed which includes just that selection.
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When you print the worksheet after defining a print area only the print area will
print. You can add cells to expand the print area as needed and you can clear the
print area to print the entire worksheet again.

To set a print area, you need to perform the following task:
 On the worksheet, select the cells that you want to define as the print area.
 On the Page Layout tab, in the Page Setup group, click Print Area and

then click Set Print Area.

The print area that you set is saved when you save the workbook. You can
add cells to an existing print area by performing the following steps:

 On the worksheet, select the cells that you want to add to the existing print
area.

 On the Page Layout tab, in the Page Setup group, click Print Area and
then click Add to Print Area.

A print area can be cleared by performing the following steps:
 Click anywhere on the worksheet for which you want to clear the print

area.
 On the Page Layout tab, in the Page Setup group, click Clear Print

Area.

Printing Worksheet With/Without Gridlines

To make a printed worksheet or workbook easier to read, you can print the
worksheet or workbook with gridlines displayed around the cells.

 Select the worksheet or worksheets that you want to print.

 When multiple worksheets are selected, [Group] appears in the title bar at
the top of the worksheet. To cancel a selection of multiple worksheets in a
workbook, click any unselected worksheet. If no unselected sheet is visible,
right click the tab of a selected sheet and then click Ungroup Sheets on
the shortcut menu.

 On the Page Layout tab, in the Sheet Options group, select the Print
check box under Gridlines.

Click Microsoft Office Button  and then click Print. You can also

press CTRL+P as keyboard shortcut. Worksheets print faster if you print without
gridlines.

Adding Standard/Customized Header and Footer Worksheet

To create a header or footer:

 Click on the Header and Footer button on the Insert tab.

 It will display the Header and Footer Design Tools Tab.
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 To switch between the Header and Footer, click on the Go to Header or
Go to Footer button.

 To insert text, enter the text in the header or footer.

 To enter preprogrammed data such as page numbers, date, time, file name
or sheet name, click on the proper button.

 To change the location of data, click on the desired cell.

4.3.9 Advanced Features in Excel 2007

Following are the advanced features supported by Excel 2007:

Results Oriented User Interface

The new results oriented user interface makes easy for you to work in Microsoft
Office Excel 2007. Commands and features that are often buried in complex menus
and toolbars are now easier to find on task oriented tabs that contain logical groups
of commands and features.

More Rows and Columns and Other New Limits

To enable you to explore massive amounts of data in worksheets, Office Excel
2007 supports up to 1 million rows and 16 thousand columns per worksheet. The
Office Excel 2007 grid is 1,048,576 rows by 16,384 columns which provides
you with 1,500 percent more rows and 6,300 percent more columns than Microsoft
Excel 2003.

Office Themes and Excel Styles

In Office Excel 2007, you can quickly format the data in your worksheet by applying
a theme and by using a specific style. Themes can be shared across other 2007
Office release programs, such as Microsoft Office Word and Microsoft Office
PowerPoint while styles are designed to change the format of Excel specific items,
such as Excel tables, charts, pivot tables, shapes or diagrams.

Rich Conditional Formatting

With Excel 2007, you can use conditional formatting to visually annotate your
data for both analytical and presentation purposes. To easily find exceptions and
important trends in your data, you can implement and manage multiple conditional
formatting rules that apply rich visual formatting in the form of gradient colors, data
bars and icon sets to data that meets those rules.
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Easy Formula Writing

The following improvements make formula writing much easier in Office Excel
2007.

 Resizable Formula Bar: The formula bar automatically resizes to
accommodate long, complex formulas which prevents the formulas from
covering other data in your worksheet. You can also write longer formulas
with more levels of nesting in Excel 2007.

 Function AutoComplete: With Function AutoComplete, you can quickly
write the proper formula syntax. From easily detecting the functions that
you want to use to getting help completing the formula arguments, you will
be able to get formulas right the first time and every time.

 Structured References: In addition to cell references, such as A1 and
R1C1, Office Excel 2007 provides structured references that reference
named ranges and tables in a formula.

 Easy Access to Named Ranges: By using the Office Excel 2007 name
manager, you can organize, update and manage multiple named ranges in a
central location which helps anyone who needs to work on your worksheet
interpret its formulas and data.

Worksheet and Workbook Protection

Microsoft Office Excel 2007 provides several layers of security and protection
that allows you to control who can access and change your Excel data. For optimal
security, you should protect your entire workbook file with a password which is
used to restrict access to a workbook, worksheet or part of a worksheet. Excel
passwords can be up to 255 letters, numbers, spaces and symbols. You must type
uppercase and lowercase letters correctly when you set and enter passwords. It
allows only authorized users to view or modify your data. Password security at
the workbook level uses advanced encryption to help protect your workbook
from unauthorized access. You can set a password when you save the workbook.
You can specify two separate passwords that users must type to:

 Open and View the Workbook: This password is encrypted to help protect
your data from unauthorized access.

 Modify the Workbook: This password is not encrypted and is only meant
to give specific users permission to edit workbook data and to save changes
to the file.

These passwords apply to the entire workbook. For optimal password
security, you should always assign a password to open and view the file. To give
only specific users permission to modify data, you may want to assign both
passwords.

Check Your Progress

24. What does print titles function permit you?

25. What is rich conditional formatting?
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4.4 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. The prime utility of PowerPoint presentations in modern days are learning,
corporate training sessions, business and marketing meetings and sales
gatherings.

2. The main feature that separates PowerPoint 2007 from PowerPoint 2003
is that in PowerPoint 2007 file is saved with a .ppt and .pptx extension.

3. Running slide presentation includes videos, audio clips, images and other
multimedia elements to improve the visual appeal of your presentation.

4. The background is the area that covers the whole slide in PowerPoint 2007.

5. The Slide Master is the main slide which stores information about the theme
and layouts of a presentation including the background, color, fonts, effects,
placeholder, sizes and positions.

6. Normal View in Microsoft PowerPoint 2007 is the main working Window
in the presentation.

7. The animation option contains preview, custom animation and various
transition settings that can be applied to the specified slides.

8. The placeholders are boxes with dotted or hatch marked borders that are
part of most slide layouts.

9. A hyperlinked custom show is a quick way to navigate one or more separate
presentations.

10. The Rehearse Timing  option provides you the option to make the
presentation within a certain time frame.

11. A spreadsheet is an electronic document which saves various types of data
in columns and rows.

12. The Advanced feature permits you to specify the options for editing, copying,
pasting, printing as well as displaying formulas, calculations and other general
settings.

13. The cell cursor is a black border that surrounds the active cell sometimes
called the current cell in a worksheet.

14. CTRL+A key combination is used to select all cells in a worksheet.

15. The cell address is a combination of column letter and row number of a cell,
such as C4 or D8.

16. A function computes the values provided and shows you the desired results,
e.g., a simple function SUM automatically adds up all the values provided
either in a range or as individual values.

17. In Excel 2007, the FACT function returns the factorial of a number.

18. In Excel 2007, the LEN function returns the length of the specified string.

19. Modifying fonts in Excel helps you to emphasize titles and headings.
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20. Sorting data helps you to quickly visualize and understand your data better,
and organize and find the data that you want.

21. Data redundancy is the property of some disk arrays to recover the data
stored in the array in the case of disk failure.

22. The Layout tab controls inserting pictures, shapes and text boxes, labels,
axes, background and analysis.

23. By default, Excel 2007 names each chart sheet sequentially starting with
Chart1.

24. The simplest way to create a macro in Excel is to use the macro recorder.

25. With Excel 2007, you can use conditional formatting to visually annotate
your data for both analytical and presentation purposes. To easily find
exceptions and important trends in your data, you can implement and manage
multiple conditional formatting rules that apply rich visual formatting in the
form of gradient colors, data bars and icon sets to data that meets those
rules.

4.5 SUMMARY

 PowerPoint 2007 is an essential element of every corporate training session.
 Inclusion of different types of charts, images, Clip Arts and other graphical

structures makes a PowerPoint 2007 presentation eye catchy.
 The Microsoft Office button performs all the functions of the ‘File’ menu of

the older versions of PowerPoint which helps you to create a new
presentation, open an existing presentation, save a presentation, save a
presentation with a new name using the ‘Save As’ option, print a presentation,
send a presentation  and close a presentation.

 Spell check underlines every wrong spelling by a red wavy line.
 Microsoft Excel 2007 charts and tables can also be embedded to Microsoft

PowerPoint 2007 by selecting InsertChart option.
 The picture tool sets the brightness of images, crops the picture, etc.
 Slide Sorter View shows miniature versions of all the slides in horizontal

rows.
 PowerPoint applies the transition effect to the slide when we click on the

thumbnail.
 The Animation option contains preview, custom animation and various

transition settings that can be applied to the specified slides.
 The movie clip is usually in the animated .gif format or the .avi format.
 The options available for creating Organizational Chart are Process, Cycle,

Hierarchy, Relationship, Matrix and Pyramids.
 Video clips will get dull when used over and over again in PowerPoint slide.
 The background is the area that covers the whole slide. It is referred to as

background because it stays in the back and it is positioned behind anything
else in the PowerPoint slide.
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 A color scheme consists of a background color, a color for lines and text,
and six other colors selected to make slides easy to read.

 Animation scheme adds preset visual effects to text on slides.
 The Slide Master is one of several master slides that are used in PowerPoint

to make global changes to all your slides at one time.
 Task pane is a Window within an Office program that provides commonly

used commands. Its location and small size allow you to use these commands
while still working on your files.

 Slide sorter view in PowerPoint 2007 is a window that displays thumbnail
versions of all your slides, arranged in horizontal rows. This view is useful to
make global changes to several slides at one time.

 PowerPoint 2007 dialog box allows you to select the gradient fills
interactively.

 In Excel 2007, the columns are lettered A to Z and then continuing with
AA, AB, AC and so on and the rows are numbered 1 to 1,048,576.

 Excel 2007 provides a wide range of customizable options that help you to
create an Excel workbook of required specifications.

 The Proofing feature permits you to personalize the options for correcting
words and formats of your text.

 If you hold down the CTRL key and then press the Home key, you move to
the beginning of the worksheet.

 If there is an error in a formula, an error message is displayed which will
begin with a # sign.

 The ROUND function in Excel 2007 can be used when rounding integers
and decimal numbers to make them easier to work within your spreadsheets.

 Within the Format tab you can modify shape styles, word styles and size of
the chart.

 To run a Macro from the Keyboard shortcut, simply press the keys that
you have assigned to run the Macro. 

 To enable you to explore massive amounts of data in worksheets, Office
Excel 2007 supports up to 1 million rows and 16 thousand columns per
worksheet.

 By using the Office Excel 2007 name manager, you can organize, update,
and manage multiple named ranges in a central location which helps anyone
who needs to work on your worksheet interpret its formulas and data.

 With the Excel Table or Excel 2007 AutoFilter, you can start filtering the
individual columns.

4.6 KEY TERMS

 Ribbon: It refers to the strip of buttons that resides on top of the main
Window.

 Design option: This option facilitates the choice of colors, background styles,
fonts, page setup, slide orientation, etc.
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 SmartArt: This option provides graphics, ranging from graphical list and
process diagrams to more complex graphics.

 Picture tool: This tool is a context sensitive tab that appears on the ribbon
and allows one to work with inserted images, photos and Clip Art pictures.

 Slide view: This view displays each slide on the screen and is helpful for
adding images, formatting text and adding background styles.

 PowerPoint slide master: This type of slide allows you to insert common
elements on every slide, such as a common footer, slide number, copyright
line, logo or even pictures.

 Basic custom show: It is a separate presentation that includes some of the
slides of the original.

 Cell address: It is the combination of a column coordinate and a row
coordinate.

 Popular feature: This feature helps you to personalize your work
environment using the mini toolbar, color schemes, default options for new
workbooks, customize sort and fill sequences user name.

 Operators: They are symbols used to represent the various arithmetic and
comparison operations you can perform on the operands.

 Absolute cell referencing: This referencing involves nothing more than
placing a dollar symbol ( $ ) before each letter and number.

 PI(): This function returns the mathematical constant which is equal to
3.14159265358979.

 NOW(): This function is used to add the current time and date to a
spreadsheet.

 LOWER(): This function converts all letters in the specified string to
lowercase.

 Level buttons: These buttons represent a level of organization in a
worksheet and clicking a level button hides all levels of detail below that of
the button you clicked.

 Charts: They help you to present the information of the worksheet in a
graphic format.

 Macro buttons: This button records all the activities in Excel 2007 which
will be issued by users.

 Print area: This area refers to one or more ranges of cells that you designate
to print when you do not want to print the entire worksheet.

 AutoComplete function: With this function, you can quickly write the
proper formula syntax.

 Password security: This concept uses advanced encryption to help protect
your workbook from unauthorized access at the workbook level.
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4.7 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What are PowerPoint 2007 presentations?
2.  What is Ribbon in PowerPoint 2007?
3.  How the footer is formatted?
4.  Write one use of picture tab.
5.  Why transition effects are used?
6. What is Slide View?
7.  How can you preview animations in PowerPoint 2007?
8.  Name the file extension in which a presentation is saved in PowerPoint

2007.

9. What is Microsoft Excel?

10.  Write the steps to select data range.

11.  Which string operator is used to concatenate the two text values?

12. Write the syntax of MOD() function.

13.  Write the steps to cut and paste the formula.

14.  How to change chart types?

15.  What are macros?

16. Why is previewing worksheet a required step before taking the printout?

17.  Write the steps which are required to add an Excel 2007 AutoFilter.

Long-Answer Questions

1.  Describe the utility of PowerPoint presentation with the help of suitable
examples.

2.  Explain the steps to insert text, graphics, Clip Art, table, chart, Organizational
Chart and photo album.

3.  Describe the concept of formatting the AutoLayout area in PowerPoint
2007.

4.  Discuss all types of views of slide presentation in PowerPoint 2007.
5.  Explain the concept and option used in automation of slide presentation.
6. Write all the steps required in adding sound effects in slides.
7.  Briefly explain the steps to insert date, time, slide numbers and common

objects into the slides.
8.  Discuss and write all the steps required to add sound effects in slides.

9.  Describe worksheet, workbook and workspace with the help of suitable
examples.

10.  Explain the features of Microsoft button in Excel 2007.

11.  Describe the concept of selection in a worksheet.
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12.  Discuss the categories of formulas.

13.  Explain the syntax of text functions LOWER(), UPPER(), PROPER(),
LEN(), LEFT()RIGHT(), MID(), REPT() and TRIM().

14.  Explain briefly the concept of editing worksheet.

15.  Discuss the steps required in creating chart and embedded chart, moving
chart and formatting chart.

16. How to assign a keyboard shortcut in creating and executing a macro?
Explain briefly.

17.  Explain the steps of creating header and footer, setting page margins and
printing an area of a worksheet.

18. Discuss advanced features of Excel 2007 with the help of suitable examples.
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5.0 INTRODUCTION

The Internet is the global system of interconnected computer networks that uses
the Internet protocol suite, such as TCP/IP (Transmission Control Protocol/Internet
Protocol) to link devices worldwide. It is a network of networks that consists of
private, public, academic, business, and government networks of local to global
scope, linked by a broad array of electronic, wireless, and optical networking
technologies. The Internet carries a vast range of information resources and
services, such as the inter-linked hypertext documents and applications of the
World Wide Web (WWW), electronic mail, telephony, and file sharing.

The Internet has no single centralized governance in either technological
implementation or policies for access and usage; each constituent network sets its
own policies. The overreaching definitions of the two principal name spaces in the
Internet, the Internet Protocol address (IP address) space and the Domain Name
System (DNS), are directed by a maintainer organization, the Internet Corporation
for Assigned Names and Numbers (ICANN). The technical underpinning and
standardization of the core protocols is an activity of the Internet Engineering Task
Force (IETF), a non-profit organization of loosely affiliated international participants
that anyone may associate with by contributing technical expertise.
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Internet security is a specific branch of computer security that is specifically
related not only to the Internet, often involving browser security and the World
Wide Web, but also network security as it applies to other applications or operating
systems as a whole. The key objective is to establish rules and measures which
can be used against attacks over the Internet. The Internet represents an insecure
channel for exchanging information, which leads to a high risk of intrusion or fraud,
such as Phishing, Online Viruses, Trojans, Worms and many more.

Computer ethics is a set of moral values that control the usage of computers.
One of the common issues of computer ethics is breaking of copyright issues
which include recreating copyrighted material without the author’s permission,
accessing personal information of others that breaks ethical values. The Internet
ethics means ‘Acceptable Behaviour’ while using the Internet. One should be
honest, respect the others persons and community, respect rights and property of
others on the Internet.

A computer virus is a set of executable code that attaches itself to other
programs to replicate itself without the awareness of a system user. These computer
viruses can damage the system and data of a computer. The various types of
computer viruses are Boot Sector Virus, Parasitic Virus, Multi-Partite Virus,
Companion Virus, Link Virus, Macro Virus, etc.

Network security is a broad topic with a multi-layered approach. It can be
addressed at the data link, network and the application layers. The issues concerned
are packet intrusion and encryption, IP packets and routing tables with their update
versions, and host-level bugs that occur at the data link, network and the application
layers, respectively.

In this unit, you will be study about the Internet, Website, E-MAIL, social
networking ethics, making secured online transactions, viruses and antiviruses,
computer security issues and its protection.

5.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand the significance of the Internet

 Discuss the importance of Website and Wi-Fi

 Work with the E-Mail using its various features

 Explain about the social networking ethics

 Know how to make secured online transactions

 Describe the various types of viruses and antiviruses

 Analyse the issues related to computer security and its protection
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5.2 INTERNET

The Internet has made things simpler. It can serve the following purposes:

 Direct Communication: You can send messages to family and friends,
business associates and acquaintances using the electronic mail facility. Using
electronic mail, you can send and receive messages within a few seconds
anywhere in the world. Using Internet Relay Chat (IRC), you can
communicate online with people over the Internet. You can log into a chat
room and converse with others by typing messages that are instantly
delivered. With the improvement of network technologies and increase in
broadband, not only can you use text messages but also graphics, audio
and video for communication with other people.

 Online Shopping: Logically, the Internet has removed all barriers of distance
and nationality. You can shop for products and services across the world by
logging on to a Web portal. You can also pay your bills online using credit
and debit cards. You can also transfer money between different accounts
with the click of a mouse.

 Distance Education: The Internet provides a perfect medium for knowledge
sharing and information dissemination. Courses are available on the Internet.
You can register and pay online, and complete a course on different interest
areas. You can also pursue specialized higher studies now in the comfort of
your own office or home.

 Knowledge Base: The Internet provides a rich information base that people
from across the globe can access. In fact, it is one of the richest information
bases that can be accessed at the click of a mouse. Using search engines,
you can search for detailed information on any topic of your interest.

 Banking: Banks are using information technology to provide online banking
facilities to their customers. Using the Internet, you can now view your
account details, get drafts made, request for chequebooks and transfer
money from one account to another. The use of Automated Teller Machine
or ATMs has shifted the mundane back-office work to the customer himself.
Instead of hiring an army of bank clerks, banks can now uses ATMs to
considerably reduce time and operational costs.

 Travel: Using the Internet, travel agencies can publish their services on the
Web along with the latest discounts, packages and availability details, so
that customers can compare rates, make online bookings and avail discounts
without having to run around multiple offices.

 Bill Payments: The government sector has also realized the benefits of
Information Technology or IT. Now you can make online payments for
public utilities, such as water, electricity and phones, using credit cards as
the payment medium.
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How to Connect to the Internet?

You can use two options for connecting to the Internet.

Direct Connection

Through a direct connection, a machine is directly connected to the Internet
backbone and acts as a gateway. Though a direct connection provides complete
access to all Internet services, it is very expensive to implement and maintain.
Direct connections are suitable only for very large organizations or companies.

Through Internet Service Provider or ISP

You can also connect to the Internet through the gateways provided by ISPs. The
range of Internet services varies depending on the ISPs. Therefore, you should
use the Internet services of the ISP that is best suitable for your requirements. You
can connect to your ISP using two methods:

Remote Dial-Up Connection

A dial-up connection enables you to connect to your ISP using a modem (refer
Figure 5.1). A modem converts the computer bits or digital signals to modulated
or analogue signals that the phone lines can transmit and vice versa. Dial-up
connections user either SLIP (Serial Line Internet Protocol) or PPP (Point-to-
Point Protocol) for transferring information over the Internet.

User’s
Computer

Modem Modem
Internet Backbone

Fig. 5.1 Remote Dial-Up Connection

For dial-up connections, regular telephone lines are used. Therefore, the
quality of the connection may not always be very good.

Permanent Dedicated Connection

You can also have a dedicated Internet connection that typically connects you to
Internet Service Provider or ISP through a dedicated phone line. A dedicated
Internet connection is a permanent telephone connection between two points.
Computer networks that are physically separated are often connected using leased
or dedicated lines. These lines are preferred because they are always open for
communication traffic unlike the regular telephone lines that require a dialling
sequence to be activated. Often, this line is an ISDN (Integrated Services Digital
Network) line that allows transmission of data, voice, video and graphics at very
high speeds. ISDN applications have revolutionized the way businesses
communicate. ISDN lines support upward scalability, which means that you can
transparently add more lines to get faster speeds,  going up to 1.28 Mbps (Million
bits per second) and ISDN PRI can be adjusted for speeds up to 2.94 Mbps
(Million bits per second).
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T1 and T3 are the two other types of commonly used dedicated line types
for the Internet connections. Dedicated lines are becoming popular because of
their faster data transfer rates. Dedicated lines are cost-effective for businesses
that use Internet services extensively.

There are various ways to connect to the Internet. Some of the common
options are described here:

Dial-Up Connections

Telephone lines were designed to transmit human voice, and not electronic data
from computers. Modems were therefore invented to convert digital computer
signals into a form that allowed them to travel over phone lines— by converting
digital signals to analog ones on one end, and converting them back to digital
signals at the receiving end. The word MODEM stands for MOdulator/
DEModulator.

If your computer does not have an internal modem, you can consider buying
an external one, as it is much easier to install and operate. For example, when your
modem freezes (not an unusual occurrence), you may need to turn it off and on
again to get it working properly. With an internal modem, that means restarting
your computer—a waste of time. With an external modem, it is as easy as flipping
a switch.

Until the end of 1995, the conventional wisdom was that 28.8 Kbps was
about the fastest speed you could squeeze out of a regular copper telephone line.
Today, data transmission for a dial-up connection is typically 56 Kbps. The key
information here is to know which speed modem is supported by your ISP. If your
ISP supports only a 28.8 Kbps modem on its end of the line, you would be able to
connect to the Net only at 28.8 Kbps, even if you had the fastest modem in the
world.

Digital Subscriber Line or  DSL

Digital Subscriber Line or DSL is a high-speed technology that has recently gained
popularity. It can carry both data and voice over telephone lines. It is possible for
a DSL line to stay connected to the Internet this means that you do not have to dial
up every time you wish to go online. Usually with DSL, data can be downloaded
at rates that can go up to 1.544 Mbps and data can be sent at 128 Kbps. Because
DSL lines carry both data and voice, a separate phone line does not have to be
installed. DSL services can be established using your existing lines, as long as the
service is offered in your locality and your system lies within the appropriate distance
from the central switching office of the telephone company.

DSL services require special modems and network cards to be installed on
your computer. The cost of equipment and the monthly service and DSL installation
charges may vary considerably; therefore, checking with the local phone company
and the ISP is recommended. It may be noted here that prices are now declining
due to the increasing competition.
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Cable Modems

You can also connect to the Internet at high speeds through cable TV. Since their
speeds go up to 36 Mbps, cable modems make it possible for data to be
downloaded in a matter of seconds, where they might take fifty times longer with
dial-up connections. Since they work over TV cables, they do not tie up telephone
lines and also do not require you to specifically connect as in the case of dial-up
connections.

Integrated Services Digital Network or ISDN

Integrated Services Digital Network or ISDN services are an older, but nevertheless
viable, technology provided by telephone companies. ISDN lines transfer data at
rates that range between 57 Kbps and 128 Kbps. These leased lines can have
two configurations: T1 and T3. T1 (the commonly used connection option) is a
dedicated connection that allows data to be transferred at a speed of 1.54 Million
bits per second (Mbps). This proves to be beneficial for computers and Web
servers that remain connected to the Internet at all times. Portions of a T1 line can
also be leased using either the Fractional T1 or the Frame Relay systems. They
can be leased in blocks that range between 128 Kbps and 1.5 Mbps.

Speed of ISDN: As telecommunications companies gradually converted
their phone infrastructures from Analog to Digital, the connections to individual
residences and businesses, referred to as the ‘Last Mile Network’ remained on
Old Signalling Standards and Copper Wire. ISDN was designed in a way to
migrate the transition to digital signals. Businesses especially found value in ISDN
due to the larger number of desk phones and fax machines their networks needed
to support. ISDN runs over ordinary telephone lines or T1 lines (E1 lines in some
countries), and it does not support wireless connections. The standard signalling
methods used on ISDN networks come from the field of telecommunications,
including Q.931 for connection setup and Q.921 for link access.

Following are the two main variations of ISDN:

Basic Rate Interface (BRI)-ISDN or BRI-ISDN: The form of ISDN
that consumers recognize as an Internet access option, BRI works over regular
copper telephone lines and supports data rates of 128 Kbps for both uploads and
downloads. Two 64 Kbps data channels called the Bearer Channels (also called
DS-0 links in telecommunications) carry the data while a 16 Kbps channel controls
information. Telecom providers sometimes call this service ISDN2 referring to the
two-data channel setup.

Primary Rate Interface (PRI)-ISDN or PRI-ISDN: This high-speed
form of ISDN supports full T1 speeds of 1.544 Mbps and up to 2.048 Mbps on
E1. On T1, PRI uses 23 parallel bearer channels, each carrying 64 Kbps of
traffic, compared to two such channels for BRI. In Europe and Asia, providers
often called this service as ISDN30 because the E1 lines used in these countries
support 30 bearer channels.
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Third Form of ISDN

The third form of ISDN is defined as Broadband ISDN (B-ISDN). This is the
most advanced form of ISDN and was designed to scale up to hundreds of Mbps,
that can run over  fibre optic cables, and use ATM as its switching technology.

In a videoconference, ISDN provides simultaneous voice, video, and text
transmission between individual desktop videoconferencing systems and group
(room) videoconferencing systems. ISDN uses the H.320 standard for Audio
Coding and Video Coding, including Audio Codecs, such as G.711 (PCM) and
G.728 (CELP), and Discrete Cosine Transform (DCT) and Video Codecs, such
as H.261 and H.263.

In India, the Bharat Sanchar Nigam Limited (BSNL), Reliance
Communications and Bharti Airtel are the largest communication service providers,
and offer both ISDN BRI and PRI services across the country. Reliance
Communications and Bharti Airtel uses the DLC technology for providing these
services. With the introduction of broadband technology, the load on bandwidth is
being absorbed by ADSL. ISDN continues to be an important backup network
for point-to-point leased line customers, such as Banks, Eseva Centers, Life
Insurance Corporation (LIC) of India, and SBI (State Bank of India) ATMs.

Since leased lines cost more, they are usually used only by those companies
whose businesses revolve around the Internet or who engage extensively in large
data transfers.

Understanding the World Wide Web

World Wide Web commonly known as ‘WWW’, ‘Web’ or W3’, consists of a
number of distributed servers that are connected through hypermedia documents.
These documents are created using HyperText Markup Language (HTML).
Related text organized into units can be accessed by using a link called hyperlink.
These links (or hyperlinks) allow the user to navigate from one document to another
without having to worry about the actual physical location of the documents. WWW
makes it possible to share information between disparate users, computers and
operating systems. It is therefore the fastest growing application of the Internet.

Understanding Web Addresses and Document Links

An Internet address uniquely identifies a node on the Internet.  Internet address may
also refer to the name or the Internet Protocol or IP of a Web site (Uniform Resource
Locator or URL). The term Internet address can also represent someone’s e-mail
address. Each document list, folder and document preview in the library has a unique
Web address that you can copy and send to another library user. When the person
receiving the link pastes it into a browser, the browser opens to the location identified
by the link address. If the user is not logged in to the library, the browser displays the
login screen first then opens the linked page. If you are copying a link to a document,
you can also copy a link address that allows another library user to download the
document. This link address is located under the heading Link to download.  Paste
the copied link address into an e-mail, blog entry or other application where it can be
used to access the folder or document.
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Web Browser

A Web browser, commonly known as a browser, is a computer application that
creates requests for HyperText Markup Language or HTML pages or Web pages
and displays the processed HTML page. Web browsers use HTTP (HyperText
Transfer Protocol) to request for information from Web servers. The most commonly
used Web browsers are as follows:

 Mozilla Firefox

 Microsoft Internet Explorer

 Google Chrome

Other examples of Web browsers include Mosaic, Cello, Lynx and Netscape
Navigator. Having knowledge of the basic features of browsers can be helpful in
using them easily.

The three most popular desktop browsers, according to Net Marketshare
(June 2019), is Chrome (66.46%), followed by Firefox (9.50%), Microsoft
Internet Explorer (8.84%), and Edge (4.71%). Other major browsers include
Apple Safari, Sogou Explorer and Opera. While most commonly use to access
information on the Web, a Web Browser can also be used to access information
hosted on Web servers in private networks.

Google Chrome

Google Chrome is a cross-platform Web browser developed by Google. It was
first released in 2008 for Microsoft Windows, and was later ported to Linux, Mac
OS, iOS, and Android. The browser is also the main component of Chrome OS,
where it serves as the platform for Web apps.

Most of Chrome’s source code comes from Google’s open-source
Chromium project, but Chrome is licensed as proprietary freeware. WebKit was
the original rendering engine, but Google eventually forked it to create the Blink
engine; all Chrome variants except iOS now use Blink.

As of July 2019, StatCounter estimates that Chrome has a 71% worldwide
browser market share on traditional PCs and 63% across all platforms. Because
of this success, Google has expanded the ‘Chrome’ brand name to other products,
such as Chrome OS, Chromecast, Chromebook, Chromebit, Chromebox, and
Chromebase.

Chrome was assembled from 25 different code libraries from Google and
third parties, such as Mozilla’s Netscape Portable Runtime, Network Security
Services, NPAPI, Skia Graphics Engine, SQLite, and a number of other open-
source projects. The V8 JavaScript virtual machine was considered a sufficiently
important project to be split off (as was Adobe/Mozilla’s Tamarin) and handled
by a separate team in Denmark coordinated by Lars Bak in Aarhus. According to
Google, existing implementations were designed ‘for small programs, where the
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performance and interactivity of the system were not that important’, but Web
applications, such as Gmail are using the Web browser to the fullest when it comes
to DOM manipulations and JavaScript, and therefore would significantly benefit
from a JavaScript engine that could work faster.

On February 7, 2012, Google launched Google Chrome Beta for Android
4.0 devices. On many new devices with Android 4.1 and later preinstalled, Chrome
is the default browser. In May 2017, Google announced a version of Chrome for
augmented reality and virtual reality devices.

Google Chrome features a minimalistic user interface, with its user-interface
principles later being implemented into other browsers. For example, the merging
of the address bar and search bar into the ‘Omnibox’. Chrome also has a reputation
for strong browser performance.

Chrome periodically retrieves updates of two blacklists (one for Phishing
and one for Malware), and warns users when they attempt to visit a site flagged as
potentially harmful. This service is also made available for use by others via a free
public API called “Google Safe Browsing API”.

Chrome uses a process-allocation model to sandbox tabs. Using the principle
of least privilege, each tab process cannot interact with critical memory functions,
for example OS memory and user files or other tab processes, similar to Microsoft’s
‘Protected Mode’ used by Internet Explorer 9 or Advanced.

On December 4, 2018, Google announced its Chrome 71 release with new
security features, including a built-in ad featuring system. In addition, Google also
announced its plan to crack down websites that make people involuntarily subscribe
to mobile subscription plans.

The current version of Chrome runs on:

 Windows 7 or Later
 OS X 10.10 or Later
 64-Bit Versions of Ubuntu 14.04+, Debian 8+, openSUSE 13.3+ and

Fedora 24+
 Android KitKat or Later
 iOS 12 or Later

As of April 2016, stable 32-bit and 64-bit builds are available for Windows,
with only 64-bit stable builds available for Linux and Mac OS. 64-bit Windows
builds became available in the developer channel and as canary builds on June 3,
2014, in the Beta channel on July 30, 2014, and in the stable channel on August
26, 2014. 64-bit OS X builds became available as canary builds on November 7,
2013, in the Beta channel on October 9, 2014, and in the stable channel on
November 18, 2014.

Google Chrome is the basis of Google’s Chrome OS operating system that
transports on specific hardware from Google’s manufacturing partners. The user
interface has a minimalist design resembling the Google Chrome browser. Chrome
OS is aimed at users who spend most of their computer time on the Web; the only
applications on the devices are a browser incorporating a media player and a file
manager. Google announced Chrome OS on July 7, 2009.
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Toolbar of the Internet Explorer

The toolbar consists of various icons that can be used to execute functions. In
fact, most of the options available through the menu bar are also available through
the icons on the toolbar. Some commonly used icons are described below:

 Back: The Back button allows you to navigate to the Web page you viewed
last.

 Forward: The Forward button on the toolbar navigates to the next Web
page that was accessed previously. To view a list of the last few Web pages
visited, you can click the down arrow button beside the Back and Forward
buttons.

 Stop: The Stop button can be used to terminate the current Web page
request. This is usually used when you type the wrong URL by mistake and
want to stop the request for the Web page or if the Web page takes too
long to download.

 Refresh: The Refresh or the Reload button is used to load the current
Web page again. In other words, it refreshes the contents of the current
page by fetching a new copy of it.

 Search: The Search button allows you to find information on the Web. You
can find information by clicking on the Search button on the toolbar. This
activates the search text box as shown. You can then type in a word or
phrase and click the ‘Search’ button to start the search.

 Favorites: The Favorites button is used to record the addresses of frequently
visited Web sites. Once a website or a webpage is added to the favorites
list, it can be revisited by simply clicking on the link in the list. This saves the
effort of typing the URL each time the user wishes to visit the same site.

 History: The History button is used to view the list of all the Web pages
visited in the last few days, hours or minutes. To revisit any one of them,
simply click on the address.

 Print: The Print button is used to print the contents of the current Web page.

 

Search Text box

Search Button
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Net Surfing

Net surfing, Internet browsing or exploring a network on the WWW is associated
with visiting different Web sites on the Internet. It is typically finding places of interest
at the click of a mouse. It is analogous to surfing TV channels with a remote control.

Searching

Searching is one of the most common uses of the Internet. You can search for any
topic or information on the Internet. This is possible by using websites that provide
a search engine.

Using Desktop Shortcuts for Quick Access to a Specific Web Site
The standard method to access applications and folders in Windows is through the
Start menu. Using the Start menu is slow because you have to open cascading
menus to find the entry for the application you want. Desktop shortcuts give you
quicker access because you only have to double click on an icon to launch the
application or open the folder. A shortcut is simply an icon with an associated link.
Place shortcuts on your desktop to all applications, folders and files to which you
need quick access. At the same time, remove clutter from your desktop by deleting
any shortcuts for applications you do not use regularly. Use the Add/Remove Program
Utility in Control Panel to remove those applications. You may have shortcuts on
your desktop for applications that you already removed, but the shortcuts remain.
To remove these shortcuts, drag them to the Recycle Bin. You may have shortcuts
on your desktop to programs that you use frequently, but you never access through
a shortcut or menu. One example is Acrobat Reader. This is a free program from
Adobe that allows you to read Portable Document Format or PDF files. Another
example is WinZip, an application used to compress and extract files. These
applications are almost always executed automatically via a file association.

Locating Information on the Web using Search Engines
A search engine is a software system that enables users to search for information on
the Web using keywords. It is designed to help Internet users locate Internet resources,
such as Web pages, documents, programs and images using a keyword search
mechanism. Search engines typically use databases that contain references to a host
of resources. The users interact with a search engine using an interface. There are
many search engines available with different appearances and search mechanisms.
Some commonly used search engines are: Google, Yahoo, Microsoft Network or
MSN, AltaVista America Online or AOL, Ask Jeeves, Lycos, Excite and HotBot.

          Google (http://www.google.com)             Yahoo (http://www.yahoo.com)
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Information is collected by programs; called ‘Spiders’ or ‘Robots’; following
which, the search engine indexes them. ‘Directories’ also provide similar services
by maintaining a systematic list of websites. Search engines function as card
catalogues for the Internet. They try to index and locate the requested information
by looking for the keywords specified by the user. They usually maintain indices of
Web resources, from which the necessary information is retrieved by querying for
the keywords that the user enters.

How do Search Engines Work?

Search engines are one of the most significant vehicles by which specific information
can be gathered on the Internet. Without them, locating something on the Web
without accurate knowledge of the URL can be like looking for a needle in a
haystack! In this section, we will attempt to outline the manner in which search
engines function, and point out why some search engines produce better results
than others.

Generally, the term search engine, when used in the context of the Web,
refers to the actual search forms through which databases of HTML documents
initially gathered by a robot are searched.

Search engines can be broadly categorized into three types: the ones that
are powered by robots (called spiders, ants or crawlers); the ones that are powered
by human submissions; and the ones that are a hybrid of the two.

The first category refers to those search engines that are powered by crawlers
or automated software agents that visit a Web site, read the information and the
meta tags available there,  and then follow the links connected by the site in order
to index all the linked websites. Data is indexed in the central depository, which is
where the information is returned by the crawler. The crawler also returns to the
sites periodically to keep track of updates and changes in the information. The
administrators of the search engine determine the frequency with which this occurs.

Search engines that are powered by humans depend on human beings to
submit the particulars that are thereafter indexed and catalogued. It is only
information that they submit that is put into the index.

Useful Tips for Searching

Following tips are useful in Web surfing:

 Select a search engine, library or directory suitable to the type of search
you wish to perform and the type of results you seek.

 Consider whether you are searching for a Web site, some information
contained within the Usenet or some academic article retrievable only with
gopher.

 Be clear about whether you wish for general information on some broad
topics or for some particular hard-to-find document on exotic subjects.
Determine whether the entire Web needs to be searched or can the
information you seek be found on some of the more popular websites or on
any number of sites.

   Try to ascertain whether the information you seek is likely to be found in the
title of a page, the first few paragraphs, or is it buried deep within the site.
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    Wherever they are available, make use of the search engine’s advanced
features and consult the help files in case the searching procedure needs to
be understood more specifically.

 Type in the words, such as ‘‘Singapore’’ in the search box to get the result
pages.

 You could also use multiple search terms that will produce more appropriate
results. For example, if you are planning a vacation in Singapore, you may
need to type both the terms in the search box, as shown:

“Vacation Singapore”

This will result in pages containing both the terms and will therefore be more
specific to your search. You should therefore, choose your search terms carefully.

 To restrict a search further, include more terms in your search criteria.

 You could also search using phrases when you need the results to contain
the exact phrases. If this is desired, include the search phrase in quotation
marks as shown:

“Five Star Hotels in Singapore”

 Searches are usually not case sensitive.

Boolean Searching

The advanced search feature of AltaVista differs from other basic search pages in
that it allows users to perform Boolean searches. In regular search forms, which
can be found at the top of the advanced page, a + (plus) sign precedes the search
terms that must appear, a – (minus) sign precedes the terms that need NOT appear,
and the words that must appear together are enclosed in quotation marks. In the
Boolean search option, on the other hand, AND, OR, NOT (or AND NOT) and
NEAR (for words which must occur within ten words of each other) are typed, or
parentheses are used for those words which should occur together.

It is advisable to list the most significant keyword(s) in the relevance ranking
field within AltaVista’s advanced form so that the results are listed in the order
most relevant to you.

Popular Search Engines

www.google.com www.yahoosearch.com www.altavista.com
www.hotbot.com

www.webcrawler.com www.savvysearch.com www.metacrawler.com
www.infoseek.com

Add a Page to Favorite Option/Links Bar

To add a page to favorite option or links bar you need to navigate to the Mail Web
page you wish to add as a link to the Farovites toolbar. Click the ‘Add to Favorites’
button. Enter a name for the link and choose the ‘Add to Favorites Bar’ option.
The mail link is now added to the Internet Explorer toolbar.

Launch Internet Explorer click the View menu, point to the ‘Toolbars’ option
and choose ‘Links’ if it is not checked. Resize the Links toolbar, if necessary by
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clicking its separator and dragging it to the desired position. Navigate to the Mail
Web page you wish to add as a link, for example Yahoo, Hotmail or Gmail. Click
the Mail Web page’s address icon located on the address bar and drag it to an
empty space on the Links toolbar. The Mail link has now been added to the
Internet Explorer toolbar. Click the ‘View’ menu, choose ‘Toolbars’ and click
‘Lock the toolbars’.

Change Your Home Page

Following steps are required to change your Home page:

 Start the Internet Explorer.

 On the Tools menu, click Internet Options...

 Click the General tab.

 In the Address box, type the Web page address that you want for your
Home page.

Specify How Many Pages are Saved in the History File

To specify how many pages are saved in the History list following steps are required:

 On the Tools menu in the browser, click Internet Options...

 Click the General tab.

 In the History area, change the number of days that Internet Explorer keeps
track of your pages.

Adjust AutoComplete Settings

You can configure AutoComplete to save and suggest only the information you
want. You can choose whether to use AutoComplete for Web addresses, forms
and passwords or not use it all.

 In the Internet Explorer, on the Tools menu select Internet Options...

 Click the Content tab.

 Under Personal information, click AutoComplete.

 Select the check boxes for the AutoComplete options you want to use.
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Save a Web Page on Your Computer

To save a Web page on your computer through Internet Explorer, click the Page
button and then click Save As.

 Navigate to the folder you want to save the page in.

 In the File name box, type a name for the page.

 To save all of the information needed to display this page in a single file,
click Web Archive, single file, such as including graphics, frames and style
sheets select Web page.

To save just the current HTML page, click Web page HTML only. This option
saves the information on the Web page but it does not save the graphics, sounds
or other files. To save just the text from the current Web page click Text File. This
option saves the information on the Webpage in text format.

Make the Current Web Page Available Offline

When you make a Web page available offline, you can read its content when your
computer is not connected to the Internet. To make a Web page available offline
you need to use Opera browser and go to FileSave as and type a name you
want and save as a Web archive. To add the Web page you are currently viewing
to your Favorites list and then make it available for offline viewing follow these
steps in Internet Explorer:

 On the Favorites menu, click Add To Favorites.

 Click the Make Available Offline check box to select it, and then click OK.

To make an existing favorite Web page available for offline viewings follow
these steps in Internet Explorer:

 On the Favorites menu, click Organize Favorites.
 Click the Web page you want to make available Offline.
 Click the Make Available Offline check box to select it and then click

Close.

View Web Pages without being Connected to the Internet
After you mark your favorite pages for viewing Offline or you can view them
offline by following these steps:

 Before you disconnect from the Internet, on the Tools menu, click
Synchronize.

 When you are ready to work offline on the File menu click Work Offline.
The Internet Explorer will always start in Offline mode until you click Work
Offline again to clear the check mark.

 In your Favorites list, click the item you want to view without connecting to
the Internet.

Turn off Graphics to Display All Pages Faster
Turning off graphics to display all Web pages faster you need to perform the
following tasks:

 On the Tools menu, click Internet Options. . ..
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 In the Internet Options. . . dialog box, click the Advanced tab.
 Scroll down in the Settings list box to the Multimedia section.
 Deselect one or all of the Show Pictures, Play Animations, Play Videos or

Play Sounds checkboxes to improve page loading speed.
 Click the Apply button.
 Click the OK button.
 In the Internet Explorer window, navigate to the Web page to be displayed.

Now, you have seen the process to turn off graphics to display all Web pages
faster.

Create More Space for Temporary Internet Pages
To create more space for temporary Internet pages, you need to perform the
following tasks:

 Go to the Tools menu and then select the Internet Options. . ..
 Click the General tab. Look for the Temporary Internet files option and

then click the Settings button.
 Use the horizontal scrollbar under Amount of disk space to use option or

enter a value directly in the box to the right of the scrollbar, then click OK to
exit the Settings dialog box.

 Click the OK button.

Define the Terms: Web Site, Search Engine, Home Page, Offline
View, Web Links

 Web Site: A Web site also written Website or simply site is a collection of
related Web pages containing images, videos or other digital assets which
is hosted on at least one Web server, accessible via a network, such as the
Internet or a private local area network through an Internet address also
called URL.

 Search Engine: Search engine is designed to search for information on the
World Wide Web (WWW) and FTP servers and the information consists
of Web pages, images, information and other types of files.

 Home Page: Home page is known as the first page of the Web page
which keeps many hyperlinks on its page with the help of Web site hosting,
designing and coding of Web site, monitoring the performance of site and
checking the Web site traffic.
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 Offline View: A device that is offline meets none of these criteria, for
example its main power source is disconnected or turned off or it is off
power.

 Web Link: A Web link is a reference to a document that the reader can
directly follow or that is followed automatically which points to a whole
document or to a specific element within a document.

 ISP  or Internet Service Provider: A vendor, such as an ISP, local
telephone company that provides network services to subscribers.

 URL or Uniform Resource Locator: An address in a standard format that
locates files (resources) on the Internet and the Web. The type of resource
depends on the Internet application protocol. Using the World Wide Web’s
protocol, the HyperText Transfer Protocol (HTTP) , the resource can be an
HTML page (like the one you’re reading), an image file, a program such as a
Common Gateway Interface or CGI application or Java applet, or any other
file supported by HTTP. The URL contains the name of the protocol required
to access the resource, a domain name that identifies a specific computer on
the Internet, and a hierarchical description of a file location on the computer.

 TCP/IP:  Transmission Control Protocol/Internet Protocol, a communication
protocol, used for Internet access. It is used to allow different types of
computers to communicate over a network. TCP/IP is actually two protocols,
TCP and IP that together allow two or more computers to communicate.

5.2.1 Website

The Web can be understood as a collection of thousands of information locations
connected to each other. Each such location is called a Website and comprises of
multiple Web pages. A Web page is created using HTML and is like any other
computer document. It consists of text, pictures, sound, video and hyperlinks.
You can navigate from one Web page to another using hyperlinks. A Website can
be created by an individual or a company. Websites are hosted on the Web servers
which are accessible on the Internet. A URL defines the address of a Website and
is used to point to the homepage of the Website. A homepage is the first page that
is displayed when you access a Website. It serves as a reference point and contains
links to additional HTML pages or links to other Websites. The screen below
displays the homepage of the Website britannica.com that is displayed on typing
the URL ‘http://www.britannica.com’.

 

hyperlink  
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Uniform Resource Locator or URL

A URL defines the address of a site on the Internet. It defines the global addresses
of documents and other resources on WWW.

Typically, the first part of a URL indicates the protocol to be used, while the
second part specifies the domain name or IP address where the resource  is located.
Some examples of URLs are shown below:

URL Description

http://mysite.com/index.html Fetch a Web page (index.html) using the HTTP protocol

ftp://www.sharware/myzip.exe Fetch an executable file (myzip.exe) using FTP
protocol

5.2.2 Wi-Fi Technology

The Wireless Fidelity or Wi-Fi was used in public switched network which was
originally created by American Telephone & Telegraph or AT&T who used Bell
Laboratories standards to ensure that all central office switches and lines that
carried calls met these preset standards. The standards set by AT&T enabled
everyone to communicate with anyone else regardless of the service provider
since the dialingringing, routing and telephone numbering were all uniform.

Wi-Fi Security for Public Networks

For the fast connection and security point of view Wi-Fi is used for public networks.
It is used for wireless devices. The Wi-Fi Alliance represents the wireless standard
protocol and basically non profit organization.  This supports interoperability features
for wireless devices. It connects the networking system without cables. But for
this, Wi-Fi and regular ISP services are needed.  The manufacturers of Wi-Fi
Alliance build the various devices for 802.11 standards. Approximately 205
companies joined to the Wi-Fi Alliance and almost 900 products have been certified
to the interoperable system. These companies give assurance that the Wi-Fi devices
are connected by physical layer in reference models. Wi-Fi Protected Access
(WPA) solution is been added recently to the Wi-Fi standard. The physical and
access control layer implement the extra enhanced features, such as the Internet
security. The Wi-Fi has grown by leaps and bounds because it is connected via
spectrum. It uses unlicensed 24 GHz and 5 GHz bands. It provides data throughput
for most uses. The prime equipment required for Wi-Fi connection is Wi-Fi PC
card. It is a common way to connect the computer to the Internet without wires.
This card is technically known as Personal Computer Memory Card International
Association or PCMCIA. The two prime solutions are included by this device as
follows:

 You can work almost anywhere by mobile Wi-Fi device connected to the
Internet without wires, when away from your home or office.

 You can free yourself from the need to drill holes and wires by creating a
network at the home or office using Wi-Fi devices.
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Fig. 5.2 Wi-Fi Zone

A hotspot is used in Wi-Fi connection  means an area in which Wi-Fi users
connect to the Internet (Refer Figure 5.2). The three approaches  used to make
the searching information are as follows:

 You can use the search tool provided by organization. It branches are
hosted by Wi-Fi hotspots, such as Starbucks chain across the world.

 If you have signed with Wi-Fi provider, you can search via the Internet
Service Provider or ISP.

 You can search many cross provider directories that are available with
Web.

The Wi-Fi hotspots are created around the antennas to outlet the radio waves of
wireless networking.  It is confined to almost 10000 hotspots in crowded areas,
such as airport lounges, cafes, etc. A series of antennas are set up into the city
wide zones. The Internet connection is facilitated by Wi-Fi chips. The long calls
possible in Wi-Fi are bypassed network and VoIP (Voice Over Internet Protocol)
technologies. The Wi-Fi assembled mobiles and laptops are connected to these
hotspots frequently and the amount is paid after using this technology by credit
card on the login page provided by Web browser. Users can hold their accounts
provided by service providers, such as BT Openzone, SkypeZones, Nintendo
Wi-Fi, T-Mobile, O2, etc.

Internet
DSL

Cable etc

Modem

Router
Wi-Fi

Access
Point

Wired Network
Client

Wired Network
Client

Wi-Fi
Devices

Wi-Fi
Devices

Wireless

Fig. 5.3 Wi-Fi Network Setup
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In Figure 5.3, the Wi-Fi access point is interconnected with Wi-Fi devices that are
configured with router. Modem is also used to make connection between router
and the Internet DSL cable. The main role of router is to connect the Wi-Fi access
point and the wired network clients. The Voice over IP or VoIP software enables
data, fax calls and voice across IP networks and represents the Internet telephony
allowing a communication between two PCs over packet switching Internet. It
works by encoding voice information. Then it is changed to digital format. It provides
cost benefits by converging data and voice over IP network into the mobile phones.
Many of the latest mobiles are connected with Wi-Fi via VoIP technology. Between
the Internet connection and Wi-Fi access point, there needs to be a hardware
designed to connect with the Internet and share the Internetworking connectivity.
The following guidelines are required for connecting the Wi-Fi with public networks:

 The Wi-Fi Protected Access 2 or WPA2 encryption is required for the
communications.

 The shared keys and certificates are encrypted.

 The Service Set IDentification (SSID) should be used for broadcasting.

 The Media Access Control or MAC address authentication must be used
for specific system that accesses the Wi-Fi link.

 The infrastructure mode must be used for the Internet connectivity.

After getting the Wi-Fi connection, you can know about your shared WPA2
key, MAC address and SSID. The infrastructure mode is used to set the wireless
network card and firewall. The connection of the Internet via Wi-Fi involves the
following equipments:

 Wi-Fi device (the client).

 A Wi-Fi broadcast unit (the access point).

 Network connectivity hardware (router and modem).

 Fast Internet connection (usually via cable or DSL).

The Wi-Fi technology is best known for its fast connectivity and speed.
Figure 5.4 illustrates the various wireless standards along with their speed.
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The  methods used for Wi-Fi vulnerabilities are as follows:

 The Wi-Fi connection must be locked, if connection is not needed.

 The Wi-Fi connection must be secured with wireless firewall security.

 The Wi-Fi connection is restricted for preconfigured users for accessing
the Internet.

Check Your Progress

1. What is direct communication?

2. What do you mean by the World Wide Web (WWW)?

3. What do you understand by the Website and Wi-Fi?

5.3 E-MAIL

Outlook helps you to communicate and share information with people within and
outside your office through e-mail, phone support, fax and group scheduling.

You can do a lot of things through Outlook, such as:

 Exchange e-mails with other users on the Intranet and the Internet.

 List appointments and events, such as business meetings (whether one
time or recurring weekly or monthly). birthdays, business trips and
vacations, etc.

 View or manage an entire year of your calendar, a month, a week or a
single day at one time.

 Send and receive faxes by using the same dialog box as e-mails.

 Check whether your e-mail messages sent to other Outlook users have
been read or not.

 Conduct online voting for any decision and compile the votes cast by all
recipients.

 Manage the address book.

In addition to these features, Outlook provides several new tools for
enhancing your productivity.

1. Outlook Today: Displays new e-mails, schedules meetings and task lists,
all in one window.

2. Preview Pane: Displays e-mail messages in a pane at the bottom of the
window for quick prioritization.

3. Auto Preview: Lets you to view the first three lines of an e-mail message
without opening it.

4. Find and Organize Tools: Allow you to search for any e-mail message,
contact or task. The Organize tool provides easy access to various folders,
views and filters.
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5. AutoSave: Automatically saves unsent notes in a draft folder.

6. Junk E-Mail Filters: Help you to block spam mail.

Parts of an Outlook Window

Following are the parts of an Outlook Window:

1. Title Bar: This tells you which application package is currently running
and which option is currently open.

2. Menu Bar: This is the traditional Windows style drop-down menu. When
you point to any menu title and click once with the mouse, the menu opens,
displaying all the commands available under this menu title.  Alternatively,
this menu can also be activated by pressing the access keys from the
keyboard, e.g., press Alt + F to activate the File menu. You will notice that
the access key for each menu option is underlined, e.g., Alt+E for Edit
menu, Alt+V for View menu, and so on. Once a roll-down menu has been
activated, clicking on the desired command tells Outlook to execute that
command.  Some commands have ellipses (…) in front of them. This indicates
that these commands have further sub-commands. Commands appearing
dimmed cannot be executed unless the pre-requisite functions required by
that command have been performed. For example, you cannot use the
Copy or Cut command from the Edit menu unless you have selected a
piece of text first.  Many commands also have keyboard shortcuts specified
against their names.

3. Standard Toolbar: This contains buttons, drop-down menus and other
controls that help you quickly alter the appearance and arrangement of
documents by executing a variety of Outlook commands. Toolbars are very
helpful and convenient in quickly executing commands without having to go
through menus. The standard toolbar contains icons for basic functions,
such as opening new files, printing files, sending and receiving e-mails,
navigating the address book, etc.

4. Scroll Bar: This helps you to travel within Outlook. You can go anywhere,
up and down, right and left, in your Outlook screen mainly by two ways:
using the horizontal and vertical scroll bars with the help of a mouse or using
the keyboard by pressing PgUp, PgDn, Home, End and the arrow keys.

5. Shortcut Bar: This bar contains shortcuts to frequently used folders.

These parts of outlook windows have been shown in the screenshot.



Internet and
Cyber Security

NOTES

Self - Learning
Material 263

Starting Outlook

A Choose Microsoft Outlook from Microsoft Office from the All Programs
option of the Start menu.

Outlook’s opening screen will be displayed.

Explanation of Each and Every Folder in Outlook Express
Outlook’s address book enables you to maintain a comprehensive database of
your business and personal contacts. This address book can store up to three
postal addresses, three e-mail addresses and nineteen different telephone numbers
for each individual. It can be integrated with Microsoft Word so that you can
perform mail merge. You can use the address book to send Microsoft exchange
mails, Internet e-mails and faxes.

Adding Contacts

Contacts display is used to organize your contacts in a business card form. Only
the fields that contain information are visible. To change any information about a
contact, double-click the contact.

 Click on the Contacts button from the Outlook Shortcuts menu.
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 Click on the New icon from the formatting toolbar.

 Click on the Maximize button to maximize the window.

A Fill in all the details required here. You can fill as many as three business
telephone numbers and two home phones.

B You can click on the roll-down button next to each window to view the
various options regarding that particular field.

C Click on the Address button to get a Check Address dialog box for filling
address details.

 Click on the Save and Close icon to save the current contact and open a
new one.

 Click on the New option from the File menu to open a new contact.

As you can see, Microsoft Outlook can create contacts just like your address
book!
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Changing View

The information viewer shows all the contacts in the current view, i.e., Address
Cards view. Depending upon what information you wish to see, you can change
different views.

A

 Choose Phone List from the Current View option of the View menu.

A You would notice that all the companies are displayed along with their phone
numbers. You can also change the look of your address book and sort it on
the basis of category, company, location or by follow-up flag.

Similarly, you can change the view on the basis of company, category, location
or follow-up flag.

Finding a Contact

You can search for information about a person by searching on any field. If you
remember any detail about the person (e.g., first name, last name, city that he lives
in, or his company’s name), you can find out the rest of his details.

 Click on the Find icon on the Standard toolbar.

  

 Type the name, address or company name of the contact that you are
searching for in the Look for field.

 Click on the Find Now button to search for the contact.

A You will see that the contact you are looking for has been displayed.

Filtering Contacts

If you want to display only those contacts from your database which meet a
particular criterion, say all the people living in a certain city or all the people whose
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last name is ‘Sharma’, etc., use the Filtering Contacts option to get the desired
results.

You can also filter your address book so that it shows only a selected group
of contacts, e.g., contacts from Mumbai only.

 Choose the Customize Current View command from the Current
View option of the View menu.

 The View Summary dialog box will be displayed here. Click on the
Filter button.

 Click in the Search for Words column and type ‘Bangladesh’.
 Click on the In: option of the roll-down list and choose the Address

fields only option from the list.
 Click on OK to continue.

      

 Click on OK to filter the contacts.

     

A You will see the list of all the contacts belonging to Bangladesh.

Sorting Contacts

You can use this feature to sort your contacts database based on any category
(field). For instance, you can sort your database on the City field so that all the
people in a particular city are listed together.
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 Choose the Customize Current View command from the Current View
option of the View menu.

 The View Summary dialog box will be displayed. Click on the Sort button.

 Choose the First Name option from the Sort items by roll-down list.

 Click on the OK button.

 The message box will be displayed, stating that ‘Sort items by field is not
shown’. Click on Yes to display the field.

 Click on the OK button.

A You will see the contact details as shown in the screen.
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Understanding Outlook Express Toolbar

The toolbar in Outlook Express appears in the top of the screen, such as Create
mail, Send/Recv, Addresses, Find, etc.

Table 5.1 summarizes the toolbars available in Outlook Express.

Table 5.1 Toolbars Available in Outlook Express

Icons Function

Older New

Outlook Today (top level of the

mailbox).

Working offline (sample of Outlook

Bar and Folder list icons).

Mail Folders (old icons are from

Outlook Bar and Folder list).

Contacts Folders (old icons are from

Outlook Bar and Folder list).

Calendar Folders (old icons are from

Outlook Bar and Folder list).

Task Folders (old icons are from

Outlook Bar and Folder list).

Notes Folders (old icons are from

Outlook Bar and Folder list).

Folder List (button in Outlook 2003’s

Navigation bar).

Additional Mailboxes or Personal

Folder stores (old icons are from
Outlook Bar and Folder list).

Journal Folder (old icons are from

Outlook Bar and Folder list).
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Customizing Outlook Express Window Layout

It is very easy to add or remove icons on the Outlook Express toolbar as shown
in the screen.

The other screen shows how to get to the Customize option.

Right click to get the Customize and once the Customize button is checked
you will get the screen as shown here.

Composing E-Mail Message

Composing mail in Outlook Express is done by clicking on create mail button. It
provides the screen where you can compose an e-mail message. You need to
write e-mail address to whom you have to send the message.
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Inserting a File Attachment into an E-Mailing Message

Attachments can be sent and received with e-mails. These are files of different
types like text, audio, video, etc.

 

Attach Files

Browse  

Sending Attachments

To send an attachment, click on the Attachments button while composing a mail.
The screen as shown will be displayed which provides options to attach one or
more file(s).

Clicking the Browse button against the box provided to enter the filename
opens a standard file selection dialog box. This lets you to browse through the files
on your disk(s) and select the file you to wish to attach. Once you select the file to
attach, click the Open button. You can repeat this process if you wish to attach
more file(s). Once you are done with selecting all the files, click the ‘Attach Files’
button and then return to your message to proceed with sending the message with
the attached file(s).

Save a File Attachment

E-mail is an electronic medium in which message can be sent or received from one
user to another. The e-mail message is sent via Simple Mail Transfer Protocol or
SMTP server, but Internet Service Provider or ISP leads the main role to
correspond the e-mails across various users. For example, if you use Outlook
Express to send the message you need to type To:, Cc: and Subject: fields. A
small edit area is provided to write the message. After clicking on send button a
message comes that ‘Message has been sent’. You can insert attachment as files
and send them. You need to find the file which has to be attached.
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If you attach the file(s) it appears in the Attach: bar as file name and size,
for example here ‘Daily Bakckup.log’ file has been attached.

Inserting a File’s Text Contents into an E-Mail Message

To insert a file’s text contents into an e-mail message following steps are required:

 Click anywhere in the message Window.

 On the Insert menu, click File Attachment and then find the file you want
to attach which displays the file’ text contents into an e-mail.

 Select the file and then click Attach.

The file is listed in the Attach box in the message header. You can also add a text
(*.txt) file into the body of your e-mail message by clicking the Insert menu and
then clicking Text from File.

Inserting a Signature
The basic approach is to create your HTML e-mail as a separate HTML file and
then create a signature file and use your HTML e-mail as the signature file. Then
you open a new e-mail message and add the new signature file. This prevents
Outlook 2003 from helpfully converting all your precious HTML code into text.
Creating a signature file in Outlook Express is done in the following way:

 Select Tools from the top menus then Options then the Mail Format tab in
the Options popup that will appear.

 Down on the lower right of the Mail Format tab is a Signatures button.
Click that button and a Create Signature popup will appear.

 Click the New button on the Create Signature popup and a Create New
Signature popup appears. Give your new signature a name and select Use
this File as a Template and browse to your HTML e-mail.

Inserting Picture

Following steps are required to insert an image or picture in an e-mail with Outlook
Express:
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 Start with a message using HyperText Markup Language or HTML
formatting.

 Position the cursor where you want the image to appear.
 Select InsertPicture menu.
 Find and highlight the desired image. You can highlight multiple images or

pictures using the CTRL key and insert them all.

Inserting Web Address

Hypertext and image links may be created that will allow visitors to send you an
e-mail message. To create a hypertext link to your e-mail address, place the cursor
where you want the link to appear, then click Insert, Hyperlink. Type To: in the
Address field, followed by your e-mail address. Then select the image, click Insert
 Hyperlink . . .. Another way is to insert hyperlink is done by selecting the Web
address and then copy it. Paste the Web address in composing mail screen and
send to the recipient. ‘Address Book’ can be accessed by pressing ‘CTRL +
SHIFT +B’ key combination.

Creating and Using Address Book

The Address Book provides a convenient place to store contact information for
easy retrieval by programs, such as Microsoft Outlook Express. It also features
access to Internet directory services, which you can use to look up people and
businesses on the Internet. You will find that the following features which help you to
organize all your contact information into the most usable form for you. Creating an
Outlook Address Book outside of the Global Address List allows you to add people
who are not in the organization or on the same Exchange Server. To create Address
Book using the following steps:

 Click Account Settings from the Tools menu.

 Select the Address Book tab and click New.

 Select ‘New Contact . . .’.

 Click Next.

 Select the address book you want to create Outlook Address Book.

 Type name and e-mail information about the contact.

 Exit and Start Outlook to start using the new Address Book.

The easiest way to exchange contact information with people over the
Internet is by attaching a business card to e-mail messages. A business card is
your contact information of the Address Book is organized in vCard format. The
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vCard format can be used with a wide variety of digital devices and operating
systems. You must have your contact information in your Address Book before
you can create a business card. To create and use Address Book in the form of
business card, following steps are required:

 In the Address Book, create an entry for yourself, and then select your
name from the Address Book list.

 On the File menu, point to Export, and then click Business Card (vCard).
 Select a location in which to store the file and then click Save.

To add your business card to an e-mail message, on the Insert menu click
My Business Card.

The Address Book supports Lightweight Directory Access Protocol (LDAP)
for viewing Internet Directory Services.

Displaying Only Unread Messages

To display only unread messages in Outlook Express follow these steps:

 Open Outlook Express.

 Click on the View menu.

 Click on ‘Current View’.

 Click on ‘Hide Read Messages’.

You can accomplish the same if you have the View controls on the control area. If
the view controls menu is not on the tools area you can display it following these
steps:

 Open Outlook Express and Click on the View menu.

 Click on Layout.

 Check Views Bar.

 Click on Apply.

This should take you to the View menu unread message in your Outlook Express
control area.

Forwarding Your E-Mail to Another Account

To forward a message you need to select button as shown in the screen.

To forward an e-mail message to another account, following steps are required:

 Select the message you want to forward and then on the Message menu,
click Forward option or press (CTRL + F).
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 Type the e-mail name for each recipient. Separate each name with a comma
or a semicolon (;).

 Type your message, and then click Send on the toolbar.

If you have multiple e-mail accounts, click inside the From area and then
click the e-mail account you want to send the message with. If you are working
offline, the message will be saved in the Outbox. It will automatically be sent when
you go back online. If the Forward menu item or toolbar button is unavailable,
make sure you have downloaded the message body from the news or Internet
Message Access Protocol or IMAP server.

Printing an E-Mail Message

To print a message you need to select [CTRL+P] or File  Print . . . option.

Delete Message Permanently

Click an e-mail in your ‘Inbox’ that you want to delete. This highlights or selects
the e-mail.

 Hold down the ‘CTRL’ key on your keyboard while clicking any other e-
mails you want to delete. The e-mails will stay highlighted, or selected.

 Press Delete key on your keyboard. The selected e-mails will now be
deleted from your Inbox and moved to your Deleted items folder.

You can check the deleted item in the list as shown in the screen.

Creating Your Own E-Mail Folder

In the E-mail Accounts step, Outlook offers you the possibility to setup an e-mail
account right away. We choose to keep the default option, and click Next to
setup an e-mail account. You can always choose to skip this step and create an e-
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mail account later, by selecting ToolsE-Mail Accounts. Click Next to choose
the type of e-mail account you want to set up in Outlook 2003.

1. Once the configuration part has been set up then you need to right click the
folder where you want to create you new folder and choose New Folder.

2. Give the folder a name and click OK.

3. The folder appears as a subfolder of the Inbox.

Creating E-Mail Group

Open up your Outlook mail as usual. Click the little Address Book icon up along
the top toolbar:
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 On this pop-up window, click the New Entry icon.

 On the next window, select New Distribution List and then click OK.

 In the space provided at the top, give your group a name.

 If you type number ‘1’, for example 1parent list  then all e-mail groups
you create will be located at the very beginning of your list of contacts
(since 1 is alphabetized first before any letters).

 Then, click either the Select Members... button.

 Select Add  New button (if you are hand typing in e-mail addresses).
When done entering, click Save and Close.

Controlling Which Message Outlook Express Downloads from Your
E-Mail Server

When you use Outlook Express to retrieve your e-mail, it downloads the messages
from the server to your computer. E-mail will automatically download when you
launch the program, and at intervals when the program is open. If you are expecting
a message, you can manually download new e-mail without waiting for Outlook
Express to automatically check the server. Launch Outlook Express which will
automatically check for new e-mails. Following steps are required to control which
message Outlook Express downloads from your e-mail server:

 Click ‘Send/Receive’ to manually check your mail server for new e-mails.
If an e-mail has arrived since the last time Outlook Express checked, this
will download the new message to your Inbox.

 Click your Inbox. If you have new messages, they will be highlighted.

Replying to an E-Mail Message

Outlook Express is a central repository for all your electronic messages. You
can send e-mails, faxes, meeting requests and task assignments.

 Click on the New button on the Standard toolbar to write a new message.

 Type the recipient’s e-mail address in the To: field.

 Type the subject of the e-mail in the Subject: field.

 Type your letter in the space given here as shown in the screen.
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 In case you want to send the same mail to many people, you can use the
(carbon copy) Cc: and the Bcc: options (Once you click on the Cc: option
you will be able to see the Bcc: field too).

A You will see that the e-mail addresses of the people you wish to send e-
mails to are listed in the Cc: and Bcc: columns.

 Type in the e-mail addresses of the people you want to send multiple copies
to.

 Click on OK once.
 To attach a file with this e-mail, simply click on the Insert File icon.
 Select the directory where your file is stored.
 Click and select the file you want to attach.

Click on Insert once.
B The file you have selected is attached along with this e-mail.

Click on the Send button once.
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C Click on the Outbox Shortcuts button and you can see that your e-mail has
been stored here.

Click on the Send/Receive button to connect to the Internet from the
Standard toolbar and it will send all your e-mails (lying in Outbox) and
receive your e-mails (if any).

D The screen as shown will be displayed.

    

Message lying in the Outbox are sent to all the recipients.

Finding a Specific E-Mail Message

To find a specific e-mail message, you need to select Find button . You

need to fill all the fields which display the specific e-mail as shown in the screen.

Stopping a Receive Operation

To stop a receive operation, following steps are required:

 Open Outlook and select ToolsOptions.

 Select General tab, if you want to disable automatic sending of messages.
Uncheck the box next to ‘Send and receive messages at startup’ as
shown in the given screen. This will disable automatic sending of messages.

 Select Apply button to view the effect.
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Using E-Mail Stationery

If you use HTML as your message format or if you use Word as your message
editor, you can use stationery to enhance your message. Stationery is a preformatted
theme. Selecting a stationery lead to show how fonts, bullets and horizontal lines
are displayed within you e-mail message and it is helpful when sending newsletter
or invitations for a personal activity, such as a birthday celebration. You can use
the Stationery Wizard to create new looks for your e-mail and newsgroup messages.
To create stationery for outgoing messages, following steps are required:

 You can use the Stationery Wizard to create new looks for your e-mail and
newsgroup messages.

 On the Tools menu, click Options ..., and then click the Compose tab.

 In the Stationery area, click Create New ....

To use stationery you see in a message from someone else, select the message
and then on the File menu, click Save as Stationery. A stationery file is an HTML
file and can be edited in Outlook Express. In a new message window, on the View
menu, click Source Edit, and then click the Source tab to make changes. When
creating your stationery, try to keep the file size smaller than 10 KB. Pictures and
other objects can make the file too large to be easily downloaded.

Check Your Progress

4. What are the new tools of Outlook which enhance the productivity?

5. What is standard toolbar?

6. What do you mean by the term scroll bar?

5.4 SOCIAL NETWORKING ETHICS AND
MAKING SECURED ONLINE
TRANSACTIONS

Ethics are a set of moral values that control any human being or a group on what
is suitable manners while using a online computer. Computer ethics is a set of
moral values that control the usage of computers. One of the common issues of
computer ethics is breaking of copyright issues. Recreating copyrighted material
without the author’s permission, accessing personal information of others are some
of the examples that breaks ethical values.

Internet ethics means “Acceptable Behaviour” while using Internet. We should
be honest, respect the others persons and community, respect rights and property
of others on the Internet. The common ethics which we follow on Internet are
categorized in different points.

 Respect the privacy of others

 Respect the copyright and stop plagiarism

 Respect the integrity of computer software
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 Do not support piracy

 Respect the intellectual work of other

 Acceptance

Respect the Privacy of Others

Internet is mode of communication with our friends and family. We should respect
the privacy of others. We should not post any photograph or personal comment
about any particular person without the permission. If we post the pictures, which
are edited with some photo editor and someone got hurt by that picture then the
case comes under cyber crime. We have give special attention while writing any
comment and posting any picture of our friend and family member on social
networking. Every person is having right to privacy so do not violate the privacy
rule.

Respect the Copyright and Stop Plagiarism

Copyright is a right given by the law to creators of literary, dramatic, musical and
artistic works and producers of cinematograph films and sound recordings. In
fact, it is a bundle of rights including, inter alia, rights of reproduction,
communication to the public, adaptation and translation of the work. There could
be slight variations in the composition of the rights depending on the work. 

There is a lack of awareness on various issues relating to copyright and
related rights amongst the users like stakeholders, enforcement agencies,
professional users like the scientific and academic communities and members of
the public. Copyright is an act related with intellectual rights. We should not copy
anyone material without the permission to reproduce. Never copy any ones idea
related to any field like music, movies, text, art work etc without permission.
When we copy the content then it is known as plagiarism. We should stop
plagiarism and never copy anyone idea and software.

Respect Integrity of Computer Software

Never use or develop the program or software which cause any type of damage
to computer or any other software. Never try to hack the information from any
ones computer. If we do this then it again comes under cyber crime. Do not use
your knowledge for destruction, use it for constructive work. Instead of hackers,
be crackers. Do not develop any virus or ransom ware which cause any to our
society. Internet was developed for the welfare of society so please do not harm
the society and always follow ethics or netiquette on Internet.

Do Not Support Piracy

Many persons uses Internet. It is a way to stay connected with current news,
research information or shop online and downloading books, online applications
etc. Do not copy or download any software, movie, song, games etc without the
licence. If you want to download the software, go for freeware. There are many
software which are available free of cost like open office.org, tux, Linux, Adobe
Reader, Team viewer, Filzip, Pixia, Winamp, Google chrome, etc. So always
download the licensed version or the freeware to stop piracy. Piracy decrease the
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growth in society. Freeware are the software which are available free of cost or
without paying any cost to developer or company.

Respect the Intellectual Work of Other

Never copy someone’s idea or work and give your name. We must respect the
intellectual work. Do not copy some ones project and give your name. Remember
original work gives satisfaction and happiness. Always respect the original work.
Never take the credit someone else work.

Acceptance

Internet is a place where we are interacting with world, so our behaviour on Internet
should be accepted by all. Our behaviour on Internet should be value based. We
should not hurt someone. We should not tease anyone on the platform like Internet.
We should not pass any comment which shows any type of controversy. Internet
is platform which should be value based. World Wide Web (WWW) is a place
where values are considered in the world wide platform. We must shape our content
for universal society.

Risk Factors Involve in the Internet

Using an Internet is easy but it involve many risk factors. There are some risk
factors or hidden danger involve in browsing. These dangers can include data
leaking (sensitive personal information exposure), get infection by malware (virus,
spyware, adware, ransom ware). We must be aware of these threats for safe
browsing. We must take some precautions while surfing on Internet. Precaution is
always better than cure. For safe browsing we can follow some common rules,
listed as follows:

 Always install Antivirus software on your computer and maintain it updated.

 Frequently update the browser.

 Install and maintain the firewall on our computer.

 Often change your password and never save it on computer.

 Password must contain combination of small letters, capital letters, numbers
and symbol. It should be any pet name, date of birth, name of family member.

 Be alert of unusual behaviour of your computer.

 Never open the attachments which are sent by unknowns.

 Do not open link send via mail or message.

 Never use important documents like credit card, debit card on public
computer.

 Never use free or unsecured Wi-Fi for online shopping and banking
transactions.

 Never use your official e-mail on social networking sites.

 Never respond to pop-up advertisement which comes up to your screen.
Close such pop-ups from task manager or block the pop-up from browser
settings.
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 Avoid checking “Keep me logged in”, “Remember me”, “Save Password”
on browser.

 Never keep the same password for different accounts.

 Delete old accounts that you do not use anymore.

 Always Access your bank website by manually typing its URL is the address
bar. Never access it from text message or e-mail.

 If the website is secure and trusted than, https is displayed with green colour
and if the site is not safe, it will be displayed with red colour.

 Take the regular backup of your important files. This backup is important
because of recent ransom ware attacks. It is always beneficial to take the
backup of your important files. Use external hard disk for backups. We can
also use trusted cloud based backup service for backup.

It only takes a little effort, alertness, few tools, and some basic information
to be safe on Internet. Follow the rules for safe browsing and protect your personal
information and your computer online from attackers, hackers and other malware.

Cyber Security

To be safe on Internet is every ones responsibility. Internet safety is a lot more than
just about ensuring that your computer has the latest anti-virus and firewall software
installed. It’s about being smart about how you handle yourself online and sense
about how you deal with other people(especially strangers who you meet online),
and not falling prey to an online scam artist who takes advantage of your ignorance.
Some of major factors concern with cyber security are:

 Identity Theft

Identity theft is one of the fastest growing problem which is effecting millions
of us in world which requires immediate attention. It is essential that every
individual is fully aware of identity theft. Personal Identity is the information
which includes Name, Phone Number, Email-ID, DOB, Address, Identity
card number, PAN number, Aadhaar card Number, Voter ID, Credit/Debit
card details, Mediclaim Number, Passport details, Travel details, Fingerprints,
Voice sample etc. Identity Theft is illegal use of another person’s personal
identity information like name, address etc., as well as financial information
like credit/debit card details in order to make purchases or borrow money,
open a new account or commit a crime without that person’s permission.
This personal information can be theft due to lucky draw coupons, malwares
attacks, online shopping, shopping malls insist you to give your phone number
for adding add on points for next shopping, due to the weak password,
cash prizes, lottery games etc. Your personal information can be used for
any type of crime like obtaining fake license, obtain medical benefits, make
fake phone calls, purchase sim card on your name, fraud, crime, open bank
account, taking loans etc. Always beware of identity theft.

 Cyber Bullying

One of the Internet danger is Cyber bullying. That’s why it’s important to
be aware of what children see and hear on the Internet, who they meet, and
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what they share about themselves online. Cyberbullying is bullying that take
place using electronic gadgets. It can be carried out through electronic
technology includes devices and equipment such as mobiles, tablets and
computers and also on communication tools including social media sites,
text messages, e-mail, chat rooms, discussion groups and websites on
Internet. Cyber bullying can include teasing and being made fun of, spreading
rumours online, sending unwanted messages and insult others on public
place. It includes harassment, uploading of edited image, sharing someone’s
secret, blackmailing the victim, use of harsh language for some other person,
making fun of friends in a group comes under cyber bullying.

 Online Gaming Safety

Online Gaming is a fun and entertainment way to spend time, encouraging
teamwork and developing skills. Online gaming world is just like as a virtual
playground. Now a days online games are very popular among children.
They play these games online and by using headphones, webcams and
interact with millions to play games. Children involvement in these games
should be limited by their parents. They take online challenges, dare to do
the any task given by group and complete the challenge at any cost. They
become so much involved in games and want to stay in virtual world and
get isolated from their family members and start doing all the challenges
given by gamer and getting depressed. Their main motto is to complete the
online games. Beware of the latest online gaming challenges and never use
webcam and headphones for playing games.

 Secure Cashless Transactions

For secure cashless transaction, we must keep remembering some points in
our mind.

o Before ATM, please ensure that there are no strange objects in the
insertion panel of the ATM

o Destroy the transaction receipts securely after reviewing.

o Change ATM PIN on a regular basis.

o Keep a close eye on bank statements.

o Destroy anything that contains credit card number written on it, like
bills, receipts etc.

o Notify credit/debit card issuers in advance for change of address.

o Do not accept the card received directly from bank in case if it is damaged
or seal is open.

o Do not disclose Credit Card Number/ATM PIN to anyone.

o Do not hand over the card to anyone, even if he/she claims to represent
the bank.

o Do not get carried away by strangers who try to help you use the ATMs
machine.
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 Online Scams

Online scam is an attempt to trap you for obtaining money. There are many
types of online scams, this includes obtaining money with fake names, fake
photos, fake e-mails, forged documents, fake job offers and many
more.Generally, and it happens by sending fake e-Mails for your personal
details like online banking details, credit card details. Sometimes e-Mails
are sent from lottery companies with fake notice, whenever you participate
in online auction and e-Mails received for fake gifts.

Online scam can be

o Lottery scam

o Phishing scam

o Email scam

o Online auction scam

o Fraud online income tax refund

Tips to protect ourselves from online scams

o Confirm whether e-mail is received from bank or not

o Be cautious while providing bank details online, before proceeding further
confirm with the bank about the e-mail you received.

o Be cautious during online auction

o Don’t be trapped with discounts and think wisely before you proceed
with online auction.

o Be aware about the product you received via e-mail

o Don’t be trapped by lottery scam

o Don’t get trapped by scammers and e-Mails with a subject line you
won some 1000000 just think why only you received the e-mail without
your participation.

Cyber Ethics: Netiquette

Netiquette is a word formed by two words Net and etiquette. As the name suggest
these are the common etiquette followed on Internet while communicating. There
are some common netiquettes which must be followed while communication on
Internet.

 Respect Privacy of Others

Do not share the personal information of others with any stranger or do not
pass on the personal information to any other outsource.

 Stop Piracy

Do not copy or download any pirated software or movies from
unauthenticated websites. Please pay for it and get your original version
and respect the author. Piracy is a kind of cyber stealing.
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 Respect Copyright Rule

Many things are available on Internet. To copy form Internet is very easy. If
you copied any copyrighted material and use it for professional and
commercial purpose and it’s a offense or crime. Please do not break
copyright rule .We must get permission of author before using the material
or mention the author name.

 Use of Respectful Language

Do not be rude, harsh and aggressive on Internet. Do not pass the statement
which may hurt any individual or community. Always use graceful language
online.

Netiquettes of E-Mail

 Use Subject Lines Very Clearly

Subject line must be short and easily identify the purpose of mail.

Use some words like

RE: For response to e-mail

URGENT: For urgent e-mail

REQ: For request e-mail

 Compose E-Mail

The text used in e-mail should be short, point to point, and in easy language.

 Line Breaks Must be Used

Line must be break as per as the window size or after 60- 70 characters.
Each point should be mentioned in new line.

 Check Spellings

Always check spellings before sending mails. It gives bad impression on
receiver.

 Use of Capital and Small Letters

Use sentence case in e-mails. It is considered harsh to write e-mail in all
capital letters. It gives the emotion of shouting on others. Important points
can be highlighted with capital or bold.

 Use of BCC Feature

When you want to send the message to many receivers then instead of
using TO: head, use BCC (Blind Carbon Copy). BCC function in the
e-mail program, to make sure that the recipients do not know who else
received the message.

 Give Proper Names to Attachments

When are attaching files the name of the file must be relevant to subject. As
the receiver is going to download the file and in future, the file must be easily
identified by logical names. Attachments must be under the size limit, of the
size exceed then upload the file on cloud drive.
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 Auto Responders Must be Used

Using Auto responders to handle the most frequently requested information
people ask from you is a great way to more fully automate the online efforts.
This feature is also very useful when we are going for long vacation or in the
case of medical urgencies.

Netiquettes of Social Networking

 Do Not Accept Strangers Friend Request

Sometimes teenagers and youngsters are having more fascination about the
social networking. They got many friend request by unknown. Youngsters
are attracted to the profile photo, which may be fake. Think before becoming
friend of stranger and do not go anywhere to meet the strange friend. If
some friend is continuously posting something wrong about you, you can
use report abuse feature or unfriend that friend.

 Status

Status updating is becoming fashion among people. Generally they upload
the status as “I am watching movie at ……” may be this status is giving
invitation to any type of crime like kidnapping, stealing etc. because we
only inform the criminal about our current position.

If you update he status, that “Going for family vacation for 5 days”, criminal
who is your strange friend get chance to do theft at your home. So please
beware of such status. Social networking must be used in limited time.

 Commenting On Posts

Do not pass the comment which can embrace or hurt anyone’s feelings.

 Do Not Post Photos of Others

We must not post photos of others without their consent.

 Use Help of Web Site

Help is given with every Web site for secure and safe browsing. Settings
option is very useful for our security on social networking.

 Report Abuse

Every Web site is having the feature REPORT ABUSE. It can be used in
the case of objectionable material or post.

Controversial Material

Internet also contains controversial material which is dangerous for human being.
It contains the information related to sex, terrorism, pornography, religious sensitive
issues etc. Internet censorship is a kind of board who restrict the information up to
some level.

After the terrorist attack in Mumbai (November 2008), the Indian Parliament
passed amendments to the Information Technology Act (ITA) that expanded the
government’s censorship and monitoring capabilities. In 2009, the Supreme Court
ruled that bloggers and moderators can face libel suits and even criminal prosecution
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for comments posted on their Web sites. In July 2006, the Indian government
ordered the blocking of 17 Web sites, including some hosted on the Blogspot,
Typepad, Geocities. The “IT Rules 2011” were adopted in April 2011 as a
supplement to the 2000 Information Technology Act (ITA). The new rules require
Internet companies to remove within 36 hours of being notified by the authorities
any content that is deemed objectionable, particularly if its nature is “defamatory,”
“hateful”, “harmful to minors”, or “infringes copyright”.

Pornography is a major concern for censorship. Both public and private
interest groups have shown great concern for the content of material available via
the Internet. This material is dangerous for our society and children. This comes
under the cybercrime and should be banned 100%. Paretal control over the child
while using Internet is most important. Teach your child to identify right and wrong.
Online games are also come under censorship. Children are gaining more access
to the Internet and there are some problems that need to be considered, such as
the “Risk that a child may be exposed to inappropriate material of a sexual or
violent nature.” Research are going on for censoring the pornography. By blocking
some common sites we can keep our children from watching and involving in such
sites.

Concerning about Internet censorship and controversial material on Internet
is a topic which is not having any clear cut solution and research are going on how
to stop this controversial material on the Internet and how to make Internet free of
cybercrime and any objectionable material which is dangerous of our society.
Some websites are banned and blocked under the Internet censorship.

Internet Censorship is a control or restriction over the Web sites for
spreading controversial material over the Internet. The Internet censorship is varies
from country to country. Democratic countries have moderate censorship. Some
population is in support of the Internet censorship and some are in opposition.

Check Your Progress

7. Define the term acceptance?

8. What do you mean by cyber security?

9.  List the netiquettes of E-mail.  

5.5 TYPES OF VIRUSES AND ANTIVIRUSES

A computer virus is a set of executable code that attaches itself to other programs
to replicate itself without the awareness of a system user. These computer viruses
can damage the system of a computer. The various types of computer viruses are
boot sector virus, parasitic virus, multi-partite virus, companion virus, link virus
and macro virus.  Every virus first occupies disk space in main memory by using
and effecting CPU processing time. Viruses are frequently transmitted through
e-mail attachments, peer-to-peer downloads, phishing (a fraudulent process to
get user’s credentials) and instant messages. Among these, e-mail attachments
carry and spread virus fast in an address book or a random combination of address
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book. If these viruses are not controlled quickly, the servers can disrupt the e-mail
services for all systems. The following Table 5.2 shows the types of computer
viruses and the years of their emergence:

Table 5.2  List of Top Ten Viruses

Computer Viruses Year 
Brain 1986 
Michelangelo  1991 
Mellisa 1999 
I Love You  2000 
Code Red 2001 
Nimba 2001 
Klez 2001 
Slammer 2003 
My Doom 2004 
Storm  2007 

The lifecycle of computer virus is as follows:

Coding ’ In this phase, the virus program is coded and developed.

Releasing ’ Once the code is ready, it is spread to the system and
network.

Spreading ’ It is out forwarded through a simple e-mail.

Quarantining ’ In this phase, the virus gets quarantined. This phase
often happens when it validates the signature of the virus and develops an antivirus
update.

According to their location, viruses can be of two types: non-resident virus
and resident virus. The non-resident virus looks for other sources to infect and
transfer control to the host program, whereas the resident virus looks new host if
the infected files are accessed by other programs. Floppy disk is referred as the
the ‘Main Spreading Factor’ of computer virus.

 
 

Steps to Control and Check Viruses

The following steps are required to control viruses:

 Keep virus definitions update

 Get a sound knowledge of antivirus program subscription

 Restrict to open or execute the unexpected attachments

 Turn off the preview features in the computer program for added protection
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 Turn off .vbs (Visual Basic Script) function

 Check out sincerely the extension of file attachment

 Donot use pirated system and application software

 Secure your system with latest antivirus

 Scan your system regularly

 Update your antivirus software

Computer viruses hoax the whole system if the particular system is defectively
infected with viruses. They generate unnecessary network traffic and can cause
damage by instructing the users to delete system files.

E-Mail Viruses

E-mail viruses are spread through sending e-mail. For example, the Mellisa virus
was being spread in MS Word document via e-mail. Anyone who downloads and
opens the document can get infected with this virus. This virus contains a friendly
note including person’s name and other details so that users would think that it
asks really his/her personal details. After entering the required information, the
virus creates 50 new mails from the recipient’s device. It is the fastest spreading
virus that forces many of big organizations to close their e-mail systems. The ‘I
Love You’ virus, that appeared on May 2000, contains a part of code as an e-
mail attachment. After clicking the attachment, it first launches the code and then
sends the copy to other’s address book and starts corrupting files on other’s
systems. It is more dangerous than Trojan horse virus distributed via e-mail.

Macro Viruses

A Macro virus is written in a macro language (Refer Figure 5.5). Macro viruses
are spread by various applications which use and run created macros, for example,
a word processor allows macro programs to be embedded in documents so that
the program can run automatically when the word document is opened. Along
with the embedded macro program the macro virus also get initialized and damages
the system files. The macro virus is specific to Word 6.0, WordBasic and Excel. A
‘CAP’ macro virus infects macros in the Word application attached to Word 6.0
for Windows, Word 6.0.1 for Windows Macintosh and Word for 95 Windows. A
‘Concept’ virus only spreads after opening a document containing the virus. Modern
antivirus software detects macro viruses as well as other types. (Source Wikipedia)

 

Fig. 5.5  Macro Virus
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Fig. 5.6  Growth of Macro Virus from July 1995 to May 1997

Trojan Virus

A Trojan Horse is a virus program and internally works something else then what
is specified by the user. The Trojan Horses are generally enclosed so that they
appear attractive, for example a saxophone.wav file is a virus file which draws
the attention of a system user interested in collecting sound samples of musical
instruments. A Trojan Horse is different form other destructive virus because they
does not reproduce. It steals the passwords and sends an E-mail to the hacker’s
false name and then the hacker has all your description in his hands.

Signs of Virus

Any odd behaviour of computer system can not be directly related to computer
virus, because many operating systems and programs also behave in strange
manner. When you run antivirus program in such cases, it will not detect any virus.

The indication of virus sometimes can be seen as unusual screen displays or
messages. A virus can slow down the function of the computer. Even longer disk
activity, or strange hardware behaviour can be caused by legitimate software,
harmless ‘prank’ programs or by hardware faults.  A virus may cause a drive to be
accessed surprisingly and the drive light to go on. The basic dependable indicator
of a virus infection is a alteration in the length of executable (*.com/*.exe) files, a
modification in their content or a change in their file date/time in the Directory
listing. Some viruses can hide the changes they have made to files, especially if
they are active in RAM memory. Another important indication of a virus infection
is modification and replacement of system resources. 

Antivirus Software

There are three different classes of anti-virus packages namely activity
monitors, authentication or change-detection software and scanners. Each type
has its own advantages and disadvantages or weaknesses. There are many good
antivirus programs. The most popularly known are Data Fellows F-Prot, EliaShim
ViruSafe, ESaSS ThunderBYTE, IBM AntiVirus, McAfee Scan, Microsoft Anti-
Virus, Symantec Norton AntiVirus and S&S Dr Solomon’s AVTK. Scanning of
hard drives and disks should be performed on a regular basis.
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Check Your Progress

10. List some steps used to control the viruses.

11. What do you understand by Trojan virus?

5.6 COMPUTER SECURITY ISSUES AND ITS
PROTECTION

Network security is a broad topic with a multi-layered approach. It can be
addressed at the data link, network and the application layers. The issues concerned
are packet intrusion and encryption, IP packets and routing tables with their update
versions, and host-level bugs that occur at the data link, network and the application
layers respectively.

TCP/IP protocols are used globally irrespective of the nature of the
organizations, whether they are general category organizations or security-specific
sensitive organizations. The news or information about hacking of websites or
portals by undesired people is very common nowadays. This shows that the TCP/
IP protocols are susceptible to interception. This generates a need to ensure all
round security for the network in an organization. The tasks of the network
administrator have to be widened to include the overall security of the network.
He has to ensure that all parts of this network are adequately protected and
adequate measures of security have been implemented within a TCP/IP network.
He should be aware of an effective security policy. He should also be able to
pinpoint the main areas of risk that the network may face. These main areas of risk
vary from network to network depending upon the functioning of the organization.
There are, therefore, various security-related aspects which have direct implications
for the network administrator alongwith the means to monitor the implemented
measures of security effectively and to tackle the problem of breach of security if
it happens.

Basic Requirements of Network Security
The main objective of the network is to share information amongst its users situated
locally or remotely. Therefore, it is possible that undesired users can hack the
network and prove to be harmful for the health of the network or the user. The
network administrator must follow the following points to provide the network
adequate security other than network-specific security as in the case of e-commerce,
etc.

 Networks are designed to share information. Therefore, the network must
be clearly configured to identify the shareable information and non-shareable
information.

 The network should also clearly specify with whom the shareable information
could be shared.

 An increase in the system security means a corresponding increase in the
costs to the management. Therefore a compromising level between security
and prices should be established as per the requirements of the network
security system policy. This will largely depend upon the level of security
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needed for the network, the overall security requirements and the effective
implementa-tion of the chosen level of security.

 Division of the responsibilities concerning the network’s security must be
clearly defined between the users and the system administrator.

 The requirements for security must be detailed within a network security
policy of the organization that indicates the valuable data and their associated
cost to the business.

 After defining the detailed network security policy and clearly identifying his
responsibilities in the organization, the system administrator should be made
responsible for ensuring that the security policy is effectively applied to the
company environment, including the existing networking infrastructure.

Levels of Security
The US Department of Defense has listed different steps in the evolution of security
levels. The first step in this direction was the trusted computer system evaluation
criteria in December 1985, popularly termed as the Orange Book. In continuation
with this level, another security level known as the trusted network interpretation
of the trusted computer system evaluation criteria or the Red Book was described
in July 1987. These security levels contain the security-related problems in the
component or the modular form. Each level contains the specific security problem
which is broken down into different divisions. Each of the divisions or classifications
represents a security level defined in terms of the following general categories:

 User identification and authentication.

 The capability to monitor and audit system activity.

 Provision of discretionary access.

 Control of the reuse of resources.

 Identifying specific areas of possible attack.

 Provision of suitable counter measures.

 The level of system trusts, including systems architecture, design,
implementation, transport, and trust of other hosts.

Data Security
Data security is concerned with the protection of data contained in a file or many files
in a computer either as a standalone or on a network, from unauthorized interception.

In case of a postal system, a postcard as a carrier of information is open to all.
It does not have any sort of security measures. An envelope is used to hide information
from other people. An envelope acts as a means for security. Therefore, postcard
and envelope have different purposes with respect to security. These two particular
cases initiated similar actions to solve the security-related issues in case of data
communication. E-mails are open to all as post cards. Following the envelope example
in the postal system will enable users to secure at least some of their data.

The access protection provided by log on passwords is not a foolproof
system and these may easily be bypassed. The bypassing can be done by booting
from a diskette or connecting the stolen hard drive as a secondary one to another
computer. In this manner, any vital data might easily be accessed. Consequently,
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encryption of the information seems to be the only effective way to protect data
from being intercepted by unauthorized persons. The encryption must be developed
to ensure reliable data security and that data is not decrypted without the right
password or the right user. The main drawback of the password-based encryption
includes the loss of password or registration of wrong passwords due to wrong
spelling or some other human mistakes. In this case, it becomes impossible to
restore the data. There are other rules to avoid in such situations.

The invalid access to the host can be prevented to a certain extent in the
case of conventional host-to-terminal as the number of terminals connected is
limited. The situation is entirely different in the case of Internet where access is
allowed from any terminal connecting on a network. Therefore, this requires proper
security measures. The following are the three types of security measures:

 Invalid Access/Possibility of Eavesdropping
 Firewall Security
 Encryption (VPN Function)

Basic Techniques
Figure 5.7 shows a LAN connected to the Internet to allow access to the outside
world. The terminals connected to the Internet have access to many servers to
obtain a variety of information bases. But it also provides an opportunity to the
undesirable person to execute commands on the servers and other computers.
Thus, allowing users or terminals to access the server or other computers through
websites to obtain desired information may create a number of problems. These
problems can be as follows:

 Hackers may access someone else’s computer and servers without valid
authentication to steal the information not meant for general purpose. The
confidential information may reach wrong hands. Hacking shows that there
is a security lapse in the particular system or network and the system or
network is unstable and prone to tampering.

 Hacking may also lead to interception of the information from the network,
which is lacking in security measures. The information may be tampered or
altered from the actual contents.

Authentication
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Fig. 5.7 Unauthorized Access to LAN and Eavesdropping
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Firewalls

The Internet provides a two-way flow of traffic that may be undesirable in many
organizations where some information is needed exclusively for the organization
or for the Intranet. The Intranet is a TCP/IP network that is modelled after the
Internet that only works within the organization. In order to delineate information
meant only for the benefit of the organization or its Intranet and the other open to
all or meant for the Internet, some sort of security measures are needed to control
the two-way flow of traffic. A measure known as firewall is used for this purpose.

A firewall is a combination of software and hardware components that
controls the traffic between a secure network (usually an office LAN) and an
insecure network (usually the Internet), using rules defined by the system
administrator. The firewall sits at the gateway of a network or sits at a connection
between the two networks, and the entire traffic between two or more networks
has to traverse the firewall. The firewall stops or allows the traffic based on the
security policy as defined in rules’ table.

The secure trusted network is said to be ‘inside’ the firewall. The insecure
untrusted network is said to be ‘outside’ the firewall. The firewall’s architecture
has to be such that it would permit a certain amount of traffic to get through,
otherwise it would be more of a ‘stonewall’, preventing access to the Internet, or
sending of e-mails or any other information from either side of the firewall, thus
turning into a self-defeating exercise.

The fact that it allows some traffic through provides a channel that could
potentially be exploited, and could carry viruses.

However, principally, the philosophy behind firewall is:
 It exists to block traffic.
 It exists to permit traffic.

In brief, the basic aim of firewall is to provide only one entrance and exit to
the network. There are two firewalls. One blocks the undesirable traffic, while the
other allows traffic.

Network Architecture of a Firewall

The most important aspect of a firewall is that it is at the entry point of the networked
system it protects. This means that the firewall is the first program that receives
and handles incoming network traffic, and it is the last to handle outgoing traffic.

The logic is simple – a firewall must be positioned in a network to control all
incoming and outgoing traffic. The internal network also needs to be structured
and configured in such a way as to implement security policy of firewall to protect
specific services running on the systems. The following are some examples of
network structure to protect it from external threats using a firewall.

1. A router on dedicated connections to the Internet can be plugged into
the firewall system as shown in Figure 5.8. This can also be provided
with the help of a hub for full access servers outside the firewall as
shown in Figure 5.9.
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Fig. 5.8 Router Connected to Firewalls on a Dedicated Connection
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Fig. 5.9 LAN Hub Connected to Firewalls

2. The router can be configured with some filtering rules. However, this
router may be owned by ISP, therefore, ISP may be asked to put all
desired control.

3. In a dial-up service like an ISDN line, a third network card is used to
provide a filtered DMZ. This gives full control over the Internet services
and still separates them from the regular network.

4. A proxy server can be used to monitor the traffic on the network and
allow the users a limited number of services or some unwanted services
may be blocked. This can be integrated with the firewall as shown in
Figure 5.10.

Internet
Proxy

Firewall

LAN
Hub

Internal Clients

Fig. 5.10 Proxy Server Connected with Firewall

5. A proxy server on an organization’s LAN connected with the firewall
should have rules to only allow the proxy server to connect to the
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Internet for the services it is providing. This way the users can get to
the Internet only through the proxy as shown in Figure 5.11.

Internet
Firewall
System

LAN
Hub

Internal Workstations

Proxy Server

Fig. 5.11 LAN Connected to the Internet via Proxy

Data Encryption

Encryption hides your data from curious eyes. This is a method of encoding data
to prevent unauthorized persons from viewing or modifying it. The main features
of data encryption are:

 Prevents unwanted access to documents and e-mail messages.

 Even the strongest levels of encryption are very difficult to break.

Processes and Types of Encryption

The process of data encryption consists of certain steps. The data passes through
a mathematical formula called an algorithm, which converts it into encrypted data
called ciphertext. These algorithms create a key and then encapsulate the message
with this key.

There are two types of encryptions – asymmetric and symmetric.

Asymmetric Encryption

In public key (asymmetric) encryption, two mathematically-related keys are used
– one to encrypt the message and the other to decrypt it. These two keys combine
to form a key pair. Asymmetric encryption provides both data encryption and
validation of the communicating parties’ identities and is considered more secure
than symmetric encryption, but is computationally slower.

A public key encryption scheme has following six major parts:

(i) Plaintext: This is the text message to which an algorithm is applied.

(ii) Encryption Algorithm: It performs mathematical operations to
conduct substitutions and transformations to the plaintext.

(iii) Public and Private Keys: These are a pair of keys where one is
used for encryption and the other for decryption.

(iv) Ciphertext: This is the encrypted or scrambled message produced
by applying the algorithm to the plaintext message using keys.

(v) Decryption Algorithm: This algorithm generates the ciphertext and
the matching key to produce the plaintext.
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Symmetric Encryption

Private key encryption (symmetric) – also known as conventional or single-key
encryption – is founded on a secret key shared by two communicating parties. It
requires all parties that are communicating to share a common key. The secret key is
used by the sending party to convert simple text to encrypted text, i.e., text that is
enciphered using the secret key as the security component of the mathematical
process. The receiving party then proceeds to decipher the encrypted material,
using the same secret key that it shares. Examples of symmetric encryption systems
would include the RSA RC4 algorithm (that furnishes the basis for Microsoft Point-
to-Point Encryption (MPPE), Data Encryption Standard (DES), International Data
Encryption Algorithm (IDEA), and the procedure now put forward by the US
Government called ‘Skipjack’ Encryption Technology already utilized in the clipper
chip.

An encryption scheme has five major parts:

(i) Plaintext: This is the text message to which an algorithm is applied.

(ii) Encryption Algorithm: It performs mathematical operations to
conduct substitutions and transformations to the plaintext.

(iii) Secret Key: This is the input for the algorithm as the key dictates the
encrypted outcome.

(iv) Ciphertext: This is the encrypted or scrambled message produced
by applying the algorithm to the plaintext message using the secret
key.

(v) Decryption Algorithm: This is the encryption algorithm in reverse. It
uses the ciphertext and the secret key to derive the plaintext message.

Authentication

A user remotely located must be first authenticated before accessing the network
or Intranet of an organization. The authentication procedures must be built into the
firewall applied to the network or Intranet for security measures. The following
are the procedures to validate remote login or access along with their comparisons
and features.

1. Using UNIX Password for Authentication: The password without
encryption is open to all over the network or the Internet. Hence,
authentication practicing UNIX password may most likely lead to
eavesdropping of the password over the network or the Internet because
the password is not encrypted before being sent. This type of system is not
suitable for authentication of remote login.

2. Using IP Address for Authentication: Packet-filtering types of firewalls
commonly use IP addresses for authentication of data. They apply a set of
already-defined procedures over each received packet before routing to
the desired destination. Each packet received is examined for the pre-
established rules to determine the access validity to the requested network
or only for some available services on the network.
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An authorized user, for example, may log into the network. However, he
may be allowed to use only certain services or server on the destination
network. This is achieved by filtering the packet for certain addresses or
packet types.

The major disadvantage of this type of authentication procedure is that the
IP address authenticated by firewall system or network to be accessed may
fall into wrong hands. Consequently, undesirable users or hackers may hack
the network by getting access through the authenticated IP address hacked
as explained above.

Packet-filtering technique enables the network to determine the type,
protocol, source and destination addresses for unauthorized access. This is
a major advantage of this technique.

3. Using One-Time Password for Authentication: In the above two
procedures, we have witnessed some loose ends which need to be looked
into. In case of password authentication, the password remains unencrypted
and therefore susceptible to be hacked. Access to a network by some
undesirable person may be avoided if the password is validated only once
to login to remote network.  Different passwords are transferred over the
network for each and every login. The authentication system involving this
feature can assure the highest security of all types. It is evident that even if a
hacker acquires the password, he cannot login to the network with that
password.

Network and Web Security
Managing Windows security is required to manage the complete system for running
the applications, downloading the update features for Windows, runtime programs,
etc. For this, installing and downloading the updated antivirus, spyware protection,
installing the firewall software, spamming and filtering the e-mails, accessing the
damaged files, setting the permission level, removing network access for
unauthorized users, setting the group policy for users and workgroups, securing
virtual private network, configuring the wireless security features, creating back-
up and restoring the essential files are essential.  These tasks are essential to
determine the Windows security. The Windows security policy is essential for
programs and documents. It supports remote accessing of data, server security,
e-mail accessing policy, anti-virus policy. It also permits the monitoring traffic too
that is applied to handle the data transaction. The security setting for windows are
basically managed by the network administrator because it is a part of the domain.
Domain represents here a group of computers on a network. To help protect your
computer, the administrator of this computer should do the following tasks:

 Install and use a firewall, such as Windows Firewall in Microsoft Windows
XP or any other enhanced firewall.

 Set up Automatic Updates to download and install critical updates
automatically. Install antivirus software keep it turns on and up to date.

The Windows can be secured by the implementation of following tasks:
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Group Policy
Group Policy Objects (GPO) are linked to active directory containers. These
containers are sites, domains, organizational units. GPOs cannot be linked directly
to users, computers or security groups. GPOs can be linked to multiple sites,
domains, or organizational units. In addition, a site, domain, or organizational unit
can be linked to several GPOs. When you link with multiple GPOs to a single
container, such as domain, site, OU, etc. you need to specify the order in which
the GPO are processed. The lowest link order GPO in the list has the highest
precedence and overwrites the settings of all other GPOs. Group Policy is processed
in this order:

 Local GPO: In this, each computer has a local GPO which is processed
first.

 Site: In this, GPOs linked to a site that a computer belongs to are processed
next. If multiple GPOs are linked to a site, the lowest link order GPO (e.g.,
the first GPO) is processed last or has the highest precedence over the
other GPOs.

 Domain: GPOs linked to the domain are processed next. Like with the
Site GPOs, the ones which have the lowest link order, e.g., link #1 are
processed last. They overwrite any settings applied by other GPOs before
it.

 Organizational Units: GPOs are then processed on the OUs or Output.
The highest OU in the AD hierarchy is processed first, then its child OUs,
until it reaches the OU which the computer or user is in. These OUs are
processed last and have the highest priority over any other settings made
before it.

The functions performed by GPO are that it can link within the Active Directory
(AD), combine the GPOs with inheritance and implement the security and Windows
Management Instrumentation (WMI) filters. It also overrides the user settings based
on computer function and install the group policy management console.

Authentication

Authentication is any process by which one verifies that someone is who they
claim they are. Basically, it involves a username and a password. It can also include
any other method of demonstrating identity, such as a smart card, retina scan,
voice recognition, or fingerprints. Basic authentication is the most basic form of
authentication to Web applications. Both server and client authentication are
required in Windows security.

Server Authentication: The server authentication is a part of client-server
computing. Basically, SSL/TLS is used for authentication. A Web server acquires
digital certificate from available server using Certification Authority (CA). CA is
third party authority that issues digital certificates for authentication. The Digital
Certificate (DC) authenticates the signature that is in fact digitally signed message.
The DC uses SSL/TLS (Secured Socket Layer/ Transport Layer Security) in
X.509 public key infrastructure that was defined by International Telecommunication
Standardization Sector (ITU-T). If client connects to server using SSL/TLS both
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client and server follows strong cryptographic algorithm. Then the server sends
X.509 certificate that contains the server’s public key. The client then generates a
48-byte random number, a premaster secret key after encrypting the number used
by the server’s public key. The encrypted premaster secret key is sent to the
server by client. After getting premaster secret key, the server decrypts the message
using the private keys. Then both client-server shares the same premaster secret
key which is basically symmetric key used to encrypt the message. Then they start
communicating via generated keys. In this mechanism, only server knows the private
key which decrypts the encrypted premaster secret key and then clients knows
the message after sending the decrypted message by server. It proves that client is
talking with correct server. This whole mechanism represents the complete scenario
of authenticating the server.

Client Authentication: In SSL/TSL, client authentication is not required instead
it is optional. A client stays anonymous communicating between Web server and
browser in B2B business transaction. Therefore, they use HTTP authentication
methods. The HTTP authentication known as RFC 2617 represents the HTTP
protocol in which client and server communicates between each other via HTTP
protocol. It basically considers two factors as userid and password to authenticate
the users/clients. Sometimes, userid might be user’s e-mail-id also. Both values
are sent to authenticate without encryption and hence they are not considered as
secure method of authentication in cryptography. In this mechanism, client sends
Base64-encoded userid and password in HTTP header. If data is sent through
SSL/TLS connection therefore, it is not altered or stolen during transmission. The
malicious server can not disguise itself as genuine Web server and also not steal
the password of user. For client authentication, SSL/TLS certificate is used to
obtain an appropriate digital certificate before connecting to the server. A client
generates the private key/public key pair to obtain the client certificate. The private
key is kept as secret key and protected by passphrase. The passphrase works as
password with added security. It is a sequence of word to control access to the
system. The application does not maintain the database of userid and password.
It verifies the certificate that is signed by trusted CA.

Fig. 5.12 Uses of Client Certificates
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Figure 5.12 shows the complete scenario of using the client certificates. Let
take an example, the customer manages ten passwords in which company ‘XXX’
uses specific password to access the system and company ‘YYY’ uses the service.
Once certificate-based authentications are used by applications ‘A’, ‘B’ and ‘C’,
the company issues CA where company trusts on legitimate user.  In this way,
client certificates are used to authenticate the message.

Authentication attaches date and time along with author of the signature and
scrutinizes the contents when signature was being completed. It ensures that message
is not altered. The message can be electronic documents, such as e-mail, text file,
spreadsheet etc. A person or information is authenticated on the computer by
using various techniques. User name and password provides authentication. If
user logs on the system unit or application, user name and password will be asked
for checking authentication. Generally password authentication is provided to user
in which two prime fields, such as ‘User Name and Password’ are required to
access the system. If the two requirements are not matched users are not allowed
to access the system. If two requirements are not matched, users are not allowed
to access the system.

The security setting for Internet user can be configured with ‘Security Settings –
Internet Zone’ tab.

Encryption

Encryption Digital signature is not forged by other person. Once signer signs the
document or message, it can not be forged. Signer can not replace the sign once
message is signed. The two types of encryption are essentially used known as
private key encryption and public key encryption.

Private Key Encryption: The private key encryption contains a secret key that
is taken as code. This mechanism encrypts a packet of information if it passed
across network to the other computer. The private key requires installing the key
which is essentially the same as secret code. The code provides the key to decode
the message. For example, a coded message A is substituted by C and B is
substituted by D. Therefore, A becomes C and B becomes D. If a clue is given for
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the message that code is shifted by 2. The message can be decoded by your
friend. A person wants to see the message, can not get the message, until and
unless he knows the secret key. The financial, legal, ecommerce business transaction
hindrance can be solved in the presence or absence of an authorized handwritten
signature.

Public Key Encryption: The public key encryption uses private and public keys.
The private key is restricted for the individual systems, whereas public key can be
accessed by any system where message would be communicated securely with
the individual system. Decoding for encrypted message is possible with public key
that is provided by the individual system and its own private key. Basically, the key
is based on hash value. The mechanisms are interrelated with each other that
increase its popularity in transaction of digital cash, e-money transfer across net
etc.

The worst kind of software failure you can have is when your computer
refuses to start up because your operating system (Windows) refuses to work.
The other type of failure you might experience is that an application refuses to run.
Both of these types of failures can really stop you in your tracks and ruin your day.
Internet hit by cable breakdown is to be considered as a major cause of irregular
Internet accessing. Recently, Internet access in India and large parts of West Asia
has been hit following breakdown of two undersea cables in the Mediterranean
Sea. Internet access in India and large parts of West Asia including the UAE,
Kuwait, and Saudi Arabia has been hit following breakdown of two undersea
cables in the Mediterranean Sea. The disruption was caused by an anchoring ship
that accidentally damaged Indian-owned Flag cable and SEA-ME-WE after being
diverted from the Egyptian port of Alexandria due to bad weather. Repair teams
have already set sail for the location to troubleshoot the problem and hence this
target was termed as breakthrough process to breakdown the Internet. The
following factors are responsible Internet breakdown to breakthrough list:

Registry Problems

Windows has a built-in database and control system to keep track of all of the
software and critical information that lives on your PC. Usually they make comments
under their breath. Your PC might not start up or an important program installed
on your PC might not work.

 Improper Installations: If you are having problems with software, you
can usually fix them by simply reinstalling your software. This is something
we often put off doing because it is a pain, but it does work better than
anything else.

 Recent Software Installation: When you install new software or
hardware, internal changes are made to your operating system, and these
changes can affect the balance of power on your computer. When you
suspect problems like this then you can see and suggest for troubleshooting
process if you can work through the list to try to find what went wrong.

 Expired Software: Many programs that users install on their PCs are often
downloaded from the Internet. Many are trial versions. Programs like this
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run fine and offer all of the features of the commercial version until one day
when they simply stop running. Software that needs to be activated may be
fully functional for a few days and then may completely cease to functions
until you activate it. Finally, subscription-based software, such as antivirus
software might continue to work after it expires typically one year. The
expired software creates problem to those system which are installed with
the recent operating system.

Viruses

Viruses are frequently transmitted through e-mail attachments, peer--to--peer
downloads, phishing and instant messages. Phishing refers to a fraudulent process
in which user’s credentials are easily grabbed. Among these, e-mail attachments
carry and spread virus fast in an address book or a random combination of address
book. If these viruses are not controlled quickly, the servers can disrupt the e-mail
services for all systems. The functions of computer viruses are as follows:

 It deletes registry attaches, system files and log files. It also destroys the
OS of system units.

 Many viruses slow down the computer performance.

 Viruses decline suddenly in speed and in loss of files or data.

 They cause to display unknown and uncommon messages or even playing a
tune.

 They are responsible for the loss of hard disk partition.

 They release of files normally via e-mail.

To know the working and spreading of viruses on PC or even on the Internet, you
must know the lifecycle of computer viruses.  The lifecycle of computer virus is as
follows:

 Coding  In this phase, the virus program is coded and developed.

 Releasing  Once the code is ready, it is spread to the system and network.

 Spreading  It is out forwarded through a simple e-mail.

 Quarantining  In this phase, the virus gets quarantined. This phase often
happens when it validates the signature of the virus and develops an antivirus
update.

Viruses spread from machine to machine and across network in a number of ways.
The viruses are always trying to trigger and execute the malicious programs that
intently spread the computer system. For example, a macro virus is booted with
infected disk and spread the viruses to boot sector. Then it started to share the
network drive or other media that exchanges infected files across Internet by
downloading files and attachments form Internet. The transmission of viruses is
possible by following ways:

 If system unit is booted from infected files.

 If programs are executed with an infected programs.
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 The virus infiltration includes common routes, floppy disks and e-mail
attachments.

 If pirated software and shareware are used in the system files.

Viruses are malicious and smart. Many a times, users are not able to realize that
their system unit has got infected with viruses. The property of viruses is that they
hide themselves among regular system files or as attachments and camouflage
themselves as standard files. The following steps are usually taken if the system
gets infected with the viruses:

 The Internet facility and LAN utilities must be disconnected for the some
time.

 The OS must be installed within the system unit if the system has not been
booted properly. If the system does not recognize the hard drive it means
that it is infected with virus. It is better to boot from Windows to rescue the
disk.  The partition table of scandisk must be recovered using scandisk for
a standard Windows program.

 A back-up of all important and critical data must be taken at regular intervals by
using external devices, such as CD, USB, floppy disks or even flash memory
etc.

 Antivirus software must be installed in the system and  should be made to
rweekend or at the end of the month. A good quality antivirus disinfects
infected objects, quarantines infected objects and is able to delete Trojans
and worms.

 The latest updates must be taken to remove the antivirus database. The
infected computer is not included to download these updates.

 Scans disinfect the mails of a client’s database and ensure the maliciousograms
are not reactivated if messages are sent from one address to another across
the network.

 Firewall security features must be installed in the system that prevent attacks
from malicious and foreign programs.

 Delete and clean the corrupted applications and files. Try to reinstall the
required applications in your system but be sure that the corresponding
software is not pirated.

Antivirus Software(s)

Now you know the concept of worms, spyware and viruses. You need to install
and run the antivirus programs to clean the virus and provides the security for
Windows. It helps in protecting Windows from crashing. The antivirus software
available in the market to deal with virus-related issues are as follows:

 Symantec Antivirus that is used to check the security of foreign programs
and applications.

  Windows Vista AntivirusSpyware, AntivirusNorton Antivirus that is used
to catch worms, rootkits, spywares, viruses, etc..

 Avast Antivirus.
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 Kaspersky Antivirus that is used for HTTP traffic-checking and for providing
a security wizard.

These antiviruses are useful for those types of viruses that are downloaded from
the net or from e-mail attachments. The most popular antivirus programs are Data
Fellows F-Prot, EliaShim ViruSafe, ESaSS ThunderBYTE, IBM Antivirus,
McAfee Scan, Microsoft Anti Virus, Symantec Norton Antivirus and S&S Dr
Solomon’s AVTK. The hard disks and drives must be scanned on a daily basis.
Every week, hackers and malicious programmers release their virus programs
across the Internet so it is better to keep the system updated with the latest antivirus
software and programs. The updated user manual and help files must be provided
to the users during the installation of expensive applications and the operating
system. In fact, automatic updates to the list of antivirus and multithread detection
are the standard features of an antivirus program.

Windows Firewall

A security audit logging feature is provided with the Windows Firewall. Windows
security is protected with firewall installation. Firewall provides a secure barrier
for Windows security that protects your PC from outside and foreign world. It is
configured with full-time Internet connection. Firewall software is considered as
an effective means to protect the Internet from malfunctions and networked-based
security threats. Information and services are essentially required for the
organizations. Internet connectivity uses dialup capability and installed with the
system unit to the Internet service provider. Connections network requires various
types of software as well as operating system.  Firewall is inserted between Internet
and Internet-based attacks that provide a single choke point in which all other
malfunctions are tracked. The characteristics of firewall are as follows:

 All Internet traffic must be passed via firewall. It the foreign accessing
approaches to the local network.

 Only authorized traffic is to be allowed to pass.

 It itself is to be immune to be permutation.

 It filters traffic with the help of allotted IP address and also takes help of
TCP port number.

 It hosts the server software, such as Web or mail service.

 It monitors security-related events.

 It provides a platform for the Internet Protocol Security (IPSec) that includes
a network address translator, audits and alarms.

The limitations of firewall are as follows:

 Some of the complex types of attacks are not protected by firewalls.

 It can not protect virus-infected programs and not able to scan the incoming
files, messages for viruses, e-mails, etc.

 It does not protect against threats.

The firewall is consisted of two systems, known as a bastion-host and a packet
filtering router. Bastion-host is worked for authenticating services and performing
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the proxy functions. The configuration of firewall is assembled between two packet-
filtering routers. In this setting, one approach comes between the bastion-host and
the Internet work. This configuration is set with an isolated subnetwork, which
provides three levels of defense to thwart intruders.

You need to select the On radio button in Windows Firewall tab, because it blocks
all outside and foreign sources from connecting to this computer.

Privacy

Each individual has his or her own personal space. Breaching that privacy is
considered to be unacceptable. This rule applies to the Internet or Web as well.
There are innumerable Internet users all over the world who are constantly accessing
data and uploading data. So the Internet privacy is to regulate what a person
reveals about himself or herself and who can gain access to it. The Internet privacy
is the desire or mandate of personal privacy concerning transactions or transmission
of data via the Internet. It involves the exercise of control over the type and amount
of information a person reveals about himself on the Internet and who may access
such information. The term is often understood to mean universal Internet privacy,
i.e., every user of the Internet possessing Internet privacy. Internet privacy forms
a subset of computer privacy. People with only a casual concern for Internet
privacy need not achieve total anonymity.

As people use computers for a variety of purposes, confidential information,
confidential communications, and personal choices can be registered in a variety
of ways. The Internet privacy is a broad term referring to the various concerns,
technologies, and strategies for protecting information, communications, and choices
that are meant to be private. In general, using the Internet often means giving up
some measure of privacy. For people who wish to remain completely anonymous,
the best approach is to use a public computer, such as those available at public
libraries. Other steps to take when anonymity is the goal include clearing the cache
and browsing history before leaving the computer. This is done in different ways
depending on the browser used and refraining from entering any personal
information or creating any user names or passwords.

For example, if you want to shop online, use social networking sites, play
online games, or participate in forums, Internet privacy can become an issue in a
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number of ways. If your passwords are exposed, your identity can be fraudulently
used or even stolen. If your words, photographs or products you have created are
posted without your permission, your reputation and income can be damaged. If
your contact information is passed around, you may be subject to spam. If your
browsing history becomes public, people will know what you have been looking at
online. Fortunately, taking certain precautions can reduce the privacy risks that you
face.

Strong passwords that are kept secret are one way to safeguard your
Internet privacy. Browser privacy settings, which control elements like storage of
your browsing and download history and the acceptance of cookies, are there for
you to alter to meet your preferences. The options differ with different browsers.
Similarly, social networking sites have settings to allow you to control the level of
privacy of various postings you may make. The default settings may be skewed
towards the public exposure of information rather than towards Internet privacy.
For sites such as forums, make sure you read the privacy terms before signing up.

Internet users obtain Internet access through an Internet Service Provider
(ISP). All data transmitted to and from users must pass through the ISP. Thus, an
ISP has the potential to observe users’ activities on the Internet. In addition, search
engines have the ability to track a user’s searches. Personal information can be
revealed through searches including search items used, the time of the search, etc.
Search engines have claimed a necessity to retain such information in order to
provide better services, protect against security pressure and protect against fraud.

Check Your Progress

    12. Define asymmetric encryption.

    13. What do you understand by symmetric encryption?

14. List the characteristics of firewall.

5.7 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. Using direct communication you can send messages to family and friends,
business associates and acquaintances using the electronic mail facility. With
the help of electronic mail, you can send and receive messages within a few
seconds anywhere in the world. Using Internet Relay Chat (IRC), you can
communicate online with people over the Internet. You can log into a chat
room and converse with others by typing messages that are instantly
delivered. With the improvement of network technologies and increase in
broadband, you can not only use text messages but also graphics, audio
and video for communication with other people.

2. World Wide Web commonly known as ‘WWW’, ‘Web’ or W3’ consists
of a number of distributed servers that are connected through hypermedia
documents. These documents are created using HyperText Markup
Language (HTML). Related text organized into units can be accessed by
using a link called hyperlink. These links allow the user to navigate from one
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document to another without having to worry about the actual physical
location of the documents. WWW makes it possible to share information
between disparate users, computers and operating systems. It is therefore
the fastest growing application of the Internet.

3. Website: The Web can be understood as a collection of thousands of
information locations connected to each other. Each such location is called
a Website and comprises of multiple Web pages. A Web page is created
using HTML and is like any other computer document. It consists of text,
pictures, sound, video and hyperlinks. You can navigate from one Web
page to another Web page using hyperlinks. A Website can be created by
an individual or a company. Websites are hosted on the Web servers which
are accessible on the Internet.

Wi-Fi: The Wireless Fidelity or Wi-Fi was used in public switched network
which was originally created by American Telephone & Telegraph or AT&T
who used Bell Laboratories standards to ensure that all central office switches
and lines that carried calls met these pre-set standards. The standards set
by AT&T enabled everyone to communicate with anyone else regardless of
the service provider since the dialling ringing, routing and telephone numbering
were all uniform.

4. Outlook provides following new tools for enhancing the productivity:
 Outlook Today: Displays new e-mails, schedules meetings and task lists,

all in one window.
 Preview Pane: Displays e-mail messages in a pane at the bottom of the

window for quick prioritization.
 Auto Preview: Lets you to view the first three lines of an e-mail message

without opening it.
 Find and Organize Tools: Allow you to search for any e-mail message,

contact or task. The Organize tool provides easy access to various
folders, views and filters.

 AutoSave: Automatically saves unsent notes in a draft folder.
 Junk E-Mail Filters: Help you to block spam mail.

5. The standard toolbar contains buttons, drop-down menus and other controls
that help you quickly alter the appearance and arrangement of documents
by executing a variety of Outlook commands. Toolbars are very helpful
and convenient in quickly executing commands without having to go through
menus. The standard toolbar contains icons for basic functions, such as
opening new files, printing files, sending and receiving e-mails, navigating
the address book, etc.

6. The scroll bar helps you to travel within Outlook. You can go anywhere, up
and down, right and left, in your Outlook screen mainly by two ways: using
the horizontal and vertical scroll bars with the help of a mouse or using the
keyboard by pressing PgUp, PgDn, Home, End and the arrow keys.

7. The Internet is a place where we are interacting with world, so our behaviour
on the Internet should be accepted by all. Additionally, our behaviour on
the Internet should be value based. We should not hurt someone. We should
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not tease anyone on the platform like the Internet. We should not pass any
comment which shows any type of controversy. The Internet is platform
which should be value based. World Wide Web (WWW) is a place where
values are considered in the world wide platform.

8. To be safe on the Internet is every ones responsibility. The Internet safety is
a lot more than just about ensuring that your computer has the latest anti-
virus and firewall software installed. It is about being smart about how you
handle yourself online and sense about how you deal with other people and
not falling prey to an online scam artist who takes advantage of your
ignorance.

9. Netiquettes of E-Mail

 Use Subject Lines Very Clearly

Subject line must be short and easily identify the purpose of mail.

Use some words like

RE: For response to e-mail

       URGENT: For urgent e-mail

       REQ: For request e-mail

 Compose Mail: The text used in mail should be short, point to point,
and in easy language.

 Line Breaks Must be Used: Line must be break as per as the window
size or after 60-70 characters. Each point should be mentioned in new
line.

 Check Spellings: Always check spellings before sending mails. It gives
bad impression on

 Use of Capital and Small Letters: Use sentence case in emails. It is
considered harsh to write email in all capital letters. It gives the emotion
of shouting on others.

 Use of BCC Feature: BCC function in the e-mail program, to make
sure that the recipients do not know who else received the message.

 Give Proper Names to Attachments: When are attaching files the name
of the file must be relevant to subject. As the receiver is going to download
the file and in future, the file must be easily identified by logical names.

10.  The following steps are required to control viruses:
 Keep virus definitions update.
 Get a sound knowledge of antivirus program subscription.
 Restrict to open or execute the unexpected attachments.
 Turn off the preview features in the computer program for added

protection.
 Turn off .vbs (Visual Basic Script) function.
 Check out sincerely the extension of file attachment.
 Do not use pirated system and application software.
 Secure your system with latest antivirus.
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 Scan your system regularly.
 Update your antivirus software.

11. A Trojan Horse is a virus program and internally works something else then
what is specified by the user. The Trojan Horses are generally enclosed so
that they appear attractive, for example a saxophone.wav file is a virus file
which draws the attention of a system user interested in collecting sound
samples of musical instruments. A Trojan Horse is different from other
destructive viruses because they does not reproduce. It steals the passwords
and sends an E-mail to the hacker’s false name and then the hacker has all
your description in his hands.

12. In public key (asymmetric) encryption, two mathematically-related keys
are used – one to encrypt the message and the other to decrypt it. These
two keys combine to form a key pair. Asymmetric encryption provides
both data encryption and validation of the communicating parties’ identities
and is considered more secure than symmetric encryption, but is
computationally slower.

A public key encryption scheme has following six major parts:
(i) Plaintext: This is the text message to which an algorithm is applied.
(ii) Encryption Algorithm: It performs mathematical operations to conduct

substitutions and transformations to the plaintext.
(iii) Public and Private Keys: These are a pair of keys where one is used

for encryption and the other for decryption.
(iv) Cipher Text: This is the encrypted or scrambled message produced

by applying the algorithm to the plaintext message using keys.
(v) Decryption Algorithm: This algorithm generates the cipher text and

the matching key to produce the plaintext.

      13. Private key encryption (symmetric) is also known as conventional or single-
key encryption, it is founded on a secret key shared by two communicating
parties. It requires all parties that are communicating to share a common
key. The secret key is used by the sending party to convert simple text to
encrypted text, i.e., text that is enciphered using the secret key as the security
component of the mathematical process. An encryption scheme has five
major parts:

(i) Plaintext: This is the text message to which an algorithm is applied.
(ii) Encryption Algorithm: It performs mathematical operations to conduct

substitutions and transformations to the plaintext.
(iii) Secret Key: This is the input for the algorithm as the key dictates the

encrypted outcome.
(iv) Cipher Text: This is the encrypted or scrambled message produced

by applying the algorithm to the plaintext message using the secret
key.

(v) Decryption Algorithm: This is the encryption algorithm in reverse. It
uses the cipher text and the secret key to derive the plaintext message.
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14. The characteristics of firewall are as follows:
 All the Internet traffic must be passed via firewall. It the foreign accessing

approaches to the local network.
 Only authorized traffic is to be allowed to pass.
 It itself is to be immune to be permutation.
 It filters traffic with the help of allotted IP address and also takes help of

TCP port number.
 It hosts the server software, such as Web or Mail Service.
 It monitors security-related events.
 It provides a platform for the Internet Protocol Security (IPSec) that

includes a network address translator, audits and alarms.

5.8 SUMMARY

 Using the Internet Relay Chat (IRC), you can communicate online with
people over the Internet. You can log into a chat room and converse with
others by typing messages that are instantly delivered. With the improvement
of network technologies and increase in broadband, not only can you use
text messages but also graphics, audio and video for communication with
other people.

 Telephone lines were designed to transmit human voice, and not electronic
data from computers. Modems were therefore invented to convert digital
computer signals into a form that allowed them to travel over phone lines—
by converting digital signals to analog ones on one end, and converting
them back to digital signals at the receiving end. The word MODEM stands
for MOdulator/DEModulator.

 Digital Subscriber Line or DSL is a high-speed technology that has recently
gained popularity. It can carry both data and voice over telephone lines. It
is possible for a DSL line to stay connected to the Internet this means that
you do not have to dial up every time you wish to go online.

 A Web browser, commonly known as a browser, is a computer application
that creates requests for HyperText Markup Language or HTML pages or
Web pages and displays the processed HTML page. Web browsers use
HTTP (HyperText Transfer Protocol) to request for information from Web
servers.

 The term search engine, when used in the context of the Web, refers to the
actual search forms through which databases of HTML documents initially
gathered by a robot are searched.

 Transmission Control Protocol/Internet Protocol (TCP/IP), a communication
protocol, used for Internet access. It is used to allow different types of
computers to communicate over a network.

 The Wi-Fi Alliance represents the wireless standard protocol and basically
non-profit organization.  This supports interoperability features for wireless
devices. It connects the networking system without cables.
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 The Wi-Fi hotspots are created around the antennas to outlet the radio
waves of wireless networking.  It is confined to almost 10000 hotspots in
crowded areas, such as airport lounges, cafes, etc.

 List appointments and events, such as business meetings, birthdays, business
trips and vacations, etc.

 Outlook’s address book enables you to maintain a comprehensive database
of your business and personal contacts.

 Contacts display is used to organize your contacts in a business card form.
Only the fields that contain information are visible. To change any information
about a contact, double-click the contact.

 E-mail is an electronic medium in which message can be sent or received
from one user to another. The e-mail message is sent via Simple Mail Transfer
Protocol or SMTP server, but Internet Service Provider or ISP leads the
main role to correspond the e-mails across various users.

 The basic approach is to create your HTML e-mail as a separate html file
and then create a signature file and use your html e-mail as the signature file.
Then you open a new e-mail message and add the new signature file.

 The Address Book provides a convenient place to store contact information
for easy retrieval by programs, such as Microsoft Outlook Express. It also
features access to Internet directory services, which you can use to look up
people and businesses on the Internet.

 Stationery is a preformatted theme. Selecting a stationery lead to show
how fonts, bullets and horizontal lines are displayed within you e-mail message
and it is helpful when sending newsletter or invitations for a personal activity,
such as a birthday celebration.

 Ethics are a set of moral values that control any human being or a group on
what is suitable manners while using an online computer. Computer ethics is
a set of moral values that control the usage of computers.

 Internet is mode of communication with our friends and family. We should
respect the privacy of others. We should not post any photograph or personal
comment about any particular person without the permission.

 One of the Internet danger is Cyber bullying. That’s why it’s important to
be aware of what children see and hear on the Internet, who they meet, and
what they share about themselves online.

 Online Gaming is a fun and entertainment way to spend time, encouraging
teamwork and developing skills. Online gaming world is just like as a virtual
playground.

 The Internet also contains controversial material which is dangerous for
human being. It contains the information related to sex, terrorism,
pornography, religious sensitive issues, etc.

 A computer virus is a set of executable code that attaches itself to other
programs to replicate itself without the awareness of a system user. These
computer viruses can damage the system of a computer.
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 The non-resident virus looks for other sources to infect and transfer control
to the host program, whereas the resident virus looks new host if the infected
files are accessed by other programs.

 Network security is a broad topic with a multi-layered approach. It can be
addressed at the data link, network and the application layers. The issues
concerned are packet intrusion and encryption, IP packets and routing tables
with their update versions, and host-level bugs that occur at the data link,
network and the application layers, respectively.

 Networks are designed to share information. Therefore, the network must
be clearly configured to identify the shareable information and non-shareable
information.

 Data security is concerned with the protection of data contained in a file or
many files in a computer either as a standalone or on a network, from
unauthorized interception.

 A firewall is a combination of software and hardware components that
controls the traffic between a secure network (usually an office LAN) and
an insecure network (usually the Internet), using rules defined by the system
administrator.

 The authentication procedures must be built into the firewall applied to the
network or Intranet for security measures.

 Authentication is any process by which one verifies that someone is who
they claim they are. Basically, it involves a username and a password. It can
also include any other method of demonstrating identity, such as a smart
card, retina scan, voice recognition, or fingerprints.

 Viruses are frequently transmitted through e-mail attachments, peer-to-peer
downloads, phishing and instant messages. Phishing refers to a fraudulent
process in which user’s credentials are easily grabbed.

 Internet users obtain Internet access through an Internet Service Provider
(ISP). All data transmitted to and from users must pass through the ISP.
Thus, an ISP has the potential to observe users’ activities on the Internet.

5.9 KEY TERMS

 Distance education: The Internet provides a perfect medium for knowledge
sharing and information dissemination.

 Favourites: The Favourites button is used to record the addresses of
frequently visited.

 Search: The Search button allows you to find information on the Web.
 Web link: A Web link is a reference to a document that the reader can

directly follow or that is followed automatically which points to a whole
document or to a specific element within a document.

 Search engine: Search engine is designed to search for information on the
World Wide Web (WWW) and FTP servers and the information consists
of Web pages, images, information and other types of files.
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 AutoSave: Automatically saves unsent notes in a draft folder.
 Title Bar: The Title Bar specifies that which application package is currently

running and which option is currently open.
 Encryption Algorithm: It performs mathematical operations to conduct

substitutions and transformations to the plaintext.
 Decryption Algorithm: This algorithm generates the cipher text and the

matching key to produce the plaintext.

5.10 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What do you mean by direct communication?
2. Define the term dial-up connections.
3. List the useful tips for Web searching.
4. What is the significance of E-mail?
5. How do you create your own E-mail folder?
6. What risk factors are involved in working with the Internet?
7. Explain the term online scams.
8. Define macro viruses.
9. What are the different levels of security?

10.  How private key encryption is different from public key encryption?

Long-Answer Questions

1. Briefly explain about the significance and purpose of the Internet.
2. Explain the options used for connecting to the Internet giving appropriate

examples.
3. Discuss the various options of the Internet explorer toolbar.
4. How the search engine works? Explain giving examples.
5. Explain the process of locating information on the Web using search engines.
6. Evaluate the significance of Wi-Fi security for the public networks.
7. Explain the various parts of an Outlook Window.
8. Discuss the common ethics which must be followed on the Internet.
9. Explain in detail about the cyber security and also discuss its factors.

10.  What are the controversial materials on the Internet? Discuss giving
examples.

11.  Briefly discuss about the different types of computer viruses.
12.  Explain the risks factors related to computer security. What protection

measures can be taken? Also explain the importance of cyber ethics.
13.  What are the firewalls? Discuss the network architecture of a firewall.
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14.  Discuss in detail about the significance of data encryption and authentication.
Explain the data encryption and authentication procedure with the help of
examples.
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